
LexisNexis® PCLaw

LexisNexis® PCLawPlus

LexisNexis® PCLawPro

LexisNexis® PCLawPro Enterprise

P C L a w  R e p o r t s

Copyright  1993-8/7/07, LexisNexis® Practice Management Systems



PCLaw Reports

Page ii 

LexisNexis® Practice Management Systems

Toronto Office

123 Commerce Valley Drive East

Suite 310

Markham, Ontario L3T 7W8

(905) 695-3900

(800) 387-9785

Fax: (905) 695-5361 (Support)

Fax: (416) 695-5360 (Sales)

E-mail: sales@pclaw.com

Web Site: www.pclaw.com

Program Suggestions: wishlist@pclaw.com

 8/7/07 LexisNexis® Practice Management Systems. All rights reserved.

LexisNexis® PCLaw, LexisNexis® PCLawPro, LexisNexis® PCLawTE, LegalPRO, SoloPRO are trademarks or registered trademarks of LexisNexis® Practice 
Management Systems.

Clip Art Copyright 1994 Metro Creative Graphics, Inc. All rights reserved. Some of the clip art images were developed by 3G Graphics.

This product includes software written by Eric Young and/or Tim Hudson.

The contents of this manual and the program referred to herein and all sub-routines and information with respect thereto are valuable, confidential trade 
secrets and proprietary information of LexisNexis® Practice Management Systems which are held in trust and only to be used on a single machine pursuant 
to a written licence agreement with LexisNexis® Practice Management Systems and not otherwise. It is also protected under the copyright laws as an 
unpublished work. Copying, modifying, merging, distributing, or transmitting to others, in form or medium whatsoever, or disclosure to anyone, is not 
permitted without the prior written consent of LexisNexis® Practice Management Systems and causes the licence to use same to automatically terminate.

The following are trademarks or registered trademarks of their respective companies or organizations:

Adobe System Inc.: Adobe Acrobat Reader; Corel Corporation: Corel WordPerfect; LexisNexis® Practice Management Systems: Time Matters, LexisNexis® 
HotDocs®; Gavel and Gown Software Incorporated: Amicus, Amicus Attorney, Amicus Assistant; Insilco Corporation: Rolodex; Intuit Inc: Quicken, 
QuickBooks; Lotus Development Corporation: Lotus 1-2-3; Microsoft Corporation: Internet Explorer, Outlook, Windows 95/98/2000/NT/ME/XP, Microsoft 
Word, Excel, Microsoft Money, SQL Server Desktop Engine (MSDE), SQL Server 2000/2005, SQL Express; Palm Computing, Inc., 3Com Corporation: Palm, 
Palm OS; Best U.S. Holdings, Inc.: Timeslips 



Table of Contents

Page iii

Table of Contents

Chapter 1: About PCLaw Reports 
Introduction to Reports............................................................................................2
Where PCLaw Reports are Available .......................................................................4
Creating Reports by Lawyer.....................................................................................6
Report Properties.....................................................................................................8

Chapter 2: Journals
Journal Overview ..................................................................................................10
Client Costs Journal...............................................................................................11
General Bank Journal ............................................................................................14
Trust Bank Journal .................................................................................................18
Trust Bank Matter-to-Matter Transfer Journal..........................................................22
General Journal.....................................................................................................24
GST Journal...........................................................................................................26
Sales Tax Journal ...................................................................................................30
Billing (Fees) Journal..............................................................................................34
Invoice Journal ......................................................................................................40
Write Up/Down Journal ........................................................................................44

Chapter 3: Client Reports
Client Report Overview.........................................................................................48
Client Ledger.........................................................................................................49
Client Accounting Ledger......................................................................................56
Client Summary ....................................................................................................60
Client Fees Listing .................................................................................................66
Client Trust Listing.................................................................................................70
Client Trust Ledger ................................................................................................74
Work-In-Progress Report .......................................................................................78
WIP Summary by Responsible Lawyer...................................................................82
Disbursement Analysis & Interest Report ...............................................................86
Disbursement History Report ................................................................................90
Hard & Soft Cost Analysis .....................................................................................94
Partner Alert Report ...............................................................................................98
List of Clients ......................................................................................................102
Matter Status Report ............................................................................................106
Matter Change Log..............................................................................................110
Closed Files Report .............................................................................................112
File Location Report ............................................................................................114

Chapter 4: Accounts Receivables Reports
Accounts Receivable Report Overview................................................................118
Receivables by Client Report...............................................................................119
Receivables by Lawyer Report .............................................................................124
Payment Allocation Listing ..................................................................................128
Interest Calculation Report ..................................................................................132



PCLaw Reports

Page iv 

Chapter 5: Accounts Payable Reports
Accounts Payable Report Overview .................................................................... 136
Purchases Journal ............................................................................................... 137
Payable Listing .................................................................................................... 140
Payment Listing................................................................................................... 144
Allocation Listing................................................................................................ 148
Discount Listing.................................................................................................. 152
Vendor Ledger .................................................................................................... 154
Vendor Listing .................................................................................................... 158
1099 Listing........................................................................................................ 160

Chapter 6: Productivity Reports
Productivity Report Overview............................................................................. 164
Billing by Lawyer Report..................................................................................... 165
Collection Summary ........................................................................................... 168
Lawyer WIP, Billing & Collection Summary ........................................................ 172
Time Listing ........................................................................................................ 176
Time Summary.................................................................................................... 180
Productivity by Client Report .............................................................................. 184
Billing Realization Report ................................................................................... 190
Client WIP, Billing, & Collection Summary ......................................................... 194
Fees Collected Summary..................................................................................... 200
Fee Adjustments Report ...................................................................................... 204
Fee Allocation Summary..................................................................................... 208
Fees Due by Lawyer Report ................................................................................ 212
Firm Cash & Fee Summary.................................................................................. 216
Billable Time Summary by Working Lawyer........................................................ 220
Comparative Time Analysis................................................................................. 224
Daily Time Summary .......................................................................................... 228
Time Utilization Analysis .................................................................................... 230
Unbilled Time & A/R Summary by Working Lawyer............................................ 232
Matters Opened Summary .................................................................................. 236
Lawyer Budgeting Report.................................................................................... 238

Chapter 7: Non-Accounting Reports
Non-Accounting Report Overview...................................................................... 242
Appointment Listing ........................................................................................... 243
Appointment Schedule ....................................................................................... 246
Contact Listing.................................................................................................... 248
User Security Listing ........................................................................................... 251
File Conflict Listing ............................................................................................. 252
Research Listing.................................................................................................. 254

Document Listing ............................................................................................... 256



Table of Contents

Page v

Chapter 8: Month-End Reports
Month End Report Overview...............................................................................260
G/L Reconciliation Report ...................................................................................261
Cash Flow Planner ..............................................................................................266
Bank Reconciliation Report.................................................................................270

Chapter 9: Canadian Reports
Trust Administration Fee Detail ...........................................................................274
Trust Administration Fee - Eligibility Report .........................................................276
Trust Administration Fee Summary ......................................................................278
Transaction Levy Detail (Newfoundland).............................................................280
Transaction Levy Summary (Newfoundland) .......................................................282
Transaction Levy Detail (Ontario) ........................................................................284
Transaction Levy Summary (Ontario)...................................................................286
Volume Surcharge Summary ...............................................................................288
Where Canadian Reports are Available ...............................................................290

Chapter 10: Additional Report Selection Tabs
Matter Tab...........................................................................................................292
Layout Tab ..........................................................................................................294
Customizable Reports .........................................................................................296



PCLaw Reports

Page vi 

Selected List of Tables

Lawyer Definitions.................................................................................................. 3

Where PCLaw Reports are Available....................................................................... 4

Creating Reports by Lawyer .................................................................................... 6

Journal Overview.................................................................................................. 10

Client Report Overview ........................................................................................ 48

Accounts Receivable Report Overview ............................................................... 114

Accounts Payable Report Overview .................................................................... 132

Productivity Report Overview............................................................................. 160

Non-Accounting Report Overview...................................................................... 238

Month End Report Overview .............................................................................. 256

Where Canadian Reports are Available............................................................... 286



    Page 1

About PCLaw Reports

Introduction to Reports ...............................................................................2
Categories of Reports ..............................................................................................2
How Reports are Structured ....................................................................................2
Lawyer Definitions..................................................................................................3
Availability of Features............................................................................................3

Where PCLaw Reports are Available............................................................4

Creating Reports by Lawyer.........................................................................6

Report Properties.........................................................................................8
Displaying Tabs ......................................................................................................8
Customizable Reports .............................................................................................8
Printing Reports ......................................................................................................8
Drill Down .............................................................................................................8



PCLaw Reports

Page 2 

Introduction to Reports
LexisNexis PCLaw reports provides an organized set of the information entered into PCLaw. reports provide 
valuable information, such as the time worked or expenses incurred on behalf of clients, which clients have 
outstanding bills, and how much income you firm has earned in a specific period.

Categories of Reports
Reports are grouped according to the area or feature on which they report.

Exhibit 1-1. A List of report types used in this manual 

How Reports are Structured
Criteria for selecting PCLaw reports are divided into tabs. Each tab contains a specific grouping of options 
used to create the precise information you want on the report.

Common Tab
The Common tab contains the most frequently used report options such as starting and ending dates, matter, 
client, and lawyer selectness, and report output options.

Matter Tab
For matter-based reports, the Matter tab defines the report by any combination of selected matters, clients, 
lawyers, types of law, or matter status. Since the appearance of this tab is standard on most reports, it is 
described separately. 

Other Tab
The Other tab contains less frequently used options that are specific to a particular report. 

Layout Tab
The Layout tab lists each data item on a report. By selecting or deselecting a data item, you specify which 
item to display on the report. Since the structure of this tab is standard on most reports, it is described 
separately. 

Report Description

Journals contain records of the actual daily transactions being made in LexisNexis PCLaw 
and provide an audit trail of the changes to the g/l if you are using g/l accounting

Client Reports provide information concerning clients and matters

Accounts Receivables provide information concerning clients and matters

Accounts Payable provide a statement of accounts for vendors conducting business with your firm.

Productivity Reports provide information on lawyer and client activity

Month End Reports provide information for cash flow and reconciling periods.

Non-Accounting Reports provide listings of persons, documents, and events within PCLaw.
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Lawyer Definitions
PCLaw uses seven unique lawyer types. Their definition is dependent on the stage of matter creation, 
time, entry, billing, or account collection where they appear.

Exhibit 1-2. Lawyer types that appear in PCLaw and their definitions 

Availability of Features
Certain reporting abilities described on reports may not be available on some editions of PCLaw.

Request Check, Release Check, Request Bill, Release Bill, and Matter Introducing Lawyer are available on 
PCLawPro and PCLawPro Enterprise only.

Correcting Features such as Correct Check, Correct Receive Payment, and others are available only on 
PCLaw systems that have converted from version 5 and lower. 

Type of Lawyer Definition

Client Introducing Lawyer The lawyer who brings the client to the firm. This lawyer is specified when creating 
the client, or a matter for a new client. Although a client can be created without a 
client introducing lawyer, it is important for reporting purposes that each client has 
an introducing lawyer.

Matter Introducing Lawyer For PCLawPro and PCLawPro Enterprise Only: The lawyer who brings the matter to 
the firm. The matter may belong to an existing client, and a client may have unique 
and multiple introducing lawyers for each matter. 

Responsible Lawyer The lawyer who is in charge of the matter. The Responsible Lawyer is specified in 
New Matter and Matter Manager and is a required field when creating a matter.

Assigned Lawyer The lawyer who is the primary timekeeper for the matter. The Assigned lawyer is 
specified in New Matter and Matter Manager.

Working Lawyer The timekeeper whose nickname is entered with a time/fee entry.

Fee Credit Lawyer The timekeeper who is assigned credits for time/fees billed on a matter. The working 
lawyer can become the fee credit lawyer, if Auto Allocate Time/Fees to Working 
Lawyer is enabled on the Matter Manager > Billing tab, or to the responsible lawyer, 
if the option is disabled. Time/fees are allocated to third party lawyers if those 
lawyers are specified through the Split Charges option on the Matter Manager > 
Billing tab. 

Collecting Lawyer The lawyer who is responsible for collecting the receivables if the invoice becomes 
outstanding. If a nickname is not entered in the Lawyer box on the Main tab of 
Create Bill/Request Bill, then the responsible lawyer becomes the collecting lawyer. 
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Where PCLaw Reports are Available
Use this chart to determine if the preferred report is in your current edition of PCLaw. .

Report Name Included in 

PCLaw PCLaw+ PCLawPro Module Country ePCLaw

1099 Listing yes yes yes a/p USA no

Allocation Listing yes yes yes a/p all no

Appointment Listing yes yes yes a/p all no

Appointment Schedule yes yes yes a/p all no

Bank Reconciliation report yes yes yes bank rec all no

Billable Time Summary by WL no no yes n/a all yes

Billing by Lawyer yes yes yes n/a all yes

Billing (Fees) Journal yes yes yes n/a all yes

Billing Realization report yes yes yes n/a all yes

Cash Flow Planner yes yes yes n/a all no

Client Accounting Ledger yes yes yes n/a all yes

Client Costs Journal yes yes yes n/a all yes

Client Fees Listing yes yes yes n/a all yes

Client Ledger yes yes yes n/a all yes

Client Summary yes yes yes n/a all yes

Client Trust Listing yes yes yes n/a all yes

Client Trust Ledger yes yes yes n/a all yes

Client WIP, Billing, & Collection no yes yes n/a all yes

Closed Files report yes yes yes n/a all yes

Collection Summary yes yes yes n/a all yes

Comparative Time Analysis no no yes n/a all yes

Contact Listing yes yes yes n/a all no

Daily Time Summary no no yes n/a all yes

Disbursement Analysis & Interest yes yes yes n/a all yes

Discount Listing yes yes yes a/p all no

Document Listing yes yes yes n/a all no

Fee Adjustment report no no yes n/a all no

Fee Allocation Summary no no yes n/a all yes

Fees Collected Summary no no yes n/a all yes

Fees Due by Lawyer report no no yes n/a all yes

File Conflict List yes yes yes n/a all no

File Location report yes yes yes n/a all yes

Firm Cash & Fee Summary no no yes n/a all yes

G/L Reconciliation report yes yes yes n/a all no

General Bank Journal yes yes yes n/a all yes

General Journal yes yes yes n/a all yes

Goods & Sales Tax (VAT) Journal yes yes yes n/a C/A/B no
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Exhibit 1-3. Table listing PCLaw reports and in what versions of PCLaw that they are available 

Report Name Included in 

PCLaw PCLaw+ PCLawPro Module Country ePCLaw

Interest Calculation report yes yes yes n/a all no

Invoice Journal yes yes yes n/a all yes

Lawyer Budgeting report no yes yes n/a all no

Lawyer WIP Billing, & Collection yes yes yes n/a all yes

List of Clients yes yes yes n/a all yes

Matter Change Log no no yes n/a Australia no

Matter Status report yes yes yes n/a all no

Matters Opened Summary no no yes n/a all yes

Partner Alert report yes yes yes n/a all yes

Payable Listing yes yes yes a/p all no

Payment Allocation Listing yes yes yes n/a all yes

Payment Listing yes yes yes a/p all no

Productivity by Client yes yes yes n/a all yes

Purchases Journal yes yes yes a/p all no

Receivable by Client yes yes yes n/a all yes

Receivable by Lawyer yes yes yes n/a all yes

Research Listing yes yes yes n/a all no

Sales Tax Journal yes yes yes n/a all yes

Time Listing yes yes yes n/a all yes

Time Summary yes yes yes n/a all yes

Time Utilization Analysis no no yes n/a all yes

Transaction Levy Detail Report yes yes yes n/a Canada no

Transaction Levy Summary yes yes yes n/a Canada no

Trust Admin Fee Detail Report yes yes yes n/a Canada no

Trust Admin Fee Eligibility yes yes yes n/a Canada no

Trust Admin Fee Summary yes yes yes n/a Canada no

Trust Bank Journal yes yes yes n/a all yes

Trust Bank Matter-to-Matter Transfer yes yes yes n/a all yes

Unbilled Time Summary by WL no no yes n/a all yes

User Security Listing yes yes yes n/a all no

Vendor Ledger yes yes yes a/p all no

Vendor Listing yes yes yes a/p all no

Volume Surcharge Summary yes yes yes n/a Canada no

WIP Summary by Responsible Lawyer no no yes n/a all yes

Work-in-Progress yes yes yes n/a all yes

Write-Up/Down Journal yes yes yes n/a all yes
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Creating Reports by Lawyer
Use this chart to determine if the reports that can be produced by a specific type of lawyer. Shaded indicates 
the report is primarily for the lawyer type. M, C, or O indicates the report has an option on the Matter, 
Common, or Other tab, respectfully, to search by the lawyer type. 

Report Name Type of Lawyer

Client 
Intro

Matter 
Intro

Working Assign-
ed

Respon-
sible

Fee 
Credit

Collect-
ing

1099 Listing

Allocation Listing M M M M

Appointment Listing

Appointment Schedule

Bank Reconciliation report

Billable Time Summary by WL M M M M C

Billing by Lawyer C

Billing (Fees) Journal M M M C O O

Billing Realization report M M C M C

Cash Flow Planner

Client Accounting Ledger M M M C

Client Costs Journal M M M M

Client Fees Listing M M O M C

Client Ledger M M O M C

Client Summary M M O M C

Client Trust Listing M M M C

Client Trust Ledger M M M C

Client WIP, Billing, & Collection M M M C

Closed Files report M M M C

Collection Summary C

Comparative Time Analysis C

Contact Listing

Daily Time Summary C

Disbursement Analysis & Interest M M C

Discount Listing

Document Listing

Fee Adjustment report M C

Fee Allocation Summary M M M M C

Fees Collected Summary C C

Fees Due by Lawyer report C

File Conflict List

File Location report M M M C

Firm Cash & Fee Summary C

G/L Reconciliation report
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Exhibit 1-4. Table displaying how PCLaw reports are created by lawyer type 

Report Name Type of Lawyer

Client 
Intro

Matter 
Intro

Working Assign-
ed

Respon-
sible

Fee 
Credit

Collect-
ing

General Bank Journal M

General Journal

Goods & Sales Tax (VAT) Journal

Interest Calculation report M M M C

Invoice Journal M M M C O O

Lawyer Budgeting report C C C

Lawyer WIP Billing, & Collection C C C C

List of Clients M M M C

Matter Change Log M M C M

Matter Status report M M M C

Matters Opened Summary C C C

Partner Alert report C C

Payable Listing

Payment Allocation Listing M M M C O

Payment Listing

Productivity by Client

Purchases Journal

Receivable by Client M M M C O

Receivable by Lawyer C C

Research Listing

Sales Tax Journal

Time Listing C

Time Summary M M C M M

Time Utilization Analysis C

Trust Bank Journal

Trust Bank Matter-to-Matter Transfer

Unbilled Time Summary by WL M M C M C

User Security Listing

Vendor Ledger

Vendor Listing

Volume Surcharge Summary

WIP Summary by Responsible Lawyer M M M C

Work-in-Progress M M O M C

Write-Up/Down Journal M M O M C
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Report Properties
The following rules and definitions are common for all PCLaw reports.

Displaying Tabs
If the Matter, Other, and Layout tabs do not appear when opening the report selections window, click the 
Advanced button on the Common tab. Tabs other than the Common tab can be suppressed if Use Advanced 
Report Selections is disabled on the Other tab of System Settings or Workstation Settings. Customizable 
reports do not have a layout tab.

Customizable Reports
Selected reports in PCLaw can be customized to meet the needs of your firm. The Customizable report 
feature, on the Common tab of the report selection window lets you choose the columns that appear on the 
report and the order that they appear. The following reports are customizable:

Printing Reports
With few exceptions, all reports have four output options when producing the report.

Output: Choose one or more of the following options:

Printer: To print a hard copy of the report, select this check box.

Screen: To view the report on the screen, select this check box.

E-mail: To attach the report in one of text, rich text, portable document format, 
or Excel97 format to an e-mail, select this check box.

Editor: To create the report as a file, in text, rich text format, portable document 
format, or Excel97 format, select this check box.

Printing in Excel97 format is limited to the following reports:

Drill Down
PCLaw gives the option to drill down on any report open on the screen to view a value in greater detail or 
view the source of an entry. There are two methods to drill down on an entry:
• double click the entry 
• right click on the entry. From the cascade menu, select View Details.

When drilling down on an entry on the majority of PCLaw reports, a data entry window or a more detailed 
report appears displaying the selected entry. 

• General Bank Journal • Trust Bank Journal • Trust Bank Matter-to-Matter Journal
• Billing (Fees) Journal • Invoice Journal • Write Up/Down Journal
• Client Ledger • Client Summary • Client Fee Listing
• Client Trust Listing • Client Trust Ledger • List of Clients
• Receivables by Client • Payment Allocation Listing • Time Listing

• General Bank Journal • Billing (Fees) Journal • Invoice Journal
• General Journal • Client Fees Listing • Receivables by Client
• Receivables by Lawyer • Payment Allocation Listing • Time Listing
• Time Summary • Custom Reports • Audit Trail (selected reports)
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Journal Overview

Exhibit 2-1. Table listing journals, their defining parameters, and what the report displays 

Journal Run the Journal 
By...

What it Does

M
ust be enabled in System

 Settings
A

ll C
ountries

PC
Law

, PC
Law

 Plus. PC
Law

Pro, PC
Law

Pro Enterprise

General Bank bank account
check/ref
g/l account
rcvd from/paid to

Lists general bank account checks and receipts.

Trust Bank bank account
check/ref
g/l account
rcvd from/paid 
to*

Lists trust bank account checks and receipts.

Trust Bank 
Matter-to-Matter 
Transfer

bank account
check/ref
g/l account

Lists portion of trust bank journal transactions that pertain to 
matter to matter transfers.

Client Costs matter
reference number
g/l account
explanation

Lists expenses incurred on behalf of clients.

General g/l account
reference number

Lists general ledger adjustments made for the specified 
period.

GST date
summary
cash basis

Lists entries that affect GST payable.

Sales Tax date
summary

Lists sales tax charged on fees and disbursements, and sales 
tax paid out on purchases.

Write Up/Down matter/client
resp lawyer
invoice
g/l account

Lists changes made after billing to fees, disbursements and 
taxes.

Billing (Fees) matter/client
resp lawyer
invoice
fee credit lawyer
collecting lawyer

Lists invoices, showing fees, disbursements, taxes, receipts, 
and balance owing.

Invoice matter/client
resp lawyer
invoice
fee credit lawyer*
collecting lawyer*

Lists fees, disbursements and taxes as billed and write-ups/
downs for each invoice.
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Client Costs Journal
The Client Costs Journal displays all costs allocated to matters, regardless of how the cost is entered into 
PCLaw. The report displays costs without differentiating between unbilled and billed items or hard and 
soft costs. Costs can be filtered by date, G/L account, and source journal.

What Entries Appear on the Journal
A cost appears on the Client Costs Journal as an expense recovery, allocation from a general check, or 
allocation from an accounts payable.

Expense recovery entries appearing on the Client Costs Journal are added or modified through the 
following features:

General check allocations appearing on the Client Costs Journal are added or modified through the 
following features:

Accounts payable allocations appearing on the Client Costs Journal are added or modified through the 
following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-2. The Common tab of the Client Costs Journal 

Matter: To view costs for a specific matter, type or select the matter nickname.

Ref #: To view a specific cost, type the reference number. 

G/L Account: To view only costs allocated to a specific G/L account, type or select the account 
nickname.

Start Date: To view costs on or after a specific date, select the date.

End Date: To view costs on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Expense Recovery • Register > Expense/Ledger tabs • Create Bill/Quick Bill/Release Bill
• Change/Write Off Bill • Matter Opening Balances.

• Register > General/Ledger tabs • General Check/General Release Check.

• New/Open Payable • Register > AP/Ledger tabs.

Pull-down menu: Reports > Journal > Client Costs > Common Tab
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The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 2-3. The Other tab of the Client Costs Journal 

Include: Select one or more of the following:

Expense Recovery Entries: To show expense recovery allocations, select this check box.

General Check Allocations: To show general check allocations, select this check box.

Accounts Payable Entries: To show A/P allocations, select this check box. 

Corrected Entries: To display costs that have been previously changed or removed, select 
this check box.

Display in Order Entered: To display entries by entry number, select this check box.

G/L Summary Only: To display only the G/L Summary section, select this check box.

If selecting the G/L Summary Only, deselect Corrected Entries and Daily Totals.

Summary by Resp. Lawyer: To display a Summary by Responsible Lawyer section, select this check box. 

Summary by Expl. Code: To display a Summary by Explanation Code section, select this check box.

Show User Name:To display the user who has entered each transaction, select this check box

Daily Totals: To display a totals line for each date, select this check box.

If both Daily Totals and Display in Ordered Entered are selected, a daily totals line appears 
for each grouping of a similar date.

Explanation Code: To view costs for a specific explanation code, type or select the code nickname.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Client Costs Journal provides a list of allocated expenses. All expenses are associated with matters. The 
journal does not take into account whether or not the expense has been paid by the client.

Exhibit 2-4. Excerpt from the Client Costs Journal 

Date: Displays the date the expense was posted.

Paid To: Displays the recipient of the expense.

Explanation: Displays the explanation from the expense. 

Pull-down menu: Reports > Journal > Client Costs > Other Tab



Client Costs Journal

Page 13

Matter: The allocated matter nickname is displayed.

Client: The allocated client nickname is displayed. 

Source: Column indicates the source journal where the entry originates. CER represents 
expense recovery. GB represents a general check allocation. AP represents an accounts 
payable allocation. WO represents change/write off bill entries.

Ref #: Displays the reference number assigned when the item is entered. The value can be: 
• reference numbers from client expense recoveries
• invoice numbers from disbursement adjustments at the time of billing, a split 

billing or a write off after billing
• check numbers from general check allocations
• payable invoice numbers from accounts payable allocations.

G/L Acct: Column displays the account to which the expense is allocated. A general check 
allocation defaults to the Client Disb Clearing account (5210). A reallocation from split 
billing defaults to Suspense (9999).

Amount: A positive value in this column indicates a cost is allocated to the matter. A negative 
value indicates the cost is reversed or written down.

The Client Costs Journal includes the following summary sections:

Exhibit 2-5. Table of the summary sections provided by the Client Costs Journal and when they appear 

Drill Down
The Client Costs Journal allows drill down in the following areas:

Exhibit 2-6. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Client Costs Journal
The chart below lists PCLaw reports that reconcile to the Client Costs Journal, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 2-7. Table displaying the different reports and their sections that reconcile to the Client Costs Journal 

Summary Title Appears when

G/L Account Summary Always appears.

Summary by Explanation Code Optional, as selected by user.

Summary by Responsible Lawyer Optional, as selected by user.

Drill down on Opens the following window

Expense recovery entry Correct - Expense Recovery

General check entry Correct - General Check

Accounts payable entry Register > Select Payable 

Write up/down Change Bill

Client Costs Journal Reconciles to Additional comments

G/L Account 
Summary > Total of 
Debit column.

Client Ledger Unbilled Che + 
Recov + Billed 
Disbs

For matter and firm totals

Client Summary Unbd Disb + Bld 
Disb

For matter and firm totals

Disbursement 
History report

Firm Totals For matter and firm totals

Hard & Soft Cost 
Analysis

Soft Cost + Hard 
Cost > Total

For matter and firm totals
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General Bank Journal
The General Bank Journal lists all transactions that affect the general bank. The entries can be viewed for all 
accounts, a single account, by check or receipt, by G/L allocations or by date.

What Entries Appear on the Journal
New transactions are added to the General Bank Journal through the following features:

Existing transactions on the General Bank Journal can be changed or removed through the following features:

General bank transactions created through the Request Check or Request Bill features do not affect the 
General Bank Journal until the check or bill is released.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-8. The Common tab of the General Bank Journal 

Acct: To view transactions for a single bank account, type or select the account nickname.

Che\Rec#: To view a single check or receipt, type the check or receipt number assigned in PCLaw.

G/L Account: To view transactions that include allocations to a specific G/L account, type or select the 
account nickname.

Transactions that are wholly or partially allocated to that general ledger account are listed. 
For partial allocations, the complete transaction is displayed.

Start Date: To view transactions on or after a specific date, type or select the date.

End Date: To view transactions on or prior to a specific date, type or select the date.

• General Check • General Release Check • General Bank Opening Balances
• Receive Payment • General Retainer • General to General Transfer
• Quick Bill > Payment • Create Bill > Trust Transfer • Release Bill > Trust Transfer
• Firm Receipt • Trust-to-General Transfer • New Payable > Pay Now/Process Payable.

• Register > General tab • Data Entry > General Bank > Correct {feature name}.

Pull-down menu: Reports > Journal > General Bank > Common Tab



General Bank Journal

Page 15

Sort By: Select one of the following:

Date: To list entries in order by date, select this option.

Entry Number: To list transactions in order entered, select this option.

Check Number: To list transactions in order by the check and receipt number 
assigned in PCLaw, select this option.

Deposit Slip: To group receipts by their deposit slip number, select this option.

Include: Select one of the following:

Receipts: To list only receipts on the report, select this option.

Disbs: To list only checks on the report, select this option.

Both: To list both checks and receipts on the report, select this option.

Layout: To produce a customized General Bank Journal, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used as the options under the 
Common tab. 

Exhibit 2-9. The Other tab of the General Bank Journal 

Report Details: Select one or more of the following:

 Totals Only: To display the summary sections only, select this check box.

Deselect Daily Totals and Include Corrected Entries when running 
the report for Totals Only.

 Daily Totals: To display daily totals, select this check box.

Daily Totals is available only when Sort by Date is selected on the 
Common tab.

 Include Corrected Entries: To display transactions that have been changed or removed, 
select this check box.

Summary by Resp. Lawyer: To include a summary by responsible lawyer, select this 
check box.

Pull-down menu: Reports > Journal > General Bank > Other Tab
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Payment Method: For firms using Deposit Slips: Select one or more of the following:

Bank Check: To display funds received as a banker’s check, select this check box.

Cash: To display funds received as cash, select this check box.

Certified Check: To display funds received as certified checks, select this check box.

Check: To display funds received as client’s personal checks, select this check 
box.

Credit: To display funds received through a credit card, select this check box.

Direct Deposit: To display funds received as a direct deposit transfer, select this check 
box.

Money Order: To display funds received as a money order, select this check box.

Wire: To display funds received as a wire transfer, select this check box.

Received From/Paid To: To list transactions for a specific client or payee, type the name.

All transactions with the exact spelling are displayed on the report.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The General Bank Journal lists all transactions for the general bank. Each transaction displays detailed check 
or receipt information, the check or receipt total, and may show the matter allocation and G/L allocations. 
Daily totals are available if Sort by Date is selected. The described report configuration uses the Default 
layout. The General Bank journal also includes the Default with (pmt usr) layout.

Exhibit 2-10. Excerpt from the General Bank Journal 

Date: Displays the date the transaction was posted.

Entry#: Displays the assigned entry number for the transaction.

Received From/Paid To: Displays the payee or recipient for the check or receipt.

Explanation: Displays the explanation from the check or receipt. 

Matter: If the transaction is allocated to a matter, the matter nickname is displayed. 

Client: If the transaction is allocated to a matter, the client nickname is displayed. 

Acct#: Lists the bank account where the transaction is posted. The account number appears 
regardless of whether the report is run for one account or for all accounts. 

Che#/Rcpt#: Lists the check, receipt, or reference number for each transaction. The number is 
determined in sequence for the specific trust feature used.

Clr: An asterisk in this column indicates the entry is cleared on the bank reconciliation. 

Batch: An asterisk in this column indicates the entry is added for Batch Check Printing but has yet 
to be printed. Once the check is printed, then the asterisk is removed.

G/L Account: This column appears only if Allocations is selected on the Other tab and Use G/L 
Accounting is selected on the Other tab of both System Settings and Workstation Settings.

Check: Column values display the original allocations when the receipt was created. If the 
disbursement is taxable, tax is displayed as a separate allocation.

Receipt: Column values display the original allocations when the receipt was created.
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Entry Total: Displays the full amount of each transaction.

Running Bal: If Show Running Balance is selected, this column displays the bank balance after each 
transaction.

If Show Daily Totals is selected, a daily totals line is added after the last transaction for each unique date.

The General Bank Journal includes the following summary sections:

Exhibit 2-11. Table of the summary sections provided by the General Bank Journal and when they appear 

Drill Down
The General Bank Journal allows drill down in the following areas:

Exhibit 2-12. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the General Bank Journal
Use the General Bank Journal to reconcile the general bank g/l accounts and the bank statements for each 
account.

The chart below lists PCLaw reports that reconcile to the General Bank Journal, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 2-13. Table displaying the different reports and their sections that reconcile to the General Bank Journal 

Summary Title Appears when

Bank Account Summary Always appears.

G/L Account Summary Always appears.

Summary by Responsible Lawyer Optional, as selected by user.

Drill down on Opens the following window

Check Correct General Check

Receive Payment Correct General Receive Payment

General Retainer Correct General Retainer

Firm Receipt Correct Firm Receipt

General to General Transfer Correct General to General

Trust-to-General Transfer Correct Trust-to-General 

Processed Payable Correct Processed Payable

Bank Account Summary - Check Tot General Bank Journal for account - Disbs Only

Bank Account Summary - Rcpt Tot General Bank Journal for account - Receipts Only

G/L Account Summary Debit/Credit 
columns

General Ledger for report period

Summary by Responsible Lawyer General Ledger for report period

General Bank 
Journal

Reconciles to Additional comments

Bank Account 
Summary

G/L > Gen Bank 
Acct #

Closing Balance Reconcile by bank account

Bank Reconciliation 
report

Actual Bank Journal 
Balance

Reconcile by bank account 
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Trust Bank Journal
The Trust Bank Journal lists all transactions that affect the trust bank. The entries can be viewed for all 
accounts, a single account, by check or receipt, by G/L allocations or by date.

What Entries Appear on the Journal
Entries appear on the Trust Bank Journal through the following features:

Existing transactions on the Trust Bank Journal can be changed or removed using the following features:

Trust bank transactions created through the Request Check or Request Bill features do not affect the Trust 
Bank Journal until the check or bill is released.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-14. The Common tab of the Trust Bank Journal 

Acct: To view only entries for a specific bank account, type or select the account nickname.

Che\Rec#: To view a specific check or receipt, type the number.

Start Date: To view entries on or after a specific date, select the date.

End Date: To view entries on or before a specific date, in the box, select the date.

Sort By: Select one of the following:

Date: To list entries in order by date, select this option.

Entry Number: To list entries in order entered, select this option.

Check Number: To list entries in order by check and receipt number, select this option. 

Deposit Slip: To group entries by deposit slip number, select this option.

• Trust Check • Trust Release Check • Trust Receipt
• Matter-to-Matter Transfer • Bank-to-Bank Transfer • Trust-to-General Transfer
• Matter Opening Balances • Bill/Release Bill > Trust Transfer.

• Register > Trust/Matter tabs • Matter Manager > Trust tab.

Pull-down menu: Reports > Journal > Trust Bank > Common Tab
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Include: Select one of the following:

Receipts: To list only receipts on the report, select this option.

Disb: To list only checks on the report, select this option.

Both: To list both checks and receipts on the report, select this option.

Layout: To produce a customized Trust Bank Journal, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 2-15. The Other tab of the Trust Bank Journal 

Report Detail: If preferred, select one or more of the following:

Include Corrected Entries:To display entries that have been changed or removed, select 
this check box.

Daily Totals: To display daily totals, select this check box.

The Daily Totals option is available only when Sort by Date is 
selected under the Common tab.

Totals Only: To display the Bank Account Summary section only, select this check 
box.

Deselect Include Corrected Entries when running the report for 
Totals Only.

Pull-down menu: Reports > Journal > Trust Bank > Other Tab
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Payment Method: For firms using Deposit Slips: Select one or more of the following:

Bank Check: To list receipts that were bankers’ checks, select this check box.

Cash: To list receipts that were cash, select this check box.

Certified Check: To list receipts that were certified checks, select this check box.

Check: To list receipts that were clients’ personal checks, select this check box.

Credit: To list funds received through a credit card, select this check box.

Direct Deposit: To list receipts that were direct deposit transfers, select this check box.

Money Order: To list receipts that were money orders, select this check box.

Wire: To list receipts that were wire transfers, select this check box.

Received From/Paid To: To list transactions for a specific client or payee, type the name.

All transactions with the exact spelling are displayed on the report.

Show Only TAF Eligible Entries: For British Columbia firms: To list only transactions eligible for trust to be 
charged a trust administration fee, select this check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Trust Bank Journal lists all transactions for the trust bank. Each transaction displays the check or receipt 
information, matter and client, and the check or receipt total. Daily totals are available if Sort by Date is 
selected. The described report configuration uses the Default layout. The Trust Bank journal also includes the 
Default with (pmt usr) layout.

Exhibit 2-16. Excerpt from the Trust Bank Journal 

Date: Displays the date the transaction was posted.

Entry#: Displays the assigned entry number for the transaction.

Received From/Paid To: Displays the payee or recipient for the check or receipt.

Explanation: Displays the explanation from the check or receipt. 

Matter: The allocated matter nickname is displayed.

Client: The allocated client nickname is displayed. 

Acct#: Column displays the bank account to which the transaction is posted. The account number 
appears regardless of whether the report is run for one account or for all accounts.

Che#/Rcpt#: Column displays the check, receipt, or reference number for each transaction. The number 
is determined in sequence for the specific trust feature used.

Clr: If there is an asterisk inn this column, then the entry is cleared on the bank reconciliation. 

Batch: If there is an asterisk in this column, then that entry is sent for Batch Check Printing but is 
yet to be printed. Once the check is printed, then the asterisk is removed.

Check: Column values display the original allocations when the receipt was created. If the 
disbursement is taxable, tax is displayed as a separate allocation.

Receipt: Column values display the original allocations when the receipt was created.

Entry Total: Column displays the full amount of each transaction.
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Running Bal: If Show Running Balance is selected, this column displays the bank balance after each 
transaction.

 Daily Totals: If Show Daily Totals is selected, an amount appears in this column.

The Trust Bank Journal includes the following summary section:

Exhibit 2-17. Table of the summary sections provided by the Trust Bank Journal and when they appear 

Drill Down
The Trust Bank Journal allows drill down in the following areas:.

Exhibit 2-18. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Trust Bank Journal
Use the Trust Bank Journal to reconcile the trust bank G/L accounts, bank statements for each account, 
and the total trust balance for all matters.

The chart on the following page lists PCLaw reports that reconcile to the Trust Bank Journal, and the item 
on the report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 2-19. Table displaying the different reports and their sections that reconcile to the Trust Bank Journal 

Summary Title Appears when

Bank Account Summary Always appears.

Drill down on Opens the following window

Check Correct Trust Check

Receipt Correct Trust Receipt

Matter-to Matter-Transfer Correct Trust Matter-to-Matter

Bank-to-Bank Transfer Correct Trust Bank-to-Bank

Trust-to-General Transfer Correct Trust-to-General

Bank Account Summary - Check Tot Trust Bank Journal for account - Disbs Only

Bank Account Summary - Rcpt Tot Trust Bank Journal for account - Receipts Only

Trust Bank Journal Reconciles to Additional comments

Bank Account 
Summary

G/L > Tru Bank Acct 
#

Closing Balance Reconcile by bank account

Bank Reconciliation 
report

Actual Bank Journal 
Balance

Reconcile by bank account 

Client Trust Listing Firm Totals > Acct 
Balance

Reconcile by bank account

Client Trust Ledger Firm Totals > 
Account Balance

Reconcile by bank account
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Trust Bank Matter-to-Matter Transfer Journal
The Trust Bank Matter-to-Matter Transfer Journal lists transfers of trust funds between matters. The report 
displays both the matter transferring funds and the receiving matter.

What Entries Appear on the Journal
The following feature adds new transactions to the Trust Bank Matter-to-Matter Transfer Journal:

Existing transactions on the Trust Bank Matter-to-Matter Transfer Journal can be changed or removed using 
the following features:

The Trust Bank Matter-to-Matter Transfer Journal displays only matter to matter transfers. To view other trust 
bank entries, use the Trust Bank Journal.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-20. The Common tab of the Trust Bank Matter-to-Matter Transfer Journal 

Acct: To view only transactions for a specific bank account, type or select the account 
nickname.

Ref #: To view a specific transfer, type the reference number.

Start Date: To view transactions on or after a specific date, select the date.

End Date: To view transactions on or prior to a specific date, select the date.

Layout: In the Layout area, to produce a customized List of Clients, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10. 

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Matter-to-Matter Transfer.

• Register > Trust/Matter tabs • Matter Manager > Ledger Tab.

Pull-down menu: Reports > Journal > Trust Bank Matter-to-Matter Transfer > Common Tab
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The Report
The Trust Bank Matter-to-Matter Transfer Journal displays trust transfers between matters. Each transaction 
displays the matters involved, the trust amounts allocated, and the trust bank containing the funds.

Exhibit 2-21. Excerpt from the Trust Bank Matter-to-Matter Transfer Journal 

Date: Displays the date the transfer was posted.

Entry#: Displays the assigned entry number for the transfer.

Received From/Paid To: Displays the payee or recipient for the transfer.

Explanation: Displays the explanation from the transfer. 

Matter: The allocated matter nickname is displayed. 

Client: The allocated client nickname is displayed. 

Acct#: Column displays the bank account to which the transfer is posted. Matter-to Matter 
transfers can only occur within one trust account. The account number appears 
regardless of whether the report is run for one account or for all accounts.

Ref#: Column displays the reference number for each transfer.

Allocated Amount: Column displays the change in the trust balance for each matter, whereas the Amount 
column shows the total amount of the transfer.

The Trust Bank Matter-to-Matter Transfer Journal includes the following summary section:

Exhibit 2-22. Table of the summary sections provided by the Trust Bank Matter-to-Matter Transfer Journal 

Drill Down
The Trust Bank Matter-to-Matter Transfer Journal allows drill down in the following areas:.

Exhibit 2-23. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Trust Bank Matter-to-Matter Journal
The purpose of the Trust Bank Matter-to-Matter Transfer Journal is to display a single transaction type that 
is not available through existing Trust Bank Journal or Client Trust Listing options. Therefore the report is 
not reconcilable with other PCLaw reports.

Summary Title Appears when

Bank Account Summary Always appears.

Drill down on Opens the following window

Matter-to Matter-Transfer Correct Trust Matter-to-Matter

Bank Account Summary - Total Transferred Trust Bank Journal for account 
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General Journal
The General Journal lists transactions that only affect the G/L and not any other journal. The journal handles 
G/L adjustments for entries where none of the debit or credit accounts are reserved. Transactions made 
through any PCLaw feature other than G/L Adjustment are recorded in the journal(s) linked to that feature. 

What Entries Appear on the Journal
The General Journal displays adjustments to the general ledger. A record is created using one of the following 
features:

The following processes also post entries to the General Journal:

Transactions can be removed from the General Journal through the Correct G/L Adjustment feature. Removed 
entries can no longer be viewed on the journal.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 2-24. The Common tab of the General Journal 

G/L Account: To view entries for a specific G/L account, type or select the account nickname.

Reference: To view a specific entry, in the box, type the reference number.

Start Date: To view items entered on or after a specified date, in the box, select the date.

End Date: To view items entered on or prior to a specified date, in the box, select the date.

Sort by Reference Number: To list transactions in order by the G/L Adjustment reference number, select this 
check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• G/L Adjustment • Correct G/L Adjustment • G/L Opening Balances.

• posting a payroll period • end of year. •

Pull-down menu: G/L > General Journal > Report 

Pull-down menu: Reports > Journal > General > Common Tab
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The Report
The General Journal lists each transaction individually, giving the allocation to each G/L account, and if 
the account was debited or credited. 

Exhibit 2-25. Excerpt from the General Journal 

The General Journal includes the following summary section:

Exhibit 2-26. Table of the summary section provided by the General Journal and when it appears 

Drill Down
The General Journal allows drill down on the following areas: 

Exhibit 2-27. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the General Journal
Since the General Journal displays transactions that are not included in other PCLaw features, it is not a 
reconcilable report.

Summary Title Appears when

G/L Account Summary Always appears.

Drill down on Opens the following window

G/L adjustment General Journal Change

G/L Account Summary General Ledger Statement
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GST Journal
The GST Journal lists all GST paid out by the firm or charges to the client. This document describes how to 
produce a GST Journal, how to interpret the entries that appear on the report. The following topics pertaining 
to the GST Journal are addressed:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-28. The Common tab of the Goods and Services Tax 

Start Date: Select the start date for the period to view.

End Date: Select the end date for the period to view.

Summary Only: To view the summary section only, select this check box.

Run Report on a Cash Basis: To view the GST Journal as it would appear under the Cash Accounting method, 
select this check box.

Report: Select one of the following:

Billed Out: To view only GST payable, select this option.

Paid Out: To view only Input Tax Credits, select this option.

Both: To view both GST payable and Input Tax Credits, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The GST Journal lists all goods and services transactions for the firm. Each transaction displays relevant GST 
information for the check or billing activity, including remittances the check or receipt total, and may show 
the matter allocation and G/L allocations.

Line 101 x 6 % (the rate of GST) is not required to equal the value of line 105. The difference will be the 
result of several contributing factors, including:
• Matters with a GST category of N or P
• Non-taxable disbursements
• Write ups to fees or disbursements (where GST is not adjusted according to the existing tax rate)
• Reversal of Provisional Write-offs where the invoice was partially paid.

Line 102 x 6 % (rate of GST) is not required to equal the value of line 108. The variance is the result of several 
contributing factors, including:
• Checks created with a GST code of N or P
• GST Journal corrections (Zero dollar checks with a non-zero GST value)
• Write downs of fees or disbursements (where GST is not reduced according to the existing tax rate)
Provisional Write-offs of partially paid invoices.

Pull-down menu: Reports > Journal > Goods and Services Tax > Common Tab
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Exhibit 2-29. An excerpt from the GST Journal displaying the relationship between the reporting and summary sections 

             Cheque information Billing information

Cheques with Y,N,B, P, and Z 

codes appear on journal.

E code cheques do not appear

This amount is negative if Billed 

Out is less than Paid Out.

If the Period Totals balance is 

different from the Running Balance, 

remit the Running Balance.  

Outstanding amounts from prior 

periods are carried forward into 

Debit 2400

Credit 2400

GST eligible billing (no E category)

Total amount of Z code cheques

Line 111 is not used.  Rebates appear 

as a negative value under Line 110

Corresponds to Box # in GST Summary

102 106 101 103 104 107

Write offs and provisional 

write offs are displayed as 

an ITC adjustment.

Write ups and reverse 

provisional write downs 

appear as a GST adjusment.

Bills, Quick Bills, Release Bills 

appear as Billed Out > Tax 

inclusive of charges written up or 

down at the time of billing.

GST remitted in the previous period.  

A negative amount indicates a rebate.

GST remitted in the current period.

106 +107 =108

105 - 108 = 

110 - 111 = 112 

109-112 = 113

103 +104 =105
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Understanding the General Reconciliation Balance
The General Reconciliation Balance displays the GST Payable (2400) account balance as of the end date of 
the GST Journal reporting period. 

The General Reconciliation Balance may not correspond to the balance in line 115 (114 if there is a refund 
claimed) due to remittance payments. Remittance payments are calculated on the GST Journal as per the 
remittance period end date, but appear on the g/l as per the check date.

Exhibit 2-30. Table demonstrating how the check and remittance dates affect the GST Journal 

Viewing a Remittance Check on the Journal
If a remittance check is created with a check date of April 15th and a remittance period end date of March 
31st, the check appears on the GST Journal for the check date, although the report filters the check as of the 
remittance period end date.

For example:
• If the GST Journal is run from April 15th to April 15th, the remittance check does not appear on the 

report.
• If the GST Journal is run from March 31st to March 31st, the remittance check does appear on the report, 

but the entry date is listed as April 15th.
• The Paid by Installments line in the GST summary is governed by the remittance period end date. That is, 

if the report is run from April 15th to April 15th, the remittance amount is not included under the Period 
Totals column, but is included in the Running Balance column.

If the Then

check date: remittance period 
end date:

lines 110 through 115: the General 
Reconciliation Balance:

Is prior to the Start 
Date of the report.

Is prior to the Start 
Date of the report.

includes the remittance amount in 
the Running Balance.

includes the remittance 
amount.

Is between the Start 
and End Dates of the 
report.

Is prior to the Start 
Date of the report.

includes the remittance amount in 
the Running Balance.

includes the remittance 
amount.

Is between the Start 
and End Dates of the 
report.

Is between the Start 
and End Dates of the 
report.

Includes the remittance amount in 
the Period Totals and Running 
Balance.

includes the remittance 
amount.

Is after the End Date of 
the report.

Is prior to the Start 
Date of the report.

includes the remittance amount in 
the Running Balance.

does not include the 
remittance amount.

Is after the End Date of 
the report.

Is between the Start 
and End Dates of the 
report.

Includes the remittance amount in 
the Period Totals and Running 
Balance.

does not include the 
remittance amount.

Is after the End Date of 
the report.

Is after the End Date 
of the report.

does not include the remittance 
amount.

does not include the 
remittance amount.
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Reconciling Period Totals to the Running Balance
If line 114 of the GST Journal summary is the same value for both the Period Totals and the Running 
Balance, then that is the amount of the GST refund. Once the GST refund is received and processed for 
the period, the Period Totals and Running Balance are reduced to zero.

If line 115 of the GST Journal summary is the same value for both the Period Totals and the Running 
Balance, then that is the amount to remit. Once the remittance check is created for the period, the Period 
Totals and Running Balance are reduced to zero.

If line 115 (or line 114) of the GST Journal summary displays a different value for the Period Totals and the 
Running Balance, then remit the amount of the Running Balance. The difference is the result of 
remittances (or refunds) in a previous period or periods that did not equal the total net tax for the period. 
If something other than the Running Balance is remitted, the difference between the remittance and the 
Running balance is carried over to the next period.

For example:

For the 1st quarter of 2003, the GST summary reads:

                                    Period Totals          Running Balance
Payment Enclosed (115):      1000.00                  1000.00          

If $750 is remitted for the period, then for the 2nd quarter of 2003, the GST summary reads:

                                    Period Totals          Running Balance
Payment Enclosed (115):      1000.00                  1250.00        

$1000 in additional Net Tax (GST) was realized in the second quarter. However, $250 of the GST payable 
balance was carried forward from the first quarter, creating a discrepancy between the Running Balance 
and the Period Totals.   

If the Period Totals value is remitted for the second quarter, there will still be an outstanding balance 
($250) carried over to the next quarter. For the Period Totals and the Running Balance to be equal for the 
third quarter, the value of the Running Balance needs to be remitted for the second quarter.
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Sales Tax Journal
The Sales Tax Journal lists payouts, billings, and write-downs where Sales tax is applicable, regardless of 
whether sales tax is actually charged on the transaction. The summary section displays the total sales tax 
payable/refundable for the period only. The journal does not display remittance or refund payments. 

Use this report to remit tax when there is no prior outstanding due from a previous period. The Sales Tax 
Payable (2450) account can also be used to determine Sales Tax payable/refundable. If there is an outstanding 
balance from a previous period, the Sales Tax Payable (2450) account should be used to determine the overall 
balance payable/refundable. 

What Entries Appear on the Journal
Transactions appearing under the Paid Out column of the Sales Tax Journal are added or modified through 
one of the following features, when the appropriate tax category is used:

Transactions appearing under the Billed Out column of the Sales Tax Journal are added or modified through 
one of the following features:

Transactions appearing under the Adjustment column of the Sales Tax Journal are added or modified through 
one of the following features:

The Report Selection Window

The Sales Tax Journal does not contain multiple tabs in its report selection window.

Exhibit 2-31. The report selection window for the Sales Tax Journal 

Start Date: Select the start date for the period to view.

End Date: Select the end date for the period to view.

Summary Only: To view the summary section only, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• General Check • General Release Check • Register > General/AP tabs
• New/Open Payable (For Accrual accounting systems)
• Process Payable (for Modified Cash and Cash accounting systems).

• Create Bill • Quick Bill • Release Bill.

• Change/Write Off Bill • Register > Ledger tab
• Provisional Write Off Bill/Reverse Provisional Write Off (for Accrual accounting systems).

Pull-down menu: Reports > Journal > Sales Tax



Sales Tax Journal

Page 31

The Report
The Sales Tax Journal provides a list of payouts, billings, and write-ups/downs, the amounts that are tax 
eligible, and the amount of sales tax calculated. Remittance checks and refunds are not displayed on the 
report. The Summary section displays period totals only.

Exhibit 2-32. Excerpt from the Sales Tax Journal 

Date: Displays the date for each transaction.

Matter: Displays the matter nickname for transactions involving matters.

Paid To: Displays the contents of the Paid To box.

Explanation: Displays the explanation on the check/top portion of the transaction.

Paid Out:

Che #: Lists the payout check number.

Disb: Displays the original amount of the payout, prior to the deduction of 
any taxes.

Tax: Displays the amount of sales tax calculated on the payout.

Billed Out:

Inv #: Lists the invoice number.

Sales: Displays the original amount of the payout, prior to the inclusion of 
any taxes.

Tax: Displays the amount of sales tax calculated on the invoice.

Adjustment Sales Tax: Displays sales tax written up or down after the invoice has been created. 

For Accrual accounting systems: Provisional and reverse provisional write-offs are 
included. The amount of the original invoice is not displayed.
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The summary of the Sales Tax Journal compares current period input credits with sales tax collectable. Each 
line number corresponds to a value in the body of the journal:

Total Billed (201) = Billed Out > Sales Period Total
Total Purchases (202) = Paid Out > Disb Period Total

PST Collectable (203) = Billed Out > Tax Period Total
PST Adjustments (204) = Adjustment > Sales Tax Period Total
Total PST and PST Adjustments (205) = box (203) + box (204)

Input Tax Credit (206) = Paid Out Tax Period Total
ITC Adjustments (207) is not used
Total ITC Adjustments (208) = box (206)

Net Tax (209) = box (205) - box (208)

Paid by Installments (210), Rebates (211), Total Other Credits (212) are not used

Balance (213) = box 209.

If the Balance (213) value is a positive amount, process a remittance check using the General Check feature. 
Allocate the amount to the Sales Tax Payable (2450) account.

If the Balance (213) value is a negative amount, claim a refund on the sales tax remittance form. When the 
refund is received, use the Firm Receipt feature and allocate the amount to the Sales Tax Payable (2450) 
account.

 The remittance/refund amount is accurate only if there is not an outstanding balance from a previous 
period.

Writing a Sales Tax Remittance Check

A sales tax remittance check is not posted to the Sales Tax Journal.

Exhibit 2-33. The General Check window displaying a sales tax remittance

To complete the general check:

1. In the To box, type the paid to name.

2. In the Date box, type or select the check date.

3. In the Amount box, type the Balance (213) value from the Sales Tax Journal.

4. In the Pay GST box, type or select E.

5. In the Explanation box, type an explanation or select an explanation code.

Pull-down menu: Data Entry > General Bank > Check
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6. In the G/L Account column, type or select the Sales Tax Payable (2450) account.

7. Click OK.

 Do this procedure only if there is no outstanding balance carried forward from the previous 
period. Since the Sales Tax Journal displays only period totals in its summary, any outstanding 
balance is not shown on the current period’s report. Refer to the Sales Tax Payable (2450) account for 
any previous balances.

Drill Down
The Sales Tax Journal does not contain any drill down options.

Reconciling the Journal to the Sales Tax Payable (2450) Account
The Sales Tax Journal can reconcile to the Sales Tax Payable (2450) account for the current quarter only.

For the report body, although the Sales Tax Journal includes an opening balance for the period prior to the 
start date of the report, it does not record remittance checks or refunds. Therefore it cannot reconcile to 
the Sales Tax Payable (2450) account as an ongoing entity.

For the report summary, the Balance (213) line of the Sales Tax Journal can reconcile to the Sales Tax 
Payable (2450) account, if the following conditions exist:

• The remittance check for the previous reporting period has already been posted to the Sales Tax 
Payable (2450) account.

• An unpaid balance is not carried over from the previous quarter (The Sales Tax Journal summary does 
not reflect previous balances).

• The Sales Tax Journal is created for the current remittance period only.

The Sales Tax Journal does not have a Running Balance column in its Summary section, as appears on the 
GST Journal. 
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Billing (Fees) Journal
The Billing (Fees) Journal is the source accounts receivable report by which other A/R reports retrieve 
information. The journal lists invoices created through billing and matter opening balance. Write-downs and 
payments affect the current amount outstanding for each invoice. Invoices are detailed by fee credit lawyer.

What Entries Appear on the Journal
For an invoice to appear on the Billing (Fees) Journal, it must first be created. An invoice is created using one 
of the following features under the Billing pull-down menu:

The following billing features do not write changes to the Billing (Fees) Journal:

Changes to invoices are reflected on the Billing (Fees) Journal as a revised invoice amount. An invoice 
amount can be changed or written down to zero using the following features:

Invoices can be removed from the Billing (Fees) Journal using the following features:

Invoices cannot be removed through Change/Write Off Bill. Removed entries can still be displayed on the 
report by selecting Include Corrected Entries.

The outstanding value of an invoice can also be reduced by general retainers applied at the time of billing, 
and payments made to the invoice during the life of the invoice.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting the report.

Exhibit 2-34. The Billing (Fees) Journal selection window displaying the Common Tab 

Matter: To view only invoices for a single matter, type or select the matter nickname.

Client: To view invoices for a single client, select the client nickname.

• Create Bill/Release Bill • Quick BIll • Matter Opening Balances.

• Pre-Bill • Settlement Statement • Past Due Notices
• Recreate Bill • Request Bill.

• Change/Write Off Bill • Matter Opening Balances • Register > Invoice/Ledger tab
• Matter Manager > Ledger tab.

• Undo Bill • Register > Invoice/Ledger tab.

Pull-down menu: Reports > Journal > Billing (Fees) > Common Tab
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Resp Lawyer: To view invoices for a responsible lawyer, select the lawyer.

When the report is run by responsible lawyer, all invoices for matters of the responsible 
lawyer are included on the report. Also displayed are fee credit lawyers, with billed 
time on any of the included invoices. Invoices where the selected lawyer is a fee credit 
lawyer but not the responsible lawyer are not included on the report.

Invoice: To view a specific invoice, in the box, type or select the invoice number.

Start Date: To view only invoices with an A/R date after a specific date, select the date.

End Date: To view only invoices with an A/R date prior to a specific date, type or select the date.

Totals Only: To display only a totals line, the Summary by Lawyer, and Firm Summary sections, 
select this check box.

Firm Totals Only: To display only a totals line, and the Firm Summary section, select this check box. 

Include Paid Invoices: To display invoices with a zero A/R balance, select this check box.

Show Balances As of End Date:To have receipts correspond to the end date of the report period, select this 
check box.

 Receipts Up To: If Show Balance As of End Date is deselected, this box becomes 
available. Select the last payment date to include on the report.

Sort by: Select one of the following:

Matter: To list invoices in order by matter, select this option.

Client Name: To list invoices alphabetically by client last name or firm name, 
select this option.

Invoice: To list invoices by invoice number, select this option.

Date: To list invoices by the date the invoice was created, select this 
option.

Layout: To produce a customized General Bank Journal, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 2-35. The Billing (Fees) Journal selection window displaying the Common Tab 

Pull-down menu: Reports > Journal > Billing (Fees) > Other Tab
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Options: If preferred, select one or more of the following:

Display in Order Entered: To list invoices by entry number, select this check box. 

To list invoices by date, deselect this check box.

Include Corrected Entries: To display invoices that have been removed, select this check 
box.

Include Write-Ups and Write-Downs: To include write-ups and write-downs in the invoice 
totals that have occurred prior to the end date of the reporting period, 
select this check box.

Summary by Fee Credit Lawyer: To include a Summary by Fee Credit Lawyer section on the 
report, select this check box.

Summary by Resp. Lawyer: To include a Summary by Responsible Lawyer section on the 
report, select this check box.

Summary by Client Intro. Lawyer: To include a Summary by Client Intro Lawyer section on 
the report, select this check box.

Summary by Referral Source: To include a Summary by Referral Type section on the 
report, select this check box.

Summary by Department: To include a Summary by Department section on the report, 
select this check box.

Summary by Lawyer by Department: To include a Summary by Lawyer by Department 
section on the report, select this check box.

Fee Credit Lawyer: To list only invoices on which a specific lawyer has worked, type or select the lawyer 
nickname.

All invoices that include the selected lawyer as a Fee Credit Lawyer are listed regardless of 
who the responsible lawyer is for the matter.

Collecting Lawyer: To list only invoices on which a certain lawyer is the collecting lawyer, type or select the 
lawyer nickname.

All invoices where the selected lawyer has been made the collecting lawyer are listed.

Age From: To group invoices in an age category, type or select the date. 

The category is calculated from the invoice date to the Age From date. The Age From date 
defaults to the period ending date. 

The Age category is used by the Age From column to indicate the age for each invoice and 
by the Summary by Lawyer section to give a total of invoices by age.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Billing (Fees) Journal lists invoices by the A/R date of the invoice. Each invoice is sub-divided into fees, 
disbursements and taxes. Payments applied to the invoice are shown as reducing the outstanding balance of 
the invoice. The described report configuration uses the Default layout. The Billing (Fees) Journal also 
includes the Default with (dept and usr), Default with (dept), and Default with (usr) layouts.

Exhibit 2-36. Excerpt from the Billing (Fees) Journal showing the Default layout. 
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Date: Displays the accounts receivable date for the invoice as determined at the time of 
billing.

Entry#: Displays the sequential entry number for the entry. This is the sort criteria used when 
running the report by Order Entered.

Invoice: Displays the invoice number assigned to the bill.

Client, Client Name: Displays the client nickname and the client’s last/first or firm name respectively. 
Client appears on the top line of the invoice only.

Matter, Matter Description: Displays the matter nickname and matter description respectively. Matter 
appears on the second line of the invoice only.

Lawyer: If the work of more than one lawyer is included on an invoice, a separate line is 
accorded to each fee credit lawyer. The responsible or collecting lawyer for the matter 
always appears on the third line of the invoice below the client and matter nicknames. 
All disbursements and taxes are attributed to the responsible lawyer.

Hours: Displays the hours billed for time entries only. Hours do not increase/decrease if the 
hours are written up/down.

Fees, Disbs, Tax: Fees include time and fee entries. Columns may increase or decrease if write-ups or 
write-downs are performed on the invoice. Write-ups and write-downs are performed 
through the Change/Write Off Bill feature and the Register. The billing slug on the 
Client Ledger displays the amount of the original invoice.

For firms collecting GST and/or sales tax: Column combines GST and sales tax, if 
applicable, on both fees and disbursements. Columns can also be shown 
independently.

Receipts: Displays all payments made after the billing has been completed. The payments can be 
made through Receive Payment or Trust-to-General Transfer.

Retainer: Displays all payments made at the time of billing. The payments can be General 
Retainers or Trust-to-General transfers added on the Billing Information window.

The Billing (Fees) Journal includes the following summary sections:

Exhibit 2-37. Table of the summary sections provided by the Billing (Fees) Journal and when they appears 

Summary Title Appears when

Summary by Lawyer Always appears.

Firm Summary Always appears.

Summary by Fee Credit Lawyer Optional, as selected by user. 

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Client Intro Lawyer Optional, as selected by user. 

Summary by Referral Source Optional, as selected by user. 

Summary by Department Optional, as selected by user.

Summary by Lawyer by Department Optional, as selected by user.
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Drill Down
Since invoices in PCLaw are the result of a procedure rather than direct data entry, drilling down on any 
column on the Billing (Fees) Journal opens the Change/Write Off Bill window with information on that 
invoice filled in instead of a detailed report.

Reconciling the Billing (Fees) Journal
The chart below lists PCLaw reports that reconcile to the Billing (Fees) Journal, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters. A report with a start date 
other than 1/1/82 may exclude entries that are included on an invoice created prior to the start date. As a 
result, the reports will not reconcile.

Billing (Fees) Reconciles to Additional comments

Hours Client Summary Bld Hrs For matter client, or firm

Fees Client Ledger Billed > Fees For matter, client, or firm

Client Summary Bld Fees For matter client, or firm

Invoice Journal Fees Deselect Include Write-Ups and Write-
Downs on Billing (Fees) Journal.

Lawyer WIP Billing, 
& Collection 
Summary

Billings > Fees For lawyer and firm. For calendar month 
only. Deselect Include Write-Ups and 
Write-Downs on Billing (Fees) Journal. For 
Accrual systems, less PWO of fees.

Billing Realization 
report

Fees > Billed For matter, lawyer and firm. Select Include 
Write-Ups and Write-Downs and Billing 
(Fees) Journal. Deselect Exclude Matters 
with Zero Time on Billing Realization 
report.

Disbs Client Ledger Billed > Disbs For matter, client, or firm

Client Summary Bld Disb For matter client, or firm

Invoice Journal Disbs Deselect Include Write-Ups and Write-
Downs on Billing (Fees) Journal.

Tax Client Ledger Billed > Tax For matter, client, or firm

Client Summary Taxes For matter client, or firm

Invoice Journal GST & Sales tax Select Show Tax Detail on Billing (Fees) 
Journal

Paid Client Ledger Billed > Receipts For matter, client, or firm

Payment Allocation 
Listing

Total

Outstanding Client Ledger Billed > Balances > 
A/R

For matter, client, or firm

Client Summary A/R Bal For matter, client, or firm

Matter Status A/R For matter only

Receivables by 
Client

Total For matter, client, or firm

Receivables by 
Lawyer

Firm Totals > Total

Accounts 
Receivables (1200)

Closing Balance For Accrual Account methods only
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Exhibit 2-38. Table displaying the different reports and their sections that reconcile to the Billing (Fees) Journal 

The Billing (Fees) Journal may not reconcile to the Billing by Lawyer report for the Billing (Fees) Journal 
does not include purged matters. Write-offs affect the Billing (Fees) Journal as per the invoice date, while 
they affect the Billing by Lawyer for the date of the write-off.

The Billing (Fees) Journal will only reconcile with the Billed Total on the Client Fees Listing if both reports 
are run for all dates. The Client Fees Listing marks a fee entry as being billed, whether or not the billing of 
the fee occurred during the report period. The Billing (Fees) Journal only reports fees billed during the 
report period.

Billing (Fees) Reconciles to Additional comments

Outstanding < 30 Cash Flow Planner Accounts 
Receivable > 
Current

Run BFJ for no start date. End date same as 
Cash Flow Planner

Outstanding 31 - 60 
Days

Accounts 
Receivable > 31 - 
60 Days

Outstanding 61 < 
90 Days

Accounts 
Receivable > 61 - 
90 Days

Outstanding 91 - 
120 Days + > 120 
Days

Accounts 
Receivable > Over 
90 Days

Firm Summary > 
Billed > Total

Invoice Journal Total



PCLaw Reports

Page 40 

Invoice Journal
The Invoice Journal displays invoices as billed, with the amount for fees, disbursements and taxes appearing 
as they did on the invoice. Write-downs are shown separately. The user has the option to display invoices by 
fee credit lawyer. Payments to invoices are not provided.

What Entries Appear on the Journal
Invoices appear on the Invoice Journal through the following features:

Time entries and fee adjustments made at billing are included in the invoice amount.

Write-Offs appear on the Invoice Journal through the following features:

Invoices can be removed from the Invoice Journal using the following features:

Removed invoices can still be viewed on the report by selecting Include Corrected Entries. Invoices cannot 
be removed through Change/Write Off Bill.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 2-39. The Common tab of the Invoice Journal 

Matter: To view invoices for a single matter, type or select the matter name.

Client: To view invoices for a specific client, type or select the client name.

Resp Lawyer: To view only invoices for matters assigned to a specific responsible lawyer, in the box, type 
or select the lawyer.

When is run by responsible lawyer, all invoices for matters of the responsible lawyer are 
included on the report. All fees are credited to the responsible lawyer. Allocations to fee 
credit lawyers are not displayed unless Show Allocations to Lawyer is selected.

Start Date: To view only invoices with an A/R date after a specified date, select the date.

End Date: To view only invoices with an A/R date prior to a specified date, select the date.

• Create Bill • Quick BIll • Release Bill
• Matter Opening Balances.

• Change/Write Off Bill • Register > Invoice/Ledger tab
• Matter Manager > Ledger tab.

• Undo Bill • Register > Invoice/Ledger tab.

Pull-down menu: Reports > Journal > Invoice > Common Tab
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Totals Only: To display only a firm totals line, as well as any summary sections selected under the 
Other tab, select this check box.

Sort by: Select one of the following:

Client Name: To list invoices alphabetically by client last name or firm name, 
select this option.

Invoice: To list invoices by invoice number, select this option.

Date: To list invoices by the invoice creation date, select this option.

Layout: To produce a customized General Bank Journal, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 2-40. The Invoice Journal Selection window displaying the Other Tab 

Summarize By: If preferred, select one or more of the following:

Responsible Lawyer: To include a Summary by Responsible Lawyer, select this check 
box.

Client Introducing Lawyer: To include a Summary by Client Introducing Lawyer, select 
this check box.

Matter Introducing Lawyer: For PCLawPro and PCLawPro Enterprise: To include a 
Summary by Matter Introducing Lawyer, select this check box.

Type of Law: To include a Summary by Type of Law, select this check box.

Resp. Lawyer within Type of Law: To include a Summary by Responsible Lawyer by 
Type of Law, select this check box.

Fee Credit Lawyer: To include a Summary by Fee Credit Lawyer, select this check box.

Referral Type: To include a Summary by Referral Type, select this check box.

Department: To include a Summary by Department, select this check box.

Department by Lawyer: To include a Summary by Lawyer by Department, select this 
check box.

Include Corrected Entries: To display invoices that have been removed, select this check box.

Pull-down menu: Reports > Journal > Invoice > Other Tab
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Include Write-Offs Only: To display only invoices with write-ups or write-downs, select this check box.

Fee Credit Lawyer: To list only invoices on which a specific lawyer has worked, type or select the lawyer 
nickname.

Collecting Lawyer: To list only invoices on which a certain lawyer is the collecting lawyer, type or select the 
lawyer nickname.

All invoices where the selected lawyer had been made the collecting lawyer, are listed.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Invoice Journal lists invoices by their value when the invoice was first created. Write-offs are listed 
separately and are included in the Total column only. The Invoice Journal does not show the amount of the 
invoice that is currently outstanding. The described report configuration uses the Default layout. The Invoice 
journal also includes Default with (Fee Crdt Alloc) and Default with (Mat Int Alloc) layouts. 

Exhibit 2-41. Excerpt from the Invoice Journal showing the Default layout. 

If the work of more than one lawyer is included on an invoice, a separate line is accorded to each fee credit 
lawyer on the Default with (Fee Crdt Alloc) or the Default with (Mat Int Alloc) layouts. The responsible or 
collecting lawyer for the matter always appears on the first line of the invoice. All disbursements and taxes 
are attributed to the responsible lawyer.

Date: Displays the accounts receivable date for the invoice from the time of billing.

Entry#: Displays the sequential entry number for the entry. This is the sort criteria used when 
running the report by Order Entered.

Invoice: Displays the invoice number assigned to the bill.

Client, Client Name: Displays the client nickname and the client’s last/first or firm name respectively. Client 
appears on the top line of the invoice only.

Matter, Matter Description: Displays the matter nickname and matter description respectively. Matter appears 
on the second line of the invoice only.

CL Intro: Lists the client introducing lawyer for the matter.

Resp: Lists the responsible lawyer for the matter.

Law Type: Lists the type of law for the matter.

Fees: Displays the fee amount from the original invoice.

Disbs: Displays the disbursement amount from the original invoice.

GST, Sales Tax: For firms collecting GST and/or Sales Tax: Taxes are displayed in separate columns. The 
GST and sales tax amounts are for both fees and disbursements.

Write-offs: Write-offs are allocated to each fee credit lawyer according to their fee percentage on the 
invoice, unless specific allocations were assigned during the write-off procedure. Use the 
Default with (Fee Crdt Alloc) layout to see the separation of write-offs.

For PCLawPro and PCLawPro Enterprise: When using the Default with (Mat Int Alloc) 
layout PCLawPro allocates write-offs according to the percentages assigned to the matter 
introducing lawyer in Matter Manager.

Totals: Displays the current value of the invoice, fees + disbursements - write-offs.



Invoice Journal

Page 43

The Invoice Journal includes the following summary sections:

Exhibit 2-42. Table of the summary sections provided by the Invoice Journal and when they appear 

Drill Down
Since invoices in PCLaw represent the result of a procedure rather in straight data entry, drilling down on 
any column on the Invoice Journal opens the Change/Write Off Bill window with information on that 
invoice filled in.

Reconciling the Invoice Journal
Most items on the Invoice Journal can reconcile to other reports, whether the report is run by matter, 
client, or firm.

The below chart lists PCLaw reports that reconcile to the Invoice Journal, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters. A report with a start date 
other than 1/1/1982 may exclude entries that are included on an invoice created after the start date. As a 
result, the reports will not reconcile.

Exhibit 2-43. Table displaying the different reports and their sections that reconcile to the Invoice Journal 

Summary Title Appears when

Summary by Fee Credit Lawyer Optional, as selected by user.

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Client Introducing Lawyer Optional, as selected by user.

Summary by Matter Introducing Lawyer Optional, as selected by user. For PCLawPro and 
PCLawPro Enterprise only.

Summary by Type of Law Optional, as selected by user.

Summary by Responsible Lawyer by Type of Law Optional, as selected by user.

Summary by Referral Type Optional, as selected by user. 

Summary by Department Optional, as selected by user.

Summary by Lawyer by Department Optional, as selected by user. 

Invoice Journal Reconciles to Additional comments

Fees Client Ledger Billed > Fees For matter, client, or firm

Client Summary Bld Fees For matter client, or firm

Billing (Fees) 
Journal

Fees Deselect Include Write-Ups and Write-
Downs on Billing (Fees) Journal

Disbs Client Ledger Billed > Disbs For matter, client, or firm

Client Summary Bld Disb For matter client, or firm

Billing (Fees) 
Journal

Disbs Deselect Include Write-Ups and Write-
Downs on Billing (Fees) Journal

Tax Client Ledger Billed > Tax For matter, client, or firm

Client Summary Taxes For matter client, or firm

Billing (Fees) 
Journal

GST & Sales tax Select Show Tax Detail on Billing (Fees) 
Journal

Write-Offs Write Up/Down 
Journal

Change For matter, client, or firm

Total Billing (Fees) 
Journal

Firm Summary > 
Billed > Total

Include Write-Ups and Write-Downs must 
be selected on Billing (Fees) Journal
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Write Up/Down Journal
The Write Up/Down Journal displays changes to invoices that occur after the time of billing. Each write-down 
is listed separately. Included for each record are the invoice amounts prior to the write down, the write down 
value, and the new invoice totals. The write down is further separated into lawyer fee allocations, 
disbursements and taxes.

What Entries Appear on the Journal
Each adjustment to an invoice is reflected on the Write Up/Down Journal as a separate entry. An invoice 
amount can be changed or written down to zero through the following features:

For the Accrual accounting method, provisional write-offs to invoices can also appear on the report if the 
Include Provision for Write-Offs option is selected. Provisional write-off entries performed through the 
following features are displayed on the Write Up/Down Journal:

Removed write-offs can still be viewed on the report by selecting Include Corrected Entries.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 2-44. The Common tab of the Write Up/Down Journal 

Matter: To view only write ups/downs for a single matter, type or select the matter nickname.

Client: To view only write ups/downs for a specific client, type or select the client name.

Resp Lawyer: To view only write ups/downs for a responsible lawyer, type or select the lawyer.

When the report is run by responsible lawyer, all write ups/downs for matters belonging to 
the responsible lawyer are included on the report. Allocations and write ups/downs to fee 
credit lawyers are displayed for each entry.

Invoice: To view the history of write ups/downs to a single invoice, type or select the invoice 
number.

Start Date: To view write ups/downs on or after a specified date, select the date.

End Date: To view write ups/downs on or prior to a specified date, select the date.

Change/Write Off Bill Register > Invoice/Ledger tabs Matter Manager > Ledger tab.

Provisional Write Off Bill Reverse Provision For Write Off.

Pull-down menu: Reports > Journal > Write Up/Down > Common Tab
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Totals Only: To display only the summary sections, select this check box.

Include Corrected Entries: To display write ups/downs that have been removed, select this check box.

Provision for Write-offs: For Accrual accounting systems only: Select one of the following:

Exclude Provision for Write-offs:To not display provisional write-offs on the report, 
select this option. 

Include Provision for Write-offs:To display provisional write-offs on the report, select 
this option.

Provision for Write-offs only:To display provisional write-offs on the report and not 
display conventional write-offs, select this option.

Layout: In the Layout area, to produce a customized Write Up/Down Journal, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Write Up/Down Journal lists all instances of write ups/downs. If an invoice has been adjusted more 
than once, each write up/down is listed individually. The described customizable report uses the Default 
layout. The Default with (usr) layout is also provided 

Exhibit 2-45. Excerpt from the Write Up/Down Journal 

Date: Entries are sorted by write up/down date. 

Inv, Inv Date: Lists the number and date of the original invoice.

Task: Displays selected code from the write up/down entry.

Explanation: Displays explanation from the write up/down entry.

Item: The write up/down displays separately, fees allocated to each lawyer, disbursements, 
GST on fees, sales tax on fees, GST on disbursements, and sales tax on disbursements.

Original: If the write up/down is the first adjustment of an invoice, this column displays the 
original values for the invoice. On any subsequent adjustments, the Original column 
displays the value of the invoice prior to the current adjustment.

New: Displays the new value of the invoice after the write up/down.

Change: Displays the value of the write up/down. A positive value indicates a write up, a 
negative value indicates a write down.

G/L Acct: Displays the g/l accounts where the write up/down is allocated.



PCLaw Reports

Page 46 

The Write Up/Down Journal includes the following summary sections:

Exhibit 2-46. Table of the summary sections provided by the Write Up/Down Journal and when they appear 

Drill Down
The Write Up/Down Journal allows drill down in the following areas:

Exhibit 2-47. Table displaying fields where drill down is enabled and the reports or features that are opened 

Drill downs are not permitted on corrected and provisional write-off entries.

Reconciling the Write Up/Down Journal
The chart below lists PCLaw reports that reconcile to the Write Up/Down Journal, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 2-48. Table displaying the different reports and their sections that reconcile to the Write Up/Down Journal 

The Write Up/Down Journal does not reconcile to the Invoice Journal for the Invoice Journal does not display 
write ups/downs of disbursements or taxes separately but instead includes those values with the default 
responsible, assigned, introducing lawyer or type of law for the matter. 

The Write Up/Down Journal does not reconcile to the Client WIP, Billing, & Collection Summary for write-
offs are included on the Client WIP, Billing, & Collection Summary according to the date of the invoice that 
the write-off applies. Furthermore, the Write Up/Down Journal summarizes by fee credit lawyer and task 
code while the Client WIP, Billing, & Collection Summary summarizes by responsible lawyer, introducing 
lawyer and type of law.

The Write Up/Down Journal does not reconcile to the Lawyer WIP, Billing, & Collection Summary for 
individual matters or invoices as the Lawyer WIP, Billing, & Collection Summary summarizes by date only.

Summary Title Appears when

Firm Totals Always appears.

G/L Account Summary Always appears.

Task Code by Fee Credit Lawyer Always appears.

Fee Credit Lawyer by Task Code Always appears.

Drill down on Opens the following window

non-provisional write up/down Change/Write Off Bill

Write Up/Down 
Journal

Reconciles to Additional comments

Total Invoice Journal Write-Offs column 
> Total

Provision for Write-Offs are not included in 
summary sections

Lawyer WIP, Billing, 
& Collection 
Summary

Sum of Write-offs 
Fees and Write-offs 
Disb + Tax columns

For firm only
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Client Report Overview

Exhibit 3-1. Table listing client reports, their defining parameters, and what the report displays 

Report Run the Report By What it Does

PC
Law

 and PC
Law

 Plus for non-A
ustralian countries

PC
Law

 and PC
Law

+
 for A

ustralia

PC
Law

Pro and PC
Law

Pro Enterprise

Client Accounting 
Ledger

matter/client
resp lawyer

Lists by matter within client an accounting history for 
disbursements, trust, billing, and payments

Client Ledger matter/client
resp lawyer
working lawyer

Lists an accounting history by matter of opening balances, 
disbursements, time/fees, trust, billing and payments.

Client Summary matter/client
resp lawyer
working lawyer* 

Lists summary totals for trust, billed and unbilled fees and 
disbursements, and matter information.

Client Fees Listing matter/client
resp lawyer
working lawyer*

Lists by matter within client the time and flat fees entered and the 
current billing status of each entry.

Client Trust Listing matter/client
resp lawyer

Lists the balance in each trust account for each matter. The report 
also shows the date of the last trust transaction.

Client Trust Ledger matter/client 
resp lawyer

List trust account balances in separate receipt and disbursement 
columns. Lists running balance for each trust account for each 
matter.

Work-in-Progress matter/client
resp lawyer
working lawyer*

Lists aged details and a summary of unbilled fees and 
disbursements by matter within client.

Disbursement 
Analysis & Interest

matter/client
resp lawyer

Lists client disbursements by matter in three different report 
formats.

List of Clients matter/client
resp lawyer
other staff
referral type

Lists clients and associated matters.

Matter Status 
report

matter/client
resp lawyer

Use this report to show, for each matter, details about the last 
document, file, or e-mail associated with the matter, the last time 
or fee entry, and the last date the matter was billed.

Closed Files report matter/client
resp lawyer
file location

Lists the closed file date, closed file number and file location for 
each closed matter.

File Location 
report

matter/client
resp lawyer
file location

Lists the location of each matter including file opening and closing 
dates.

Matter Change Log matter/client Tracks all additions and changes made to matters in PCLaw, 
including the user who made the changes. 

WIP Summary by 
Responsible 
Lawyer

matter/client
resp lawyer
working lawyer*

Lists an aged summary of unbilled fees by responsible lawyer by 
client/matter.

Partner Alert report time, expense, 
A/R or trust 
parameters

Lists matters with no time entries for a specified number of days, or 
unbilled time, unbilled disbursements, accounts receivable or trust 
balances exceeding a specified amount or number of days.
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Client Ledger 
The Client Ledger lists transactions by matter, including opening balances, disbursements, time and fees, 
billing, and payments. All accounting history pertaining to the matter is contained on the Client Ledger. 
The report can be created by matter, client, or responsible lawyer, for all dates or a specific period. A 
summarized ledger displays only matter and firm totals or firm totals only. Options allow the user to view 
only time entries, disbursements, receipts, trust entries or billed items.

What Entries Appear on the Client Ledger
The following table lists PCLaw features that add or modify entries on the client ledger.

Exhibit 3-2. Table displaying transactions that appear on the Client Ledger and the feature by which they appear 

Data Entry Window Fees Disb Receipts Trust Billing

General Check add

Receive Payment add

General Retainer add

Release Check add

Trust Check add disb

Trust Receipt add receipt

Matter-to-Matter Transfer add disb/rcpt

Bank-to-Bank Transfer add disb/rcpt

Trust-to-General Transfer add add disb

Release Trust Check add disb

New/Open Payable add

Quick Timer/PCLaw Timers add time entry

Time Sheet add time entry

Fee Sheet add fee entry

Expense Recovery add 

Transaction Levy add

Global Change Time modify time/
fee entry

Matter Opening Balances fee opening 
balance

disb opening 
balance

prior 
payments

opening 
balance

prior 
invoices

Appointment Sheet add time entry

Phone Call add time entry

Web Timer add time entry

Calendar add time entry

Quick Bill add fee entry add add add

Bill add time/fees add add add disb add

Release Bill add time/ fees add add add disb add

Change/Write Off Bill fee adjustment disb adj
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The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 3-3. The Common tab of the Client Ledger 

Matter: To view records for a single matter, type or select the matter nickname.
A matter summary appears at the bottom of the window.

Client: To view records for matters assigned to one client, type or select the client name.
Details are displayed for each matter. Client totals are included at the bottom of the report.

Resp Lawyer: To view records for matters assigned to a responsible lawyer, select the lawyer nickname.

Start Date: To view records for matters posted on or after a specific date, select the date.

End Date: To view records for matters posted on or prior to a specific date, select the date.

Totals Only: To display only matter and firm totals, select this check box.

Firm Totals Only: To display only firm totals, select this check box. 

Layout: In the Layout area, to produce a customized Client Ledger, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that are not as frequently used. 

Exhibit 3-4. The Other tab of the Client Ledger 

Pull-down menu: Reports > Client > Ledger > Common Tab

Pull-down menu: Reports > Client > Ledger > Other Tab



Client Ledger

Page 51

Include Entries: Select one or more of the following:

Billed Only: To display only billed transactions, select this check box.

Disbs: To display client costs, select this check box.

Receipts: To display Receive Payments and General Retainers, select this check 
box.

Trust: To display trust checks and receipts, select this check box.

To display trust entries for one bank account only, in the Bank Acct 
box, type or select the account nickname.

Time/Fees: To display time and fee entries, select this check box.

Include only Matters with: If preferred, select one or more of the following options:

Retainer Balances: To create ledgers only for matters that have a general retainer 
balance, select this check box.

If only one matter for a multi-mattered client has a retainer balance, 
only the ledger for that matter is created.

 Negative Unbilled Disb Balance: To create ledgers only for matters with a negative 
balance for unbilled disbursements, select this check box.

Only matters with an overall negative unbilled disbursement balance 
are included on the report. If a matter contains a negative unbilled 
disbursement but the overall unbilled disbursement balance is 
positive, that matter is not included on the report.

Show Client Address: To include the client street address, city, and postal code, select this check box. 

The client number and name, matter nickname and description appear on the ledger 
regardless whether or not the check box is selected.

Show Interest: To include interest owing and paid on the Client Ledger, select this check box.
The Interest Up to box becomes available.

Interest Up To: To set an ending calculation date for interest, type or select the date. 

Interest owing is displayed in the billing slug and the matter totals section. Interest Paid 
is displayed in the explanation for payments received and in the matters total section. 
For more information on how interest appears on the Client Ledger.

Consolidate Payments: To show payments without allocations to fees, disbursements or taxes, select this 
check box.

Include Corrected Entries: To include transactions that have since been modified, select this check box.

Show Paid by Check # on Paid Payable: To display in the explanation, the check number for disbursements 
created and paid through Accounts Payable, select this check box.

Show Invoices that payments were applied to: To display in the explanation, the invoice number where a 
payments was allocated, select this check box.

Show Trust Summary by Account: To display in the matter and firm totals section, balances for each trust 
bank account, select this check box. 

Working Lawyer: To show only transactions for a specific working lawyer, type or select the lawyer 
nickname.

No Activity After: In the Show maters with area, to include only matters with no transactions after a 
specific date, type or select the date.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.
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The Report
The Client Ledger lists fee, disbursement, billing, payment and trust information for matters. The described 
customizable report uses the Default layout. The Default with (usr) layout is also provided

Exhibit 3-5. Excerpt from the Client Ledger 

The header for each ledger contains the client number and name, matter nickname and description, and the 
responsible lawyer for the matter.

Date: Displays the date the transaction was posted.

Entry #: Displays the entry number automatically assigned to the transaction.

Received From/Paid To: Displays the contents of the Received From or To boxes for all receipts and checks, 
the working lawyer, rate, and hours for time entries, or default transaction descriptions for 
billing, trust transfers, and interest.

Explanation: Displays the contents of the explanation box from the matter allocation section of the 
respective data entry window. If Show Paid by Check # on Paid Payables is enabled, a ‘Paid 
by Check #’ notation is included in the explanation for any disbursements created and 
paid through Accounts Payable. If Show Invoices that Payments were Applied to is 
enabled, a ‘PMT - Inv # Amount $$$’ notation appears in the explanation for any 
payments allocated to one or more invoices.

Che#/Rec#: Lists check, A/P invoice, reference, or receipt numbers for general check, new payables, 
receive payment and general retainers, or client expense recovery features.

General Rcpts: Lists payments, general retainers, and general retainer re-allocation amounts.

General > Disbs: Lists general check and A/P allocations of client costs, and client expense recoveries. 
When an invoice is created, GST and sales tax charged to disbursements appear in the 
column. Write-ups and write-downs to disbursements or taxes on disbursements through 
the Change/Write Off Bill feature are also included in the column. 

Fees: Lists time and fee entries, and fee adjustments at the time of billing. When an invoice is 
created, GST and sales tax on fees appear in the column. Write-ups and write-downs to 
fees or taxes on fees through the Change/Write Off Bill feature are also included in the 
column.

Bld Inv#: When a transaction is included on an invoice, the invoice number appears on the 
transaction line in this column.
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Acc: For every trust transaction, the trust account number in which the transaction is posted 
is displayed in this column. 

Trust > Rcpts: Lists trust receipts and incoming transfers. 

Trust > Disbs: Trust checks and outgoing transfers are listed under the column.

Balance: Displays the running trust balance for the matter. The running balance includes trust 
transactions that occur prior to the start date of the report. Balances in separate trust 
accounts are not differentiated in the Balance column nor in the matter totals. 

The Matter and Firm Summary sections are divided into Unbilled and Billed totals for fees and 
disbursements. Unbilled disbursements are further sub-divided into Che and Recov. Che balances consists 
of matter allocations from the general check and accounts payable features. Recov consists of matter 
allocations from the Expense Recovery feature.

Balances for General Retainers, Interest Paid, and Interest Due are provided in both the Matter Summary 
and Firm Summary sections. 

The Client Ledger includes the following summary sections:

Exhibit 3-6. Table of the summary sections provided by the Client Ledger and when they appear 

Drill Down
The Client Ledger allows drill down in the following areas:

Exhibit 3-7. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Matter Totals Always appears.

Firm Totals Always appears.

Trust Summary by Account As selected by user. 

Drill down on Opens the following window

Matter Information Open Matter

Unbilled Time Correct Time Entry

Unbilled Fees Correct Fee Entry

General Check Allocation Correct General Check

Expense Recovery Correct Expense Recovery

Billing Slug Change Bill

Receive Payment Correct General-Receive Payment

Write Up/Down Change Bill

Trust Check Correct Trust Check

Trust Receipt Correct Trust Receipt

Matter-to-matter transfer Correct Trust Matter to Matter

Bank-to-Bank Transfer Correct Trust Bank to Bank

Trust-to-General Transfer Correct Trust-to-General

General Retainer Correct General Retainer
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Reconciling the Client Ledger
The chart below lists PCLaw reports that reconcile to the Client Ledger, and the item on the report that can be 
reconciled. The reports must be run with identical dates and parameters.

Client Ledger Reconciles to Additional comments

Unbilled > Che + 
Recov

Client Acc’ting 
Ledger

Disb For matter, client, or firm.

Client Summary Unbd Disb For matter, client, or firm. Start date for 
Client Ledger must be 1/1/82.

Work-in-Progress Unbilled Disb > 
Total

For matter, client, or firm.

Matter Status Unbd Disbs For matter only

Unbilled > Fees Client Summary Unbd Fees For matter, client, or firm. Start date for 
Client Ledger must be 1/1/82.

Client Fees Listing Amount > Unbilled No matter or client totals when report is run 
for the firm.

Work-in-Progress Fees For matter, client, or firm.

Matter Status Unbd Fees For matter only

Client WIP, Billing, 
& Collection 
Summary

W.I.P. Time For matter, lawyer, or firm.

Unbilled > Total Work-in-Progress Total > Total For matter, client, or firm.

Billed > Disb Client Summary Bld Disbs For matter, client or firm. Start Date for 
Client Ledger must be 1/1/82

Billing (Fees) 
Journal

Billed > Disbs For matter, client or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Disbs For matter, client, or firm. Start Date for 
both reports must be 1/1/82.

Billed > Fees Client Summary Bld Fees For matter, client or firm. Start Date for 
Client Ledger must be 1/1/82.

Client Acc’ting 
Ledger

Fees For matter, client or firm. Billed fees appear 
as a negative value on Client Accounting 
Ledger.

Billing (Fees) 
Journal

Billed > Fees For matter, client or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Fees For matter, client, or firm. Start Date for 
both reports must be 1/1/82.

Billed > Tax Client Summary Taxes For matter, client, or firm. Start Date for 
Client Ledger must be 1/1/82.

Billing (Fees) 
Journal

Tax For matter, client, or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates

Invoice Journal Fees For matter, client, or firm. Run reports for 
all dates.

Billed > Receipts Billing (Fees) 
Journal

Paid For matter, client, or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Payment Allocation 
Listing

Total For matter, client, or firm.
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Exhibit 3-8. Table displaying the different reports and their sections that reconcile to the Client Ledger 

The Client Ledger does not reconcile to the Hard & Soft Cost Analysis report for Che or Recov for the Hard 
& Soft Cost Analysis report does not separate billed and unbilled costs. 

The Client Ledger does not reconcile to the General Bank Journal when created for a specific matter, for 
Che as the General Bank Journal does not differentiate between billed and unbilled matter allocations. 

The Client Ledger does not reconcile to the Interest Calculation report for Interest Due or Interest Paid, for 
the Interest Calculation report only adds interest accrued according to the last A/R activity for the matter. 
Also, Interest Due and Interest Paid is given as an aggregate total.

Client Ledger Reconciles to Additional comments

Balances > A/R Client Acc’ting 
Ledger

A/R > Totals for 
Report Period

For matter, client, or firm.

Client Summary A/R Bal For matter, client, or firm. Start Date for 
Client Ledger must be 1/1/82

Matter Status A/R For matter only

Billing (Fees) Outstanding For matter, client, or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Total For matter, client, or firm. Start Date for 
both reports must be 1/1/82.

Receivables by 
Client

Total For matter, client, or firm. Start date for both 
reports must be 1/1/82.

Receivables by 
Lawyer

Firm Totals > Total For firm only

Accounts 
Receivable (1200)

Closing Balance For Accrual Accounting method only.

Balances > Trust Client Acc’ting 
Ledger

Trust > Totals for 
Report Period

For matter, client, or firm.

Client Summary Trust Balance For matter, client, or firm. Start Date for 
Client Ledger must be 1/1/82.

Client Trust Listing Matter Total For matter, client, or firm.

Client Trust Ledger Matter Total For matter, client, or firm.

Matter Status Trust For matter only. For all accounts only.

General Retainers Client Acc’ting 
Ledger

Retainer For matter, client, and firm.

Client Summary Retainers For matter, client, and firm. Start Date for 
Client Ledger must be 1/1/82.

Matter Status Retainer For matter only.

Interest Paid Client Summary Interest Paid For matter, client, and firm. Start Date for 
Client Ledger must be 1/1/82

Interest Due Client Summary Retainers For matter, client, and firm. Start Date for 
Client Ledger must be 1/1/82.

Receivables by 
Client

Interest Due For matter, client, or firm. Run reports for 
all dates.
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Client Accounting Ledger 
The Client Accounting Ledger displays G/L postings for matter transactions. Fees are displayed only after they 
are billed, while a running balance is provided for unbilled disbursements, receivables, trust, taxes and 
general retainers. Balances for both the report period and report end date are provided. 

What Entries Appear on the Ledger
Disbursements appear on the Client Accounting Ledger as a positive value through following features. 

The following billing features credit fees and disbursements and adds a positive value for the sum under the 
A/R column:

Disbursements added at the time of billing, or billed as part of Matter Opening Balances appear on the Client 
Accounting Ledger as both a positive and negative value.

Changes to the A/R column are added through the following features:

Invoices can be removed from the Client Accounting Ledger using the following features:

Trust balances on the Client Accounting Ledger are increased or reduced through the following features:

General Retainer balances are added through the following features:

General Retainer balances are reduced through the following features:

 Time and Fee entries do not affect the Client Accounting Ledger until billed.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-9. The Common tab of the Client Accounting Ledger 

• General Check • Expense Recovery • New/Open Payable
• Matter Opening Balances (for unbilled disbursements).

• Quick Bill • Create Bill • Release Bill.

• Change/Write Off Bill • Register > Invoice/Ledger tabs • .Matter Manager > Ledger tab.

• Undo Bill • Register > Invoice/Ledger tabs.

• Trust Check • Release Trust Check • Trust Receipt
• Matter-to-Matter Transfer// • Bank-to-Bank Transfer • Trust-to-General Transfer.

• General Retainer • Receive Payment • Quick Bill.

• Create Bill • Release Bill.

Pull-down menu: Reports > Client > Accounting Ledger > Common Tab
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Matter: To view only items for one matter, type or select the matter nickname.

A matter summary appears at the bottom of the window.

Client: To view only items for matters belonging to a specific client, type or select the client 
nickname.

Resp Lawyer: To view only items for matters assigned to a specific responsible lawyer, type or select 
the lawyer.

Start Date: To view items on or after a specific date, select the date.

End Date: To view items on or prior to a specific date, select the date.

Totals Only: To display only matter and firm totals, select this check box.

Firm Totals Only: To display only the Firm Summary section, select this check box. 

Trust Only: To display details of trust transactions only, select this check box.

Show Paid by Check # on Paid Payables: To display in the explanation, the check number for 
disbursements created and paid through Accounts Payable, select this check box. 

Show Trust Summary by Account: To display in the firm totals section, balances for each trust bank 
account, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Client Accounting Ledger lists expense, billing, payment and trust details for matters.

Exhibit 3-10. Excerpt from the Client Accounting Ledger 

Each matter displays matter and client nickname, client name and description. It is not necessary to re-
open an archived matter to view information. The report displays ‘inactive’ or ‘archived’ along with the 
Close Date and Close Number.

Date: Lists the posting date for each transaction.

Type: Displays an abbreviation for the transaction type for each record. For example, CER 
indicates the entry is a client expense recovery. When an invoice is created, a billing 
slug is added to the Client Accounting Ledger. The slug is identifiable by the description 
“Billing On Invoice ##”.

Ref#: Lists the check number for general checks, reference number for client expense entries, 
or the invoice number for payable, invoices, and write-off entries.

Received From/Paid To: Displays the payee name or transaction description.

Explanation: Displays the explanation for the original entry.
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Paid by Check #: If Show Paid by Check # on Paid Payables is enabled, a notation is included in the 
explanation for any disbursements created and paid through Accounts Payable.

Fees: Displays only billed time and fees. Unbilled time and fee entries do not appear on the 
Client Accounting Ledger. The billed amount of a fee appears as a negative value to reflect 
the G/L posting. Unlike the subsequent data columns, only negative postings appear under 
the fee column therefore fees can never reconcile to zero.

Disbursement: Unbilled expenses appear as a positive value. When the expense is billed, the billed value 
appears as a negative. If a expense is written up at the time of billing, the amount of the 
write up appears separately as a positive value while the amount of all billed expenses 
including the write up appear as a negative value. Therefore, the Disbursement column 
will reconcile to zero once all disbursements are billed.

When a disbursement is billed, the letter B appears to the right of the entry.

A/R: The billed amount of fees and disbursements appear as a positive value. If applicable, GST 
and Sales tax appear separately.

Payments and write-offs appear under the A/R column as a negative value, reducing the 
total receivables for the client. Therefore the A/R column can reconcile to zero if all 
invoices are paid or written down.

Trust: Trust receipts and incoming transfers appear as a positive value. Trust checks and outgoing 
transfers appear as a negative value. Therefore the Trust column will reconcile to zero only 
if all trust funds have been disbursed.

Acc#: Lists the trust bank account number for each trust transaction.

Retainer: Unallocated general retainers appear as a positive value. Once a retainer is allocated, it 
shows as a negative value. Therefore the Retainer column will reconcile to zero if all 
retainers are allocated.

The Client Accounting Ledger includes the following summary section:

Exhibit 3-11. Table of the summary sections provided by the Client Accounting Ledger and when they appear 

Drill Down
The Client Accounting Ledger allows drill down to the following areas:

Exhibit 3-12. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Firm Totals Always appears.

Trust Summary by Account As selected d by user. 

Drill down on Opens the following window

Billed Fees Change Bill

General Check Allocation Correct General Check

Expense Recovery Correct Expense Recovery

Billing Slug Change Bill

Receive Payment Correct - General Receive Payment

Write Up/Down Change Bill

Trust Check Correct - Trust Check

Trust Receipt Correct - Trust Receipt

Matter-to-matter transfer Correct - Trust Matter-to-Matter

Bank-to-Bank Transfer Correct - Trust-Bank-to-Bank

Trust-to-General Transfer Correct - Trust-to-General

General Retainer Correct - General Retainer
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Reconciling the Client Accounting Ledger
Most items on the Client Accounting Ledger can reconcile to other reports, whether the report is run by 
matter, client, or firm.

The chart below lists PCLaw reports that reconcile to the Client Accounting Ledger, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters.
.

Exhibit 3-13. Table displaying the different reports that reconcile to the Client Accounting Ledger 

Billed disbursements displayed on the Client Accounting Ledger are not reconcilable to any other report 
since a separate total is not provided. The total for the disbursement column represents unbilled 
disbursements only.

Taxes displayed on the Client Accounting Ledger are not reconcilable to any other report since a separate 
total is not provided.

Payments displayed on the Client Accounting Ledger are not reconcilable to any other report since a 
separate total is not provided.

Client Accounting 
Ledger

Reconciles to Additional comments

Fees Client Ledger Billed > Fees For matter or firm.

Client Summary Bld Fees For matter or firm. Start Date for Client 
Accounting Ledger must be 1/1/82.

Billing (Fees) 
Journal

Fees Include Write-Ups and Write-Downs must 
be deselected on Billing (Fees) Journal. 
Reports must be run for all dates.

Disbs Client Ledger Unbilled > Che + 
Recov

For matter, client, or firm.

Client Summary Unbd Disb For matter, client, or firm. Start Date for 
Accounting Ledger must be 1/1/82.

Work-in-Progress Unbilled Disb > 
Total

For matter, client, or firm.

Matter Status Unbd Disbs For matter only

A/R Client Ledger Billed > Balances > 
A/R

For matter, client, or firm.

Client Summary A/R Bal For matter, client, or firm. Start Date for 
Accounting Ledger must be 1/1/82.

Matter Status A/R Totals for report period. For matter only.

Billing (Fees) 
Journal

Outstanding For matter, client, or firm. Run both reports 
for all dates.

Receivables by 
Client

Total For matter, client, or firm. Run both reports 
for all dates.

Receivables by 
Lawyer

Firm Totals > Total For firm only. Run both reports for all dates.

Accounts 
Receivable (1200)

Closing Balance For Accrual Account method only

Trust Client Trust Listing Matter Total For matter, client, or firm

Client Trust Ledger Matter Total For matter, client, or firm

Matter Status Trust For matter only. For all accounts only.

Trust Bank Journal Balance > Total For firm only

Retainer Client Ledger General Retainer For matter, client, and firm

Client Summary Retainers For matter, client, and firm

Matter Status Retainer For matter only
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Client Summary 
The Client Summary lists account balances for billed and unbilled fees and disbursements, accounts 
receivables, trust, and matter information. The report can be run by matter, client, or responsible lawyer, for 
all dates or for a specific end date. 

What Entries Appear on the Client Summary
The following table lists all PCLaw features that modify values on the Client Summary.

Exhibit 3-14. Table displaying transactions that appear on the Client Summary and the feature by which they appear 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report.

Exhibit 3-15. The Common tab of the Client Summary 

Data Entry Window Fees Disb Receipts Trust Billing

General Check/Release 
Check

unbilled

Receive Payment billed billed A/R Bal

General Retainer retainers

Trust Check/Release Check trust balance

Trust Receipt trust balance

Matter-to-matter transfer trust balance

Bank-to-Bank Transfer trust balance

Trust-to-General Transfer billed billed trust balance A/R Bal

New/Open Payable unbilled

Quick Timer/PCLaw Timers unbilled

Time Sheet/Fee Sheet unbilled

Expense Recovery unbilled

Global Change Time unbilled

Matter Manager  billed/
unbilled

billed/
unbilled

retainers trust balance A/R Bal

Calendar/Appointment Sheet unbilled

Phone Calls unbilled

Quick Bill billed billed A/R Bal

Create Bill/Release Bill billed billed retainer trust balance A/R Bal

Change/Write Off Bill billed billed A/R Bal

Pull-down menu: Reports > Client > Summary > Common Tab
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Matter: To view details for a single matter, type or select the matter nickname.

A matter summary appears at the bottom of the window.

Client: To view details for matters belonging to a single client, type or select the client 
nickname.

Resp Lawyer: To view details for matters assigned to a responsible lawyer, type or select the lawyer 
nickname.

End Date: To include items up to and on a specific date, select the date.

Totals Only: To display only firm totals and the Summary by Responsible Lawyer section, select this 
check box.

Client Balances Only: To display only client totals, firm totals, and the Summary by Responsible Lawyer 
section, select this check box. 

Layout: In the Layout area, to produce a customized Client Summary, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that are not as frequently used. 

Exhibit 3-16. The Other tab of the Client Summary 

Include Matters with: Select one or both of the following: 

Zero Balances: To display summaries only for matters that have zero balances for all 
of hours, fees, disbursements, retainer, trust, and A/R balance, select 
this check box.

Non-zero Balances: To display summaries only for matters that contain a balance in at 
least one of hours, fees, disbursements or trust, select this check box.

Pull-down menu: Reports > Client > Summary > Other Tab
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Include only Matters with: If preferred, select one of the following:

Retainer Balances: To display summaries only for matters that have a general retainer 
balance, select this check box.

If only one matter for a multi-mattered client has a retainer balance, 
only the summary for that matter is created.

Negative Unbilled Disb Balance: To display summaries only for matters with a negative 
balance for unbilled disbursements, select this check box.

Only matters with an overall negative unbilled disbursement balance 
are included on the report. If a matter contains a negative unbilled 
disbursement but the overall unbilled disbursement balance is positive, 
that matter is not included on the report.

Unbld Disb Over: To display summaries only for matters with an unbilled disbursement 
value over a specific amount, type the amount.

Summary by Department: To include a Summary by Department section on the report, select this check box.

Working Lawyer: To show only values for a specific working lawyer, type or select the lawyer nickname.

No Activity After: To include only matters with no transactions after a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Client Summary lists fee, disbursement, billing, payment and trust details for matters. The described 
customizable report uses the Default layout provided with PCLaw.

Exhibit 3-17. Excerpt from the Client Summary 

Client: Lists client nickname and client last/first or firm name. Information does not appear if 
Client Balances Only is selected.

Matter: Lists matter nickname and matter description. Information does not appear if Client 
Balances Only is selected.

Resp: Lists the nickname for the matter’s responsible lawyer. Information does not appear if 
Client Balances Only is selected.

Assgnd: Lists the nickname for the matter’s assigned lawyer. Information does not appear if Client 
Balances Only is selected.

Open Date: Displays the date the matter was opened.

Last Entry: Displays the date of the last transaction to the matter. Open Date and Last Entry do not 
appear on the summary if Client Balances Only is selected.

Unbd Hrs: Displays the total unbilled hours for the matter.

Bld Hrs: Displays the total billed hours. Hours values do not appear on the summary if Client 
Balances Only is selected.

Unbd Fees: Displays the total value of unbilled time and fee entries for the matter.
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Bld Fees: Displays the total value of billed time and fee entries and fee adjustments, net of 
payments and write-offs applied to fees for the matter. If Matter Balances Only or Client 
Balances Only is selected, unbilled and billed fees are displayed in Unbilled > Fees and 
Net Billed > Fees columns respectively.

Unbd Disb: Displays the total value of unbilled disbursements for the matter.

Bld Disb: Displays the total value of billed disbursements and adjustments to disbursements at 
the time of billing, net of payments and write-offs applied to the disbursements. If 
Matter Balances Only or Client Balances Only is selected, unbilled disbursements are 
displayed in Unbilled > Disb column. Billed disbursements are included along with 
taxes in the Net Billed > Disb + Tax column.

Retainers: Display the total value of non-applied general retainers for the matter. Retainer values 
are always included on the Client Summary.

Taxes: Display the total value of taxes charged to the matter at the time of billing. If Matter 
Balances Only or Client Balances Only is selected, taxes are included with 
disbursements under the Net Billed > Disb + Tax column. 

Last Bld: Displays the date when the last invoice was created for the matter. Last Bld does not 
appear on the summary if Matter Balances Only or Client Balances Only is selected.

A/R Bal: Displays the value of the current accounts receivable for the matter. If Matter Balances 
Only or Client Balances Only is selected, the value appears under the Balances > A/R 
column.

Trust: Ac#: Lists the trust account containing that balance. 

Balance: Displays the balance for each trust account for the matter.

Last Entry: Displays the last transaction date for that account. 

If Matter Balances Only or Client Balances only is selected, only the total balance for 
all trust accounts appear under the Balances > Trust column.

Balances for Interest Paid, and Interest Due are provided for the matter, client, and firm.

The Client Summary includes the following summary sections:

Exhibit 3-18. Table of the summary sections provided by the Client Summary and when they appear 

Drill Down
The Client Ledger allows drill down in the following areas:

Summary Title Appears when

Summary by Responsible Lawyer Always appears. 

Firm Totals Always appears.

Summary by Department Optional, as selected by user.

Drill down on Opens the following window

Matter Information Open Matter

Open Date Open Matter

Unbd Hrs Client Fees Listing

Bld Hrs Client Fees Listing

Unbd Fees Client Fees Listing

Bld Fees Client Fees Listing

Unbd Disb Work-in-Progress

Billed Disb Billing (Fees) Journal
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Exhibit 3-19. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Client Summary
The chart below lists PCLaw reports that reconcile to the Client Summary, and the item on the report that can 
be reconciled. The reports must be run with identical dates and parameters. Since the Client Summary is 
always created with a default start date of 1/1/82, for any report to reconcile with the summary, that report 
must be created for the same start date.

Drill down on Opens the following window

Taxes Receivables by Client

A/R Bal Receivables by Client

Trust Client Trust Listing

Client Summary Reconciles to Additional comments

Unbd Hrs Client Fees Listing Hours > Unbilled For matter, client, or firm.

Work-in-Progress Hours > Total For matter, client, or firm.

Bld Hrs Billing (Fees) 
Journal

Hours For matter, client, or firm.

Unbd Fees Client Ledger Unbilled > Fees For matter, client, or firm.

Client Fees Listing Amount > Unbilled For matter, client, and firm.

Work-in-Progress Fees > Total For matter, client, or firm.

Matter Status Unbd Fees For matter only.

Client WIP, Billing, 
& Collection 
Summary

W.I.P. Time For matter, lawyer, or firm.

Bld Fees Client Ledger Billed >Fees For matter, client or firm.

Client Accounting 
Ledger

Fees For matter, client or firm. Billed fees appear 
as a negative value on Client Accounting 
Ledger.

Billing (Fees) 
Journal

Billed > Fees For matter, client or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Fees For matter, client, or firm. Run reports for 
all dates.

Unbd > Disb Client Accounting 
Ledger

Disb For matter, client, or firm.

Client Ledger Unbilled > Che + 
Recov

For matter, client, or firm.

Work-in-Progress Unbilled Disb > 
Total

For matter, client, or firm.

Matter Status Unbd Disbs For matter only.

Bld > Disb Client Ledger Billed Disb For matter, client or firm.

Billing (Fees) 
Journal

Billed > Disbs For matter, client or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Disbs For matter, client, or firm. Run reports for 
all dates.
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Exhibit 3-20. Table displaying the different reports and their sections that reconcile to the Client Summary 

The Client Summary does not reconcile to the Time Listing, Time Summary, Daily Time Summary, 
Comparative Time Analysis, or Unbilled Time & A/R Summary by Working Lawyer for billed and unbilled 
hours and time, for the Client Summary summarizes information by responsible lawyer whereas the latter 
reports summarize information by working lawyer.

The Client Summary does not reconcile to the Client Fees Listing for billed hours or fees, for the Client 
Summary displays a billed fee value that is net of payments. The Client Fees Listing displays total billed 
fees for the matter, regardless or not if the fee is still outstanding.

The Client Summary does not reconcile to the Invoice Journal for the Invoice Journal does not reflect 
payments made to invoices.

The Client Summary does not reconcile to the Interest Calculation report for Interest Due or Interest Paid, 
for the Interest Calculation report adds interest accrued according to the last A/R activity for the matter. In 
addition, Interest Due and Interest Paid is given as an aggregate total.

Client Summary Reconciles to Additional comments

Retainers Client Ledger General Retainer For matter, client, and firm.

Client Accounting 
Ledger

Retainers For matter, client, and firm.

Matter Status Retainer For matter only.

Taxes Client Ledger Billed > Tax For matter, client, or firm.

Billing (Fees) 
Journal

Tax For matter, client, or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Fees For matter, client, or firm. Run reports for 
all dates.

A/R Bal Client Accounting 
Ledger

A/R > Totals for 
Report Period

For matter, client, or firm.

Client Ledger Balances > A/R Bal For matter, client, or firm.

Matter Status A/R For matter only.

Billing (Fees) 
Journal 

Outstanding For matter, client, or firm. Select Include 
Write-Ups and Write Downs & Include 
Paid Invoices. Run reports for all dates.

Invoice Journal Total For matter, client, or firm.

Receivables by 
Client

Total For matter, client, or firm.

Receivables by 
Lawyer

Firm Totals > Total For firm only.

Accounts 
Receivables (1200)

Closing Balance For Accrual Accounting method only.

Trust > Balances Client Accounting 
Ledger

Trust > Totals for 
Report Period

For matter, client, or firm.

Client Ledger Balances > Trust For matter, client, or firm.

Client Trust Listing Matter Total For matter, client, or firm.

Client Trust Ledger Matter Total For matter, client, or firm.

Matter Status Trust For matter only. For all accounts only.

Interest Paid Client Ledger Interest Paid For matter, client, or firm.

Interest Due Client Ledger Interest Due For matter, client, or firm.

Receivables by 
Client

Interest Due For matter, client, or firm. Run reports for 
all dates.
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Client Fees Listing
The Client Fees Listing displays time and fee entries for a matter. The report indicates if a fee is billed and 
provides the invoice number containing the entry. A comparison of billed and unbilled transactions is given 
for each matter.

What Entries Appear on the Report
Transactions appearing on the Client Fees Listing are added from the following features:

Existing fees appearing on the Client Fees Listing can be modified from the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-21. The Common tab of the Client Fees Listing 

Matter: To view only fees for a single matter, type or select the matter nickname.

Client: To view only fees for a single client, type or select the client nickname.

Resp Lawyer: To view fees for matters belonging to a specific responsible lawyer, type or select the 
lawyer.

Start Date: To view fees on or after a specific date, select the date.

End Date: To view fees on or prior to a specific date, select the date.

Totals Only: To view the summary sections only, select this check box.

Client Balances Only: To view client totals and the summary section, select this check box. 

Matter Balances Only: To view matter totals and the summary section, select this check box.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Calendar/Appointment Sheet
• Matter Opening Balances • Phone Call Manager • Create Bill/Quick Bill/Release Bill.

• Register > Time/Ledger/Invoice tabs • Global Change Time
• Matter Manager > Time/Ledger tabs • Change/Write Off Bill.

Pull-down menu: Reports > Client > Fee Listing > Common Tab
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Layout: In the Layout area, to produce a customized Client Fee Listing, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-22. The Other tab of the Client Fees Listing 

Include: Select one or more of the following:

Billed Items: To include billed transactions on the report, select this check box.

Unbilled Items: To include unbilled transactions on the report, select this check box.

Billable Tasks: To include transactions with a billable task code, select this check 
box.

Non-Billable Tasks: To include transactions with a nonbillable task code, select this 
check box.

Be careful not to double filter the report. Deselecting both Billed and Unbilled Items or 
Billable and Non-Billable Tasks will result in a blank report.

Working Lawyer: To view transactions for a specific working lawyer, type or select the lawyer. 

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Client > Fee Listing > Other Tab
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The Report
The Client Fees Listing provides a list of time and fee entries and indicates whether or not they have been 
billed. The described customizable report uses the Default layout. The Default with (usr) layout is also 
provided 

Exhibit 3-23. Excerpt from the Client Fees Listing   

Date: Displays the date the entry was posted.

Entry #: Lists the assigned entry number for the record.

Fee/Time: Displays ‘Fees to Lawyer’ for fee entries, and hours times rate for time entries.

Explanation: Displays the description for the time or fee entry.

Working Lawyer: Displays the working lawyer’s nickname and full name, up to thirteen characters.

Hours: List hours for time entries. Fee entries are shown as having zero hours. The column is sub-
totalled for both unbilled and billed hours. An overall total and percent billed value is also 
displayed. 

Amount: Lists the values for time and fee entries. The column is sub-totalled for both unbilled and 
billed amounts. An overall total and percent billed value is also displayed.

Inv#: For billed entries, displays the invoice number of the invoice that includes.

Billing Status: Displays ‘Billed’ if the entry is included on an invoice and ‘Unbilled’ if the entry has yet to 
be billed. 

The Client Fees Listing includes the following summary sections:

Exhibit 3-24. Table of the summary sections provided by the Client Fees Listing and when they appear

Drill Down
The Client Fees Listing allows drill down on the following areas:

Exhibit 3-25. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Working Lawyer Always appears.

Summary by Responsible Lawyer Always appears.

Drill down on Opens the following window

Time entry Correct Time Entry

Fee entry Correct Fee Entry

Matter Information Open Matter
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Reconciling the Client Fees Listing
The chart below lists PCLaw reports that reconcile to the Client Fees Listing, and the item on the report 
that can be reconciled. The reports must be created with identical dates and parameters.

Exhibit 3-26. Table displaying the different reports and their sections that reconcile to the Client Fees Listing 

The Client Fees Listing cannot reconcile to the Time Listing or Time Summary reports for time value, as the 
latter reports do not include changes to fees after the time of billing.

The Billed Total on the Client Fees Listing will only reconcile to the Billing (Fees) Journal if both reports are 
run for all dates. The Client Fees Listing marks a fee entry as being billed, whether or not the billing of the 
fee occurred during the report period. The Billing (Fees) Journal only reports fees billed during the report 
period.

Although the Client Fees Listing does reconcile to the Time Listing and Time Summary for hours, the Time 
Listing and Time Summary do not include Split Bill Fee Transfers. Split Bill Fee Transfer entries should add 
up to zero.

Client Fees Listing Reconciles to Additional comments

Hours Client Summary Unbd Hrs For matter, client, and firm

Work-in-Progress Hours > Total Unbilled hours only

Time Listing Hours > Total For hours only

Time Summary Hours (Hr) > Total For hours only

Billing Realization Summary by 
Wrking Lawyer > 
Hour

For matter, working lawyer, and firm. 
Deselect Unbilled Items on Client Fees 
Listing 

Amount Client Ledger Unbilled > Fees For matter, client, and firm

Client Summary Unbd Fees For matter, client, and firm

Work-in-Progress Fees Total Unbilled fees only

WIP Summary by 
Resp Lawyer

Fees > Total Unbilled fees only

Matter Status report Unbd Fees For matter only. Unbilled fees only.

Client WIP, Billing, 
& Collection 
Summary

W.I.P. Time For matter, client, and firm.

Comparative Time 
Analysis

Amount Include Billed, Unbilled, Billable, and 
Non-billable tasks
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Client Trust Listing 
The Client Trust Listing shows trust balances by client and matter. A balance is provided for each trust 
account in which the matter has funds, followed by a matter total. A last entry date is also displayed for each 
trust account.

What Entries Appear on the Listing
Trust transactions calculated for the Client Trust Listing are compiled through the following features:

Trust transactions on the Client Trust Listing are modified through the following features:.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report.

Exhibit 3-27. The Common tab of the Client Trust Listing 

Matter: To view balances for a single matter, type or select the matter nickname.

The matter summary appears at the bottom of the window.

Client: To view balances for matters belonging to a specific client, type or select the client 
nickname.

Resp Lawyer: To view balances for matters assigned to a responsible lawyer, type or select the lawyer 
nickname.

End Date: To view balances on a specific date, select the date.

• Trust Check • Trust Release Check • Trust Receipt
• Matter Opening Balances • Matter-to-Matter Transfer/Trust-to-General Transfer.

• Register > Trust/Ledger tabs • Matter Manager > Ledger tab.

Pull-down menu: Reports > Client > Trust Listing > Common Tab
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Acct: To view balances for a specific trust account, type or select the account nickname.

Totals Only: To display matter totals without individual account details, select this check box.

Firm Totals Only: To display only the Summary by Responsible Lawyer and Firm Totals by Account 
summary sections, select this check box. 

Negative Balances Only: To view information on matters with a negative trust balance on one or more 
trust account, select this check box.

Layout: In the Layout area, to produce a customized Client Trust Listing, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that are not as frequently used.

Exhibit 3-28. The Other tab of the Client Trust Listing 

Show Matters with No Activity After: To view balances only for matters with no trust activity after a 
specific date, type or select the date.

Show Trust Account Balance in Summary: To include trust balances in the Summary by Responsible 
Lawyer section, select this check box. Balances are displayed for each trust account for 
each lawyer. Balances are calculated according to the matters assigned to the 
responsible lawyer. 

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Client Trust Listing Acct Balance is calculated from all trust receipts and disbursements for the 
included matters. The described report uses the Default address layout provided with PCLaw.

Exhibit 3-29. Excerpt from the Client Trust Listing 

Pull-down menu: Reports > Client > Trust Listing > Common Tab
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Client: Lists the client nickname and name. 

Matter: Lists the matter nickname. 

Description: Displays the matter description as it appears in Matter Manager.

Resp Lawyer: Lists the responsible lawyer for each matter.

Bank Acct#: Lists the account number for each trust account, including accounts that contains a non-
zero balance, for matters belonging to the client.

Acct Balance: Displays the balance for each respective trust account for each matter. 

Last Entry: Lists the date of the last transaction for each trust account for the matter.

The Client Trust Listing includes the following summary sections:

Exhibit 3-30. Table of the summary sections provided by the Client Trust Listing and when they appear 

Drill Down
The Client Trust Listing allows drill down in the following areas:

Exhibit 3-31. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Responsible Lawyer Always appears.

Firm Totals by Account Always appears.

Drill down on Opens the following window

Matter Information Matter Manager

Account Balance Client Trust Ledger for bank account

Firm Total - Responsible Lawyer Summary Client Trust Ledger fo lawyer.
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Reconciling the Client Trust Listing
The chart below lists PCLaw reports that reconcile to the Client Trust Listing, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 3-32. Table displaying the different reports and their sections that reconcile to the Client Trust Listing 

Client Trust Listing Reconciles to Additional comments

Acct Balance Client Trust Ledger Account Balance For matter and client

Client Ledger Balances > Trust For matter and client.

Client Accounting 
Ledger

Trust > Ending Date For matters.

Client Summary Trust Balance > Ac# For matters.

Matter Status Trust For matters.

Firm Totals > Acct 
Balance

Client Trust Ledger Firm Total > 
Account Balance

For firm.

Client Ledger Firm Totals > End 
Date > Trust 

For firm.

Client Accounting 
Ledger

Trust > Firm Totals 
up to Ending Date

For firm.

Client Summary Firm Totals > Trust 
Balance

For firm.

Trust Bank Journal Bank Account 
Summary > Balance

For firm.

G/L > Trust Bank 
Acct #

Closing Balance For firm.
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Client Trust Ledger
The Client Trust Ledger shows trust activity for each matter. A balance is provided for each trust account in 
which the matter has funds, followed by a matter and client total. Separate columns are provided for receipts 
and disbursements.

What Entries Appear on the Ledger
Trust transactions on the Client Trust Ledger are added through the following features:

Trust transactions on the Client Trust Listing are modified through the following features:.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report.

Exhibit 3-33. The Common tab of the Client Trust Ledger 

Matter: To view details for a single matter, type or select the matter nickname.

Client: To view details for matters belonging to a specific client, type or select the client 
nickname.

Resp Lawyer: To view details for matters assigned to a responsible lawyer, type or select the lawyer 
nickname.

End Date: To view details up to a specific date, select the date.

Acct: To view details for a specific trust account, type or select the account nickname.

Totals Only: To display matter totals without individual account details, select this check box.

Firm Totals Only: To display only the Summary by Responsible Lawyer and Firm Totals sections, select this 
check box. 

Negative Balances Only: To view information on matters with a negative trust balance on one or more trust 
account, select this check box.

Layout: In the Layout area, to produce a customized Client Trust Ledger, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

• Trust Check • Trust Release Check • Trust Receipt
• Matter Opening Balances • Matter-to-Matter Transfer/Trust-to-General Transfer.

• Register > Trust/Ledger tabs • Matter Manager > Ledger tab.

Pull-down menu: Reports > Client > Trust Ledger > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that are not as frequently used.

Exhibit 3-34. The Other tab of the Client Trust Ledger 

Start Date: To view items on or after a specific date, select the date.

End Date: To view items on or before a specific date, select the date.

Include Totals for all Matters: To display totals for each matter in the Check and Receipts columns, select 
this check box.

Exclude details for Clients with Totals less than: To suppress details for matters with a total trust balance 
under a specific value, select this check box.

Type the value in the adjacent box.

The typed value is compared to both the total of Receipts and the total of Checks. 

Details for:

Checks: To include details for checks, select this check box.

Receipts: To include details for receipts, select this check box.

If Use Deposit Slips are Enabled: To include details for receipts 
according to how they were received by the firm, select the 
respective check box.

Show Matters with No Activity After: To view balances only for matters with no trust activity after a 
specific date, type or select the date.

Show Entries which result in a negative trust balance: To restrict the Trust Ledger to entries that take 
individual account balances for matters below zero, select this check box. 

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Client > Trust Ledger > Common Tab
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The Report
The Client Trust Ledger includes trust disbursement, receipt, and balance details for matters. The described 
customizable report uses the Default address layout provided with PCLaw.

Exhibit 3-35. Excerpt from the Client Trust Ledger 

Client: Lists the client nickname and name. 

Matter: Lists the matter nickname. 

Date Displays the date that each trust transaction was posted.

Entry # Lists the unique entry number assigned for each record.

Description: Displays the matter description as displayed in Matter Manager.

Received From/Paid To: Lists the contents of the payee or paid to boxes.

Explanation: Displays the explanation typed into the check/receipt area of the data entry window.

Resp Lawyer: Lists the responsible lawyer for each matter.

Che#/Rec#: Lists the check, receipt or reference number. Reference numbers are used for matter-to-
matter transfers.

Bank Acct#: Lists the account number for each trust account that contains a non-zero balance for 
matters belonging to the client.

Account Balance: Displays the balance for each trust account for each matter. 

Matter Total: If Include Totals For Matters is selected: Displays the trust balance for each matter. For 
clients with multiple matters, individual account balance totals for each matter and a client 
balance are provided.

Receipt, Disbs: The amount of each individual transaction is displayed in the respective columns.

The Client Trust Ledger includes the following summary sections:

Exhibit 3-36. Table of the summary sections provided by the Client Trust Ledger and when they appear 

Drill Down
The Client Trust Ledger allows drill down in the following areas:

Summary Title Appears when

Firm Totals by Account Always appears.

Drill down on Opens the following window

Matter Totals Detailed Client Trust Listing for the Matter

Matter Information Matter Manager

Trust Check Correct Trust Check

Trust Receipt Correct Trust Receipt
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Exhibit 3-37. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Client Trust Ledger
The chart below lists PCLaw reports that reconcile to the Client Trust Ledger, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 3-38. Table displaying the different reports and their sections that reconcile to the Client Trust Ledger 

Drill down on Opens the following window

Matter-to-Matter Transfer Correct Trust Matter to Matter

Bank-to-Bank Transfer Correct Trust Bank to Bank

Trust-to-General Transfer Correct Trust-to-General

Client Trust Ledger Reconciles to Additional comments

Account Balance Client Trust Listing Acct Balance For matter and client.

Client Summary Trust Balance > Ac# For matter or client.

Matter Total Client Ledger Balances > Trust For matter.

Client Accounting 
Ledger

Trust > Ending Date For matters.

Client Summary Trust Balance > Ac# For matters.

Matter Status Trust For matter only.

Firm Totals > 
Account Balance

Client Trust Listing Firm Totals > Acct 
Balance 

For firm

Client Ledger Firm Totals > End 
Date > Trust 

For firm.

Client Accounting 
Ledger

Trust > Firm Totals 
up to Ending Date

For firm.

Client Summary Firm Totals > Trust 
Balance

For firm.

Trust Bank Journal Bank Account 
Summary > Balance

For firm.

G/L > Trust Bank 
Acct #

Closing Balance For firm.

Firm Totals by 
Account > Firm 
Total

G/L > Trust Funds 
Owed

Closing Balance For firm.

Trust Bank Journal Bank Account 
Summary > Total

For firm.
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Work-In-Progress Report
The Work-in-Progress report lists all unbilled fees and costs for a matter. Hours, fees, and costs are divided 
into age categories for billing purposes. If an item is billed after the end date of the report, it will appear on 
the Work-in-Progress report as unbilled for the report period. The report does not differentiate between time 
and fee entries. Contingency matters can be excluded from the report.

What Entries Appear on the Report
Fees on the Work-in-Progress report are added or modified through the following features:

Fee adjustments, time added at billing, and write-downs of billed time are not included on the report.

Costs on the Work-in-Progress report are added or modified through the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-39. The Common tab of the Work-in-Progress report 

Matter: To view only transactions for a single matter, type or select the matter nickname.

Client: To view only transactions for a specific client, type or select the client nickname.

Resp Lawyer: To view transactions for matters assigned to a responsible lawyer, type or select the lawyer 
nickname.

Start Date: To view transactions on or after a specific date, select the date.

End Date: To view transactions on or prior to a specific date, select the date.

Totals Only: To view a Summary by Working Lawyer only, select check box.

Firm Totals Only: To view firm totals only, select this check box.

Client Balances Only: To view client totals and the summary section, select this check box.

Matter Balances Only: To view matter totals and the summary sections, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet/Fee Sheet • Quick Timer • Matter Manager > Time/Ledger tabs
• PCLaw Timers • Global Change Time • Register > Time/Ledger tabs
• Matter Opening Balances • Phone Call Manager • Calendar/Appointment Sheet.

• Expense Recovery • General Check • General Release Check
• New/Open Payable • General Retainer (as a negative disbursement)
• Matter Opening Balances • Register > Expense/General/AP/Ledger tabs.

Pull-down menu: Reports > Client > Work-in-Progress > Common Tab
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The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-40. The Other tab of the Work-in-Progress report 

Include: Select one or more of the following:

Time/Fees: To include time and fee entries on the report, select this check box.

Disbursements: To include disbursements on the report, select this check box.

Retainers: To include general retainers on the report, select this check box.

Summarize By: If preferred, select one or more of the following:

Working Lawyer: To include a Summary by Working Lawyer, select this check box.

Responsible Lawyer: To include a Summary by Responsible Lawyer, select this check 
box.

Client Introducing Lawyer: To include a Summary by Client Introducing Lawyer, select 
this check box .

Matter Introducing Lawyer: For PCLawPro and PCLawPro Enterprise: To include a 
Summary by Matter Introducing Lawyer, select this check box.

Department: To include a Summary by Department section, select this check box.

Age From: To set the base date for the age categories, select the date. 

The date defaults to the default entry date. The age categories are calculated as the 
number of days prior to the base date.

Working Lawyer: To view transactions for a specific working lawyer, type or select the lawyer nickname.

Only time and fee entries belonging to the selected lawyer appear on the report. Costs 
where the selected lawyer is the responsible lawyer for the matter also appear.

Include only Matters with: If preferred, select one or more of the following:

Negative Unbilled Disbursement Balances: To view only matters with a negative 
disbursement balance, select this check box.

Entries Older Than ## Days: To include only matters with entries older than a specified 
number of days, type the number of days.

Ignore Matter If: If preferred, complete one of the following:

Fees Less Than: To exclude matters with fees less than a predetermined amount, type 
the amount.

Pull-down menu: Reports > Client > Work-in-Progress > Other Tab
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Disbursements Less Than: To exclude matters with disbursements less than a 
predetermined amount, type the amount.

Charges Less Than: To exclude matters whose sum of fees and disbursements are less than 
a predetermined amount, type the amount.

Include Contingency Matters: To include matters with a quoted type of Contingency, select this check box.

OK: To create the report, click this button.

The Report
The Work-in-Progress report provides a list of unbilled time and expenses. Once a time or expense entry is 
billed, it no longer appears on the report.

Exhibit 3-41. Excerpt from the Work-in-Progress report 

Date: Displays the date the entry was posted.

Entry #: Lists the assigned entry number for the record.

Paid To/Fee/Time: Provides a description of entry.

Explanation: Displays explanation added on allocation portion of the data entry window.

Che/Inv: Displays the reference number for disbursements, check number for checks and invoice 
number for a/p allocations to matters. Since time and fees do not include a reference 
number, the column is left blank.

Retainers: Displays the value of unapplied general retainers.

Disbursement: Displays the value of unbilled expenses. For modified cash and cash systems: Both hard 
and soft costs are included in the value.

Fee/Time: Displays the value of time and fee amounts. Time and fee amounts are not separated.

Current A/R bal: Displays the accounts receivable balance for the matter as of the date of the report.

Current Trust bal: Displays the current trust balance for the matter as of the date of the report.

Each matter displays a summary of hours, fees, and costs by age category. A client total by age category is not 
included on the report. To see a client total, select Client Balances Only under the Common tab.

The Work-in-Progress report includes the following summary sections:

Exhibit 3-42. Table of the summary sections provided by the Work-in-Progress report and when they appear 

Summary Title Appears when

Summary by Working Lawyer Appears on a detailed report or when Totals Only is selected.

Firm Summary Always appears.

Summary by Working Lawyer Optional, as selected by user. 

Summary by Responsible Lawyer Optional, as selected by user. .

Summary by Client Introducing Lawyer Optional, as selected by user. 

Summary by Matter Introducing Lawyer Optional, as selected by user. 

Summary by Department Optional, as selected by user. 
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Drill Down
The Work-in-Progress report allows drill down in the following areas:

Exhibit 3-43. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Work-in-Progress Report
The Work-in-Progress report can reconcile to reports that display unbilled fees or costs. However, the 
Work-in-Progress report lists fees and expenses without separating the transactions by source or type as 
may be found on other PCLaw reports.

The below chart lists PCLaw reports that reconcile to the WIP Summary by Responsible Lawyer, and the 
items on the report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 3-44. Table displaying the different reports and their sections that reconcile to the Work-in-Progress report 

The Work-in-Progress report does not reconcile to the Client Costs, Disbursement History, Time Listing, or 
Time Summary as these reports cannot be run for unbilled transactions only.

The Work-in-Progress report does not reconcile to the Hard & Soft Cost Analysis or Client WIP, Billing, & 
Collection Summary as the latter two reports do not include general retainers.

Drill down on Opens the following window

Time entry Correct Time Entry

Fee entry Correct Fee Entry

Expense recovery entry Correct - Expense Recovery

General check entry Correct - General Check

Accounts payable entry Register > Select Payable 

Current A/R balance Receivables by Client report for matter only

Current trust balance Client Trust Listing

Work-in-Progress Reconciles to Additional comments

Hours (matter, 
client, or firm totals 
summary sections)

Client Summary Unbd Hrs For matter, client, and firm

Client Fees Listing Hours > Unbilled No matter or client totals when report run 
for firm

WIP by Resp 
Lawyer

Hours > Total Firm totals only

Fees (matter, client, 
or firm totals 
summary sections)

Client Ledger Unbilled > Fees For matter, client, and firm.

Client Summary Unbd Fees For matter, client, and firm.

Client Fees Listing Unbilled > Amount No matter or client totals when report run 
for firm.

Matter Status Unbd Fees For matter only.

WIP by Resp 
Lawyer

Fees > Total Firm totals only.

Client WIP, Billing, 
& Collection 
Summary

W.I.P. > Time For matter, lawyer, and firm.

Disbursements 
(matter, client, or 
firm totals summary 
sections)

Client Ledger Unbilled > Che + 
Recov - General 
Retainers 

For matter, client, and firm.

Client Summary Unbd Disb - 
General Retainers 

For matter and firm.

WIP by Resp 
Lawyer

Disbs > Total Firm totals only.

Matter Status Unbd Disbs For matter only.
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WIP Summary by Responsible Lawyer
The Work-in-Progress (WIP) Summary by Responsible Lawyer summarizes all unbilled fees and costs by 
responsible lawyer.    Hours, fees, and costs are divided into age categories for billing purposes. Matters for 
each responsible lawyer are listed under the lawyer heading. Matter information is further divided by working 
lawyer, and there is an overall working lawyer summary for each responsible lawyer grouping. Contingency 
matters can be excluded from the report. 

What Entries Appear on the Summary
Fees that comprise the values on the WIP Summary by Responsible Lawyer report originate from one of the 
following features:

Fee adjustments, time added at billing, and writedowns are not included on the report.

Fees that comprise the values on the WIP Summary by Responsible Lawyer report can be modified through 
the following features:

Costs that comprise the values on the WIP Summary by Responsible Lawyer report originate through the 
following features:

Costs that comprise the values on the WIP Summary by Responsible Lawyer report can be modified through 
the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-45. The Common tab of the WIP Summary by Responsible Lawyer 

Matter: To view WIP for a specific matter, type or select the matter nickname.

Client: To view WIP for a specific client, type or select the client nickname.

Resp Lawyer: To view WIP for a responsible lawyer, type or select the lawyer nickname.

Start Date: To view WIP on or after a specific date, select the date.

End Date: To view WIP on or prior to a specific date, select the date.

Totals Only: To view the summary sections only, select this check box.

• Time Sheet/Fee Sheet • Quick Timer • PCLaw Timers
• Phone Call Manager • Matter Opening Balances • Calendar/Appointment Sheet.

• Global Change Time • Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

• Expense Recovery • General Check • General Release Check
• New/Open Payable • Matter Opening Balances. •

• Register > Expense/General/AP/Ledger tabs.

Pull-down menu: Reports > Client > WIP Summary by Responsible Lawyer > Common Tab
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Client Balances Only: To view client totals and the summary section, select this check box.

Matter Balances Only: To view matter totals and the summary sections, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-46. The Other tab of the WIP Summary by Responsible Lawyer 

Include: Select one or more of the following:

Time/Fees: To include time and fee entries on the report, select this check box.

Disbursements: To include disbursements on the report, select this check box.

Summarize By: If preferred, select one or more of the following:

Working Lawyer: To include a Summary by Working Lawyer section on the report, 
select this check box.

Responsible Lawyer: To include a Summary by Responsible Lawyer section on the 
report, select this check box.

Age From: To set the base date for the age categories, select the date. 

The date defaults to the default entry date. The age categories are calculated as the 
number of days prior to the base date.

Working Lawyer: To view transactions for a specific working lawyer, type or select the lawyer nickname.

Only time and fee entries belonging to the selected lawyer appear on the report. Costs 
where the selected lawyer is the responsible lawyer for the matter also appear.

Include only Matters with: If preferred, select one or more of the following:

Negative Unbilled Disbursement Balance: To view only matters with a negative 
disbursement balance, select this check box.

Entries Older Than ## Days:To include only matters with entries older than a specified 
number of days, type the number of days.

Pull-down menu: Reports > Client > WIP Summary by Responsible Lawyer > Common Tab
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Ignore Matter If: If preferred, complete one or more of the following:

Fees Less Than: To exclude matters with fees less than a predetermined amount, type the 
amount.

Disbursements Less Than: To exclude matters with disbursements less than a 
predetermined amount, type the amount.

Charges Less Than: To exclude matters whose sum of fees and disbursements are less than 
a predetermined amount, type the amount.

Include Contingency Matters: To include matters with a quoted type of Contingency, select this check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The WIP Summary by Responsible Lawyer provides a summary of unbilled time and expenses. Once a time 
or expense entry is billed, it no longer appears on the report.

Exhibit 3-47. Excerpt from the WIP Summary by Responsible Lawyer 

Each responsible lawyer appears as a separate heading. A Sub-totals by Working Lawyer compilation 
completes each responsible lawyer section. The summation calculates total hours and fees for all working 
lawyers who have unbilled time for matters belonging to the responsible lawyer.

Client Name: Lists client nickname and client last/first or firm name.

Matter: Matters assigned to the responsible lawyer are listed individually by nickname and 
description. 

Wkg Lwyr: Lawyers who posted time to that matter are displayed including their unbilled time.

Hours: Displays the hours of unbilled time for the matter, client, and lawyer.

Current: Displays the value of work-in-progress that is within 30 days of their posted date.

31-60 Days, 61-90 Days, 91-120 Days, >=121 Days: Fees and disbursements are divided into separate age 
categories, calculated from the base date as entered in the Age From box under the Other 
tab.

Total: Displays the total work-in-progress for the mater, client, or responsible lawyer. 

 %: Calculates the total fees for each working lawyer as a percentage of the total fees for the 
matter.

Last Time Entry: Displays the posted date for the last time entry.



WIP Summary by Responsible Lawyer

Page 85

Disbs: Displays the total disbursements for the matter. Disbursements listed are the amounts 
accorded to the responsible lawyer.   

Current A/R: Displays the current accounts receivables balance for the matter.

Current Trust: Displays the current trust balance for the matter.

The WIP Summary by Responsible Lawyer report includes the following summary sections:

Exhibit 3-48. Table of summary sections for the WIP Summary by Responsible Lawyer and when they appear

Drill Down
The Work-in-Progress by Responsible Lawyer report allows drill down in the following areas:

Exhibit 3-49. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the WIP Summary by Responsible Lawyer
Since the WIP Summary by Responsible Lawyer does not display totals for matters or clients, it can 
reconcile firm totals for hours, unbilled fees and costs.

The chart on the following page lists PCLaw reports that reconcile to the WIP Summary by Responsible 
Lawyer, and the items on the report that can be reconciled. The reports must be run with identical dates 
and parameters.

Exhibit 3-50. Table displaying the different reports and their sections that reconcile to the WIP Summary by Responsible Lawyer 

The WIP Summary by Responsible Lawyer does not reconcile to the Client Costs, Disbursement History, 
Time Listing, or Time Summary as these reports cannot be run for unbilled transactions only.

The WIP Summary by Responsible Lawyer does not reconcile to the Hard & Soft Cost Analysis or Client 
WIP, Billing, & Collection Summary for disbursements as the WIP Summary by Responsible Lawyer 
includes unapplied general retainers.

Summary Title Appears when

Summary by Working Lawyer Optional, as selected by user. 

Summary by Responsible Lawyer Optional, as selected by user. 

Drill down on Opens the following window

Matter information Open Matter

Current A/R balance Receivables by Client report for matter only

Current trust balance Client Trust Listing

WIP Summary by 
Resp Lawyer 

Reconciles to Additional comments

Hours (matter, 
client, or firm totals 
summary sections)

Client Summary Unbd Hrs For firm only

Client Fees Listing Hours > Unbilled For firm only

Work-in-Progress Hours > Total For firm only

Fees (matter, client, 
or firm totals 
summary sections)

Client Ledger Unbilled > Fees For firm only

Client Summary Unbd Fees For firm only

Client Fees Listing Unbilled > Amount For firm only

Work-in-Progress Fees > Total For firm only

Disbursements 
(matter, client, or 
firm totals summary 
sections)

Client Ledger Unbilled Che + 
Recov

For firm only

Client Summary Unbd Disb For firm only

Work-in-Progress Disbs > Totals For firm only
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Disbursement Analysis & Interest Report
The Disbursement Analysis & Interest report is one of the three reports that comprise the Disbursement 
Interest & Analysis report grouping. The Disbursement Analysis & Interest report displays costs allocated to 
each matter and shows interest calculated on disbursements at a specified rate. The report displays costs 
without separating unbilled and billed or hard and soft costs in item totals. Costs can be filtered by matter, 
client, responsible lawyer or date.

What Entries Appear on the Report
Costs listed on the Disbursement Analysis & Interest report are added or changed through one of the 
following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-51. The Common tab of the Disbursement Analysis & Interest report 

Matter: To view only costs for a single matter, type or select the matter nickname.

Client: To view costs for a specific client, type or select the client nickname.

Resp Lawyer: To view only costs allocated to matters belonging to a specific responsible lawyer, type or 
select the lawyer nickname.

Start Date: To view costs on or after a specific date, select the date.

End Date: To view costs on or before a specific date, select the date.

Disbursement Analysis and Interest: To create the Disbursement Analysis & Interest report, select this option.

Calculate Interest: To calculate interest on Disbursements, select this check box.

Interest to: Select the end date to which interest is calculated.

Interest Rate: Type the interest rate.

Billed Up To: To view costs as billed on or before a specific date, type or select the date.

Receipts Up To: To view payments applied to costs on or before a specific date, type or select the date.

• General Check • Release Check • Expense Recovery
• New/Open Payable • Register > General/Expense/AP tabs
• Matter Opening Balances • Create Bill/Quick Bill/Release Bill.

Pull-down menu: Reports > Client > Disbursement Analysis and Interest > Common Tab
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Include: Select one of the following:

Billed: To view only billed disbursements select this option.

Unbilled: To view only unbilled disbursements, select this option.

Billed + Unbilled: To view both billed and unbilled disbursements selected this option.

Select one of the following:

Paid by Client: To view only billed disbursements to which payments are applied, 
select this option.

For partially paid invoices, only the paid portion of the disbursement 
is shown.

Unpaid by Client: To view only billed disbursements to which payments are not 
applied, select this option.

For partially paid invoices, only the unpaid portion of the 
disbursement is shown.

Paid + Unpaid: To view both paid and unpaid disbursements, select this option.

Summarize By: If preferred, select one or more of the following:

Resp Lawyer: To include a Summary by Responsible Lawyer section on the report, 
select this check box.

Type of Law: To include a Summary by Type of Law section on the report, select 
this check box.

Expl. Code: To include a Summary by Explanation Code section on the report, 
select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Disabled options on the Disbursement Analysis & Interest selections window are specific to the 
Disbursement History or Hard & Soft Analysis reports.

The Report
The Disbursement Analysis & Interest report provides a list of allocated expenses. All expenses are 
associated with matters. The Journal does not take into account whether or not the expense has been paid 
by the client.

Exhibit 3-52. Excerpt from the Disbursement Analysis & History report 

Matter #: The report is sorted by client name and then matter nickname. Disbursements are 
displayed by matter.

Client Name: Lists client last/first or firm name.

Description: Displays matter description. 

Date: Displays the posting date of the disbursement.
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 Ref #: Displays the reference number when the transaction was entered. The value can be:

• the reference number from a client expense recovery
• invoice number from a disbursement adjustment at the time of billing, a split billing 

or a write-off after billing
• check number from a general check allocation
• payable invoice number from an accounts payable allocation.

Explanation: Appears as it would on the Client Ledger. Non-taxable entries are marked with an asterisk. 

Resp: Displays the lawyer responsible for the matter.

Law Type: Displays the type of law for the matter.

Amount: Displays the value of a cost allocated to the matter. If a check or expense recovery 
transaction lists multiple allocations for one matter, each allocation is listed separately. A 
negative amount indicates the cost is reversed or written down.

Interest: Displays the calculated interest for the disbursement from the original disbursement date. 
The interest rate and end date are determined under the Common tab. 

Billed: Displays a Y if a cost is billed or an N if it is still awaiting billing.

The Disbursement Analysis & Interest report includes the following summary sections:

Exhibit 3-53. Table of the summary sections provided by the Disbursement Analysis & Interest report 

Drill Down
The Disbursement Analysis & Interest report allows drill down in the following areas:

Exhibit 3-54. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Type of Law Optional, as selected by user.

Summary by Explanation Code Optional, as selected by user.

Drill down on Opens the following window

Unbilled expense recovery entry Correct - Expense Recovery

Unbilled general check entry Correct - General Check

Unbilled accounts payable entry Register > Select Payable 

Billed entry Change Bill

Write up/down Change Bill

Matter information Matter Manager

Matter total Matter Manager
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Reconciling the Disbursement Analysis & Interest Report
The Disbursement Analysis & Interest reconciles to many reports that display matter costs. However, the 
Disbursement Analysis & Interest report lists expenses only without separating billed and unbilled costs in 
the matter or firm totals. The report does not provide client totals.

The chart below lists PCLaw reports that reconcile to the Disbursement Analysis & Interest report, and the 
item on the report that can be reconciled. Run the reports with identical dates and parameters.

Exhibit 3-55. Table displaying the different reports that reconcile to the Disbursement Analysis & Interest report 

Disbursement 
Analysis & Interest

Reconciles to Additional comments

Total/Firm Total Client Ledger Unbilled Che + 
Recov + Billed 
Disbs

For matter and firm totals

Client Summary Unbd Disb + Bld 
Disb

For matter and firm totals

Client Costs Journal Total > Debit 
column

To reconcile for matters, run report for the 
matter only 

Hard & Soft Cost 
Analysis

Soft Cost + Hard 
Cost > Total

For matter and firm totals 
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Disbursement History Report
The Disbursement History report is one of the three reports that comprise the Disbursement Interest & 
Analysis report grouping. The Disbursement History report displays costs allocated to each matter and 
indicates if the cost has been billed. The report displays costs without separating unbilled and billed or hard 
and soft costs in item totals. Costs can be filtered by matter, client, responsible lawyer or date.

What Entries Appear on the Report
Costs listed on the Disbursement History report are added or changed through the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-56. The Common tab of the Disbursement History report 

Matter: To view only costs for a single matter, type or select the matter nickname.

Client: To view costs for a specific client, type or select the client nickname.

Resp Lawyer: To view only costs allocated to matters belonging to a specific responsible lawyer, type or 
select the lawyer nickname.

Start Date: To view costs on or after a specific date, select the date.

End Date: To view costs on or before a specific date, select the date.

Disbursement History: To create the Disbursement History report, select this option.

Billed Up To: To view costs as billed on or before a specific date, type or select the date.

Receipts Up To: To view payments applied to costs on or before a specific date, type or select the date.

• General Check • Release Check • Expense Recovery
• New/Open Payable • Change/Write Off Bill Create Bill/Quick Bill/Release Bill

• Matter Opening Balances • Register > General/Expense/Ledger/AP tabs.

Pull-down menu: Reports > Client > Disbursement Analysis and Interest > Common Tab
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Include: Select one of the following:

Billed: To view only billed disbursements select this option.

Unbilled: To view only unbilled disbursements, select this option.

Billed + Unbilled: To view both billed and unbilled disbursements selected this option.

Select one of the following:

Paid by Client: To view only billed disbursements to which payments are applied, 
select this option.

For partially paid invoices, only the paid portion of the disbursement 
is shown.

Unpaid by Client: To view only billed disbursements to which payments are not 
applied, select this option.

For partially paid invoices, only the unpaid portion of the 
disbursement is shown.

Paid + Unpaid: To view both paid and unpaid disbursements, select this option.

Matter Totals Only: To view only matter totals, select this check box.

Matter and Expl. Code Totals Only: To view totals for matters and explanation codes with no transaction 
detail, select this check box.

Firm Totals Only: To view the firm totals line only, select this check box.

Summarize By: If preferred, select one or more of the following:

Resp Lawyer: To include a Summary by Responsible Lawyer section on the report, 
select this check box.

Type of Law: To include a Summary by Type of Law section on the report, select 
this check box.

Expl. Code: To include a Summary by Explanation Code section on the report, 
select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Disabled options on the Disbursement Analysis & Interest selections window are specific to the 
Disbursement Analysis & Interest or Hard & Soft Analysis reports.

The Report
The Disbursement History report provides a list of allocated expenses. All expenses are associated with 
matters. The Journal does not take into account whether or not the expense has been paid by the client.

Exhibit 3-57. Excerpt from the Disbursement History report 
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Matter #: The report is sorted by client name and then matter nickname. Disbursements are 
displayed by matter.

Client Name: Lists client last/first or firm name.

Description: Displays matter description. 

Date: Displays the posting date of the disbursement.

 Ref #: Displays the reference number when the transaction was entered. The value can be:

• the reference number from a client expense recovery
• invoice number from a disbursement adjustment at the time of billing, a split billing 

or a write-off after billing
• check number from a general check allocation
• payable invoice number from an accounts payable allocation.

Explanation: Appears as it would on the Client Ledger. Non-taxable entries are marked with an asterisk. 

Resp: Displays the lawyer responsible for the matter.

Law Type: Displays the type of law for the matter.

Amount: Displays the value of a cost allocated to the matter. If a check or expense recovery 
transaction lists multiple allocations for one matter, each allocation is listed separately. A 
negative amount indicates the cost is reversed or written down.

Interest: Displays the calculated interest for the disbursement from the original disbursement date. 
The interest rate and end date are determined under the Common tab. 

Billed: Displays a Y if a cost is billed or an N if it is still awaiting billing.

The Disbursement History report includes the following summary sections:

Exhibit 3-58. Table of the summary sections provided by the Disbursement History report and when they appear

Drill Down
The Disbursement History report allows drill down in the following areas:

Exhibit 3-59. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Type of Law Optional, as selected by user.

Summary by Explanation Code Optional, as selected by user.

Drill down on Opens the following window

Unbilled expense recovery entry Correct - Expense Recovery

Unbilled general check entry Correct - General Check

Unbilled accounts payable entry Register > Select Payable 

Billed entry Change Bill

Write up/down Change Bill

Matter information Open Matter

Matter total Open Matter
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Reconciling the Disbursement History Report
The Disbursement History can reconcile to the majority of reports that display costs for matters. However, 
the Disbursement History lists expenses only and does not separate billed and unbilled costs in the matter 
or firm totals. The Disbursement History report does not provide client totals.

The chart below lists PCLaw reports that reconcile to the Disbursement History, and the item on the report 
that can be reconciled. Run the reports with identical dates and parameters.

Exhibit 3-60. Table showing the different reports and their sections that reconcile to the Disbursement History report 

Disbursement 
History

Reconciles to Additional comments

Total/Firm Total Client Ledger Unbilled Che + 
Recov + Billed 
Disbs

For matter and firm totals

Client Summary Unbd Disb + Bld 
Disb

For matter and firm totals

Client Costs Journal Total > Debit 
column

To reconcile for matters, report must be run 
for the matter only 

Hard & Soft Cost 
Analysis

Soft Cost + Hard 
Cost > Total

For matter and firm totals
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Hard & Soft Cost Analysis
The Hard & Soft Cost Analysis is one of the three reports that comprise the Disbursement Interest & Analysis 
report grouping. The Hard & Soft Cost Analysis categorizes costs as per their origin. Expense recovery and 
billing adjustments are soft costs while allocations from general checks or new payables are hard costs. The 
report indicates whether or not a cost is billed and paid. Costs can be filtered by matter, client, responsible 
lawyer or date.

What Entries Appear on the Report
Expense recovery entries on the Hard & Soft Cost Analysis are added or modified through:

General check allocations on the Hard & Soft Cost Analysis are added or modified through:

A/P allocations on the Hard & Soft Cost Analysis are added or modified through:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-61. The Common tab of the Hard & Soft Cost Analysis 

Matter: To view only costs for a single matter, type or select the matter nickname.

Client: To view costs for a specific client, type or select the client nickname.

Resp Lawyer: To view only costs allocated to matters belonging to a specific responsible lawyer, type or 
select the lawyer nickname.

Start Date: To view costs on or after a specific date, select the date.

End Date: To view costs on or before a specific date, select the date.

Hard and Soft Cost Analysis: To create the Hard and Soft Cost Analysis report, select this option.

Billed Up To: To view costs as billed on or before a specific date, type or select the date.

Receipts Up To: To view payments applied to costs on or before a specific date, type or select the date.

• Expense Recovery • Create Bill/Quick Bill • Change/Write Off Bill
• Matter Opening Balances • Register > Expense/Ledger tabs.

• General Check • General Release Check • Register > General/Ledger tabs.

• New/Open Payable • Register > AP tab. •

Pull-down menu: Reports > Client > Disbursement Analysis and Interest > Common Tab



Hard & Soft Cost Analysis

Page 95

Include: Select one of the following:

Billed: To view only billed disbursements select this option.

Unbilled: To view only unbilled disbursements, select this option.

Billed + Unbilled: To view both billed and unbilled disbursements selected this option.

Select one of the following:

Paid by Client: To view only billed disbursements to which payments are applied, 
select this option.

For partially paid invoices, only the paid portion of the disbursement 
is shown.

Unpaid by Client: To view only billed disbursements to which payments are not 
applied, select this option.

For partially paid invoices, only the unpaid portion of the 
disbursement is shown.

Paid + Unpaid: To view both paid and unpaid disbursements, select this option.

Matter Totals Only: To view only matter totals, select this check box.

Matter and Expl. Code Totals Only: To view totals for matters and explanation codes with no transaction 
detail, select this check box.

Firm Totals Only: To view the firm totals line only, select this check box.

Summarize By: If preferred, select one or more of the following:

Resp Lawyer: To include a Summary by Responsible Lawyer section on the report, 
select this check box.

Type of Law: To include a Summary by Type of Law section on the report, select 
this check box.

Expl. Code: To include a Summary by Explanation Code section on the report, 
select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The report provides a list of allocated expenses. All expenses are associated with matters. The report 
indicates if the expense is paid by the client, but does not separate hard and soft costs in the item totals.

Exhibit 3-62. Excerpt from the Hard & Soft Cost Analysis 

Client Name: Lists client last/first or firm name.

Matter: The report is sorted by client and then matter nickname. Disbursements are displayed 
by matter.

Date: Displays the posting date of the disbursement.
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Src: indicates whether the transaction is a CER, CHE, AP, or W/D.

 Ref #: Displays the reference number when the transaction was entered. The value can be:

• the reference number from a client expense recovery
• invoice number from a disbursement adjustment at the time of billing, a split billing 

or a write-off after billing
• check number from a general check allocation
• payable invoice number from an accounts payable allocation.

Explanation: Appears as it would on the Client Ledger. Non-taxable entries are marked with an asterisk. 

Law Type: Displays the type of law for the matter.

Soft Cost: Lists all soft costs whether it is an expense recovery, adjustment at the time of billing, or 
write up/down after billing.

Hard Cost: Section divides costs allocated to matters between checks (Advanced column) and 
payables (A/P Pending column). 

Billed: Displays a Y if a cost is billed or an N if it is still awaiting billing.

Paid by Client: Displays a Y if a payment has been applied to a cost, an N if the cost is unpaid, or a P if the 
cost is partially paid.

The Hard & Soft Analysis includes the following summary sections:

Exhibit 3-63. Table of the summary sections provided by the Hard & Soft Cost Analysis and when they appear

Drill Down
The Hard & Soft Cost Analysis report allows drill down in the following areas:

Exhibit 3-64. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Type of Law Optional, as selected by user.

Summary by Explanation Code Optional, as selected by user.

Drill down on Opens the following window

Unbilled expense recovery entry Correct - Expense Recovery

Unbilled general check entry Correct - General Check

Unbilled accounts payable entry Register > Select Payable 

Write up/down Change Bill

Matter information Open Matter

Matter total Open Matter
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Reconciling the Hard & Soft Cost Analysis
The Hard & Soft Cost Analysis lists expenses only and does not separate billed and unbilled costs for 
matter or firm totals. Client totals are not listed separately.

The chart below lists PCLaw reports that reconcile to the Hard & Soft Cost Analysis, and the item on the 
report that can be reconciled. Run the reports with identical dates and parameters.

Exhibit 3-65. Table displaying the different reports and their sections that reconcile to the Hard & Soft Cost Analysis 

The Hard & Soft Analysis does not reconcile to the Work-in-Progress or Work-in-Progress Summary by 
Responsible Lawyer reports as the latter reports includes unapplied general retainers in their disbursement 
WIP. 

Hrd & Sft Cost Anal Reconciles to Additional comments

Soft Cost: Matter > 
and Firm Totals

Client Ledger Unbilled Recov Select Unbilled in Include section

Hard Cost > Total 
column: Matter and 
Firm Totals

Client Ledger Unbilled Che Select Unbilled in Include section

Soft Cost + Hard 
Cost > Total: Matter 
and Firm Totals

Client Costs Total > Debit 
column

Select Billed + Unbilled/Paid + Unpaid

Disbursement 
History

Total + Firm Total Select Billed + Unbilled/Paid + Unpaid
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Partner Alert Report
The Partner Alert is a notification report listing matters with no activity for a specified period of time, or have 
balances exceeding a specified amount. The time or amount parameters are determined when the report is 
created. The areas where the parameters can apply include accounts receivables, unbilled time, unbilled 
disbursements, and trust. The report can be run for client introducing lawyer or responsible lawyer. The report 
displays matter totals only and not individual transactions.

What Entries Appear on the Report
The balance of unbilled time on the Partner Alert report is comprised of transactions made through the 
following features:

The balance of unbilled disbursements on the Partner Alert report is comprised of transactions made through 
the following features: 

The A/R balance on the Partner Alert report is comprised of transactions made through the following features:

Trust balance on the Partner Alert is comprised of transactions made through the following features:

The Partner Alert Criteria Tab

The Partner Alert Criteria tab contains the parameters to define the Partner Alert report. It is the first tab to 
appear when selecting the report from the pull-down menu or Quick Step. When setting defaults under the 
Workstation Settings > Other tab for the Partner Alert report to appear automatically at start up, the window 
that appears when clicking the Criteria button is identical to the Partner Alert Criteria tab.   See “Workstation 
Settings” on page 100.

Exhibit 3-66. The Partner Alert Criteria tab of the Partner Alert report 

• Time Sheet/Fee Sheet • Quick Timer • PCLaw Timers
• Phone Call Manager • Calendar • Appointment Sheet
• Matter Opening Balances.

• Expense Recovery • General Check > with allocations to a matter
• Matter Opening Balances (for unbilled disbursements).

• Create Bill • Release Bill • Register > Invoice/Ledger tabs
• Quick Bill • Change/Write Off Bill • Matter Manager > Ledger tab.

• Trust Check • Trust Release Check • Trust-to-General Transfer
• Trust Receipt • Matter-to-Matter Transfer. •

Pull-down menu: Reports > Client > Partner Alert > Partner Alert Criteria Tab
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Client Intro Lawyers: To view only information for matters assigned to one or more client introducing 
lawyers, click the Select button to choose the lawyers.

Responsible Lawyers: To view only information for matters assigned to one or more responsible lawyers, 
click the Select button to choose the lawyers.

No Time Entries for: To view information on matters where a time entry has not been posted for a 
specified number of days, select this check box.

Type the minimum number of days in the adjacent box. 

Time Alert: To view information on matters where unbilled time exceeds a specified value or time 
remains unbilled for a specified number of days, select this check box.

WIP exceeding: Type the minimum value of the unbilled time.

Days exceeding: Type the minimum number of days.

Although a value can be assigned to both the WIP exceeding and Days exceeding 
boxes, only one valued is require when Time Alert is selected.

Disbursement Alert: To view information on matters where unbilled disbursements exceed a specified 
value or disbursements remain unbilled for a specified number of days, select this 
check box.

WIP exceeding: Type the minimum value of the unbilled disbursement.

Days exceeding: Type the minimum number of days.

Although a value can be assigned to both the WIP exceeding and Days exceeding 
boxes, only one valued is require when Disbursement Alert is selected.

A/R Alert: To view information on matters where the A/R balance exceeds a specified value or has 
aged for a specified number of days, select this check box.

Balances exceeding: Type the minimum A/R balance.

Days due exceeding: Type the minimum number of days.

Although a value can be assigned to both the Balances exceeding and Days due 
exceeding boxes, only one valued is require when A/R Alert is selected.

Trust Alert: To view information on matters where the trust balance exceeds a specified value or 
has no activity for a specified number of days, select this check box.

Balances exceeding: Type the minimum trust balance.

Days exceeding: Type the minimum number of days.

Although a value can be assigned to both the Balances exceeding and Days exceeding 
boxes, only one valued is require when Trust Alert is selected.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.
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Workstation Settings

The Partner Alert report can be set to appear automatically when PCLaw is opened. Select Display Partner 
Alert at Startup on the Workstation Settings > Other tab. Click the Criteria button to set the alert parameters 
for the pop up report. 

The selected settings apply to this workstation only. Unique criteria for the Partner Alert report can be 
assigned for different workstations.

The Report
The Partner Alert lists disbursement, billing, payment and trust details for matters.

Exhibit 3-67. Excerpt from the Partner Alert report 

Each matter displays matter nickname, description, and responsible lawyer.

Accounts Receivable: Provides the outstanding receivable balance for the matter as of 12/31/2199. All post 
dated billings and receipts are included in the A/R total.

Unbilled Time: Provides the value of unbilled time and fees for the matter as of 12/31/2199. All post dated 
time entries are included in the unbilled time value. Delay post entries are not included in 
the balance until saved.

Unbilled Disbursements: Provides the value of unbilled disbursements for the matter as of 12/31/2199. All 
post dated disbursement entries are included in the unbilled disbursement balance. 
Recurring entries that have not been posted are not included in the balance.

Trust Balance: Provides the sum balance for all trust accounts assigned to the matter, including checks 
and receipts as of 12/31/2199. All post dated trust entries are included in the trust balance. 
Recurring entries that have not been posted are not included in the balance.

Last Activity: Displays the date of the last transaction posted to the client ledger, even if the transaction is 
post-dated.

The Partner Alert report does not contain any summary sections.

Drill Down
The Partner Alert allows drill down in the following areas:

Exhibit 3-68. Table displaying fields where drill down is enabled and the reports or features that are opened 

Pull-down menu: Options > Workstation Settings > Other tab

Quick Step Utilities > Workstation Settings > Other tab

Drill down on Opens the following window

Matter Information Matter Manager > Summary Tab

Accounts Receivable Matter Manager > Summary Tab

Unbilled Time Matter Manager > Summary Tab

Unbilled Disbursements Matter Manager > Summary Tab

Trust Balance Matter Manager > Summary Tab

Last Activity Matter Manager > Summary Tab
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Reconciling the Partner Alert
The Partner Alert is not primarily a reconcilable report. However, balances on the Partner Alert can 
reconcile to other reports.

The chart below lists PCLaw reports that reconcile to the Partner Alert, and the item on the report that can 
be reconciled. The comparative reports must be run with identical dates and parameters. A report with a 
start date other than 1/1/82 may exclude entries that occurred prior to the start date. An end date of 12/31/
2199 must be used on all comparative reports to include any post-dated entries.

Exhibit 3-69. Table displaying the different reports and their sections that reconcile to the Partner Alert report 

Unbilled time on the Partner Alert report cannot reconcile to the Client Accounting Ledger, for that report 
does not display time or fees until they are billed.

Unbilled time on the Partner Alert report cannot reconcile to the Time Listing, for that report does not 
summarize time by matter nor differentiate between billed and unbilled time.

Unbilled time on the Partner Alert report cannot reconcile to the Time Summary, for that report 
summarizes time by task code and does not differentiate between unbilled and billed time.

Unbilled disbursements on the Partner Alert report cannot reconcile to the Client Costs Journal, for that 
report does not differentiate between unbilled and billed disbursements.

Billed disbursements displayed on the Partner Alert report are not reconcilable to any other report since a 
separate total is not provided. The total for the disbursement column represents unbilled disbursements 
only.

Trust Balances on the Partner Alert report cannot reconcile to the Trust Bank Journal, for that report does 
not display trust balances by matter.

Partner Alert Reconciles to Additional comments

Accounts 
Receivable

Client Summary A/R Bal For matter

Client Ledger Balances > A/R For matter

Client Accounting 
Ledger

A/R > Totals Up to 
Ending Date

For matter

Billing (Fees) 
Journal

Outstanding > Total Include Write-Ups and Write-Downs

Invoice Journal Total > Firm Total For matter

Receivables by 
Client

Total > Matter Total Set both End Date and Receipts Up To Date 
to 12/31/2199

Unbilled Time Client Summary Unbd Fees For matter

Client Ledger Unbilled > Fees For matter

Work-in-Progress Unbilled Fees > 
Total

For matter

Client Fees Listing Amount > Unbilled For matter

Unbilled 
Disbursements

Client Ledger Unbilled > Che + 
Recov

For matter

Client Summary Unbd Disb For matter

Client Accounting 
Ledger

Disb > Total Up To 
Ending Date

For matter

Work-in-Progress Total > Disb For matter

Trust Balance Client Summary Trust > Balance For matter

Client Ledger Balances > Trust For matter

Client Accounting 
Ledger

Trust > Totals Up to 
Ending Date

For matter

Client Trust Listing Matter Total For matter, client, or firm



PCLaw Reports

Page 102 

List of Clients
The List of Clients report provides a list of clients and their relevant information. Included on the report are 
the client number and name, major client number, client introducing lawyer and business phone numbers. 
When creating the report, you can choose to display client address, a list of associated matters, matter cross 
references, contacts associated with the matter, memos and collection memos. 

The report can be run to include active, inactive and archived matters. Purged matters are not included on the 
report. The Firm Summary quantifies the listed active, inactive and archived matters.

What Entries Appear on the Report
Clients, matters, and matter information listed on the List of Clients report are added, changed or removed 
through one of the following features. 

Clients with no associated matters do not appear on the List of Clients report. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-70. The Common tab of the List of Clients 

Matter: To view details for a single matter, type or select the matter nickname.

Client: To view details for matters belonging to a specific client, type or select the client 
nickname.

Resp Lawyer: To view details for matters assigned to a specific responsible lawyer, type or select the 
lawyer nickname.

Sort by Name: To sort the list by client last name, select this option.

Sort by Matter: To sort the list by client number, and matter nickname within the client number, select this 
option.

Layout: In the Layout area, to produce a customized List of Clients, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

• New Matter • Matter Manager > Main/Settings/Summary/Billing/Contacts tabs
• Close Matter • Closed Matter Register • Contact Manager.

Pull-down menu: Reports > Client > List of Clients > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-71. The Other tab of the List of Clients 

Matter Open Date: If preferred, select one or more of the following:

Begin: To view matters opened on or after a given date, select the date.

End: To view matters opened on or prior to given date, select the date.

Matter Close Date: If preferred, select one or more of the following:

Begin: To view matters closed on or after a given date, select the date.

End: To view matters closed on or prior to a given date, select the date.

Other Staff: To restrict the report to matters assigned to a specific staff member, select the user name 
from the drop down list.

The Other Staff member is assigned on the Main tab of Matter Manager.

Referral Type: To restrict the report to a specific referral type, select the type from the drop down list.
The adjacent box becomes available.

Select the referral source in the adjacent box.

The Referral Type and Source are assigned on the Main tab of Matter Manager.

Summarize by: If preferred, select one or more the following:

Type of Law: To include a Summary by Type of Law section on the report, select 
this check box.

Resp Lawyer: To include a Summary by Responsible Lawyer section on the report, 
select this check box.

Referral Type: To include a Summary by Referral Type section on the report, select 
this check box.

Show Summary Only: To display only the select summary sections and the Firm Totals section, select this 
check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Client > List of Clients > Other Tab
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The Report
The List of Clients report provides a list of client names and relevant information. Additional matter and 
contact information can be included if requested. The described report uses the Default - client address 
layout. Default - client address )archv matt), default - billing address, and default - second billing address 
layouts are also provided.

Exhibit 3-72. An excerpt from the List of Clients displaying the Default - Client Address layout

Client: Displays client nickname.

Client Name: Displays client last/first name or the client firm name.

Address: Displays client address information.

Matter: Lists the nickname of all matters associated with the client.

Description: Displays the matter description.

Law Type: Displays the assigned type of law for the matter.

Maj Clnt: If the client is associated with a major client, the major client number is listed.

Int Lwyr: Displays the client introducing lawyer for the matter.

Business: Displays the business phone number. 

Fax: Displays the fax number.

Home: Displays home phone number.

Rate: Displays the default billing rate for the matter.

Resp: Displays the responsible lawyer for the matter.

Assg: Displays the assigned lawyer for the matter.

Oth Stf: Displays the staff member assigned on the Main tab of Matter Manager. 

Open Date: Displays the date when the matter was opened.

Referred By: Displays the referral source on the Main tab of Matter Manager.

The List of Clients includes the following summary sections:

Exhibit 3-73. Table of the summary sections provided by the List of Client and when they appear

Summary Title Appears when

Firm Summary Always appears.

Summary by Type of Law Optional, as selected by user.

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Referral Type Optional, as selected by user.
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Drill Down
Drilling down on matter information on the List of Clients report activates the Matter Manager > Summary 
tab window. 

You can drill down on inactive and archived matters.

Reconciling the List of Clients
Since the List of Clients is contains no accounting data, it is not a reconcilable report. 

Since the List of Clients does not include clients with no associated matters, it should not be used as a 
conflict check when creating new clients and matters. Use the File Conflict List created in the Conflict 
Search tool.
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Matter Status Report
The Matter Status report provides an overview of the last entries to the matter with respect to data entry, 
billing, documents added, calendar events, notes and memos. If requested, the Matter Status report displays 
matter balances. Matters are included on the report if they have activity in the date range of the report. Post 
dated entries are also included for these matters.

What Entries Appear on the Report
The Last Document appears on the Matter Status report according to the latest Creation date in the Add 
PCLaw Document window. The document can be added through Document Manager or any of PCLaw’s 
document integration features.

The Last Time Entry appears according to the latest date posted through the Time Sheet, Fee Sheet, or any 
other time features in PCLaw.

The Last/Next Appointment Entry and Last/Next To Do Entry appear according to the latest Due Date 
specified in the New/Change Appointment or New/Change To Do window.

The Last Note appears according to the latest date posted in the New/Change Notes window.

The Last Billing appears according to the latest A/R date used for creating an invoice. The invoice can be 
created through Create Bill, Quick Bill or Release Bill.

The Last Payment appears according to the latest payment date for a Receive Payment or the latest A/R date 
where a General Retainer or Trust-to-General Transfer was applied at billing.

Memo information is pulled from the Summary tab of Matter Manager. If the Include Matter Balances option 
is selected, the balances from the Client Summary are displayed.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-74. The Common tab of the Matter Status report 

Matter: To list details for a single matter, type or select the matter nickname. 

Client: To list details for all matters assigned to a single client, type or select the client nickname.

Resp Lawyer: To view the status for all matters belonging to a specific responsible lawyer, type or select 
the lawyer nickname.

Start Date: To include all matters that contain activity after a specific date, select the date.

End Date: To include all matters that contain activity before a specific date, select the date.

Include only Matters with No Activity After: To filter the report to include matters with no activity after a 
specified date, select this check box.

Select the date in the date box.

Pull-down menu: Reports > Client > Matte Status Report > Common Tab
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Include Matter Balances: To include WIP, A/R and trust balances for the matter, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Matter Status report displays the latest activity of the chosen matters.

Exhibit 3-75. An excerpt from the Matter Status report 

Client: Displays client nickname.

Client Name: Displays client last/first name or the client firm name.

Matter: Lists the nickname of all matters associated with the client.

Description: Displays the matter description.

Last/Next: The following categories are displayed in this column:

Last Document: Displays the document file name, the staff member who linked the 
document to the matter, and the date of the document. When a 
document is added to PCLaw, the document date reflects the 
creation date of the document. However, that date can be changed 
in the Add PCLaw document window, therefore the date is not 
necessarily the original creation date.

Last Time Entry: Displays the date of the latest time entry posted and the timekeeper 
who posted the time.

Last/Next To Do Entry: Displays the action and lawyer for the latest dated to do. If the to 
do is assigned a due date, that date appears on the report, else 0/0 is 
shown in the Date column. If the due date is prior to the default 
entry date, the title appears as Last To Do. If the due date is after the 
default entry date or there is no due date, then the title is shown as 
Next To Do.

Last/Next Appointment Entry: Displays the action, lawyer, and due date for the latest 
dated appointment. If the due date is prior to the default entry date, 
the title appears as Last Appointment. If the due date is after the 
default entry date or there is no due date, then the title is shown as 
Next Appointment.

Last Note: Displays the note, lawyer, and date for the latest dated note. 

Last Billing: Displays the amount billed, user who processed the bill, and the A/R 
date for the latest dated invoice.
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Last Payment: Displays the payment explanation, posted date, and user who processed 
the payment, for the latest payment for the matter. The payment can be 
posted through as a receive payment, or at the time of billing for general 
retainers or trust-to-general transfers. Retainers and trust transfers appear 
on the Matter Status report for the portion that is applied on an bill. 

Memo: Displays the first 44 characters of the most recently posted memo. If the 
last added memo is less than 44 characters, a portion of the next most 
recent memo is also displayed.

If Include Matter Balance is selected, the following matter balances are displayed on the Matter Status report: 
unbilled fees, unbilled disbursements, A/R balance, unapplied general retainers, and trust funds. These 
balances are not affected by the default entry date as displayed on the top of the report, as they include post 
dated entries.

The Matter Status report does not have contain any summary sections.

Drill Down
The Matter Status report allows drill down in the following areas:

Exhibit 3-76. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Matter Status Report
The Matter Status report is not intended as a reconcilable report. All balances are taken from the Client 
Summary and include post dated entries.

Drill down on Opens the following window

Matter/Client Information Matter Manager > Main tab

Last Document Change PCLaw Document

Last Time Entry Correct Time/Fee Entry

Last/Next To Do Change To Do

Last/Next Appointment Change Appointment

Last Note Notes

Last Billing Change Bill

Last Payment Correct Receive Payments (for payments only

Memo Matter Manager > Summary tab

Matter Balances Matter Manager. Summary tab

Matter Status Reconciles to Additional comments

Unbd Fees Client Summary Unbd Fees For matter only

Client Ledger Unbilled > Fees For matter only.

Client Fees Listing Amount > Unbilled For matter only.

Work-in-Progress Fees > Total For matter only

Client WIP, Billing, 
& Collection 
Summary

W.I.P. Time For matter only.
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Exhibit 3-77. Table displaying the different reports and their sections that reconcile to the Matter Status report 

The Matter Status report does not reconcile to the Time Listing, Time Summary, Daily Time Summary, 
Comparative Time Analysis, or Unbilled Time & A/R Summary by Working Lawyer for Unbd Fees for the 
Matter Status report displays matter totals only. The other reports are not matter based.

The Matter Status report does not reconcile to the General Ledger for Unbd Disbs, A/R, or Trust for the 
Matter Status report includes post-dated entries.

The Matter Status report does not reconcile to the Receivables by Lawyer report for A/R for the Matter 
Status report displays matter balances only. The Receivables by Lawyer report displays balances for the 
lawyer and firm only.

The Matter Status report does not reconcile to the Invoice Journal for A/R, for the Invoice Journal does not 
reflect payments.

Matter Status Reconciles to Additional comments

Unbd Disb Client Summary Unbd Disb For matter only. End date = 12/31/2199.

Client Accounting 
Ledger

Disb For matter only. End date = 12/31/2199.

Client Ledger Unbilled > Che + 
Recov

For matter only. End date = 12/31/2199.

Work-in-Progress Unbilled Disb > 
Total

For matter only. End date = 12/31/2199.

A/R Client Summary A/R Bal For matter only. End date = 12/31/2199.

Client Accounting 
Ledger

A/R > Totals for 
Report Period

For matter only. End date = 12/31/2199.

Client Ledger Balances > A/R Bal For matter only. End date = 12/31/2199.

Billing (Fees) 
Journal 

Outstanding For matter only. End date = 12/31/2199. 
Select Include Write-Ups and Write Downs 
& Include Paid Invoices. Run reports for all 
dates.

Receivables by 
Client

Total For matter only. End date = 12/31/2199. 
Select Show Balances as of End Date. 

Retainer Client Summary Retainers For matter only. End date = 12/31/2199.

Client Ledger General Retainer For matter only. End date = 12/31/2199.

Client Accounting 
Ledger

Retainers For matter only. End date = 12/31/2199.

Trust > Balances Client Summary Trust > Balances For matter only, all accounts. End date = 
12/31/2199.

Client Accounting 
Ledger

Trust > Totals for 
Report Period

For matter only, all accounts. End date = 
12/31/2199.

Client Ledger Balances > Trust For matter only, all accounts. End date = 
12/31/2199.

Client Trust Listing Matter Total For matter only, all accounts. End date = 
12/31/2199.

Client Trust Ledger Matter TOtals For matter only, all accounts, End date = 
12/31/2199
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Matter Change Log
The Matter Change Log provides a record of changes made to matter information, such as name, address, 
description and the status of the matter. The report can be created by matter, client or date range.

What Entries Appear on the Log
A new record is added to the Matter Change Log each time an item is changed and saved. Multiple items 
changed in the same Matter Manager session are included in a single record, providing information is not 
saved within the session by switching tabs or matter nicknames.

Changes made through the Main tab of Matter Manager are recorded on the Matter Change Log if any of the 
following areas are modified:
• description field
• client, billing, or second billing name including title and firm name
• client, billing, or second billing address
• client, billing, or second billing phone and fax numbers, e-mails, and web sites.

Changes made through Close Matter or Closed Matter Register are recorded on the Matter Change Log if, the 
matter status is changed from active to inactive, archived, or purged, or changed to active from inactive or 
archived.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report.

Exhibit 3-78. Matter Change Log selection window displaying the Common tab 

Matter: To view changes for a single matter, type or select the matter name.

Client: To view changes for all matters assigned to a single client, type or select the client 
nickname. 

Start Date: To include all matters with changes made on or after a specified date, select the date.

End Date: To include all matters with changes made on or before a specified date, select the date.

Sort By: Select one of the following options:

Date: To sort changes by the date they occurred, select this option.

Client/Matter: To sort changes first by client and secondly by matter, select this option.

Type of Change: To sort changes by the fields changed, select this option.

User: To sort changes by the users who made the change, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Pull-down menu: Reports > Client > Matter Change Log > Common Tab
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Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Matter Change Log displays the latest activity of the chosen matters.

Exhibit 3-79. The Matter Change Log report as it appears

Client, Client Name: Displays the client nickname and the client last/first or firm name.

Matter: Displays the matter nickname.

Matter Description: Displays the matter description.

Data Before Changes: Displays the original information. If a change is made to an address field, the entire 
address appears under this column. If a change is made to the matter’s status, this field 
remains blank on the report. 

Date: Displays the date the record was changed. 

User Name: Lists the nickname of the user who effected the change.

Data After Change: Records the information modified. If a change is made to an address field, the entire 
address appears under this column. If a change is made to the matter’s status, this field 
remains blank on the report.

Source of Change: Displays the name of the PCLaw feature where the change occurred, such as Matter 
Manager or Close Matter.

Action/Description: Describes the type of change made to the matter. If a change is made to an address, a 
description such as ‘Billing Address Changed’ is displayed. If a change is made to the 
matter’s status, the new status is displayed such as ‘Matter deactivated’.

The Matter Change Log does not have contain any summary sections.

Drill Down
The Matter Change Log does not support the drill down on items that appear on the report.
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Closed Files Report
The Closed Files report provides a list of matters that are currently inactive or archived. Matters and 
description, open and close date, close matter number, and file location are included on the report. Purged 
matters are not included on the report.

What Entries Appear on the Report
Matters listed on the Closed Files report are added or modified through Close Matter and Closed Matter 
Register. When a matter is re-activated, it is no longer included on the Closed Files report.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-80. The Common tab of the Closed Files report

Matter: To view details for a single matter, type or select the matter nickname.

Client: To view details for matters assigned to one client, type or select the client nickname.

Resp Lawyer: To view information for matters assigned to a specific responsible lawyer, type or select the 
lawyer nickname.

File Open Date: Select the following:

Begin: To view matters opened on or after a specific date, select the date.

End: To view matters opened on or before a specific date, select the date.

File Close Date: If preferred, complete the following:

Begin: To view matters closed on or after a specific date, select the date.

End: To view matters closed on or before a specific date, select the date.

File Destroy Date: If preferred, complete the following:

Begin: To view matters with a file destroy date scheduled on or after a specific 
date, select the date.

End: To view matters with a file destroy date scheduled on or before a 
specific date, select the date.

Inactive Matters: To list inactive matters, select this check box.

Archived Matters: To list archived matters, select check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Client > Closed Files Report > Common Tab
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The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-81. The Other tab of the Closed Files report 

File Location: If preferred, select one of the following options:

Starts With: To list matters whose file location begins with a specific letters, 
select this option.

Type the beginning characters in the adjacent box.

Contains: To list matters whose file location contains a specific string of 
characters anywhere within the name, select this option.

Type the consecutive characters in the adjacent box.

Leave the boxes blank to list all matters.

Sort By: If preferred, select one of the following:

Closed Number: To sort the list of closed matters by the close matter number, select 
this option. 

File Location: To sort the list of closed matters by file location, select this option.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Closed Files report provides a list of closed matters, including the open and closed date, the close 
matter number, and location of any printed files.

Exhibit 3-82. Excerpt from the Closed Matters report 

Client, Name: Displays the client nickname and the client last/first or firm name.

Matter: Displays the matter nickname.

Description: Displays the matter description.

Open Date: Displays the matter open date from the Matter Manager > Main tab.

Close Date: Displays the date when the matter was closed. If the matter has been closed and 
reopened multiple times, the most recent date when the matter was closed.

Destroy Date: Displays the scheduled destroy date for the matter’s physical files.

Close No.: This number is assigned when the matter is archived or made inactive. PCLaw assigns a 
number automatically, however the number can be changed when closing the matter.

File Location: Displays the details from the Matter Manager > Settings tab or added through the Close 
Matter feature, when the matter is archived or made inactive.

Resp Lwyr: Displays the matter’s responsible lawyer.

The Closed Files report does not contain any summary sections.

Pull-down menu: Reports > Client > Closed Files Report > Other Tab
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File Location Report
The File Location report provides a list of matters and the physical location of their printed files. Also 
included on the report are the file open date, close date (if applicable), and cross reference. The report 
can be run for active, inactive and archived matters. Purged matters are not included on the report.

What Entries Appear on the Report
Clients, matters, and matter information listed on the File Location report are added, changed or removed 
through one of the following features:

Clients with no associated matters do not appear on the File Location report.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 3-83. The Common tab of the File Location report 

Matter: To view details for a single matter, type or select the matter nickname.

Client: To view details for matters belonging to a single client, type or select the client 
nickname.

Resp Lawyer: To view information for matters assigned to a specific responsible lawyer, type or select 
the lawyer nickname.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 3-84. The Other tab of the File Location report 

• Close Matter • Closed Matter Register • Matter Manager > Billing tab.

Pull-down menu: Reports > Client > File Location > Common Tab

Pull-down menu: Reports > Client > File Location > Other Tab
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Matter Open Date:Complete the following:

Begin: To view matters opened on or after a specific date, select the date.

End: To view matters opened on or before a specific date, select the date.

Matter Close Date: Complete the following:

Begin: To view matters closed on or after a specific date, select the date.

End: To view matters closed on or before a specific date, select the date.

File Location: If preferred, select one of the following options:

Starts With: To list matters whose file location begins with a specific letters, 
select this option.

Type the beginning characters in the adjacent box.

Contains: To list matters whose file location contains a specific string of 
characters anywhere within the name, select this option.

Type the consecutive characters in the adjacent box.

Range: To list matters whose file location falls within a string of characters at 
the start of the text, select this option.

Type the characters that will start the range in the left hand box.

Type the characters that will end the range in the right hand box.

Leave the boxes blank to list all matters.

Sort by File Location: To sort the list alphabetically according to the physical location of the files, select 
this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The File Location report provides a list of closed matters, including the open and closed date, the close 
matter number, and location of any printed files.

Exhibit 3-85. Excerpt of the File Location report 

Client, Name: Displays the client nickname and the client last/first or firm name.

Matter: Displays the matter nickname.

Description: Displays the matter description.

Open Date: Displays the matter open date from the Matter Manager > Main tab.

Close Date: Displays the date when the matter was closed. If the matter has been closed and 
reopened multiple times, the most recent date when the matter was closed.

Cross Reference: Displays the details for the Cross Reference box from the Matter Manager > Settings 
tab.
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File Number: This number is assigned when the matter is archived or made inactive. PCLaw assigns a 
number automatically, however, the number can be changed prior to the closing of the 
matter.

File Location: Displays the details from the Matter Manager > Settings tab or added through the Close 
Matter feature, when the matter is archived or made inactive.

Resp Lwyr: Displays the matter’s responsible lawyer.

Drill Down
Drilling down on active matter information on the File Location report activates the Matter Manager. You 
cannot drill down on an archived matter.
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Accounts Receivable Report Overview

Exhibit 4-1. Table listing accounts receivable reports, their defining parameters, and what the report displays 

Report Run the Report By What it Does

ePC
Law

A
ll C

ountries

A
ll PC

Law

Receivables by 
Client 

matter/client
resp lawyer
collecting lawyer

Lists aged receivables for each matter by client.

Receivables by 
Lawyer

fee credit lawyer
resp lawyer

Lists total outstanding fees, disbursements and taxes by fee credit 
lawyer.

Payment 
Allocation Listing

matter/client
resp lawyer
fee credit lawyer*

Lists in date order by invoice number receipts applied to invoices 
showing allocation split between fees, disbursements and taxes.

Interest 
Calculation

matter/client
resp lawyer

Lists invoices, including principal and interest, by matter within 
client.
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Receivables by Client Report
The Receivables by Client report lists aged receivables by client for collection follow-up. Client 
information is provided, with invoices grouped by matter. The original invoice amount is displayed, along 
with the current aged outstanding balance, and interest due. The date and amount of the last receipt is 
included with any interest paid on that receipt. 

What Entries Appear on the Report
Invoices on the Receivables by Client report appear through one of the following features:

Invoices on the Receivables by Client report are modified or removed through one of the following 
features:

Last receipt values appears on the Receivables by Client report through the following features:

The outstanding value of an invoice can be reduced by general retainers applied at the time of billing, and 
payments made to the invoice during the life of the invoice.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 4-2. The Common tab of the Receivables by Client report 

Matter: To view invoices for a single matter, type or select the matter nickname.

Client: To view invoices for matters associated with a specific client, type or select the client 
nickname.

Resp Lawyer: To view invoices for matters assigned to a specific responsible lawyer, type or select the 
lawyer nickname.

End Date: To view invoices with an A/R date prior to a specific date, select the date.

• Matter Opening Balances • Create Bill/Quick Bill/Release Bill.

• Change/Write Off Bill • Register > Invoice/Ledger tabs • Create Bill/Quick Bill/Release Bill
• Matter Manager > Ledger tab • Undo Bill.

• Receive Payment • Create Bill/Quick Bill/Release Bill
• Trust-to-General Transfer (applied to existing A/R balance).

Pull-down menu: Reports > Accounts Receivable > Receivables by Client > Common Tab
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Matter Totals: To display only a totals line for each matter without listing individual invoices, select this 
check box. 

Client Totals Only: To display only a totals line for each client without listing individual matters or invoices, 
select this check box.

Firm Totals Only: To display only a totals line, without listing individual clients, matters, or invoices, select 
this check box. 

Show Balances As of End Date: To have receipts correspond to the end date of the report period, select this 
check box.

If this option is deselected, the Receipts Up To box becomes available. 

Receipts Up To: To include receipts received after the specified End Date of the report, 
type or select the cut off date.

Invoices paid in full are not included on the Receivable by Client report 
unless one or more of the receipts are outside the date range of the 
report, as displayed in the Receipts Up To box. Partially paid invoices 
are included on the report.

Layout: To produce a customized Receivables by Client report, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 4-3. The Other Tab of the Receivables by Client report 

Age From: Select a base date from which to calculate the aging categories.

Aging Categories: To change the intervals, in the 1, 2, and 3 boxes, type the value in days.

Collecting Lawyer: To view only invoices for matters assigned to a specific collecting lawyer, type or select 
the lawyer.

Pull-down menu: Reports > Accounts Receivable > Receivables by Client > Other Tab
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Ignore Matter If: If preferred, complete one or more of the following:

A/R Balance Less Than: To exclude matters with an A/R balance less than a specified 
amount, type the amount.

Outstanding Days Less Than: To exclude matters whose oldest outstanding invoice is 
less than a specified number of days, type the number of days.

Provision for Write-Offs: For Accrual accounting systems only, select one of the following:

Exclude Provision for Write-offs: To exclude provisional write-offs in the billing 
amounts totals, select this option. 

Invoices that are provisionally written are included in the billed 
values by their original amounts.

Include Provision for Write-offs: To include provisional write-offs, select this option.

Invoices that are provisionally written off are included in the billed 
values by their original amounts. A second section displays total 
provisional write-offs for each lawyer. A net total of billings minus 
provisional write-offs are also provided for each lawyer.

Provision for Write-offs Only: To include only invoices that were provisionally written 
off, select this option.

Only invoices that are provisionally written off are included in the 
billed values. 

Summarize By: If preferred, select one or more of the following:

Collecting Lawyer: To include a Summary by Collecting Lawyer section, select this 
check box.

Responsible Lawyer: To include a Summary by Responsible Lawyer section, select this 
check box.

Client Introducing Lawyer: To include a Summary by Client Intro Lawyer section, select 
select this check box.

Matter Introducing Lawyer: For PCLawPro and PCLawPro Enterprise: To include a 
Summary by Matter Introducing Lawyer section, select this check 
box.

Department: To include a Summary by Department section, select this check box.

Department by Lawyer: To include a Summary by Lawyer by Department section, 
select this check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.
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The Report
The Receivables by Client report lists invoices by the A/R date. Separate aging columns provide for easy 
prioritization of overdue invoices. Only the most recent payment is shown. The described report 
configuration uses the Default layout. The Receivable by Client report also includes the Default with (coll 
memos) layout.

Exhibit 4-4. Excerpt from the Receivables by Client report 

Client No. & Name: Displays the client nickname and client last and first name, or client firm name.

Intro: Lists the introducing lawyer for the client.

Bus #: Lists the business phone number for the client as stored in Matter Manager.

Home #: Lists the home phone number for the client as stored in Matter Manager.

Matter No.: Displays the matter nickname and the first 26 characters of the matter description.

Last Receipt: This section consists of the Date and Amount columns.

Date: Displays the date that the last receipt was posted.

Amount: DIsplays the payment amount applied to the principal of the invoice. 
The last receipt is determined by chronological date, and not entry 
number.

Inv: Lists the invoice number.

AR Date: Lists the date the invoice is posted to the general ledger. 

Col Lwyr: Displays the assigned collecting lawyer for each invoice.

Billed: Displays the original amount of the invoice prior to any payments received. Write downs 
to the invoice are included in the billed value. 

Outstanding: The age categories are assigned the values in the 1, 2, and 3 boxes in the Aging Categories 
area of the Other tab. PCLaw defaults to 30, 60, and 90 days. 

Total: Displays the amount outstanding for invoices after payments and write-offs are deducted. 
A matter total is provided for each age category and the Total column.

Write-offs posted after the report End Date are not included in the invoice totals for both 
the Billed and Total columns. Payments posted after the Receipts Up To date are not 
included in the invoice totals for the Total column, but the receipt is shown in the Last 
Receipt section.

Trust Bal: Displays the total trust on the matter information line.

The Receivables by Client report includes the following summary sections:

Exhibit 4-5. Table of the summary sections provided by the Receivables by Client report and when they appear

Summary Title Appears when

Summary by Collecting Lawyer Optional, as selected by user. 

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Client Intro Lawyer Optional, as selected by user.

Summary by Matter Introducing Lawyer Optional, as selected by user. 

Summary by Department Optional, as selected by user. 

Summary by Lawyer by Department Optional, as selected by user. 
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Drill Down
The Receivables by Client report allows drill down in the following areas:

Exhibit 4-6. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Receivables by Client report
The chart below lists PCLaw reports that reconcile to the Receivables by Client report, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters. A report with 
a start date other than 1/1/82 may exclude entries crucial to the reconciliation of the report.

Exhibit 4-7. Table displaying different reports and their sections that reconcile to the Receivables by Client report 

The Receivables by Client report may not reconcile to the Billing by Lawyer report for the Receivables by 
Client report does not include purged matters. 

The Receivables by Client report may not reconcile to the Billing by Lawyer report for a specified end date 
if there are write-offs or payments made after the end date. The Billing by Lawyer report reports all 
transactions that apply to invoices within the report period. The Receivables by Client report includes 
transactions that apply to invoices if both the invoice and the transaction fall within the report period.

Drill down on Opens the following window

Client information Open Matter > Main tab

Matter information Open Matter > Main tab

Invoice information Change Bill

Trust column Open Matter > Main tab 

Receivables by 
Client

Reconciles to Additional comments

Totals Client Ledger Balances > A/R > 
End Date

For matter, client, or firm. Use 1/1/82 as a 
start date.

Client Summary A/R Bal For matter client, or firm. Use 1/1/82 as a 
start date.

Client Accounting 
Ledger

A/R > Totals Up to 
Ending Date

For matter, client, or firm. Use 1/1/82 as a 
start date.

Billing (Fees) 
Journal

A/R Bal Use the default Start Date. Use the same 
end dates. Select Show Balances as of End 
Date and Include Write Ups/Write Downs. 
Deselect Include Paid Invoices. 

Receivables by 
Lawyer

Firm Totals > Total Receivable by Lawyer

Matter Status A/R For matter only

Accounts 
Receivable (1200)

Closing Balance For Accrual Account methods only

Trust Bal Client Ledger Balances > Trust > 
End Date

For matter, client, or firm

Client Summary Trust > Balance > 
Total

For matter client, or firm

Client Accounting 
Ledger

Trust > Totals Up to 
Ending Date

For matter, client, or firm

Client Trust Listing Matter Total For matter, client, or firm
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Receivables by Lawyer Report
The Receivables by Lawyer report summarizes lawyers’ billings into billed, paid, aging, and total outstanding 
categories. Billed amounts are sub-divided into fees, disbursements and taxes. The lawyers’ accounts 
receivable totals are also shown as a percentage of the total firm a/r.

What Entries Appear on the Report
Billed values appear on the Receivables by Lawyer report through the following features:

Changes to invoices through the following features are reflected on the Receivables by Lawyer report:

Payments applied to invoices appear on the Receivables by Lawyer report through the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 4-8. The Common tab of the Receivables by Lawyer report 

Start Date: To display only billed values with an A/R date on or after a specific date, select the date.

End Date: To display only billed values with an A/R date on or prior to a specific date, select the date.

Age From: A/R balances are grouped and displayed in 30 day intervals. To change the base date that 
these intervals are calculated, select the date.

Fee Credit Lawyer: To summarize billed information by fee credit lawyer, select this option.

Collecting Lawyer: To summarize billed information by responsible lawyer, select this option.

• Matter Opening Balances • Create Bill/Quick Bill/Release Bill.

• Undo Bill • Change/Write Off Bill
• Register > Invoice/Ledger tabs • Matter Manager > Ledger tab.

• Receive Payment • Create Bill/Quick Bill/Release Bill
• Trust-to-General Transfer (applied to existing A/R balance).

Pull-down menu: Reports > Accounts Receivable > Receivables by Lawyer > Common Tab
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Provision for Write-Offs: For Accrual accounting systems only, select one of the following:

Exclude Provision for Write-offs: To exclude provisional write-offs in the billing 
amounts totals, select this option. 

Invoices that are provisionally written are included in the billed 
values by their original amounts.

Include Provision for Write-offs: To include provisional write-offs, select this option.

Invoices that are provisionally written off are included in the billed 
values by their original amounts. A second section displays total 
provisional write-offs for each lawyer. A net total of billings minus 
provisional write-offs are also provided for each lawyer.

Provision for Write-offs Only: To include only invoices that were provisionally written 
off, select this option.

Only invoices that are provisionally written off are included in the 
billed values. 

Show Balances as of End Date: To include payments only up to the end date of the report, select this 
check box.

When Show Balance as of End Date is deselected, all payments applied to the invoice 
are included in the invoice balance under the Age and Total columns, regardless of 
when they were entered. 

Write ups/downs posted after the end date of the report are not included on the report 
whether or not Show Balances as of End Date is selected.

New Page for Each Lawyer: To have information for each lawyer appear on a separate page, select this 
check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Receivables by Lawyer report summarizes accounts receivables by lawyer. Separate aging columns 
provide for easy prioritization of overdue accounts.

Exhibit 4-9. Excerpt from the Receivables by Lawyer report 

Fee Credit Lawyer: Displays the lawyer nickname and name. This column appears only when Fee Credit 
Lawyer is selected on the Common tab.

Collecting Lawyer: Displays the lawyer nickname and name. This column appears only when Collecting 
Lawyer is selected on the Common tab.

Billed: Summarizes the billed value for fees, disbursements, taxes, and the overall total. Write-
offs occurring prior to the end date of the report are included in the balance. Payments 
applied to the invoice are not included.
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Paid: Summarizes the payment amount applied to fees, disbursements, taxes, and the overall 
total. If Show Balance as of End Date is not selected, all payments applied to the invoice 
amounts assigned to the respective lawyer are displayed.

Outstanding: Ages the A/R balance in 30 day intervals.   Unlike the Receivables by Client report, the 
interval length cannot be changed when creating the report.

Total: Displays the A/R balance net of payments and write-offs.

% Firm: Compares the lawyer totals to the firm totals.

Write-offs posted after the End Date of the report are not included in the lawyer totals for 
both the Billed and Total columns. Payments posted after the Receipts Up To date are not 
included in the lawyer totals for the Total column, however the receipt is shown under the 
Last Receipt section.

The Receivables by Lawyer report includes the following summary section:

Exhibit 4-10. Table of the summary sections provided by the Receivables by Lawyer report and when they appear. 

Drill Down
The Receivables by Lawyer report allows drill down in the following areas:

Exhibit 4-11. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Receivables by Lawyer report
The chart below lists PCLaw reports that reconcile to the Receivables by Lawyer report, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 4-12. Table displaying different reports and their sections that reconcile to the Receivables by Lawyer report 

Summary Title Appears when

Firm Totals Always appears.

Drill down on Opens the following window

Lawyer information Billing (Fees) Journal for that Fee Credit or Responsible Lawyer

Firm Totals Drill down option is not available

Receivables by 
Lawyer

Reconciles to Additional comments

Billed > Fees       
Billed > Disb 
Billed > Taxes

Billing (Fees) 
Journal

Billed > Fees       
Billed > Disb       
Billed > Taxes

Include Write Up/Down - Run for one 
responsible or fee credit lawyer. Refer to 
Summary by Lawyer section

Billed > Total Invoice Journal Total > Total Refer either to Summary by Fee Credit or 
Responsible Lawyer section.

Paid > Fees 
Paid > Disb
Paid > Tax
Paid > Total

Payment Allocation 
Listing

Fees > (lawyer)    
Disb > (lawyer)      
Tax > (lawyer)      
Total > (lawyer)

Refer either to Summary by Fee Credit or 
Responsible Lawyer section.

Total > Fees
Total > Disb
Total > Tax

Billing (Fees) 
Journal

Total > Fees         
Total > Disb          
Total > Tax

Include Write Up/Down - Run for one 
responsible or fee credit lawyer. Refer to 
Summary by Lawyer section.

Total > Total Billing (Fees) 
Journal

Total > Total Include Write Up/Down - Run for single 
responsible or fee credit lawyer. Refer to 
Summary by Lawyer section.

Receivables by 
Client 

Total > Firm Total Run for single Responsible Lawyer.
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If the Receivables by Lawyer report is created by fee credit lawyer, it cannot reconcile to the Receivables 
by Client report as that lawyer type is not available for the latter report.

The Receivables by Lawyer report does not reconcile to the Invoice Journal as the latter report does not 
record payments. 

The Receivables by Lawyer report may not reconcile to the Billing by Lawyer report for the Receivables by 
Lawyer report does not include purged matters. 

The Receivables by Lawyer report may not reconcile to the Billing by Lawyer report for a specified end 
date if there are write-offs or payments made after the end date. The Billing by Lawyer report reports all 
transactions that apply to invoices within the report period. The Receivables by Lawyer report includes 
transactions that apply to invoices if both the invoice and the transaction fall within the report period.
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Payment Allocation Listing
The Payment Allocation Listing displays in payments applied to client invoices in date order. The payments 
show the allocation split between individual lawyer fees, disbursements and taxes. The report can be created 
for fee credit, responsible, client introducing lawyers, and for type of law.

What Entries Appear on the Listing
A payment appears on the Payment Allocation Listing through the following features:

A general retainer is not included on the Payment Allocation Listing until it is reallocated during the billing 
process. A Trust-to-General transfer can appear on the Payment Allocation Listing if it is applied to an existing 
A/R balance, or transferred at the time of billing.

The Payment Allocation Listing allocates payments to invoices according to the settings selected under the 
Payment Rules section of the Option > System Settings > Data Entry tab. Payments are allocated even if Auto 
Allocate Payments to G/L Accounts is deselected.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.   

Exhibit 4-13. The Common tab of the Payment Allocation Listing 

Matter: To view only payments applied to invoices for a specific matter, type or select the matter 
nickname.

Client: To view only payments applied to invoices for a specific client, type or select the client 
nickname.

Resp Lawyer: To view only payments applied to invoices for matters assigned to a specific responsible 
lawyer, type or select the lawyer.

When the report is run by responsible lawyer, all payments to invoices for matters assigned 
to a responsible lawyer are included on the report. Fees are allocated to the fee credit 
lawyers for PCLaw and PCLaw Plus. PCLawPro and PCLawPro Enterprise can also show 
allocations by matter introducing lawyer.

Start Date: To view only payments applied on or after a specific date, select the date.

End Date: To view only payments applied on or prior to a specified date, select the date.

• Receive Payment • Matter Opening Balances • Create Bill/Quick Bill//Release Bill.

Pull-down menu: Reports > Accounts Receivable > Payment Allocation Listing > Common Tab
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Totals Only: To display only a firm totals line, as well as any summary sections selected under the 
Other tab, select this check box.

Layout: To produce a customized Payment Allocation Listing, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used as the options under the 
Common tab. 

Exhibit 4-14. The Other tab of the Payment Allocation Listing 

Summarize By: If preferred, select one or more of the following options:

Fee Credit Lawyer: To include a Summary by Fee Credit Lawyer section, select this 
check box.

Responsible Lawyer: To include a Summary by Responsible Lawyer section, select this 
check box. 

Client Intro Lawyer: To include a Summary by Client Introducing Lawyer section, select 
this check box.

Type of Law: To include a Summary by Type of Law section, select this check box.

Resp Lawyer within Type of Law: To include a Summary by Responsible Lawyer by 
Type of Law section, select this check box.

Matter Intro Lawyer: For PCLawPro and PCLawPro Enterprise: To include a Summary by 
Matter Introducing Lawyer section, select this check box.

Referral Type: To include a Summary by Referral Type section on the report, select 
this check box.

Department: To include a Summary by Department section on the report, select 
this check box.

Lawyer by Department: To include a Summary by Lawyer by Department section on the 
report, select this check box.

Pull-down menu: Reports > Accounts Receivable > Payment Allocation Listing > Common Tab
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Fee Credit Lawyer: To display only payments to invoices where a specified lawyer is one of the fee credit 
lawyer, type or select the lawyer nickname.

Exclude General Retainers: To exclude payments that are applied general retainers, select this check box.

Payments made through the Receive Payment feature, or that are trust-to-general Transfers 
at the time of billing are displayed on the report. 

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Payment Allocation Listing displays payments applied to invoices in date order. Client information and 
details on how the payment was applied is provided. The described report configuration uses the Default 
layout.

Exhibit 4-15. Excerpt from the Payment Allocation Listing 

Date: Displays the date the payment was posted to PCLaw.

Entry #: Displays the sequence that the payments were entered.

Client #: Displays the client nickname.

Name: Displays the client name.

Matter #: Displays the matter nickname.

Description: Displays the matter description.

Cl Int: Lists the introducing lawyer for the client.

Mat Int: For PCLawPro and PCLawPro Enterprise: Lists the introducing lawyer for the matter.

Resp: Lists the responsible lawyer for the matter.

Law Type: Lists the matter’s default type of law.

Payment #: Lists the receipt number in the Receive Payment, General Retainer, or Trust-to-General 
Transfer windows. Receipts entered as part of Matter Opening Balances are not displayed 
with a receipt number.

For PCLawPro and PCLawPro Enterprise: If payment is received by client, or by general 
retainer as part of a split billing, the application of the payment to each matter is shown as 
a separate entry. 

Inv #: Displays the invoice to which the payment was applied.

Fee Lwyr: Lists the fee credit lawyer that was allocated the portion of fees displayed under the 
Allocation column.

Allocation: Displays the portion of fees for each fee credit lawyer to which payment was applied.

Fee Tot: Displays the portion of the payment applied to fees for all lawyers. Value is shown for the 
matter’s responsible lawyer.

Disb: Displays the portion of the payment applied to disbursements. Value is shown for the 
matter’s responsible lawyer.

Tax: Displays the portion of the payment applied to taxes. Value is shown for the matter’s 
responsible lawyer. 

Total: Displays the overall payment amount.
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The Payment Allocation Listing includes the following summary sections:

Exhibit 4-16. Table of the summary sections provided by the Payment Allocation Listing and when they appear 

Drill Down
The Payment Allocation Listing allows drill down in the following areas:

Exhibit 4-17. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Fee Credit Lawyer optional, as selected by user.

Summary by Responsible Lawyer optional, as selected by user.

Summary by Client Introducing Lawyer optional, as selected by user.

Summary by Matter Introducing Lawyer optional, as selected by user. For PCLawPro and PCLawPro 
Enterprise only.

Summary by Type of Law optional, as selected by user.

Summary by Responsible Lawyer by Type 
of Law

optional, as selected by user.

Summary by Referral Source optional, as selected by user. 

Summary by Department optional, as selected by user.

Summary by Lawyer by Department optional, as selected by user. 

Drill down on Opens the following window

Receive Payment Correct - General Receive Payment 

General Retainer Correct - General Retainer

Trust-to-General Transfer Correct - Trust-to-General Transfer

Responsible Lawyer Payment Allocation Listing by the Responsible Lawyer

Client Introducing Lawyer Payment Allocation Listing by the Client Intro Lawyer

Matter Introducing Lawyer Payment Allocation Listing by the Matter Intro Lawyer

Type of Law Payment Allocation Listing by the Type of Law
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Interest Calculation Report
The Interest Calculation report lists invoices including principal and interest by matter within the client. aged 
receivables by client for collection follow-up. Client information is provided, with invoices grouped by 
matter. The original invoice amount is displayed, along with the current aged outstanding balance, and 
interest due. The date and amount of the last receipt is included with any interest paid on that receipt. 

What Entries Appear on the Report
Invoices on the Interest Calculation report appear through the following features:

Invoices are modified or removed through the following features:

Last receipt information appears through the following features:

The outstanding value of an invoice can be reduced by general retainers applied at the time of billing, and 
payments made to the invoice during the life of the invoice.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 4-18. The Common tab of the Interest Calculation report 

Matter: To view items for a single matter, type or select the matter nickname.

Client: To view items for matters associated with a specific client, type or select the client 
nickname.

Resp Lawyer: To view items for matters assigned to a specific responsible lawyer, type or select the 
lawyer nickname.

Invoice: To view a specific invoice, type or select the invoice number.

Start Date: To view items occurring after a specific date, select a date.

End Date: To view items occurring prior to a specific date, select the date.

Interest Up To: To restrict interest calculation to a cut off date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Matter Opening Balances Quick Bill/Create Bill/Release Bill.

Change/Write Off Bill Register > Invoice/Ledger tabs

Matter Manager > Ledger tab Undo Bill.

Receive Payment Quick Bill/Create Bill/Release Bill

Trust-to-General Transfer (applied to existing A/R balance).

Pull-down menu: Reports > Accounts Receivable > Interest Calculation > Common Tab
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The Report
The Interest Calculation report lists invoices by the client, matter, and A/R date. Separate activity is 
displayed for invoicing, interest, payments, and write ups/downs (adjustments). Interest, payments, and 
write-downs only appear for invoices whose A/R dates are included in the date range of the report. 

Exhibit 4-19. An excerpt from the Interest Calculation report 

Client Information: Includes client nickname, client last and first name or firm name, business, fax, and 
home phone numbers. 

Clnt Lawyer: Lists the introducing lawyer for the client.

Matter: Lists the matter nickname.

Description: Displays the first 26 characters of the matter description.

Entry #: Lists the entry numbers for all posted transactions, such as invoicing, payments, and 
write ups/downs. Interest calculations do not display entry numbers.

Date: Lists the date of the listed transaction. 

Inv#: Lists the invoice number for all invoicing transactions. Payments, write ups/downs, and 
interest do not display invoice numbers.

Type: Shows whether the transaction is an invoice, payment, write up/down, or interest.

Int. Rate: Displays the rate of interest for the invoice. If the rate changes during the life of the 
invoice, either for the invoice, for the matter, or for the firm, Var appears in the column.

Activity: This section consists of principal and interest:

Principal: Is displayed net of interest. Write-downs appear in this column as 
negative values.

Interest: Calculated value is displayed according to the parameters specified 
when producing the report.

Balance Owing: Section displays a running balance of principal, interest, and invoice total.

Principal: Is displayed net of interest and less any payments applied to the 
invoice.

Interest: Calculated value is displayed according to the parameters specified 
when producing the report and net of payments to the invoice 
applied specifically to interest.

Total: Displays the sum of the principal and interest columns.

Matter Total: Displays the total outstanding for the matter. Since all columns in the Activity and 
Balance Owing sections are running balances, the matter totals are not the sum of all 
the values in the columns.

The Interest Calculation report does not include any summary sections.
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Drill Down
The Interest Calculation report allows drill down in the following areas:

Exhibit 4-20. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Interest Calculation report
The chart on the following page lists PCLaw reports that reconcile to the Interest Calculation report, and the 
item on the report that can be reconciled. The reports must be run with identical dates and parameters. A 
report with a start date other than 1/1/82 may exclude entries crucial to the reconciliation of the report.

Exhibit 4-21.  Table displaying the different reports and their sections that reconcile to the Interest Calculation report 

The Interest Calculation report may not reconcile to the Client Ledger, Client Summary, or Client Accounting 
Ledger, for interest if a grace period is used for the firm, for the client reports do not include a grace period in 
its interest calculations.

The Interest Calculation report does not reconcile to Billing by Lawyer report, for the Interest Calculation 
report does not display include purged matters. 

The Interest Calculation report may not reconcile to the Billing by Lawyer report for a specified end date if 
there are write-offs or payments made after the end date. The Billing by Lawyer report reports all transactions 
that apply to invoices within the report period. The Interest Calculation report includes transactions that 
apply to invoices if both the invoice and the transaction fall within the report period.

Drill down on Opens the following window

Client/Matter information Matter Manager > Main tab

Invoice, Payment, Write up/down, and 
Interest information

Change Bill

Interest Calculation Reconciles to Additional comments

Matter Total > 
Balance Owing > 
Principal 

Client Ledger Balances > A/R > 
End Date

For matter, client, and firm. Use 1/1/82 as a 
start date.

Client Summary A/R Bal For matter, client, and firm. Use 1/1/82 as a 
start date.

Client Accounting 
Ledger

A/R > Totals Up to 
Ending Date

For matter, client, and firm. Use 1/1/82 as a 
start date.

Billing (Fees) 
Journal

A/R Bal Use the default Start Date. Use the same 
end date. Select Show Balances as of End 
Date. Select Include Write Ups and Write 
Downs. Select Include Paid Invoices. 

Receivables by 
Client

Matter Totals > Total For matter only.
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Accounts Payable Report Overview

Exhibit 5-1. Table listing accounts payable reports, their defining parameters, and what the report displays 

Report Run the Report by... What it Does

O
utside The U

nited States

U
nited States

PC
Law

 and PC
Law

 Plus

PC
Law

Pro and PC
Law

Pro Enterprise

 Purchases Journal vendor
g/l account
invoice date
due date

. Lists invoices entered in accounts payable.

Payable Listing vendor
invoice
invoice date
due date

Lists invoices payable by due date.

Payment Listing vendor
g/l account
invoice date
payment date

Lists payments made for payables.

Allocation Listing vendor
invoice date
matter

Lists entries from accounts payable that are allocated to 
matters

Discount Listing vendor
invoice date
due date

Lists payables where discounts can be taken.

Vendor Ledger vendor Lists accounts payable invoices, payments and discounts 
by vendor.

Vendor Listing active/inactive vendors Lists all vendors.

1099 Listing vendor 
threshold amount
payment date

Lists vendors and amounts paid to vendors for the time 
period specified.

1099 Forms vendor 
threshold amount
payment date

Prints 1099 forms for vendors classified as 1099 vendors 
who have reached the threshold amount for the year.
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Purchases Journal 
The Purchases Journal lists invoices created through the Accounts Payable feature. The report provides 
vendor information, groups invoices by vendor, and lists matters to which costs are allocated. G/L account 
allocations are shown, although only Accrual systems post to the g/l when a payable is created. Separate 
values are given for allocation, invoice, and vendor totals.

What Entries Appear on the Journal
Invoices appear on the Purchases Journal through the New Payable feature and can be modified through 
the Open Payable feature, or under the A/P tab of the Register.

Changes to entries on the Purchases Journal can be performed through the Register, Matter Manager, 
report drill down, or correct features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-2. The Purchases Journal selection window displaying the Common tab 

Vendor: To view invoices for a single vendor, type or select the vendor nickname.

G/L Account: To view invoices allocated to a specific G/L account, type or select the account.

Invoice Date: To restrict your search, complete one or both of the following:

Start Date: To view invoices created on or after a specific date, select the date.   

End Date: To view invoices created on or before a specific date, select the date.

Due Date: To restrict your search, complete one or both of the following:

Start Date: To view invoices due on or after a specific date, select the date.    

End Date: To view invoices due on or before a specific date, select the date. 

Include Vendors: Select one of the following: 

Active: To view invoices belonging to active vendors only, select this option.

Inactive: To view invoices belonging to inactive vendors only, select this 
option.

Both: To view invoices belonging to both active and inactive vendors, 
select this option. 

Detailed Report: To view a detailed journal, select this check box.

To view only the AP Allocations Summary, deselect this check box.

Summary by Resp. Lawyer: To include the Summary by Responsible Lawyer section on the journal, select 
this check box. 

Pull-down menu: Reports > Accounts Payable > Purchases Journal > Common Tab
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Show User Name:To display the user who added the payable invoice, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Purchases Journal lists A/P invoices by vendor, including matter and G/L allocation information and their 
associated amounts.

Exhibit 5-3. Excerpt from the Purchases Journal 

Vendor: Invoices for each vendor is grouped into its own section. Vendor nickname, name, notes, 
and vendor account number is provided at the top of the section.

Entered: Invoice information appears on the first line of the invoice. The invoice date is listed under 
this column. 

Due: Lists the due date for the payable invoice.

Reference: Lists the assigned invoice number. 

Explanation: Displays the explanation from the top portion of the New Payable window.

Entry #: Lists the entry number of each invoice.

Matter #: If the payable is allocated to a matter, the matter nickname is displayed.

Matter Name: If the payable is allocated to a matter, the client’s last name is displayed. 

G/L Acct: Lists the general ledger accounts where payable expenses are allocated.

Accrual accounting systems post to these accounts when the payable is created. Modified 
Cash and Cash methods post to these accounts only when the payable is paid.

GST: For firms collecting GST: Lists the GST category for both the invoice and any matters where 
costs are allocated.

Inv Total: The Amount column displays each separate allocation, whether it is strictly to a G/L 
account or to a matter. 

Ven Total: Sums the total of all invoices for any one vendor. Since the Purchases Journal does not 
display payments, the Ven Total value is not the outstanding amount for the Vendor.

The Summary by Responsible Lawyer section separates matter allocations by responsible lawyer into billed 
and non-billed amounts.

The Purchases Journal includes the following summary sections:

Exhibit 5-4. Table of the summary sections provided by the Purchases Journal and when they appear 

Summary Title Appears when

A/P Allocations Summary Always appears.

Summary by Responsible Lawyer Optional, as selected by user.
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Drill Down
The Purchases Journal allows drill down for the following areas:

Exhibit 5-5. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Purchases Journal
The chart below lists PCLaw reports that reconcile to the Purchases Journal, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 5-6. Table displaying the different reports and their sections that reconcile to the Purchases Journal 

The Purchases Journal does not reconcile to the Allocation Listing for allocations by matter for individual 
matter totals are not available on either report.

The Purchases Journal does not reconcile to the Allocation Listing for allocations by vendor for the 
Purchases Journal does not give allocation totals for the vendor.

The Purchases Journal does not reconcile to the Discount Listing for the Discount Listing only lists 
invoices eligible for a discount.

The Purchases Journal does not reconcile to the Payment Listing for Amount, for the Payment Listing 
includes realized discounts in the amount value.

The Purchases Journal does not reconcile to the Vendor Listing for the original invoice amount, for the 
Vendor Listing includes discounts.

Drill down on Opens the following window

Vendor Information Change Vendor

Invoice information Register - Select Payable 

Purchases Journal Reconciles to Additional comments

Ven Total Payable Listing Amount > Total For vendor. For Include Invoices, select 
Both. 

A/P Allocations 
Summary > Debit

Payable Listing A/P Allocations 
Listing > Debit 

For G/L Account and total debits.

Summary by 
Responsible Lawyer 
> Billed

Allocation Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. 

Payable Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both. 

Summary by 
Responsible Lawyer 
> Unbilled

Allocation Listing Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm.

Payable Listing Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm. For 
Include Invoices, select Both. 

Summary by 
Responsible Lawyer 
> Total

Allocation Listing Summary by 
Responsible Lawyer 
> Total

For responsible lawyer and firm.

Payable Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both. 
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Payable Listing 
The Payable Listing displays outstanding payables by due date. The original amount of the invoice is provided 
along with any payments and discounts. Invoices can be aged by due date, invoice date, or by time overdue. 
Paid invoices can be included on the report.

What Entries Appear on the Listing
Invoices appear on the Payable Listing through the New Payable feature. Existing invoices can be modified 
through the Open Payable feature, or under the A/P tab of the Register.

Payments to A/P invoices can occur through the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-7. The Common tab of the Payable Listing 
Vendor: To view invoices for a specific vendor, type or select the vendor nickname.

Invoice: To view a specific invoice, type or select the invoice number.

Invoice Date: To restrict the search, complete one or both of the following:

Start Date: To view invoices created on or after a specific date, select the date.

End Date: To view invoices created on or before a specific date, select the date. 

Due Date: To restrict the search, complete one or both of the following:

Start Date: To view invoices due on or after a specific date, select the date.   

End Date: To view invoices due on or before a specific date, select the date. 

• New/Open Payable • Process Payable
• General Check • Overdue Recurring Transactions.

Pull-down menu: Reports > Accounts Payable > Payable Listing > Common Tab
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Age By: Select one of the following: 

Until Due: To age invoices by the number of days prior to the due date, select 
this option.

Overdue: To age invoices by the number of days beyond the due date, select 
this option.

Since Inv: To age invoices by the invoice date, select this option.

Include Invoices: Select one of the following: 

Paid: To view only paid invoices, select this option.

Unpaid: To view only unpaid invoices, select this option.

Both: To view both paid and unpaid invoices, select this option.

Include Vendors: Select one of the following: 

Active: To view invoices belonging to active vendors only, select this option.

Inactive: To view invoices belonging to inactive vendors only, select this 
option.

Both: To view invoices belonging to both active and inactive vendors, 
select this option. 

Aging Categories: To set the time interval for the three aging categories, type the number of days in the 1:, 
2:, and 3: boxes.

Payments Up To: To restrict payments after a certain date, select the date.

Detailed Report: To view a detailed journal, select this check box.

To view only the Firm Totals and the A/P Allocations Summary, deselect this check box.

Summary by Resp. Lawyer: To include the Summary by Responsible Lawyer section on the journal, select 
this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Payable Listing lists A/P invoices by due date for each vendor and indicates the balance still 
outstanding.

Exhibit 5-8. Excerpt from the Payable Listing 

Vendor: Invoices for each vendor are grouped into their own section. Vendor nickname, name, 
notes, and vendor account number is provided at the top of the section.

Entered: Invoice information appears on the first line of the invoice. The invoice date is listed in 
this column.

Entry #: Displays the sequential entry number assigned to each transaction.

Due: Displays the due date for each payable. 

Explanation: Displays the explanation from the top portion of the New Payable window.
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Reference: Displays the invoice number assigned to the payable.

Amount: Displays the value of the original payable.

Paid+Disc: If there has been any payments or discounts applied to the invoice, that value is shown in 
this column. 

Outstanding: The outstanding value of the invoice appears in the respective age category column 
according to the criteria specified when creating the report. The category column heading 
displays the category interval specified when creating the report. The amount outstanding 
for each invoice appears in the Outstanding column.

The A/P Allocations Summary displays the total amount allocated to each G/L account for all invoices 
included on the report. Individual allocations for each invoice are not included on the report. To view general 
ledger allocations, refer to the Purchases Journal.

The Summary by Responsible Lawyer section separates matter allocations by responsible lawyer into billed 
and non-billed amounts.

The Payable Listing includes the following summary sections:

Exhibit 5-9. Table of the summary sections provided by the Payable Listing and when they appear 

Drill Down
The Payable Listing allows drill down in the following areas:

Exhibit 5-10. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Payable Listing
The chart below lists PCLaw reports that reconcile to the Payable Listing, and the item on the report that can 
be reconciled. The reports must be run with identical dates and parameters.

Summary Title Appears when

A/P Allocations Summary Always appears.

Summary by Responsible Lawyer Optional, as selected by user.

Drill down on Opens the following window

Vendor Information Change Vendor

Invoice information Register - Select Payable 

Payable Listing Reconciles to Additional comments

Amount > Total Purchases Journal Ven Total For vendor. For Include Invoices, select 
Both on Payable Listing. 

Outstanding Payment Listing Balance > Total For firm only.

A/P Allocations 
Summary > Debit

Purchases Journal A/P Allocations 
Listing > Debit 

For G/L Account and total debits. For 
Include Invoices, select Both on Payable 
Listing.

Summary by 
Responsible Lawyer 
> Billed

Allocation Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. 

Purchases Journal Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both on Payable 
Listing.
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Exhibit 5-11. Table displaying the different reports and their sections that reconcile to the Payable Listing 

The Payable Listing does not reconcile to the Payment Listing or Vendor Ledger for the original invoice 
amount, for the amount values on the latter two reports include any discount applicable to the invoice.

The Payable Listing does not reconcile to the Payment Listing or Vendor Ledger for payments, for the 
Payable Listing includes discounts in the paid values.

The Payable Listing does not reconcile to the Allocation Listing for Amount or Paid, for the Allocation 
Listing only includes payables where there are matter allocations.

The Payable Listing does not reconcile to the Discount Listing for the Discount Listing only lists invoices 
eligible for a discount.

The Payable Listing does not reconcile to the Cash Flow Planner if the aging categories differ than those 
specified in the above exhibit.

Payable Listing Reconciles to Additional comments

Summary by 
Responsible Lawyer 
> Unbilled

Allocation Listing Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm.

Purchases Journal Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm. For 
Include Invoices, select Both on Payable 
Listing. 

Summary by 
Responsible Lawyer 
> Total

Allocation Listing Summary by 
Responsible Lawyer 
> Total

For responsible lawyer and firm.

Purchases Journal Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both on Payable 
Listing. 

Firm Totals > Aging 
Categories

Cash Flow Planner Accounts Payable Run for all Vendors. Change Aging 
Categories to 1 = 1, 2 = 8, 3 = 30. For 
Include Invoices; select Unpaid. For Age 
By; select Until Due. For Payments Up To 
date, select date displayed in Header of 
Cash Flow Planner.
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Payment Listing 
The Payment Listing displays payments applied to outstanding payables by due date. Payments are grouped by 
vendor and sorted by Invoice date. The report provides the G/L allocation the amount of the original invoice, 
the payment amount, and whether any discount was realized.

What Entries Appear on the Listing
Invoices appear on the Payment Listing through the New Payable feature.   Existing invoices on the Payment 
Listing cannot be modified unless the payment is removed from the invoice. 

Payments to A/P invoices can occur through the following features:

Payments can be removed or modified for a payable through the General tab of the Register.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-12. The Common tab of the Payment Listing

Vendor: To view payments for a specific vendor, type or select the vendor nickname.

G/L Account: To view payments allocated to a specific G/L account, type or select the account number.

Include Vendors: Select one of the following: 

Active: To view payments applied to invoices of active vendors only, select this 
option.

Inactive: To view payments applied to invoices of inactive vendors only, select 
this option.

Both: To view payments applied to invoices for both active and inactive 
vendors, select this option. 

• New/Open Payable • Process Payable
• General Check • Overdue Recurring Transactions

Pull-down menu: Reports > Accounts Payable > Payment Listing > Common Tab
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Invoice Date: To restrict the search, complete one or both of the following:

Start Date: For invoices created on or after a specific date, select the date.   

End Date: For invoices created on or before a specific date, select the date.

Payment Date: To restrict the search, complete one or both of the following:

Start Date: For payments made on or after a specific date, select the date.    

End Date: For payments made on or before a specific date, select the date.

Acct: To view payments made from a specific bank account, type or select the account 
number.

Check: To view payments made on a specific check number, type the number.

Include Unpaid Invoices: To include invoices to which no full or partial payments have been made, select 
this check box.

Show payments to original Payable G/L Accounts: For Accrual systems only: To show payments allocated 
to the general ledger accounts used when the payable was created instead of to 
General Liabilities (2000), select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Payment Listing lists A/P invoices by due date for each vendor and indicates the balance still 
outstanding.

Exhibit 5-13. Exhibit 2: Excerpt from the Payment Listing

Vendor: Invoices for each vendor are grouped into their own section. Vendor nickname, name, 
notes, and vendor account number is provided at the top of the section.

Entered: Invoice information appears on the first line of the invoice. The invoice date is listed in 
this column.

Due: Displays the due date for each payable. 

Explanation: Displays the explanation from the top portion of the New Payable window.

Reference: Displays the invoice number assigned to the payable.

Payment Date: Displays the date of the payment.

Acct: Displays the account number from the bank where the check was drawn.

Che: Lists the check number. 

G/L Acct: Displays the general ledger accounts to which the payment is allocated. G/L postings 
are made for Accrual, Modified Cash, and Cash systems. 

For Accrual systems, 2000 appears in this column if the option, Show payments to 
original Payable G/L Account, is deselected as payments to payables are applied to 
General Liabilities (2000). If the option is deselected, the G/L allocations made when 
the payable was created are used, in the same way that they are for Modified Cash and 
Cash systems.
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Amount (-Disc): Displays the original value of the invoice less any discount realized. Potential discounts are 
not shown on the Payment Listing.

Payment: Displays payments applied to the invoice. The payment value appears including any 
realized discount amount. A realized discount also appears separately as a negative value.

Balance: Displays the current outstanding value of the invoice. 

If an invoice is paid and the discount realized, the transaction appears as two separate 
entries. The first entry displays the original amount of the invoice less any discount. The 
discount appears under the Payment column as a negative value. The Balance column 
displays the original value of the invoice prior to realizing the discount. The second entry 
displays the payment plus the discount amount under the Payment column. The balance 
column displays a value of zero.

The Payment Listing includes the following summary section:

Exhibit 5-14. Table of the summary section provided by the Payment Listing and when it appears 

Drill Down
The Payment Listing allows drill down in the following areas:

Exhibit 5-15. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Payment Listing
The chart below lists PCLaw reports that reconcile to the Payment Listing, and the item on the report that can 
be reconciled. The reports must be run with identical dates and parameters.

Exhibit 5-16. Table displaying the different reports and their sections that reconcile to the Payment Listing 

Summary Title Appears when

G/L Account Summary Always appears.

Drill down on Opens the following window

Vendor Information Change Vendor

Payment information Correct Processed Payables

Payment Listing Reconciles to Additional comments

Amount (-Disc) Vendor Ledger Invoice > End of 
Period

For firm only. Select Include Unpaid 
Invoices for Payment Listing. Deselect 
include General & Trust Checks for Vendor 
Ledger.

Payment Vendor Ledger Payment > End of 
Period

For firm only. Select Include Unpaid 
Invoices for Payment Listing. Deselect 
include General & Trust Checks for Vendor 
Ledger.

1099 Listing Transaction Amount For U.S. clients only. For vendor only. 
Deselect Include General and Trust Checks.

Balance Payable Listing Outstanding For firm Only. Select Include Unpaid 
Invoices for Payment Listing. For Include 
Invoices, select Both on Payable Listing.
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The Payment Listing does not reconcile to the Payable Listing or Purchases Journal for the original invoice 
amount, for the Payment Listing includes discounts realized on the invoice.

The Payment Listing does not reconcile to the Payable Listing for payments, for the Payable Listing includes 
discounts in the paid values.

The Payment Listing does not reconcile to the Allocation Listing for Amount or Paid, for the Allocation 
Listing only includes payables where there are matter allocations.

The Payment Listing does not reconcile to the Discount Listing for the Discount Listing only lists invoices 
eligible for a discount.

The Payment Listing does not reconcile to the 1099 Listing for the firm since the 1099 Listing only 
includes vendors whose payments surpass a specified threshold amount.

The Payment Listing does not reconcile to the 1099 Listing when include General and/or Trust Checks is 
selected for the 1099 Listing, as the Payment Listing only includes payments made directly to payables.
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Allocation Listing 
The Allocation Listing displays costs allocated to matters through the Accounts Payable feature. Invoices are 
grouped by vendor and can be sorted by matter or invoice number. The report displays the original amount of 
the invoice, payments applied to the invoice and any discount realized.   Allocations to matters and the 
matter’s GST category are shown. The Summary by Responsible Lawyer separates billed and unbilled 
allocations by lawyer.

What Entries Appear on the Listing
Invoices appear on the Allocation Listing through the New Payable feature. Payments to A/P invoices can 
occur through the following features:

Payables can be modified through the Open Payable feature and the A/P tab of the Register. Payments applied 
to an invoice can be modified through the General tab of the Register.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-17. The Common tab of the Allocation Listing 

Vendor: To view allocations for a single vendor, select the vendor nickname.

Invoice Date: To restrict the search, complete one or both of the following:

Start Date: To view allocations for invoices created on or after a specific date, 
select the date.

End Date: To view allocations for invoices created on or before a specific date, 
select the date.

Matter: To view allocations for a specific matter, type or select the matter nickname.   

Sort By: Select one of the following: 

Invoice: To sort allocations for a vendor by invoice number, select this option.

Matter: To sort allocations for a vendor by matter number, select this option.

• New/Open Payable • Process Payable
• General Check • Overdue Recurring Transactions.

Pull-down menu: Reports > Accounts Payable > Allocation Listing > Common Tab
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Include Vendors: Select one of the following: 

Active: To view allocations of active vendors only, select this option.

Inactive: To view allocations of inactive vendors only, select this option.

Both: To view allocations for both active and inactive vendors, select this 
option. 

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. .

Exhibit 5-18. The Other tab of the Allocation Listing 

Include Allocations: Select one or more of the following:

Billed: To view allocations to matters where the matter have since been 
billed, select this check box.

Unbilled: To view allocations to matters where the matter have yet to be billed, 
select this check box.

Paid: To view allocations on payables where the payable has been paid, 
select this check box.

Unpaid: To view allocations on payables where the payable has yet to be 
paid, select this check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Accounts Payable > Allocation Listing > Other Tab
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The Report
The Allocation Listing lists A/P invoices by due date for each vendor and indicates the balance still 
outstanding.

Exhibit 5-19. Excerpt from the Allocation Listing 

Vendor: Invoices for each vendor are grouped into their own section. Vendor nickname, name, 
notes, and vendor account number is provided at the top of the section.

Entered: Invoice information appears on the first line of the invoice. The invoice date is listed in this 
column.

Due: Displays the due date for each payable. 

Reference: Displays the invoice number assigned to the payable.

Explanation: Displays the explanation from the top portion of the New Payable window.

Amount: Lists the original value of the invoice. 

Paid: Lists the payments applied to the invoice.

Disc: Lists the discounts realized on payments. 

Balance: Displays the balance outstanding for the payable.

Matter: Lists the matter nicknames to which costs are allocated. 

Allocated: Lists the amount of the allocation to the matter.

GST: For firms collecting GST: Displays the GST category for the matter.

The Summary by Responsible Lawyer section separates matter allocations by responsible lawyer into 
billed and non-billed amounts.

The Allocation Listing includes the following summary section:

Exhibit 5-20. Table of the summary section provided by the Allocation Listing and when it appears 

Drill Down
The Allocation Listing allows drill down in the following areas:

Exhibit 5-21. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Responsible Lawyer Always appears.

Drill down on Opens the following window

Vendor Information Change Vendor

Invoice information Register - Select Payables
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Reconciling the Allocation Listing
The chart below lists PCLaw reports that reconcile to the Allocation Listing, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 5-22. Table displaying the different reports and their sections that reconcile to the Allocation Listing 

The Allocation Listing does not reconcile to the Purchases Journal, Payable Listing, or Payment Listing for 
the original invoice amount, for the Allocation Listing only includes payables that have matter allocations.

The Allocation Listing does not reconcile to the Payable Listing, Payment Listing, or Purchases Journal for 
payments for the Allocation Listing only includes payables that have matter allocations.

The Allocation Listing does not reconcile to the Discount Listing for discounts for the Allocation Listing 
shows discounts realized on payables that have matter allocations while the Discount Listing displays 
potential discounts not yet realized.

Allocation Listing Reconciles to Additional comments

Summary by 
Responsible Lawyer 
> Billed

Purchases Journal Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. 

Payable Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both. 

Summary by 
Responsible Lawyer 
> Unbilled

Purchases Journal Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm.

Payable Listing Summary by 
Responsible Lawyer 
> Unbilled

For responsible lawyer and firm. For 
Include Invoices, select Both. 

Summary by 
Responsible Lawyer 
> Total

Purchases Journal Summary by 
Responsible Lawyer 
> Total

For responsible lawyer and firm.

Payable Listing Summary by 
Responsible Lawyer 
> Billed

For responsible lawyer and firm. For 
Include Invoices, select Both. 
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Discount Listing
The Discount Listing displays accounts payable invoices where discounts are available. Included are the 
percentage and dollar amount of the unrealized discount. Once a discount period has elapsed, or an invoice 
is paid and the discount realized, that invoice no longer appears on the Discount Listing.

What Entries Appear on the Listing
Invoices appear on the Discount Listing through the New Payable feature.   The vendor of the payable must 
have at least one set discount period and rate.   Vendor discounts are added or changed through the New/
Open Vendor feature.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-23. The Common tab of the Discount Listing

Vendor: To view unrealized discounts for a specific vendor, type or select the vendor nickname.

Invoice Date: To restrict the search, complete one or both of the following:

Start Date: To view unrealized discounts for invoices created on or after a specific 
date, select the date.   

End Date: To view unrealized discounts for invoices created on or before a specific 
date, select the date.

Due Date: To restrict the search, complete one or both of the following:

Start Date: To view invoices due on or after a specific date, select the date.   

End Date: To view invoices due on or before a specific date, select the date.

Include Vendors: Select one of the following: 

Active: To view invoices belonging to active vendors only, select this option.

Inactive: To view invoices belonging to inactive vendors only, select this option.

Both: To view invoices belonging to both active and inactive vendors, select 
this option. 

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Accounts Payable > Discount Listing > Common Tab
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The Report
The Discount Listing lists unrealized discounts by vendor.

Exhibit 5-24. Excerpt from the Discount Listing 

Vendor: Invoices for each vendor are grouped into their own section. Vendor nickname, name, 
notes, and vendor account number is provided at the top of the section.

Entered: Invoice information appears on the first line of the invoice. The invoice date is listed in 
this column.

Due: Displays the due date for each payable. 

Reference: Displays the invoice number assigned to the payable.

Explanation: Displays the explanation from the top portion of the New Payable window.

Amount: Lists the original value of the invoice. 

Date: Indicates when the unrealized discount expires. 

Percent: Lists the discount rate.

Saving: Lists the dollar value of the discount. 

Payable: Lists the amount of the invoice less discount. 

The Discount Listing does not contain any summary sections.

Drill Down
The Discount Listing allows drill down in the following areas:

Exhibit 5-25. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Discount Listing
Since the Discount Listing only displays invoices where there is a unrealized discount, it is not a 
reconcilable report. No other report in PCLaw can be created using the same criteria.

Drill down on Opens the following window

Vendor Information Change Vendor

Invoice information Register - Select Payables
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Vendor Ledger 
The Vendor Ledger lists invoices created through the Accounts Payable feature, payments, and discounts 
realized on the invoices. Use the Vendor Ledger to show A/P activity for a specific vendor or period. 

What Entries Appear on the Ledger
Invoices that appear on the Vendor Ledger are added through the New Payable feature.   Existing invoices on 
the Vendor Ledger can be modified through the Open Payable feature or under the A/P tab of the Register.

Payments to A/P invoices appear on the Vendor Ledger through one of the following features: 

Vendor discounts can only be applied through the Process Payable feature. 
Changes to entries on the Vendor Ledger can be performed through the following features:

Changes cannot be made to a payable if a portion of the costs are allocated to a matter, and that matter is 
billed.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-26. The Common tab of the Vendor Ledger selection window 

Vendor: To view activity for a single vendor, type or select the vendor nickname.

Start Date: To view activity on or after a specific date, select the date.   

End Date: To view activity on or before a specific date, select the date.

Include: If preferred, select one or more of the following:

General Checks: To include vendor checks made through the General Check feature with 
Include in A/P deselected, select this option.

If Include In A/P is selected, the general check is treated as if it was a 
processed payable and is included on the Vendor Ledger regardless of 
whether Include General Checks is selected when creating the ledger. 

• New/Open Payable • Process Payable • General Check.

• Open Payable • Register AP/General tabs

Pull-down menu: Reports > Accounts Payable > Vendor Ledger > Common Tab
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Trust Check: To include trust checks to vendors made through the Trust Check 
feature, select this option.

General and Trust checks will only be included on the Vendor Ledger if the vendor 
name appearing in the Paid To box of the check matches the exact vendor name that 
appears in the Open Vendor window. It is recommended to select Show Vendors In 
Paid To Pop Up Help under the System Settings > Other tab, and select the Vendor from 
the Pop Up Help each time a check to the vendor is created.

Include Vendors: Select one of the following: 

Active: To view activity for active vendors only, select this option.

Inactive: To view activity for inactive vendors only, select this option.

Both: To view activity for both active and inactive vendors, select this 
option. 

Totals Only: To view only vendor opening and closing balances, and the total transactions for the 
period, select this check box.

Firm Totals Only: To view only the Firm Totals section, select this check box.

Show User Name:To display the user who entered each transaction, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Vendor Ledger displays A/P invoices by vendor, payments applied to the invoices, and any discounts 
that were realized.

Exhibit 5-27. Excerpt from the Vendor Ledger 

Each Vendor Ledger contains the Vendor nickname, name, address, notes, and vendor account number. 
Inactive Vendors displays ---Inactive--- below the vendor name.

Date: Displays the invoice or payment date.

Due Date: Displays the due dates for invoices. 

Invoice Number: Lists the invoice number for invoices and discounts. Payments do not appear with 
invoice numbers.
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Check Number: Lists check numbers for payments, general and trust checks. 

Explanation: Displays explanations for invoices payments, general and trust checks. Discounts do not 
display explanations. 

Source: Lists the origin of the transaction. Invoices, payments made through Process Payables, and 
general checks with the Include in A/P box checked appear as AP. General checks with the 
Include in A/P box deselected, and Trust checks appear as GB and TB respectively. 
Discounts appear as DI.

Invoice: Lists values for invoices and discounts. Discounts appear as a negative amount.

Payments: Lists Payments from Process Payables and general checks. Trust checks create a double 
entry, in both the Invoice and Payment column.

In the Totals for Vendor section, the opening balance for the period is shown, along with the net total of 
transactions in the period, and the totals at the end of the period. 

The Vendor Ledger does not contain any summary sections.

Drill Down
The Vendor Ledger allows drill down in the following areas:

Exhibit 5-28. Table of the summary sections provided by the Vendor Ledger when they appear 

Reconciling the Vendor Ledger
The chart below lists PCLaw reports that reconcile to the Vendor Ledger, and the item on the report that can 
be reconciled. The reports must be run with identical dates and parameters.

Exhibit 5-29. Table displaying the different reports and their sections that reconcile to the Vendor Ledger 

Drill down on Opens the following window

Vendor Information Change Vendor

Invoice information Register - Select Payable 

Processed Payable Correct Processed Payable

Discounts Drill down not available

General Check - Include in A/P selected Correct Processed Payable

General Check - Include in A/P deselected Correct General Check

Trust Check Correct Trust Check

Vendor Ledger Reconciles to Additional comments
Invoice > End of 
Period

Payment Listing Amount (-Disc) For vendor or firm. Select Include Unpaid 
Invoices for Payment Listing. Deselect 
include General & Trust Checks for Vendor 
Ledger.

Payment > End of 
Period

Payment Listing Payment For vendor or firm. Select Include Unpaid 
Invoices for Payment Listing. Deselect 
include General & Trust Checks for Vendor 
Ledger.

1099 Listing Transaction Amount For U.S. Clients only. For vendor only. The 
same settings must be used for Include 
General and Trust Checks on both reports.
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The Vendor Ledger does not reconcile to the Purchases Journal or Payable Listing for the original invoice 
amount, for the Vendor Listing includes discounts.

The Vendor Ledger does not reconcile to the Payable Listing for payments, for the Payable Listing includes 
discounts in the paid values.

The Vendor Ledger does not reconcile to the Allocation Listing for invoice or payment values, for the 
Allocation Listing only includes invoices that have matter allocations.

The Vendor Ledger does not reconcile to the Discount Listing for invoice or payment values, for the 
Discount Listing only includes invoices eligible for discounts. 
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Vendor Listing 
The Vendor Listing provides all non-accounting information for the vendor, including vendor name, address, 
phone and fax numbers, and e-mail address. The report also displays default invoice terms, posting reference, 
explanation and GST category, if applicable.

What Entries Appear on the Listing
Vendor information is added through the New Vendor feature and modified through the Open Vendor 
feature.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-30. The Common tab of the Payment Listing 

Include Vendors: Select one of the following: 

Active: To view information for active vendors only, select this option.

Inactive: To view information for inactive vendors only, select this option.

Both: To view information for both active and inactive vendors, select this 
option. 

Detailed Report: To view vendor name, address, phone and fax numbers, e-mail address, discount and 
default information, select this check box.

To view only vendor name, address, phone and fax numbers, and e-mail address, deselect 
this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Vendor Listing provides all non-accounting vendor information.

Exhibit 5-31. Excerpt from the Vendor Listing 

Pull-down menu: Reports > Accounts Payable > Vendor Listing > Common Tab
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Ven#: Displays the vendor number.

Vendor Name & Address: Displays vendor name, address, and notes. 

Phone Numbers: Lists business phone number, fax number, e-mail address, vendor account number, and 
vendor terms.

If Detailed Report is selected when creating the report, two additional lines of information are added. The 
first displays discount percentage and days for all three discount categories. The second displays the 
default posting reference, explanation and gst category, if applicable.

The Vendor Listing does not contain any summary sections.

Drill Down
The Vendor Listing allows drill down in the following areas:

Exhibit 5-32. Table of the summary section provided by the Vendor Listing and when it appears

Reconciling the Vendor Listing
Since the Vendor Listing does not contain any accounting information, it is not reconcilable with other 
PCLaw reports.

Drill down on Opens the following window

Vendor Information Change Vendor
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1099 Listing 
The 1099 Listing provides vendors and amounts paid to vendors that exceed a specified threshold amount. 
The listing provides required information in order to prepare for the year end 1099 reporting.

What Entries Appear on the Listing
Opening Balances appear on the 1099 Listing through the following features:

Transaction Amount values appear on the 1099 Listing through the following features:

Transaction Amount values can be modified through one of the following features:

If Include in AP is selected when making a payment to a vendor, that transaction is considered a Process 
Payable and will appear on the 1099 Listing even if Include General is deselected when creating the report. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 5-33. The Common tab of the 1099 Listing 

Vendor: To view payments to a specific vendor, type or select the vendor nickname.

Threshold Amount:To view only vendors whose total payments exceed a minimum threshold amount, type 
the payment amount.

1099 Type: From the drop down list select Misc.
Start Date: To include payments on or after a specific date, select the date.

End Date: To include payment on or before a specific date, select the date.

• New Vendor • Open Vendor.

• New/Open Payable • Process Payable
• General Check • Trust Check.

• Register > General/Trust tabs.

Pull-down menu: Reports > Accounts Payable > 1099 Listing > Common Tab
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Include: If preferred, select one or more of the following: 

General Checks: To include payments to vendors added as general checks, select this 
check box.

If the Include in A/P option is selected when the check is created, 
those checks are included on the 1099 Listing automatically. The 
General Checks option consists of general checks where Include in 
A/P is not selected when the check is created.

Trust Checks: To include payments to vendors added as trust checks, select this 
check box.

Include Vendors: Select one of the following: 

Active: To view payments to active vendors only, select this option.

Inactive: To view invoices belonging to inactive vendors only, select this 
option.

Both: To view invoices belonging to both active and inactive vendors, 
select this option. 

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The 1099 Listing lists vendors and payments made to the vendor during the report period.

Exhibit 5-34. Excerpt from the 1099 Listing 

Recipient’s Name and Address: Displays the vendor’s name and mailing address.

Recipient’s ID:  The vendor’s 1099 ID number, as entered in the New/Open Vendor window.

Opening Balance: Displays the value of the Opening Bal box in the New/Open Vendor window. If this is 
the first year for reporting 1099’s through PCLaw for a vendor, the total of all previous 
payments made to the vendor outside of PCLaw but belonging to the current 1099 year 
should be entered as the opening balance.

Transaction Amount: Displays the total value of the payments, If the total of all payments in the report 
period exceed the threshold amount.

Non-employee Compensation: Displays the sum of the Opening Balance, if applicable, and the 
Transaction Amount.

The 1099 Listing does not contain any summary sections:

Drill Down
The 1099 Listing does not contain any drill down capabilities.
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Reconciling the 1099 Listing
The chart below lists PCLaw reports that reconcile to the 1099 Listing, and the item on the report that can be 
reconciled. The reports must be run with identical dates and parameters.

Exhibit 5-35. Table displaying the different reports and their sections that reconcile to the 1099 Listing 

The 1099 Listing does not reconcile to the sum of Payment Listing and General Bank Journal when Include 
General Checks is selected on the 1099 Listing, for general checks created with Include in A/P selected 
appear on both the Payment Listing and General Bank Journal.

The 1099 Listing does not reconcile to the 1099 Form for Opening Balance or Transaction amounts, for the 
1099 Forms only reports the overall balance, or Non-employee Compensation. The Opening Balance/
Transaction Amount separation on the 1099 Listing indicates vendors being tracked in PCLaw for the first 
time.

1099 Listing Reconciles to Additional comments

Transaction Amount 
(A/P Only)

Payment Listing Payment For vendor only. Deselect Include General 
and Trust Checks.

Vendor Ledger Payment For vendor only. Deselect Include General 
and Trust Checks.

Transaction Amount 
(A/P and General 
only)

Vendor Ledger Payment For vendor only. Select Include General 
Checks. Deselect Include Trust Checks.

Transaction Amount 
(A/P and Trust only)

Vendor Ledger Payment For vendor only.   Select Include Trust 
Checks. Deselect Include Trust Checks

Payment Listing + 
Trust Bank Journal

Payment + Check 
Tot

For vendor only. For 1099 Listing, select 
Include Trust Checks. Deselect Include 
Trust Checks. For Trust Bank Journal, create 
report by recipient’s name in the Received 
From/Paid To box.

Transaction Amount 
(A/P, General, and 
Trust)

Vendor Ledger Payment For vendor Only. Select Include General 
and Trust Checks.

Non-Employee 
Compensation

1099 Form Box 7 For vendor only. 



    Page 163

Productivity Reports

Productivity Report Overview..............................................................164

Billing by Lawyer Report ......................................................................165

Collection Summary .............................................................................168

Lawyer WIP, Billing & Collection Summary ........................................172

Time Listing ...........................................................................................176

Time Summary ......................................................................................180

Productivity by Client Report...............................................................184

Billing Realization Report.....................................................................190

Client WIP, Billing, & Collection Summary .........................................194

Fees Collected Summary .....................................................................200

Fee Adjustments Report.......................................................................204

Fee Allocation Summary ......................................................................208

Fees Due by Lawyer Report .................................................................212

Firm Cash & Fee Summary ..................................................................216

Billable Time Summary by Working Lawyer.......................................220

Comparative Time Analysis .................................................................224

Daily Time Summary.............................................................................228

Time Utilization Analysis ......................................................................230

Unbilled Time & A/R Summary by Working Lawyer ..........................232

Matters Opened Summary....................................................................236

Lawyer Budgeting Report ....................................................................238



PCLaw Reports

Page 164 

Productivity Report Overview

Exhibit 6-1. Table listing productivity reports, their defining parameters, and what the report displays 

Report Run Report by What it Does

PC
Law

PC
Law

 Plus

PC
Law

Pro and PC
Law

Pro Enterprise

Billing by Lawyer fee credit lawyer
type of law

Lists fees billed by type of law for each fee credit lawyer and can be 
sorted by fee credit lawyer or by type of law.

Collection 
Summary 

fee credit lawyer
month

Lists totals for fees, disbursements and taxes billed, amount 
collected and A/R by fee credit lawyer.

Lawyer WIP Billing 
& Collection 
Summary

working, fee credit, 
responsible, and 
assigned lawyer 

Lists a monthly comparison of billable time worked (working 
lawyer), billed fees (fee credit lawyer), fees collected (responsible 
lawyer) and fees written off (assigned lawyer). 

Time Listing task code, working 
lawyer, type of law

Lists details of time and fee entries sorted by task code or by type of 
law.

Time Summary task code, working 
lawyer, type of law

Summarizes time by working lawyer and by type of law or by task 
code. Task code summary includes breakdown by billable work, 
non-billable work and write up/down.

Productivity by 
Client

lawyer Ranks clients by criteria specified.

Client WIP Billing 
& Collection Sum.

matter/client
resp lawyer

Lists work-in-progress, billed amounts, collected amounts and 
write-off amounts by client.

Billing Realization matter/client
resp lawyer
working lawyer

Lists billed hours, billed fees and fee write-offs by matter and 
calculates the actual billed fees and hourly rate after write-offs.

Lawyer Budgeting working, fee credit, 
collecting lawyer

Compares lawyer's budgeted hours and value to: worked (working 
lawyer), billed (fee credit lawyer), collected (collecting lawyer). 

Fees Collected 
Summary

fee credit lawyer
resp lawyer

Shows fees collected for each fee credit and responsible lawyer by 
month, year, & previous year.

Fee Adjustments task code, working 
lawyer, type of law

Lists of all increases and decreases made to fees during billing, as 
long as they were not entered with the Details button, and shows 
which user made the changes.

Fee Allocation matter/client
resp lawyer

Lists the fees billed, collected and written off by a lawyer on 
matters where they are the responsible lawyer.

Fees Due by 
Lawyer report

fee credit lawyer Lists outstanding invoices by fee credit lawyer. Also, lists fees 
received, billed or written off during the reporting period.

Firm Cash & Fee 
Summary

fee credit lawyer Compares hours and fees docketed, fees billed, fees received and 
fees adjusted for a specified month and year.

Billable Time 
Summary by 
Working Lawyer

matter/client, resp 
lawyer, working 
lawyer, task code

Shows a comparison of hours and amounts for the month and year 
by matter for each working lawyer by responsible lawyer.

Comparative Time 
Analysis

working lawyer Show hours, amounts and percentages by task code or type of law 
for working lawyers.

Daily Time 
Summary

task code, working 
lawyer, type of law

Shows hours docketed daily by each working lawyer for both 
billable and non-billable time.

Time Utilization 
Analysis

working lawyer
task code

Shows hours docketed monthly over a 12 month period by each 
working lawyer by billable and non-billable time.

Unbilled Time &   
A/R Summary by 
Working Lawyer

matter/client
resp lawyer
working lawyer

Lists matters with unbilled time and billed but uncollected fees, by 
client. 

Matters Opened 
Summary

responsible, client 
introducing, and 
working lawyer

Shows the number of matters opened by each lawyer as 
introducing, responsible, assigned lawyer for one 12 month period.
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Billing by Lawyer Report
The Billing by Lawyer report summarizes billed time and hours by fee credit lawyer or type of law. The 
effective billing rate is calculated for billed time and fees, fee adjustments, and write-ups/downs. Payments 
applied against fees is provided, as is the percentage of fees that payment is applied.

What Entries Appear on the report
Time and fee values are added or modified on the Billing by Lawyer report through one of the following 
features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 6-2. The Common tab of the Billing by Lawyer report 

Fee Credit Lawyer: To view fees billed for a single lawyer, select the lawyer.

Type of Law: To view fees billed for a single type of law, select the nickname.

Start Date: To view fees billed on or after a specific date, select the date.

End Date: To view fees billed on or before a specific date, select the date.

Sort By: Select one of the following:

Type of Law: With fee credit lawyers as sub-categories to types of law, select this 
option.

Fee Credit Lawyer: With types of law as sub-categories to fee credit lawyers, select this 
option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Create Bill/Release Bill • Quick Bill • Register > Invoice/Ledger tabs
• Matter Manager > Ledger tab • Change/Write Off Bill • Matter Opening Balances.

Pull-down menu: Reports > Productivity > Billing by Lawyer Report > Common Tab
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The Report
The Billing by Lawyer report displays billed time and hours by fee credit lawyer or type of law. The effective 
rate per hour and payments applied to fees are also shown.

Exhibit 6-3. An excerpt from the Billing by Lawyer report 

Categories/Fee Credit Lawyer: Displays type of law as the main category and fee credit lawyer as sub-
categories when Sort by Type of Law is selected. Select Sort by Fee Credit Lawyer to show 
fee credit lawyer as the main category and types of law as sub-categories.

Billed: Displays billed time and fee entries, fee adjustments at the time of billing, and write ups/
downs after billing.

Hours: Displays billed hours added prior to the time of billing, and at the time of billing only 
when using the Details button on the Billing Information window.

Rate/Hr: Column divides the Billed value by the Hour value.

Rcvd: Displays all payments applied to billed fees. The payments can originate through the 
Receive Payment, General Retainer, or Trust-to-General Transfer features. Payments appear 
according to the date of the invoice not the date of the payment.

Rcvd %: Column divides the Rcvd value by the Billed value.

The Billing by Lawyer report includes the following summary sections:

Exhibit 6-4. Table of the summary sections provided by the Billing (Fees) Journal and when they appear

Drill Down
The Billing by Lawyer report allows drill down on the following areas:

Exhibit 6-5. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Lawyer Summary Always appears.

Firm Summary Always appears.

Drill down on Opens the following window

Body of report Detailed Billing (Fees) Journal

Firm Summary Detailed Billing (Fees) Journal

Lawyer Summary Detailed Billing (Fees) Journal
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Reconciling the Billing by Lawyer Report
The chart below lists PCLaw reports that reconcile to the Billing by Lawyer report, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-6. Table displaying the different reports and their sections that reconcile to the Billing by Lawyer report 

The Billing by Lawyer report does not reconcile to the Billing (Fees) Journal for a specified end date if there 
are write-offs or payments made after the end date. The Billing by Lawyer report reports all transactions 
that apply to invoices within the report period. The Billing (Fees) Journal includes transactions that apply 
to invoices if both the invoice and the transaction fall within the report period.

The Billing by Lawyer report does not reconcile to the Invoice Journal for the latter report does not 
separate write ups/downs on fees and disbursements.

The Billing by Lawyer report does not reconcile to the Client Ledger and Client Summary for a modified 
start date. Fees dated prior to the start date but are billed after the start date are included on the Billing by 
Lawyer report only.

The Billing by Lawyer report does not reconcile to the Time Summary for billed time as the Billing by 
Lawyer report is created by collecting lawyer whereas the Time Summary is created by working lawyer.

The Billing by Lawyer report does not reconcile to the Payment Allocation Listing for Rcvd for the Billing 
by Lawyer report includes payments according to invoice date whereas the Payment Allocation Listing 
includes payments by payment date.

Billing by Lawyer Reconciles to Additional comments

Hours Client Summary Bld Hrs For firm only with 1/1/82 start date.

Billed Client Ledger Billed > Fees For firm > end date only with 1/1/82 start 
date.

Client Summary Bld Fees For firm only with 1/1/82 start date.

Billing (Fees) 
Journal

Fees For fee credit lawyer or firm. Select Include 
Paid Invoices. Select End Date of 12/31/
2199. Receipts Up to 12/31/2199. Include 
Write Ups/Downs.

Paid Billing (Fees) 
Journal

Summary by Lawyer 
> Billed

For fee credit lawyer or firm. Select Include 
Paid Invoices. Select End Date of 12/31/
2199. Receipts Up to 12/31/2199. Include 
Write Ups/Downs.
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Collection Summary
The Collection Summary provides a monthly analysis of billing by fee credit lawyer. Payments received 
during the same period are compiled, including fee, disbursement, and tax allocations. A monthly accounts 
receivable balance is provided for each lawyer.

What Entries Appear on the Report
Billing values appear on the Collection Summary through one of the following features:

Payment values appear on the Collection Summary through one of the following features:

For Accrual accounting systems: Provisional write-offs do not appear on the report.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-7. The Common tab of the Collection Summary 

Fee Credit Lawyer: To view collection information for a specific fee credit lawyer, type or select the lawyer 
nickname.

Start Month: To view only collection information posted on or after a specific date, select the date.

End Month: To view only collection information posted on or prior to a specified date, select the date.

Firm Totals Only: To display only the firm summary section, select this check box.

Summary By: If preferred, select one or more of the following:

Fee Credit Lawyer: To include a Summary by Fee Credit Lawyer section on the report, 
select this check box.

Responsible Lawyer: To include a Summary by Responsible Lawyer section on the report, 
select this check box.

Client Introducing Lawyer: To include a Summary by Client Introducing Lawyer section on 
the report, select this check box.

Matter Introducing Lawyer: For PCLawPro and PCLawPro Enterprise: To include a 
Summary by Matter Introducing Lawyer section on the report, select this 
check box.

• Create Bill • Quick Bill • Release Bill
• Matter Opening Balances. • Change/Write Off Bill.

Receive Payment Create Bill/Quick Bill/Release Bill

Trust-to-General Transfer (when applied to an existing A/R balance).

Pull-down menu: Reports > Productivity > Collection Summary > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Collection Summary reports the net billing, payments received, and how the payments were applied 
monthly by lawyer. If the report is run for all dates, only months that display non-zero values are listed for 
each lawyer. Invoices and matters are not shown individually.

Exhibit 6-8. An excerpt from the Collection Summary 

Month: Lists all non-zero months for each lawyer.

Net Billed: This section contains hours, fees, disbursements and tax columns for the month and 
monthly totals less any write-downs dated for the calendar month less any write-downs 
dated for that month. Write-downs are included on the Collection Summary according 
to the date of the write-down and not the A/R date of the invoice to which the write-
down is applied.   If an invoice is written down in a separate month to the invoice, the 
original value of the invoice appears for the month that it was created. 

Hrs: Lists the number of hours worked by the specific lawyer. 

Fees: Displays the amount credited to the lawyer at the time of billing.

Cash In: This section divides payments received for the calendar month into retainers and 
receipts.

Retainers: Include general retainers, trust-to-general transfers made at the time 
of billing, and receipts not applied to an existing A/R balance. 

Receipts: Include receive payments and trust-to-general transfers applied to a 
previously existing a/r balance.

Payment Used: This section displays the portion of the payment applied to fees, and to disbursements 
and taxes combined. The allocation is determined according to the Payment Allocation 
Listing. If a payment is manually allocated to g/l accounts, that manual allocation is not 
shown on the Collection Summary. As a result, the Collection Summary and lawyers’ 
fee accounts may not reconcile.

A/R Balance: Displays the uncollected billing after payments and write-offs for the last day of the 
respective month.

The Collection Summary includes the following summary section:

Exhibit 6-9. Table of the summary sections provided by the Collection Summary and when they appear

Summary Title Appears when

Firm Summary Always appears.

Summary by Fee Credit Lawyer Optional, as selected by user.

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Client Introducing Lawyer Optional, as selected by user.

Summary by Matter Introducing Lawyer Optional, as selected by user.
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Drill Down
The Collection Summary allows drill down on the following areas:

Exhibit 6-10. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Collection Summary
The chart below lists PCLaw reports that reconcile to the Collection Summary, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Drill down on Opens the following window

Net Billed section Drill down not available

Cash In section Drill down not available

Payment Used section Payment Allocation Listing for fee credit lawyer for selected month

A/R Balance Billing (Fees) Journal for fee credit lawyer for selected month

Firm Summary Collection Summary for fee credit lawyer

Collection 
Summary

Reconciles to Additional comments

Net Billed > Fees Billing (Fees) 
Journal less Write 
Up/Down Journal

Firm Summary > 
Billed > Fees less 
Task Code by Fee 
Credit Lawyer 
Summary > Fees

For lawyer or firm. Run journals for 
calendar month. For Billing (Fees) journal, 
select Include Paid Invoices, deselect 
Include Write Ups and Write Downs. For 
Accrual systems only, select Include 
Provision for Write-offs on Write Up/Down 
Journal

Client WIP Billing & 
Collection 
Summary

Billings > Fees less 
Write Offs > Fees

For firm only. Run report for calendar 
month.

Lawyer WIP Billing 
& Collection 
Summary

Billings > Fees less 
Write Offs > Fees

For fee credit lawyer and firm. Run report 
for calendar month. For Accrual systems 
only, provisional write-offs are included on 
Lawyer WIP report but not on Collection 
Summary.

Disbs + Tax Billing (Fees) 
Journal less Write 
Up/Down Journal

Firm Summary > 
Billed > Disb and 
Tax values less Task 
Code by Fee Credit 
Lawyer Summary > 
Disb and Tax values

For lawyer or firm. Run journals for 
calendar month. On Billing (Fees) Journal, 
select Include Paid Invoices, deselect 
Include Write Ups and Write Downs.

Client WIP Billing & 
Collection 
Summary

Billings > Disb + 
Tax less Write Offs 
> Disb + Tax

For firm only. Run report for calendar 
month.

Lawyer WIP Billing 
& Collection 
Summary

Billings > Disb + 
Tax less Write Offs 
> Disb + Tax

For lawyer and firm. Run report for 
calendar month. 
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Exhibit 6-11. The different reports and their sections that reconcile to the Collection Summary 

The Collection Summary does not reconcile to the Billing (Fees) Journal for Cash In > Retainers/Cash In > 
Receipts as the Billing (Fees) Journal Invoice Journal includes only retainers that are applied to an existing 
A/R balance. The Collection Summary includes unapplied general retainers.

The Collection Summary does not reconcile to the Invoice Journal for Net Billed, as the Invoice Journal 
does not include write-offs to invoices that are outside the report period date.

The Collection Summary does not reconcile to the Invoice Journal for A/R Balance as the Invoice Journal 
does not include payments.

The Collection Summary does not reconcile to the Client Ledger or Client Summary for Billed Fees, Disb 
+ Tax, or A/R Balance, for those reports cannot be created for fee credit lawyer. 

The Collection Summary does not reconcile to the Client WIP, Billing, & Collection Summary for 
payments applied to fees as the Collection Summary is created by fee credit lawyer, whereas the Client 
WIP Billing & Collection Summary is created for responsible lawyer.

The Collection Summary may not reconcile to the Client WIP, Billing, & Collection Summary for Net 
Billed fees for the Accrual accounting method, as the Client WIP report may include provisional write-offs 
on fees, whereas the Collection Summary does not. Neither report includes provisional write-offs on 
disbursements or taxes.

The Collection Summary may not reconcile to the General Ledger for the lawyer fee accounts as payments 
may be manually allocated to the respective G/L accounts. The Collection Summary does not display 
manual allocations.

Collection 
Summary

Reconciles to Additional comments

Payment Used > 
Fees

Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer > 
Fees

For fee credit lawyer or firm. 

Fees Collected 
Summary

Fees Collected As 
Fee Collecting 
Lawyer > This 
Month

For fee collecting lawyer or firm for month 
or YTD only. 

Lawyer WIP Billing 
& Collection 
Summary

Collections > Fees For fee credit lawyer and firm. Run report 
for calendar month.

Payments Used > 
Disb + Tax

Payment Allocation 
Listing

Summary by 
Responsible 
Lawyer> Disb and 
Tax values

For lawyer or firm.

Client WIP Billing & 
Collection 
Summary

Collections > Disb For lawyer and firm. Run report for 
calendar month. 

Lawyer WIP Billing 
& Collection 
Summary

Collections > Fees For lawyer and firm. Run report for 
calendar month.

A/R Balance Billing (Fees) 
Journal

Summary by Fee 
Credit Lawyer > 
Total

For fee credit lawyer or firm. Run report for 
fee credit lawyer from 1/1/82 to end of 
calendar month. Include Write Ups and 
Write Downs.
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Lawyer WIP, Billing & Collection Summary
The Lawyer WIP, Billing, & Collection Summary provides a summary by fee collecting lawyer of billable time 
worked and the amount actually billed. Also displayed is the value of the billed work that was either 
collected or written off.

What Entries Appear on the Report
Billable time values appear on the Lawyer WIP, BIlling & Collection Summary through the following features:

Fee adjustments and time added at billing are not included on the report as billable time.
Billing totals appearing on the summary are added through the following features:

Collection totals on the summary are added or modified through the following features:

A write-off value appears on the Lawyer WIP, Billing, & Collection Summary through the Change/Write off 
Bill feature. For Accrual accounting systems, provisional write-offs are not included in the Write-offs section.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. 

Exhibit 6-12. The Common tab of the Lawyer WIP, Billing, & Collection Summary 

Lawyer: To view totals for a specific fee credit lawyer, type or select the lawyer nickname.

Start Month: To view totals for and after a specific month, select the date.

End Month: To view totals for and prior to a specified month, select the date.

Firm Totals Only: To display only the Firm Totals summary section, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Phone Call Manager
• Calendar/Appointment Sheet • Matter Opening Balances • Register > Time/Ledger tabs
• Global Change Time • Matter Manager > Time/Ledger tabs.

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • Register > General tab • Create Bill/Release Bill
• Quick Bill Trust-to-General Transfer (when applied to existing A/R balances).

Pull-down menu: Reports > Productivity > Lawyer WIP, Billing & Collection Summary > Common Tab
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 The Report
The Lawyer WIP, Billing & Collection Summary reports all time posted having a billable task code. All 
billed time, fees, disbursements and taxes are displayed, as are payments and write-offs applied to 
billings.

Exhibit 6-13. Excerpt from the Lawyer WIP, Billing, & Collection Summary 

Lawyer: Displays the lawyer’s nickname and full name as headings for each lawyer.

Matters: This section displays matter information for each lawyer.

Opened: Displays the number of matters opened where the shown lawyer is 
assigned as responsible lawyer.

Introd.: Displays the number of matters opened where the shown lawyer is 
the client introducing lawyer. 

Fee Val.: Displays the net dollar value after write-offs of fees billed for the 
month for all matters where the shown lawyer is the client 
introducing lawyer.

Billable Time Worked: This section displays time posted with a billable work type task code. A billable 
work task code is defined as one that has Billable selected from the drop down list in 
the Options > Category box of the task code.

Hours: Displays time, in hours, as originally posted for the month.

Value: Displays the dollar value of time as posted for the month. 

Billings: This section displays the dollar value billed for the month for the shown lawyer as fee 
credit lawyer. Billings are divided into Fees and Disb + Tax columns.

Collections: This column displays how payments are allocated between fees and disbursements/tax. 
Payments appear on the report according to the payment date and not the date of the 
invoice. 

Fees: Displays time and fees for the lawyer as fee credit lawyer.

Disb + Tax: Displays disbursements and tax for the lawyer as responsible lawyer.

Write-offs: This section displays how write-offs are allocated between fees and disbursements/tax. 
Write-offs appear according to the date the write off occurs and not the date of the 
invoice.

Fees: Displays write-offs of time and fees according to the allocation of the 
write-off.

Disb + Tax: Displays write-offs of disbursements for the lawyer as responsible 
lawyer. 

The Lawyer WIP, Billing & Collection Summary does not contain any summary sections.
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Drill Down
The Lawyer WIP, Billing, & Collection Summary allows drill down in the following areas:

Exhibit 6-14. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Lawyer WIP, Billing & Collection Summary
The chart on the following page lists PCLaw reports that reconcile to the Lawyer WIP, Billing & Collection 
Summary, and the item on the report that can be reconciled. The reports must be run with identical dates and 
parameters.

Drill down on Opens the following window

Matters section drill down not currently available

Billable Time Worked > Hours and Value 
columns

Client Fees Listing for current working lawyer

Billable Time Worked > Adjsts column Fee Adjustments report

Billings section Billing (Fees) Journal for current fee credit lawyer

Collections section Payment Allocation Listing for current responsible lawyer

Write-Offs section Write Up/Down Journal for current assigned lawyer

Lawyer WIP, Billing 
& Collection 
Summary

Reconciles to Additional comments

Matters > Opened Matters Opened 
Summary

Responsible For lawyer and firm. For calendar month 
only.

Matters > Introd Matters Opened 
Summary

Introducing For lawyer and firm. For calendar month 
only.

Billable Time 
Worked > Hours

Time Summary Hours (Hr) > 
Billable Work

For lawyer and firm. Run Time Summary for 
calendar month.

Time Utilization 
Analysis

(month) > Total 
Billable

For lawyer only. 

Billable Time 
Worked > Value

Time Summary Value > Billable 
Work

For lawyer and firm. Run Time Summary for 
calendar month.

Billings > Fees Billing (Fees) 
Journal

Summary by Lawyer 
> Billed > Fees

For lawyer and firm. Select Include Paid 
Invoices. Deselect Include Write Ups and 
Write Downs. For Accrual systems, exclude 
PWO of Fees.

Invoice Journal Summary by 
Responsible Lawyer 
> Fees

For lawyer and firm. For Accrual systems, 
exclude PWO of Fees

Billings > Disb + 
Tax

Billing (Fees) 
Journal 

Summary by Lawyer 
> Billed > Disb + 
Tax values

For lawyer and firm.   Select Include Paid 
Invoices. Deselect Include Write Ups and 
Write Downs.

Invoice Journal Summary by 
Responsible Lawyer 
> Disb + GST + 
Sales Tax

For lawyer, and firm.   Select Show Billings 
and Write-Offs Separately.
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Exhibit 6-15. The different reports that reconcile to the Lawyer WIP, Billing, & Collection Summary 

The Fees Value column on the Lawyer WIP, Billing, & Collection Summary does not reconcile to the 
Summary by Client Introducing Lawyer section of the Invoice Journal for the Invoice Journal does not 
separate write-offs of fees, disbursements, and taxes. 

The Fees Value column on the Lawyer WIP, Billing, & Collection Summary does not reconcile to the 
Billing (Fees) Journal for although the Billing (Fees) Journal can be run for a single client introducing 
lawyer, invoices belonging to matters opened in prior months are also included on the report.

The Lawyer WIP, BIlling & Collection Summary does not reconcile to the Time Listing for Billable Time 
Worked the Time Listing does not separate time entries by billable and non-billable categories.

Although the Lawyer WIP, Billing, & Collection Summary does reconcile to the Time Summary for billable 
hours and work, the Time Summary does not include Split Bill Fee Transfers, whereas the Lawyer WIP, 
Billing & Collection Summary and Client Fees Listing reports do. Split Bill Fee Transfer entries should add 
up to zero.

The Lawyer WIP, Billing & Collection Summary does not reconcile to the Client WIP, Billing, & Collection 
Summary for single lawyer Billings and Collections as the Lawyer WIP report is created by fee credit 
lawyer whereas the Client WIP report is created by responsible lawyer.

Lawyer WIP, Billing 
& Collection 

Reconciles to Additional comments

Collection > Fees Billing (Fees) 
Journal

Summary by Lawyer 
> Paid > Fees (this 
month) less 
Summary by Lawyer 
> Paid > Fees 
(previous month)

For lawyer and firm. Run Billing (Fees) 
Journal from 1/1/82 to end of current 
month. Next run Billing (Fees) Journal from 
1/1/82 to end of previous month. Minus the 
Paid totals of previous month from current 
month.

Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer > 
Fees

For fee credit lawyer or firm. 

Collection 
Summary

Payment Used > 
Fees

For fee credit lawyer or firm. Run report for 
calendar month.

Fees Collected 
Summary

Fees Collected As 
Fee Collecting 
Lawyer > This 
Month

For fee collecting lawyer or firm for month 
or YTD only. 

Collection > Disb + 
Tax

Payment Allocation 
Listing

Summary by 
Responsible 
Lawyer> Disb and 
Tax values

For lawyer or firm.

Collection 
Summary

Payment Used > 
Disb + Tax

For lawyer and firm. Run report for 
calendar month.

Client WIP, Billing 
& Collection 
Summary

Collections > Disb For firm only. Run report for calendar 
month. 

Write-Offs > Fees Write Up/Down 
Journal

Task Code by Fee 
Credit Lawyer > 
Fees

For lawyer only. Select Exclude Provisional 
for Write-offs.

Write-Offs > Disb + 
Tax

Write Up/Down 
Journal

Task Code by Fee 
Credit Lawyer > 
Disb + GST + Sales 
Tax

For lawyer only. Select Exclude Provisional 
for Write-offs
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Time Listing
The Time Listing displays time and fee entries for a matter, entered prior to or at the time of billing. The report 
displays the type of law, rate and quantity of hours. Transactions are grouped by working lawyer and a total is 
supplied for each lawyer.

What Entries Appear on the Report
Transactions appearing on the Time Listing are added from one of the following features:

Unbilled transactions appearing on the Time Listing can be modified from one of the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 6-16. The Common tab of the Time Listing 

Working Lawyer: To view only transactions for a specific working lawyer, type or select the lawyer.

Task Code: To include a Summary by Task Code section in the report, select this option.

To view only items for a single task code, type or select the task code.

Type of Law: To include a Summary by Type of Law section in the report, select this option.

To view items for a single type of law, type or select the type of law.

Start Date: To view items on or after a specific date, select the date.

End Date: To view items on or prior to a specific date, select the date.

Options: Select one or more of the following:

Time Entry: To display time entries only, select this option.

Fee Entry: To display fee entries only, select this option.

Both: To display both time and fee entries, select this option.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Create Bill/Quick Bill/Release Bill
• Calendar/Appointment Sheet • Phone Call Manager • Matter Opening Balances.

• Global Change Time • Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Time Listing > Common Tab
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Include only Held Items: If Allow Charges to be Held is enabled on the System Settings 
> Other tab: To include only time entries currently on hold, select 
this check box. 

Include Corrected Entries: To show original items that have since been modified or 
removed, select this check box.

Totals Only: To view the summary sections only, select this check box.

Layout: To produce a customized Time Listing, select the layout.

To add or change a layout, see Customizing Reports in Chapter 10. 

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Sort By: Select one of the following:

Order Entered: To sort the report by the order transaction were entered, select this 
option.

Date: To sort the report by transaction date, select this option.

Working Lawyer: To group items by working lawyer, select this option.

Task Code: To group items by task code if Show by Task Code is checked, select 
this option.

Type of Law: To group items by type of law if Show by Type of Law is checked, 
select this option.

Summarize By: If preferred, select one or more of the following:

Daily Totals: To include a Daily Totals by Lawyer summary section, select this 
check box.

Show Summary by Department: To include a Summary by Department section on the 
report, select this check box.

Show Summary by Department by Lawyer: To display a Summary by Department by 
Lawyer section on the report, select this check box.

Pull-down menu: Reports > Productivity > Time Summary > Other Tab
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Working Lawyers: Select one of the following:

All: To list time entries for all working lawyers, select this option.

Selected: To list time entries for selected working lawyers, click this option.
The Select button becomes available.

Click the Select button.
A Pop Up Help - Lawyers window appears.

Task Codes: Select one of the following:

All: To list time entries for all task codes, select this option.

Selected: To list time entries for selected task codes, click this option.
The Select button becomes available.

Click the Select button.
A Pop Up Help - Task Codes window appears.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Time Listing provides a list of time and fee entries, displaying rates, hours, and types of law. The 
described report configuration uses the Default layout. The Time Listing also includes the Default with (usr) 
layout 

Exhibit 6-17. An excerpt from the Time Listing 

Lwyr, Lawyer: Displays the lawyers nickname and name as headings for their respective time listings.

Date: Displays the date from the time sheet.

Entry #: Displays the sequential entry number assigned to the record.

Matter: Displays the nickname of the matter charged the time.

Client: Displays the client last and first name or the client firm name.

Matter Description: Displays the matter description as appears in Matter Manager.

Explanation: Displays the explanation for the time entry.

Task: Lists the task code assigned to the time entry. This column appears regardless of whether 
the report is sorted by task code or type of law.

Law Type: Lists the type of law assigned to the task code or to the matter. This column appears 
regardless of whether the report is sorted by task code or type of law.

Hours: Lists the hours for each time entry.

Rates: Lists the assigned rate for each time entry.

Total: Lists the value of the time entry by summing hours x rate.
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The Time Listing report includes the following summary sections:

Exhibit 6-18. Table of the summary sections provided by the Time Listing and when they appear 

Drill Down
The Time Listing allows drill down in the following areas:

Exhibit 6-19. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Time Listing
Although the Time Listing can reconcile to reports that display time and fee entries, the Time Listing does 
not differentiate between billed and unbilled transactions.

The following chart lists PCLaw reports that reconcile to the Time Listing, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-20.  Table displaying the different reports and their sections that reconcile to the Time Listing 

The Time Listing cannot reconcile to the Client Ledger or Client Summary as these reports include 
changes to fees after the time of billing. Furthermore, when run by working lawyer, the Client Summary 
displays all matters for which the working lawyer has submitted time, however time for all lawyers are 
included in the matter totals.

The Time Listing report cannot reconcile to the Work-in-Progress and WIP Summary by Responsible 
Lawyer reports as the Time Listing includes billed time.

The Time Listing cannot reconcile to the Client Fees Listing for time value as Client Fees includes changes 
to fees after the time of billing. The Time Listing reconciles to the Client Fees Listing for hours only.

The Time Listing cannot reconcile to the Firm Cash & Fee Summary for fee value as the latter report 
includes changes to fees after the time of billing. The Time Listing can reconcile to the Firm Cash & Fee 
Summary for hours only.

Summary Title Appears when

Summary by Working Lawyer Always appears.

Summary by Task Code Appears when Show by Task Code is selected.

Summary by Type of Law Appears when Show by Type of Law is selected.

Daily Totals by Lawyer Appears when Daily Totals is selected.

Summary by Department Optional, as selected by user.

Summary by Department by Lawyer Optional, as selected by user .

Drill down on Opens the following window

Time entry Correct Time Entry

Fee entry Correct Fee Entry

Summary by Task Code Detailed Time Listing

Summary by Type of Law Detailed Time Listing

Summary by Working Lawyer Detailed Time Listing

Time Listing Reconciles to Additional comments

Hours Time Summary Hours > Total For firm.

Time Utilization 
Analysis

Total Hours / Firm 
Total Hours

For firm or working lawyer only.

Comparative Time 
Analysis

Hours > Totals For firm or working lawyer only.

Amount Time Summary Value > Total For working lawyer by month only.

Comparative Time 
Analysis

Amounts > Totals For firm or working lawyer only.
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Time Summary
The Time Summary summarizes time and fee entries by either task code or working lawyer. The report 
displays the amount and hours as both a value and a percentage. Time is also divided between billable, non-
billable, or write-up/down categories. Write-up/downs refer to fee adjustments at the time of billing.

What Entries Appear on the Report
Transactions appearing on the Time Summary are added from one of the following features:

Unbilled transactions appearing on the Time Summary can be modified from one of the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 6-21. The Common tab of the Time Summary 

Matter: To view items for a single matter, type or select the matter nickname.

Client: To view items for a specific client, type or select the client nickname.

Working Lawyer: To view items for a specific working lawyer, type or select the lawyer.

Start Date: To view items on or after a specific date, select the date.

End Date: To view items on or prior to a specific date, select the date.

Options: Select one of the following:

Time Entry: To display time entries only, select this option.

Fee Entry: To display fee entries only, select this option.

Both: To display both time and fee entries, select this option.

Totals Only: To view the summary sections only, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Create Bill/Quick Bill/Release Bill
• Calendar/Appointment Sheet • Phone Call Manager • Matter Opening Balances.

• Global Change Time • Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Time Summary > Common Tab
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The Other Tab

The Other tab displays report options that may not be as frequently used as the options under the 
Common tab.

Exhibit 6-22. The Other tab of the Time Summary 

Include: Select at least one item and task:

Billed Items: To include billed items on the report, select this check box.

Unbilled Items: To include unbilled items on the report, select this check box.

Billable Tasks: To include items with a billable task code, select this check box.

Non-billable Tasks: To include items with a non-billable task code, select this check 
box.

Be careful not to double filter the report. Deselecting both Billed and Unbilled Items or 
Billable and Non-Billable Tasks will result in a blank report.

Show By: Select one of the following:

Task Code: To include a Summary by Task Code section in the report, select this 
option.
The adjacent box becomes available.

To view items for a single task code, type or select the task code.

Type of Law: To include a Summary by Type of Law section in the report, select 
this option.
The adjacent box becomes available.

To view items for a single type of law, select the type of law.

Sort by Working Lawyer: To group totals by working lawyer, then by task code, select this check box. 

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Productivity > Time Summary > Other Tab
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The Report
The Time Summary summarizes time and fee entries by task code then by working lawyer. 

Exhibit 6-23. An excerpt from the Time Summary 

Categories/Fee Credit Lawyer: Presents the task code as the main category, and the lawyer as the sub-
category. If Sort by Working Lawyer is selected, working lawyer becomes the main 
category and task code the sub-category.

Value: Provides the sum of hours times rate for each lawyer.

%(Value): Displays the time value as a percentage of the main category.

Hours (Hr): Lists the quantity of hours for each lawyer.

%(Hrs): Displays the hour value as a percentage of the main category.

Rate/Hr: Displays the lawyers effective rate, the total value of time and fees divided by total hours.

The Time Summary report includes the following summary sections:

Exhibit 6-24. Table of the summary sections provided by the Time Summary and when they appear 

Drill Down
The Time Summary allows drill down on the following areas:

Exhibit 6-25. Table displaying fields where drill down is enabled and the reports or features that are opened 

Summary Title Appears when

Summary by Working Lawyer Always appears.

Summary by Task Code Appears when Show by Task Code is selected.

Summary by Type of Law Appears when Show by Type of Law is selected.

Firm Totals Appears when Show by Type of Law is selected.

Drill down on Opens the following window

Body of report Detailed Time Summary

Firm Summary Detailed Time Summary

Summary by Task Code Detailed Time Listing

Summary by Type of Law Detailed Time Listing

Summary by Working Lawyer Detailed Time Listing
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Reconciling the Time Summary
Although the Time Summary can reconcile to reports that display time and fee entries, the Time Summary 
does not differentiate between billed and unbilled time.

Exhibit 6-26.  Table displaying the different reports and their sections that reconcile to the Time Summary 

The Time Summary does not reconcile to the Client Ledger or Client Summary as these reports include 
changes to fees after the time of billing. Also, when run by working lawyer, the Client Summary displays 
all matters where the working lawyer has submitted time, however time for all lawyers are included in the 
matter totals.

The Time Summary does not reconcile to the Work-in-Progress and WIP Summary by Responsible Lawyer 
reports for the Time Summary also includes billed time.

The Time Summary does not reconcile to the time value on the Client Fees Listing as this report includes 
changes to fees after the time of billing.

The Time Summary does not reconcile to the time value on the Time Utilization Analysis, as this report 
does not include non-billable work.

The Time Summary does not reconcile to the time value on the Billing by Lawyer report for billed time, as 
the Time Summary is created by working lawyer and the Billing by Lawyer report is created by collecting 
lawyer.

Split Bill Fee Transfers are included on the Lawyer WIP, Billing, & Collection Summary and the Client Fees 
Listing, but are not included on the Time Summary. Split Bill Fee Transfer entries should add up to zero.

Time Summary Reconciles to Additional comments

Hours(Hrs) Client Fees Listing Summary by 
Working Lawyer > 
Total

For hours only

Time Listing Hours > Total For firm or working lawyer

Daily Time 
Summary

Hours/Day 
Reported > Total

For working lawyer by month only

Hours > Billable 
Work

Lawyer WIP, Billing, 
& Collection 
Summary

Billable Time 
Worked > Hours

For lawyer and firm. Run Time Summary for 
calendar month

Value > Total Time Listing Value > Total For firm or working lawyer

Comparative Time 
Analysis

Amounts > Totals For firm or working lawyer only

Value > Billable 
Work

Lawyer WIP, BIlling 
& Collection 
Summary

Billable Time 
Worked > Value

For lawyer and firm. Run Time Summary for 
calendar month
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Productivity by Client Report
The Productivity by Client report ranks clients by criteria selected when creating the report. Run the report to 
show clients with the most unbilled, billed and paid fees, unbilled and billed disbursements, or total 
accounts receivable, trust, or paid.

What Entries Appear on the Report
Fee values appear on the Productivity by Client report through the following features:

Disbursement values appear on the Productivity by Client report through the following features:

A/R values appear on the Productivity by Client report through the following features:

Collection values appear on the Productivity by Client report through the following features:

Trust values appear on the Productivity by Client report through one of the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. 

Exhibit 6-27. The Common tab of the Productivity by Client report 

Lawyer: To view rankings for a single lawyer, type or select the lawyer name.

Number of Clients: To limit the list to a set number of clients, type the number. 

Start Date: To rank clients on transactions that occur on or after a specific date, select the date.

End Date: To rank clients on transactions that occur on or prior to a specific date, select the date.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Global Change Time
• Calendar • Appointment Sheet • Phone Call Manager
• Matter Opening Balances • Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

• Expense Recovery • General Check (with matter allocation)
• New/Open Payable (with matter allocation).

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • General Retainer • Trust-to-General Transfer
• Register > General tab • Create Bill/Quick Bill/Release Bill.

• Trust Receipt • Trust Check • Release Trust Check
• Matter-to-Matter Transfer • Bank-to-Bank Transfer • Trust-to-General Transfer.

Pull-down menu: Reports > Productivity > Productivity by Client Report > Common Tab
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Sort By: Select one of the following:

Billed Fees: To rank clients by billed fees, including write-offs that occur during 
the billing period, select this option. Billed Fees are determined by 
the invoice date.

Paid Fees: To rank clients by payments applied to fees according to payment 
date, select this option.

Unpaid Fees: To rank clients by time and fees that are not billed prior to the end of 
the report period, select this option.

Billed Disbs: To rank clients by billed disbursements, net of write-offs, select this 
option. Billed disbursements are determined by the invoice date.

Unbilled Disbs: To rank clients by unbilled disbursements that were not billed during 
the report period, select this option.

Total Fees: To rank clients by total unbilled and billed time and fee, select this 
option.

Total Disbs: To rank clients by total unbilled and billed disbursements, select this 
option.

Total A/R: To rank clients by total receivables, select this option. 

Total Trust: To rank clients by trust balance, select this option.

Total Paid: To rank clients by total payments collected, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

 The Report
The Productivity by Client report ranks clients by category. One one list of rankings can be created at any 
one time.

Exhibit 6-28. Excerpt from the Productivity by Client report 

Common to all report configurations, the client number, first and last name, and responsible lawyer are 
listed to the right of the created list. If there are different responsible lawyers for matters belonging to a 
client, Multiple Lawyers appear as the lawyer.

Billed Fees: Fees are included according to the bill date of the invoice on which the fees appear. 
Fees can be added prior to billing, at the time of billing, or after the invoice has been 
created. Write-offs affect the value of billed fees and are included according to the date 
of the write-off. If a client has a fee write-off during the report period, but no billed fees 
during the period, that client is not included on the report. Payments do not affect the 
value of billed fees.

Paid Fees: Payments are included according to the payment date. Only the portion of payments 
applied to fees are included in the value.

Unbilled Fees: Both time and fee entries are included in the fee value. If a fee entry is billed after the 
end date of the report, it is still considered unbilled on the report.
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Billed Disb: Disbursements are included according to the bill date of the invoice on which the 
disbursements appear. Disbursements can be added prior to billing, at the time of billing, 
or after the invoice has been created. Write-offs affect the value of billed disbursements 
and are included according to the date of the write-off. If a client has an expense write-off 
during the report period but no billed disbursements, that client is not included on the 
report.

Unbilled Disbs: Hard and soft costs are included in the disbursement value. If a disbursement is billed after 
the report end date, it is still considered unbilled on the report.

Total Fees: Consists unbilled time and fee entries, fee adjustments and time added at the time of 
billing, and write-downs to fees after the invoice has been created. Unbilled time and fees 
are included in the value according to the date the transaction is posted. Billed fees are 
included according to the date of the invoice. Write-downs affect the value according to 
the date of the write-down. Payments do not affect the value of Total Fees.

Total Disbs: Consist of unbilled disbursement entries, disbursements added at the time of billing, and 
write-downs to disbursements after the invoice has been created. Unbilled disbursements 
are included in the value according to the date the transaction is posted. Billed 
disbursements are included in the value according to the date of the invoice. Write-downs 
to disbursements affect the value according to the date of the write-down. Payments do not 
affect the value of Total Disbursements.

Total A/R: All billed fees, disbursements, taxes, and payments for the report period are included on 
the report. The transactions appear on the report according to the date the transaction is 
entered and not the date the invoice was created.   Thus if a fee is posted in January, but 
billed in February, the billed fee does not appear on the Productivity by client report 
created with a start date of February.

For Total A/R, a start date of 1/1/82 is recommended.

Total Trust: The trust balance is the net value of all trust receipts and disbursements that are recorded 
during the report period.

Total Paid: The balance is comprised of payments applied to existing invoices, trust-to-general 
transfers, and general retainers applied during the billing process. Receive payments are 
included in the Total Paid value according to the date of the invoice. Trust-to-general 
transfers are included in the Total Paid value according to the date of the transfer, if the 
transfer occurs at the time of billing or is applied to an existing A/R balance. A trust-to-
general transfer applied to an existing work-in-progress posts the same as a general 
retainer. A general retainer is not included in the Total Paid value until the retainer is 
applied to an invoice. The Productivity by Client report must include both the date the 
retainer was originally entered, and the invoice date, for the retainer to properly by 
included in the Total Paid value.

The Productivity by Client report does not include any summary sections.
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Drill Down
The Productivity by Client report allows drill down on the following areas:

Exhibit 6-29. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Productivity by Client Report
The chart on the following page lists PCLaw reports that reconcile to the Productivity by Client report, and 
the item on the report that can be reconciled. The reports must be run with identical dates and 
parameters.

Drill down on Opens the following window

Billed Fees Billing (Fees) Journal for client

Paid Fees Payment Allocation Listing for client

Unbilled Fees Work-in-Progress for client

Billed Disbs Billing (Fees) Journal for client

Unbilled Disbs Work-in-Progress for client

Total Fees Client Fees Listing

Total Disbs Client Costs Journal

Total A/R Receivables by Client for client

Total Trust Client Trust Listing for client

Total Paid Billing (Fees) Journal for client

Productivity by 
Client

Reconciles to Additional comments

Billed Fees  Billing (Fees) 
Journal

Fees > Total For client only. Select Include Write Ups 
and Write Downs. 

Paid Fees Payment Allocation 
Listing

Fee Tot > Total 
Payments and 
Adjustments

For client only. Run report for client.

Unbilled Fees Client Ledger Unbilled > Fees For client only. Run report for client.

Client Summary Unbd Fees For client only. Productivity by Client must 
have start date of 1/1/82.

Client Fees Listing Summary by 
Working Lawyer > 
Fees > Unbilled > 
Firm Totals.

For client only. Run report for client. 
Deselect Billed Items. 

Work-in-Progress Total > Fees For client only.

Client WIP, 
Billing,& Collection 
Summary

W.I.P. > Time For client only. 

Billed Disbs  Billing (Fees) 
Journal

Disbs> Total For client only. Select Include Write Ups 
and Write Downs.
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Exhibit 6-30. Table displaying the different reports and their sections that reconcile to the Purchases Journal 

Productivity by 
Client

Reconciles to Additional comments

Unbilled Disbs Client Ledger Unbilled > Che + 
Unbilled > Recov

For client only. Run report for client.

Client Summary Unbd Disbs For client only. Productivity by Client must 
have start date of 1/1/82.

Client WIP, Billing, 
& Collection 
Summary

W.I.P. > Disb For client only. 

Total Fees Client Ledger Unbilled > Fees + 
Billed > Fees

For client only. Run report for client.

Client Summary Unbd Fees + Bd 
Fees

For client only. Productivity by Client must 
have start date of 1/1/82.

Client Fees Listing Summary by 
Working Lawyer > 
Fees > Total> Firm 
Totals.

For client only. Run report for client. Select 
Billed Items. Select Unbilled Items. 

Total Disbs Client Ledger Unbilled > Che + 
Unbilled Recov + 
Billed >Disbs

For client only. Run report for client.

Client Summary Unbd Disbs + Bd 
Disbs

For client only. Productivity by Client must 
have start date of 1/1/82.

Total A/R Billing (Fees) 
Journal

Outstanding > Total For client only. Run report for the client. 
Both reports must have a start date of 1/1/
82.

Receivables by 
Client

Total > Client Total For client only. Productivity by Client report 
must have a start date of 1/1/82.

Total A/R (cont’d) Client Ledger Balances > A/R > 
End Date

For client only. Run report for client. Both 
reports must have a start date of 1/1/82.

Client Summary A/R Bal For client only. Productivity by Client must 
have a start date of 1/1/82.

Total Trust Client Ledger Balances > Trust For client only. Run report for client.

Client Summary Trust > Balance For client only. Productivity by Client must 
have a start date of 1/1/82.

Client Trust Listing Matter Total > Total 
for Client

For client only. Productivity by Client must 
have a start date of 1/1/82.

Total Paid Payment Allocation 
Listing

Total > Total 
Payments and 
Adjustments

For client only. Run report for client. Both 
reports must have a start date of 1/1/82.
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The Productivity by Client report does not reconcile to the Client Ledger, Client Summary, Client Fees 
Listing, or Client WIP, Billing, & Collection Summary for Billed Fees for the Productivity by Client report 
includes transactions by invoice date whereas the latter reports include transactions according to the date 
the transaction was posted.

The Productivity by Client report does not reconcile to the Client Ledger, Client Summary or Client Costs 
Journal for Billed Disbs for the Productivity by Client report includes transactions by invoice date whereas 
the latter three reports include transactions according to the date the transaction was posted.

The Productivity by Client report does not reconcile to the Client WIP, Billing, & Collection Summary for 
Billed Disbs for the Client WIP report includes taxes with disbursements.

The Productivity by Client report does not reconcile to the Billing (Fees) Journal for Fees Paid or Total Paid 
for the Productivity by Client report is compiled by payment date whereas the Billing (fees) Journal is 
compiled by invoice date. 

The Productivity by Client report does not reconcile to the Work-in-Progress report for Unbilled Disbs for 
the Work-in-Progress report includes general retainers.

The Productivity by Client report does not reconcile to the Client Costs Journal for Total Disbs for the 
Client Costs Journal does not provide client totals.

The Productivity by Client report does not reconcile to the Payment Allocation Listing for Total Paid for a 
start date other than 1/1/82, for the Productivity by Client report takes into consideration when a General 
Retainer is first posted in its calculations, whereas the Payment Allocation Listing considers only when the 
retainer is applied.
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Billing Realization Report
The Billing Realization report lists billed hours, fees, and adjustments added at the time of billing, or after the 
bill is created. The report is summarized by working lawyer by matter. Given are actual fees realized and the 
percent collected for the month. The report provides working lawyers, responsible lawyers, and types of law 
by the actual effective rate and realized dollars.

What Entries Appear on the Report
Time values appear on the Billing Realization report through the following features:

Adjustments appear on the Billing Realization report through the following features:

Billed values include time and fee entries, fee adjustments at the time of billing, and write ups/down to 
invoices after they are created.

Fee adjustments, allocated to lawyers who do not already have time or fee entries posted to the matter, are 
included as Time > Values. Write-offs, allocated to lawyers that do not already have time or fee entries posted 
to the matter, appear as a Time > Value and Fees > Adjustments. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. 

Exhibit 6-31. The Common tab of the Billing Realization report 

Matter: To view fees realized for a single matter, select the matter nickname.

Client: To view fees realized for matters belonging to a specific client, type or select the client 
name.

Resp Lawyer: To view fees realized for matters assigned to a specific responsible lawyer, type or select 
the lawyer nickname.

Start Date: To view fees realized on or after a specified date, select the date.

End Date: To view fees realized on or prior to a specified date, select the date.

Matter Totals Only: To view matter totals only without working lawyer amounts, select this check box. 

Client Totals Only: To view client totals only without working lawyer amounts, select this check box.

Firm Totals Only: To view only firm totals and the summary sections, select this check box.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Phone Call Manager
• Calendar/Appointment Sheet • Matter Opening Balances • Matter Manager > Time/Ledger tabs.

• Create Bill • Quick Bill • Release Bill.

Pull-down menu: Reports > Productivity > Billing Realization Report > Common Tab



Billing Realization Report

Page 191

Exclude Matters with Zero Time: To include only matters that have time entries, select this check box.

Matters that have no entries, or only fee entries, fee adjustments and/or fee write-offs 
during the report period but no time entries are not included on the report.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Billing Realization report provides a comparison of fees billed to fees collected or written off by fee 
credit lawyer.

Exhibit 6-32. An excerpt from the Billing Realization report 

Client, Name: Displays the client nickname and the client last and first name or client firm name.

Matter: Displays the associated matters, by nickname, to the client.

Description: Displays the matter description as it appears in Matter Manager.

Resp Lwyr: Displays the nickname of the matter’s responsible lawyer.

Law Type: Lists the type of law assigned to the matter.

Wkg Lwyr: Displays the fee credit lawyer if Matter Totals Only is deselected.

Hours: Displays billed hours.

Value: Includes both time and fee entries. If Exclude Matters with Zero Time is selected, the 
Value column displays only time entries. The Hours column is not affected by this 
option. Entries comprising both the Hours and Value amounts are included on the 
Billing Realization report according to the date the transaction was billed, and not 
when the individual time or fee entry was posted.

Adjustments: Includes adjustments to fees at the time of billing and write-offs of fees charged to the 
lawyer after the time of billing. The write-offs do not necessary have to pertain to fees 
originally posted by the lawyer, but instead to how the write-downs were allocated in 
the Change/Write-off Bill feature. If Exclude Matters with Zero Time is selected, matters 
that have fee adjustments and/or write-downs but do not have any time entries, are 
excluded from the value. Entries comprising the Adjustments amounts appear on the 
Billing Realization report according to the date the adjustment was billed.

Billed: Displays the value of time and fees billed, net of adjustments added at the time of 
billing, and write-offs performed after the bill was created.   If Exclude Matters with 
Zero Time is selected, matters that have fee entries, fee adjustments and/or write-downs 
but do not have any time entries, are excluded from the value. Write-offs that help 
comprise the Billed amounts are included on the Billing Realization report according to 
the date when the write-down is posted. 

% Realized: Divides the Billed amount by the Value amount, to provide the percent actually billed 
of the original time and fees entered for the matter.

Effective Rate/Hr: Provides the effective billing rate by dividing the Billed amount by the Hours amount.
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The Billing Realization report includes the following summary sections:

Exhibit 6-33. Table of the summary sections provided by the Billing Realization report and when they appear. 

Drill Down
The Billing Realization report allows drill down in the following areas:

Exhibit 6-34. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Billing Realization Report
The chart below lists PCLaw reports that reconcile to the Billing Realization report, and the item that can be 
reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-35. Table displaying different reports and their sections that reconcile to the Billing Realization report 

Summary Title Appears when

Summary by Working Lawyer Always appears.

Summary by Responsible Lawyer Always appears.

Summary by Type of Law Always appears.

Drill down on Opens the following window

Matter Information Open Matter

Hours Time Listing

Value Time Listing

Adjustments Fee Adjustments report

Billed Billing (Fees) Journal for matter

Summary by Working Lawyer Billing Realization report for working lawyer

Summary by Responsible Lawyer Billing Realization report for responsible lawyer

Summary by Type of Law Billing Realization report for type of law

Billing Realization Reconciles to Additional comments

Summary by 
Working Lawyer > 
Hour

Client Summary Bld Hours For matter and firm.

Client Fees Listing Hours For matter, working lawyer and firm. 
Deselect Unbilled Items.

Time Summary Summary by 
Working Lawyer > 
Hours

For working lawyer and firm. Deselect 
Unbilled Items.

Time Utilization 
Analysis

Total Hours / Firm 
Total Hours

For working lawyer and firm. Deselect 
Unbilled Items.

Value - (all entries) not a reconcilable amount.

Value - (time 
entries)

not a reconcilable amount

Adjustments (all 
entries)

Fee Adjustments 
report

Fees > Adjustments For matter, lawyer, and firm. The value 
reconciles if there are no write-downs 
allocated to a separate lawyer. If there are, 
then this is not a reconcilable value. 

Adjustments (time) not a reconcilable amount

Fees > Billed (all 
entries)

Billing (Fees) 
Journal

Billed > Fees For matter, lawyer, or firm. Select Include 
Write-Ups and Write-Downs on the Billing 
(Fees) Journal.

Client Ledger Billed > Fees For matter or firm

Client Summary Bld Fees For matter or firm

Fees > Billed (time) Not a reconcilable amount
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The Billing Realization report does not reconcile to the Time Listing and Comparative Time Analysis 
reports for Hours or Value, for the latter two reports do not differentiate between billed and unbilled time.

The Billing Realization report does not reconcile to the Daily Time Summary for Hours, for the Daily Time 
Summary do not differentiate between billed and unbilled time.

The Billing Realization report does not reconcile to the Client Summary and Client Ledger for Value, for 
the latter two reports include fee adjustments and write-offs in the billed fees value.

The Billing Realization report does not reconcile to the Client Fees Listing for Value, for the Client Fees 
Listing do not differentiate between time and fees.

The Billing Realization report does not reconcile to the Collection Summary for Value, for the Collection 
Summary includes adjustments and write-offs in its Net Billed > Fees value.

The Billing Realization report does not reconcile to the Client WIP, Billing, & Collection Summary for Fees 
Billed for the Billing Realization report is created by fee credit lawyer, where the Client WIP report is 
created by responsible lawyer.

The Billing Realization report does not reconcile to the Lawyer WIP, Billing, & Collection Summary for 
Fees Billed for the Lawyer WIP report includes fee adjustments in its Billed > Fees value.

The Billing Realization report does not reconcile to the Fee Adjustments report for Adjustments when 
Exclude Matters with Zero Time is selected, for the Fee Adjustments report includes these values.   

The Billing Realization report may not reconcile to the Fee Adjustments report for Adjustments when 
Exclude Matters with Zero Time is deselected, for if there are write-downs to lawyers other than the 
existing fee credit lawyer, the value of the write-downs are included as adjustments on the BIlling 
Realization report.

The Billing Realization report does not reconcile to the Invoice Journal for Fees Billed for the Invoice 
Journal does not differentiate between write-downs on fees, disbursements and taxes.
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Client WIP, Billing, & Collection Summary
The Client WIP, Billing, & Collection Summary provides a summary by matter and client of unbilled and 
billed time and disbursements, including the billing collected and written off.

What Entries Appear on the Report
Time work-in-progress values appear on the Client WIP, Billing, & Collection Summary through one of the 
following features:

Fee adjustments, time added at the time of billing, and write ups/downs of billed time are not included on the 
report.

Disbursement values appearing on the Client WIP, Billing, & Collection Summary are added or modified 
through one of the following features:

Billing values appearing on the Client WIP, Billing, & Collection Summary are added through one of the 
following features:

Collection values appearing on the Client WIP, Billing, & Collection Summary are added or modified through 
one of the following features:

A write-off value appears on the Client WIP, Billing, & Collection Summary through the Change/Write off Bill 
feature. For the Accrual accounting method, provisional write-offs are not included in the Write-offs section.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-36. The Common tab of the Client WIP, Billing, & Collection Summary 

Matter: To view values for a single matter, type or select the matter nickname.

Client: To view values for matters belonging to a specific client, type or select the client name.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Global Change Time
• Calendar/Appointment Sheet • Matter Opening Balances • Phone Call Manager
• Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

• Expense Recovery • General Check/Release Check • New/Open Payable
• Matter Opening Balances • Register > Expense/General/AP/Ledger tabs.

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • Trust-to-General Transfer (applied to existing A/R balances)
• Register > General Tab • Create Bill/Release Bill • Quick Bill.

Pull-down menu: Reports > Productivity > Client WIP, Billing & Collection Summary > Common Tab
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Resp Lawyer: To view values for matters assigned to a specific responsible lawyer, type or select the 
lawyer nickname.

Start Date: To view values on or after a specific date, select the date.

End Date: To view values on or prior to a specific date, select the date.

Matter Totals: To display only totals for each matter, select this check box.

Client Totals Only: To display only client totals and the summary sections checked under the Other tab, 
select this check box.

Firm Totals Only: To display only the summary sections checked on the Other tab, select this check box.

Show Billings and Write-offs Separately: To display write-offs in a separate column, select this option.

Include W/O’s in Billings: To display billing values net of write-offs, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

 The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 6-37. The Other tab of the Client WIP, Billing, & Collection Summary 

Summary By: If preferred, select one or more of the following:

Responsible Lawyer: To include a Summary by Responsible Lawyer section, select this 
check box.

Client Introducing Lawyer: To include a Summary by Client Introducing Lawyer 
section, select this check box.

Matter Introducing Lawyer: To include a Summary by Matter Introducing Lawyer 
section, select this check box.

Type of Law: A Summary by Type of Law section, select this check box.

Show by Matter Introducing Lawyer: To display the matter introducing lawyer(s) on the report in place of 
the responsible lawyer, select this check box.

The Show by Matter Introducing Lawyer option is not available if Client Totals Only or 
Firm Totals Only is selected.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Productivity > Client WIP, Billing & Collection Summary > Other Tab
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The Report
The Client WIP, Billing & Collection Summary reports the work-in-progress, billing prior to write-offs, and 
collections by matter, client, or firm.

Exhibit 6-38. An excerpt from the Client WIP, Billing, & Collection Summary

Client Name: Displays the client last and first or the client firm name.

Matter: Displays the matter nickname. Column is not available if Client Totals Only is selected.

Description: Displays the matter description as it appears in Matter Manager. Column is not available if 
Client Totals Only is selected.

Resp Lwyr: Displays the matter’s responsible lawyer. Column is not available if Show by Matter 
Introducing Lawyer or Client Totals Only is selected.

Law Type: Displays the type of law assigned to the matter. Column is not available if Show by Matter 
Introducing Lawyer or Client Totals Only is selected.

Matt Int Lwyr: Displays the matter introducing lawyers credited to the matter and displays their allocation 
percentage. WIP, billing, and collection information is displayed for each lawyer according 
to their percentage. This column is only available if Show by Matter Introducing Lawyer is 
selected. This column is not available if Client Totals Only is selected.

Client Int Lwr: Displays the client introducing lawyer nickname for each client. This column is available 
only when Client Totals Only is selected.

WIP: This section provides columns for unbilled time and fees, and unbilled disbursements.

Billings: This section provides columns for billed fees, and for billed disbursements and applied 
taxes. 

If Show Billings and Write-offs Separately is selected, the billing totals are comprised of the 
original invoices. 

If Include Write-Offs in Billing is selected, the billing totals are comprised of the original 
invoices less any write-offs that occur prior to the end date of the report.

Write-offs appear in the Billing section of the report according to the date of the invoice 
and not the date of the write-off.

Collections: This section provides columns for payments applied to fees and payments applied to 
disbursements and taxes. Payments appear on the report according to the payment date 
and not the date of the invoice.

Write-offs: This section provides columns for write-offs of fees and write-offs of disbursements and 
taxes. The Write-offs section appears only if Show Billings and W/O separately is selected. 

The Client WIP, Billing, & Collection Summary includes the following summary sections:

Exhibit 6-39. Table of the summary sections provided by the Client WIP, Billing, & Collection Summary and when they appear

Summary Title Appears when

Summary by Responsible Lawyer Optional, as selected by user.

Summary by Client Introducing Lawyer Optional, as selected by user.

Summary by Matter Introducing Lawyer Optional, as selected by user.

Summary by Type of Law Optional, as selected by user.
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Drill Down
The Client WIP, Billing, & Collection Summary allows drill down on the following areas:

Exhibit 6-40. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Client WIP, Billing & Collection Summary
The chart on the following page lists PCLaw reports that reconcile to the Client WIP, Billing & Collection 
Summary, and the item on the report that can be reconciled. The reports must be run with identical dates 
and parameters. 

Drill down on Opens the following window

Client Information Open Matter

WIP section Work-In-Progress report for matter

Billings section Billing (Fees) Journal for matter

Collections section Payment Allocation Listing for matter

Write-Offs section Write Up/Down Journal for matter

Summary by Responsible Lawyer Client WIP Billing & Collection Summary for responsible lawyer

Summary by Client Introducing Lawyer Client WIP Billing & Collection Summary for client introducing 
lawyer

Summary by Matter Introducing Lawyer Client WIP Billing & Collection Summary for matter introducing 
lawyer

Summary by Type of Law Client WIP Billing & Collection Summary for type of law

Client WIP, Billing, 
& Collection 
Summary

Reconciles to Additional comments

W.I.P. > 
Time

Work-in-Progress Fee/Time For matter, lawyer, or firm

Client Ledger Unbilled > Fees For matter, client, and firm

Client Summary Unbd Fees For matter, client, and firm

Client Fees Listing Unbilled > Amount No matter or client totals when report run 
for firm

WIP by Resp 
Lawyer

Fees > Total Firm totals only

Matter Status UnBd Fees For matter only

WIP > 
Disbs

Client Ledger Unbilled > Che + 
Recovs

For matter, client, and firm

Client Summary Unbd Disb For matter and firm

Hard & Soft Cost 
Analysis

Soft Cost + Hard 
Cost > Total

Select Unbilled in the Include section
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Exhibit 6-41. Reports and the sections that reconcile to the Client WIP, Billing, & Collection Summary 

Client WIP, Billing 
& Collection 
Summary

Reconciles to Additional comments

Billings > Fees Billing (Fees) 
Journal 

Firm Summary > 
Billed > Fees

For matter, lawyer or firm. Select Show 
Billings and Write-Offs Separately. On 
Billing (Fees) Journal, select Include Paid 
Invoices, deselect Include Write Ups and 
Write Downs.

Invoice Journal Fees For matter, responsible lawyer, and firm.   
Select Show Billings and Write-Offs 
Separately

Collection 
Summary

Net Billed > Fees For firm only. Run report for calendar 
month. Select Write-Offs in Billings.

Billings Disb + Tax Billing (Fees) 
Journal

Firm Summary > 
Billed > Disb and 
Tax values

For matter, lawyer or firm. Select Show 
Billings and Write-Offs Separately. On 
Billing (Fees) Journal, select Include Paid 
Invoices, deselect Include Write Ups and 
Write Downs.

Invoice Journal Disbs + GST + Sales 
Tax values

For matter, responsible lawyer, and firm.   
Select Show Billings and Write-Offs 
Separately

Collection 
Summary

Net Billed > Disb + 
Tax

For firm only. Run report for calendar 
month. Select Write-Offs in Billings.

Lawyer WIP Billing 
& Collection 
Summary

Billings > Disb + 
Tax

For responsible lawyer and firm. Run report 
for calendar month. Select Show Billings 
and Write-Offs Separately

Cash In > Retainers 
/Cash In > Receipts

Billing (Fees) 
Journal

Retainers/Receipts 
> Total (this month) 
less Retainers/
Receipts Totals 
(previous month)

For firm. Run Billing (Fees) Journal from 1/
1/82 to end of current month.   Minus the 
Retainer/Receipts totals of previous month 
from current month

Collections > Fees Payment Allocation 
Listing

Summary by 
Responsible Lawyer 
> Fees

For responsible lawyer or firm. 

Fees Collected 
Summary

Fees Collected As 
Resp. Lawyer > This 
Month

For responsible lawyer or firm for month or 
YTD only. 

Collections > Disb 
+ Tax

Payment Allocation 
Listing

Summary by 
Responsible 
Lawyer> Disb and 
Tax values

For responsible lawyer or firm

Collection 
Summary

Payment Used > 
Disb + Tax

For responsible lawyer and firm. Run report 
for calendar month. 

Lawyer WIP, Billing 
& Collection 
Summary

Collections > Disb 
+ Tax

For responsible lawyer and firm. Run report 
for calendar month
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The Client WIP, Billing, & Collection Summary does not reconcile to the Client Costs, Disbursement 
History, Time Listing, or Time Summary reports as these reports cannot be run for unbilled transactions 
only.

The Client WIP, Billing, & Collection Summary does not reconcile to the Work-in-Progress or WIP by 
Responsible Lawyer reports for W.I.P. Disbursements for the latter reports include unapplied general 
retainers.

The Client WIP, Billing, & Collection Summary does not reconcile to the Collection Summary or the 
Lawyer WIP, Billing, & Collection Summary for payments applied to fees, as the Client WIP, Billing & 
Collection Summary is created for responsible lawyer, whereas the Collection Summary and Lawyer WIP, 
Billing, & Collection Summary are created for fee credit lawyer.

The Client WIP, Billing, & Collection Summary does not reconcile to the Write Up/Down Journal for 
write-offs are included on the Client WIP, Billing & Collection Summary according to the date of the 
invoice that the write-off applies. Write downs of fees cannot be compared on the two reports for the 
Client WIP, Billing & Collection Summary displays write-down of fees by responsible lawyer whereas the 
Write Up/Down Journal displays write-down of fees by fee credit lawyer.
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Fees Collected Summary
The Fees Collected Summary provides a monthly and year to date analysis of fees collected by lawyer as fee 
credit and responsible lawyers. A comparison of current and previous year to date values are provided 
included the percentage of change between the two years.

What Entries Appear on the Report
A payment value appears on the Fees Collected Summary through one of the following features:

The Fees Collected Summary lists payments applied to billing during and after the invoice process. The report 
does not provide information on total billing or write-downs.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-42. The Common tab of the Fees Collected Summary 

Lawyer: To view collection information for a specific lawyer only, type or select the lawyer 
nickname.

Start of Year: To set the start of the year to date period, select the date.

Month: To set the current month to be reported separately, select the month.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Fees Collected Summary reports fees collected for the given month and year to date figures for a start 
month selected when creating the report. 

Exhibit 6-43. An excerpt from the Fees Collected Summary 

• Receive Payment • Trust-to-General Transfer (when applied to an existing A/R balance)
• Create Bill • Quick Bill • Release Bill.

Pull-down menu: Reports > Productivity > Fees Collected Summary > Common Tab
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This Month: Displays fees collected for the selected month for fee credit and responsible lawyer 
respectively.

This YTD: Display fees collected from the beginning of the year as indicated in the Start of Year 
box when creating the report. The values compile up to the current month selected in 
the This Month box when creating the report. Separate values are provided for fee 
credit and responsible lawyer respectively. The start of the year for the Fees Collected 
Summary does not have to correspond with the calendar year or fiscal year for this set 
of books.

Last YTD: Displays fees collected for the same calendar months in the prior year as are used to 
calculate the value for This YTD. Separate values are provided for fee credit and 
responsible lawyer respectively.

% Change: Provides the change between Last YTD and This YTD. The formula used in the 
calculation is (This YTD - Last YTD)/Last YTD.

The Fees Collected Summary does not contain any summary sections.

Drill Down
The Fees Collected Summary allows drill down on the following areas:

Exhibit 6-44. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Fees Collected Summary
The chart on the following page lists PCLaw reports that reconcile to the Fees Collected Summary, and the 
item on the report that can be reconciled. The reports must be run with identical dates and parameters.

Drill down on Opens the following window

Fees Collected as Fee Credit Lawyer section Payment Allocation Listing dated for This YTD for selected 
allocating lawyer

Fees Collected as Responsible Lawyer 
section

Payment Allocation Listing dated for This YTD for selected 
responsible lawyer

Fees Collected 
Summary

Reconciles to Additional comments

Fees Collected as Fee Credit Lawyer

This Month Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer

For lawyer or firm. Run report for Calendar 
Month.

Collection 
Summary

Payment Used > 
Fees

For lawyer. Refer to calendar month under 
Month column.

Lawyer WIP, Billing, 
& Collection 
Summary

Collections > Fees For lawyer and firm. Run report for 
calendar month.

Fees Due by Lawyer 
report

Report Period > 
Fees Rcvd

For lawyer and firm. Run report for 
calendar month.
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Fees Collected 
Summary

Reconciles to Additional comments

This YTD Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer

For lawyer or firm. Run Payment Allocation 
Listing for identical calendar months as 
Fees Collected Summary. 

Collection 
Summary

Payments Used > 
Fees

For lawyer or firm. Run Collection 
Summary for identical calendar months as 
Fees Collected Summary.

Lawyer WIP, Billing, 
& Collection 
Summary

Collections > Fees For lawyer or firm. Run Lawyer WIP & CS 
for identical calendar months as Fees 
Collected Summary.

Fees Due by Lawyer 
report

Report Period > 
Fees Rcvd

For lawyer and firm. Run Fees Due by 
Lawyer for identical calendar months as 
Fees Collected Summary.

Last YTD Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer

For lawyer or firm. Run Payment Allocation 
Listing for identical calendar months as 
Fees Collected Summary.

Collection 
Summary

Payment Used > 
Fees

For lawyer or firm. Run Collection 
Summary for identical calendar months as 
Fees Collected Summary.

Lawyer WIP, Billing, 
& Collection 
Summary

Collections > Fees For lawyer or firm. Run Lawyer WIP & CS 
for identical calendar months as Fees 
Collected Summary.

Fees Due by Lawyer 
report

Report Period > 
Fees Rcvd

For lawyer and firm. Run Fees Due by 
Lawyer for identical calendar months as 
Fees Collected Summary.

Fees Collected as Responsible Lawyer

This Month Payment Allocation 
Listing

Summary by 
Responsible Lawyer

For lawyer or firm. Run report for calendar 
month.

Client WIP, Billing, 
& Collection 
Summary

Summary by 
Responsible Lawyer 
> Collections > Fees

For lawyer or firm. Run report for calendar 
month. 

This YTD Payment Allocation 
Listing

Summary by 
Responsible Lawyer

For lawyer or firm. Run Payment Allocation 
Listing for identical calendar months as 
Fees Collected Summary.

Client WIP, Billing, 
& Collection 
Summary

Summary by 
Responsible Lawyer 
> Collections > Fees

For lawyer or firm. Run Client WIP & CS for 
identical calendar months as Fees 
Collected Summary. 

Last YTD Payment Allocation 
Listing

Summary by 
Responsible Lawyer

For lawyer or firm. Run Payment Allocation 
Listing for identical calendar months as 
Fees Collected Summary.

Client WIP Billing & 
Collection 
Summary

Summary by 
Responsible Lawyer 
> Collections > Fees

For lawyer or firm. Run Client WIP & CS for 
identical calendar months as Fees 
Collected Summary. 
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The Fees Collected Summary does not reconcile to the Billing (Fees) Journal or Invoice Journal for 
payments received on the latter two reports are only for invoices included on the report.

The Fees Collected Summary does not reconcile to the Collection Summary, Lawyer WIP, Billing, & 
Collection Summary, or Fees Due by Lawyer report for Fees Collected as Responsible Lawyer, as the latter 
three reports are created for fee credit lawyers only.

The Fees Collected Summary does not reconcile to the Client WIP, Billing, & Collection Summary for Fees 
Collected as Fee Credit Lawyer as the latter report is created for responsible lawyer only.

The Fees Collected Summary does not reconcile to the Fee Allocation Summary. Fees manually allocated 
at the time of billing take precedence on the Fees Collected Summary over allocation percentages under 
the Open Matter > Collections tab, and the Income Allocation Percentage under the Lawyers and Rates > 
Accounting Tab. For the Fee Allocation Summary, the allocation percentages override any manual 
allocation made under the Allocation button of the Billing Information window.

The Fees Collected Summary does not reconcile to the General Ledger for the lawyer fee accounts as 
payments may be manually allocated to the respective G/L accounts.
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Fee Adjustments Report
The Fee Adjustments report records adjustments to fees made at the time of billing not including new time 
entries added at the time of billing. Adjustments are summarized by working lawyer, responsible lawyer, and 
type of law.

Defining a Fee Adjustment
A fee adjustment is an increase or decrease to fees at the time of billing. A fee adjustment can take the form 
of:
• A fee increase or decrease allocated to one or more lawyers under the Allocation button in the Billing 

Information window.
• A fee increase allocated to one or more lawyers under the Calculator button in the Billing Information 

window.
• A contingency fee assigned to one or more lawyers under the Cntngncy button in the Billing Information 

window.
• A fee increase or decrease to which no allocation is made under the Allocation button and A Fee Entry 

is selected under the Explanation For Fee Adjustment window.

Exhibit 6-45. The Explanation for Fee Adjustment window provided when changing fees at the time of billing

• A fee increase or decrease to which no allocation is made under the Allocation button and Discount is 
selected under the Explanation For Fee Adjustment window.

The following are not considered to be fee adjustments:
• An increase or decrease to fees performed through the Change/Write Off Bill feature.
• The assigning of fees performed through the Quick Bill feature.

• An increase or decrease to fees at the time of billing, allocated through the Details button on the Billing 
Information window. 

 The Details button allows the user to assign lawyers, hours, rates and explanation to fee changes. As 
a result, the entry is treated as a time or fee entry and not an adjustment.
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The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-46. The Common tab of the Fee Adjustments report 

Working Lawyer: To run the report for a specific fee credit lawyer, type or select the lawyer nickname. 

If an allocation is not made at the time of billing, the change in fees is assigned to the 
responsible lawyer.

If an allocation is made on the Billing Information window, the lawyer(s) to whom the 
allocations are made are considered the fee credit lawyer(s).

Show By: Select one of the following:

Task Code: To include a Summary by Task Code section, select this option.
The adjacent box becomes available.

To list adjustments for a single task code, type or select the task code.

Type of Law: To include a Summary by Type of Law section on the report, select 
this option.
The adjacent box becomes available.

To list adjustments for single type of law, type or select the type of 
law.

Start Date: To see only adjustments made after a specific date, select the date.

End Date: To see only adjustments made before a specific date, select the date.

Sort By: Select one of the following:

Order Entered: To sort adjustments by entry number, select this option.

Date: To sort adjustments by date, select this option.

Fee Credit Lawyer: To sort adjustments by fee adjustment lawyer, select this option.

Task Code: To sort adjustments by task code, select this option. Task Code needs 
to be selected in the Show By area.

Type of Law: To sort adjustments by type of law, select this option. Type of Law 
needs to be selected in the Show By area.

Pull-down menu: Reports > Productivity > Fee Adjustments Report > Common Tab
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Daily Totals: To include a Daily Totals by Lawyer summary section, select this check box. 

Totals Only: To display the summary sections only, select this check box.

Show User Name: To display the user that created each individual entry, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Fee Adjustments report displays all fee changes made at the time of billing, that are not converted to time 
entries. 

Exhibit 6-47. Excerpt from the Fee Adjustment report 

Date: Displays the date of the invoice containing the adjustments.

Entry #: Displays the sequential entry number assigned to the adjustments. The numbers come after 
the entry number for the invoice.

Matter: Displays the matter nickname.

Client: Displays the client nickname.

Description: Displays the matter description as it appears in Matter Manager.

Lawyer: Displays the fee credit lawyer to whom the fees are adjusted.

Task: Displays the task code assigned the fee adjustment.

Resp Lawyer: Displays the responsible lawyer for the matter.

Law Type: Displays the type of law assigned to the matter.

Inv: Displays the invoice number on which the adjustment occurs.

Fee Adjustment: Each fee adjustment is listed separately, increases in the Up column, decreases in the 
Down column. 

Net Total: Lists the net adjustment for the fee credit lawyer when Sort by Working Lawyer is enabled.

The description entered in the Explanation for Fee Adjustment box during billing is not transferred to the Fee 
Adjustments report.

The Fee Adjustment report includes the following summary sections:

Exhibit 6-48. Table of the summary sections provided by the Fee Adjustment report and when they appear 

Summary Title Appears when

Summary by Task Code Show by Task Code is selected under the Common tab.

Summary by Type of Law Show by Type of Law is selected under the Common tab.

Daily Totals by Lawyer Daily Totals is selected under the Common tab.

Summary by Working Lawyer Always appears.

Summary by Responsible Lawyer Always appears.
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Drill Down
The Fee Adjustments report does not offer the drill down option.

Reconciling the Fee Adjustments Report
Since no other report displays the information that the Fee Adjustments report does in the same format, 
the Fee Adjustments report cannot be reconciled with other PCLaw reports.

The chart below lists other PCLaw reports that display fee adjustments, and the format that the adjustments 
appear.

Exhibit 6-49. Table displaying different reports and their sections that reconcile to the Fee Adjustment report 

Report How the adjustment appears Additional comments

Client Ledger Total adjustment is always displayed as 
allocated to responsible lawyer despite 
how it was entered at billing.

Report cannot show adjustments only.

Client Fees Listing Adjustment is shown by allocation as 
entered at the time of billing.

Report cannot show adjustments only.

Billing (Fees) Journal Adjustments included in invoice totals. Fee adjustments cannot be viewed on 
the journal.

Invoice Journal Adjustments included in invoice totals. Adjustments are not included in the 
Write-Off column.

Write Up/Down Journal Adjustments do not appear on the 
journal.

Adjustments do not fit the criteria for a 
write up or write down.

Fee Allocation Summary Adjustments included in invoice totals. Report cannot show adjustments only.

Billing Realization Adjustments included in matter totals. Report cannot show adjustments only.
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Fee Allocation Summary
The Fee Allocation Summary displays fees billed, collected and written off by lawyer for each matter. Values 
are divided into work performed by that lawyer and by all other lawyers for the same matters.The lawyer is 
categorized into client introducing, responsible, introducing and responsible, and fee credit lawyer.    

Unlike other PCLaw reports, fees allocated at the time of billing do not override the allocation percentages on 
the Matter Manager > Billing tab.

What Entries Appear on the Report
Billed fees appear on the Fee Allocation Summary through one of the following features: 

Payment values appear on the Fee Allocation Summary through one of the following features:

Write-off values appear on the Fee Allocation Summary through Change/Write Off Bill.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-50. The Common tab of the Fee Allocation Summary 

Matter: To view fee allocation details for a single matter, type or select the matter nickname.

Client: To view fee allocation details for matters belonging to a single client, type or select the 
client nickname.

Resp Lawyer: To view fee allocation details for matters assigned to a specific responsible lawyer, type or 
select the lawyer nickname.

Start Date: To view fee details on or after a specific date, select the date.

End Date: To view fee details on or prior to a specific date, select the date.

Totals Only: To view only totals for Client Introducing, Responsible, Introducing and Responsible, and 
Fee Credit Lawyers, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • Trust-to-General Transfer (when applied to existing A/R balances)
• Create Bill • Release Bill • Quick Bill.

Pull-down menu: Reports > Productivity > Fee Allocation Summary > Common Tab
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The Report
The Fee Allocation Summary displays fees billed, collected and written off by lawyer category. 

Exhibit 6-51. An excerpt from the Fee Allocation Summary 

Each lawyer is displayed in a separate section on the report. The section is divided into Introducing Only, 
Intro and Resp, Responsible Only, and Fee Credit lawyer headings. If the lawyer does not fit into any one 
of these heading categories, then that category does not appear on the report.

Fees Billed: This section displays total fees billed during the report period prior to write-offs for the 
lawyer and for all other lawyers. 

Fees Collected: This section displays total payments applied to fees during the report period for the 
lawyer and for all other lawyers. 

Fee Write-Offs: This section displays total fees written off during the report period for the lawyer and for 
all other lawyers.

Totals are given for each lawyer and for each heading within a lawyer section.

The Fees Allocation Summary does not contain any summary sections. 

Drill Down
The Fee Allocation Summary allows drill down on the following areas:

Exhibit 6-52. Table displaying fields where drill down is enabled and the reports or features that are opened 

Drill down on Opens the following window

Fees Billed section Billing (Fees) Journal

Fees Collected section Payment Allocation Listing

Fee Write-Offs Write Up/Down Journal
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Reconciling the Fee Allocation Summary
The below chart lists PCLaw reports that reconcile to the Fee Allocation Summary, and the item on the report 
that can be reconciled. The reports must be run with identical dates and parameters.

Fees Allocation 
Summary

Reconciles to Additional comments

Fees Billed > Client 
Introducing Lawyer 
> Self

Invoice Journal Summary by Client 
Introducing Lawyer

For lawyer. Sum of Introducing Only and 
Intro & Resp values.

Billing (Fees) 
Journal

Summary by Lawyer 
> Billed Fees

For lawyer. Sum of Introducing Only and 
Intro & Resp values. Run report for single 
client introducing lawyer. Deselect Include 
Write-offs.

Client WIP, Billing, 
& Collection 
Summary

Summary by Client 
Introducing Lawyer 
> Billings > Fees

For lawyer. Sum of Introducing Only and 
Intro & Resp values. Run reports for 
calendar month.

Fees Billed > 
Responsible Lawyer 
> Self

Invoice Journal Summary by 
Responsible Lawyer

For lawyer. Sum of Responsible Only and 
Intro & Resp values.

Billing (Fees) 
Journal

Summary by Lawyer 
> Billed Fees

For lawyer. Sum of Responsible Only and 
Intro & Resp values. Run report for single 
responsible lawyer. Deselect Include Write-
offs.

Client WIP, Billing, 
& Collection 
Summary

Summary by 
Responsible Lawyer 
> Billings > Fees

For lawyer. Sum of Responsible Only and 
Intro & Resp values. Run reports for 
calendar month.

Fees Billed > Intro & 
Resp Lawyer > Self

Invoice Journal Summary by 
Responsible Lawyer

For lawyer. Run report by one responsible 
lawyer. Select the same lawyer as Client 
Introducing lawyer under the Matter tab.

Billing (Fees) 
Journal

Summary by Lawyer 
> Billed Fees

For lawyer. Run report by one responsible 
lawyer. Select the same lawyer as Client 
Introducing lawyer under the Matter tab. 
Deselect Include Write-offs.

Client WIP, Billing, 
& Collection 
Summary

Summary by 
Responsible Lawyer 
> Billings > Fees

For lawyer. Run report by one responsible 
lawyer. Select the same lawyer as Client 
Introducing lawyer under the Matter tab. 
Run reports for calendar month.

Fees Billed > Fee 
Credit Lawyer > Self

Invoice Journal Summary by Fee 
Credit Lawyer > 
Billings > Fees

For lawyer. 

Fees Collected > 
Client Introducing 
Lawyer > Self

Payment Allocation 
Listing

Summary by Client 
Introducing Lawyer 
> Fees

For lawyer. Sum of Introducing Only and 
Intro & Resp values.    

Fees Collected > 
Responsible Lawyer 
> Self

Payment Allocation 
Listing

Summary by 
Responsible Lawyer 
> Fees

For lawyer. Sum of Responsible Only and 
Intro & Resp values.    
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Exhibit 6-53. Table displaying the different reports and their sections that reconcile to the Fee Allocation Summary 

The Fee Allocation Summary does not reconcile to the Client Fees Listing for the latter report displays time 
and fee values according to the date they were posted, and not when they were billed.

The Fee Allocation Summary does not reconcile to the Collection Summary and Lawyer WIP, Billing, & 
Collection Summary for Fees Billed > Self for client Introducing or responsible lawyer, for the collection 
reports are created for fee credit lawyer.

The Fee Allocation Summary does not reconcile to the Billing (Fees) Journal for fee credit lawyer, even if 
the journal is run for a particular fee credit lawyer because the Summary by Lawyer section on the Billing 
(Fees) Journal is still grouped by responsible lawyer.

The Fee Allocation Summary does not reconcile to the Collection Summary for Fees Billed > Self for fee 
credit lawyer for the Collection Summary includes write-offs in its Billed > Fees values.

The Fee Allocation Summary does not reconcile to the Lawyer WIP, Billing, & Collection Summary, for the 
latter report does not include allocation percentages on the Billing tab of Matter Manager.

The Fee Allocation Summary does not reconcile to the Write Up/Down Journal, Client WIP, Billing, & 
Collection Summary, or the Lawyer WIP, Billing, & Collection Summary for client introducing lawyer, 
responsible lawyer, or fee credit lawyer for the summary sections of the latter three reports, display the 
entire amount of the write off for each lawyer designation. The Fee Allocation Summary only displays the 
write-off portion once for any category. If 25% of a write-down is accorded to the responsible lawyer, that 
portion of the write-down does not appear under the fee credit category for any lawyer, including the 
responsible lawyer.

Fees Allocation 
Summary

Reconciles to Additional comments

Fees Collected > 
Intro & Resp Lawyer 
> Self

Payment Allocation 
Listing

Summary by 
Responsible Lawyer 
> Fees

For lawyer. Run report by one responsible 
lawyer. Select the same lawyer as Client 
Introducing lawyer under the Matter tab. 
Run reports for calendar month.   

Fees Collected > 
Fee Credit Lawyer > 
Self

Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer > 
Fees

For lawyer. 

Fee Write-offs > 
Lawyer Total > Self

Write Up/Down 
Journal

Firm Totals > Fees > 
(lawyer name)

Can reconcile for lawyer totals only, not for 
specific lawyer category.

Lawyer WIP, Billing, 
& Collection 
Summary

Write-Offs > Fees Can reconcile for lawyer totals only, not for 
specific lawyer category.
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Fees Due by Lawyer Report
The Fees Due by Lawyer report provides a period and overall view of fees billed, written off, and collected. 
The current A/R balance is also given for each fee credit lawyer. Use the report to assist in determining 
lawyers draws based on billings and collections. The report is detailed by matter, with each invoice reported 
separately.

What Entries Appear on the Report
Billing values appear on the Fees Due by Lawyer report through the following features:

Payment values appear on the Fees Due by Lawyer report through the following features:

Write-off values appear on the Fees Due by Lawyer report through the Change/Write Off Bill feature.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-54. The Common tab of the Fees Due by Lawyer report 

Fee Credit Lawyer: To view billed, received or written off for a specific fee credit lawyer, type or select the 
lawyer nickname.

Start Date: To view fees billed, received or written off on or after a specified date, select the date.

End Date: To view fees billed, received or written off on or prior to a specified date, select the date.

Totals Only: To view only the Firm Totals summary section, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • Trust-to-General Transfer (to existing A/R balances)
• Create Bill • Release Bill • Quick Bill.

Pull-down menu: Reports > Productivity > Fees Due by Lawyer Report > Common Tab
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The Report
The Fees Due by Lawyer report provides an overview of fees billed, collected, and written off by fee credit 
lawyer. 

Exhibit 6-55. An excerpt from the Fees Due by Lawyer report 

Information appearing on the non-report period section is determined solely by the end date of the report. 
Items posted after the end date of the report are not included on the report. All items prior to the end date 
are included on the report, even if the transactions are posted prior to the start date of the report.

Client: Displays the client last and first name or the client firm name.

 Matter: Displays the matter nickname for which work was billed for the lawyer. 

Inv#: Lists the specific invoice. Since the report is created by fee credit lawyer, the same 
client, matter and invoice can appear for separate lawyers.

Original: Lists the billed fee amount for the lawyer at the time of billing. This column display 
absolute values and are not affected by the dates entered when creating the report.

Write-Offs: Lists any write-offs of fees charged to the lawyer after the time of billing. The write-offs 
do not necessary have to pertain to fees originally posted by the lawyer, but instead to 
how the write-downs were allocated in the Change/Write-off Bill feature. This column 
display absolute values and are not affected by the dates entered when creating the 
report.

Fees Rcvd: Displays payments allocated to fees for the lawyer. This column display absolute values 
and are not affected by the dates entered when creating the report.

Outst.: Provides the value of billed fees for the lawyer that has yet to be collected or written-
off. An invoice with a zero outstanding value for the lawyer does not appear on the 
report unless there is activity for the lawyer in the Report Period section. This column 
display absolute values and are not affected by the dates entered when creating the 
report.

Last Pmt: Displays the date of the last payment applied to the invoice, regardless whether any 
portion of the payment was applied to the particular lawyer’s fees. This column display 
absolute values and are not affected by the dates entered when creating the report.

Period Report: All values in this section are determined by the dates entered when creating the report.

Fees Rcvd: Displays payments allocated to lawyer fees during the report period.

Fees Bld: Displays fees credited to the lawyer, billed during the report period. 

Write-Offs: Lists write-offs of fees charged to the lawyer during the report period. 
Write-offs are allocated in the Change/Write-off Bill feature. 

The Collection Summary includes the following summary section:

Exhibit 6-56.  Table of the summary section provided by the Fees Due by Lawyer report and when it appears 

Summary Title Appears when

Firm Totals always appears.
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Drill Down
The Fees Due by Lawyer report allows drill down in the following areas:

Exhibit 6-57. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Fees Due by Lawyer report
The chart below lists PCLaw reports that reconcile to the Fees Due by Lawyer report, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-58.  Table displaying the different reports and their sections that reconcile to the Fees Due by Lawyer report 

Drill down on Opens the following window

Original Billing (Fees) Journal for invoice

Cash In section Write Up/Down Journal for matter

Fees Rcvd no drill down available

Outst no drill down available

Last Pmt no drill down available

Report Period no drill down available

Firm Totals Fees Due by Lawyer report for selected lawyer

Fees Due by Lawyer 
report

Reconciles to Additional comments

Original Billing (Fees) 
Journal

Fees > {lawyer 
name}

For invoice and lawyer. Run Billing (Fees)   
Journal for all dates. Select Include Paid 
Invoices. Deselect Include Write Ups and 
Write Downs.

Write-Offs Write-Up/Down 
Journal

Change > {lawyer 
name}

For invoice only. Run Write Up/Down 
Journal for all dates.

Outst Billing (Fees) 
Journal

Outstand > {lawyer 
name}

For invoice only. Run Billing (Fees) Journals 
for all dates. Select Include Paid Invoices. 
Select Include Write Ups and Write 
Downs.

Report Period > 
Fees Bld

Billing (Fees) 
Journal

Fees > {lawyer 
name}

For invoice and lawyer. Run Billing (Fees) 
Journal for report period. Select Paid 
Invoices. Deselect Include Write Ups and 
Write Downs.

Report Period > 
Write-Offs

Write Up/Down 
Journal

Change > {lawyer 
name}

For invoice only. Run Write Up/Down 
Journal for report period.
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The Fees Due by Lawyer report does not reconcile to the Invoice Journal for invoice amounts for the 
Invoice Journal does not separate billed fees by fee credit lawyer. 

The Fees Due by Lawyer report does not reconcile to the Invoice Journal for total billed fees for fee credit 
lawyer, for the Fees Due by Lawyer report may not include invoices where there is no outstanding 
balance. The Invoice Journal includes all invoices, paid and unpaid.

The Fees Due by Lawyer report does not reconcile to the Collection Summary for billed fees, or receipts 
for the Fees Due by Lawyer report may not include invoices where there is no outstanding balance. The 
Collection Summary also includes write-offs in its billed fees values.

The Fees Due by Lawyer report does not reconcile to the Client WIP, Billing, & Collection Summary for 
billed fees, write-offs, or receipts for the Fees Due by Lawyer report is created by fee credit lawyer, where 
the Client WIP report is created by responsible lawyer.

The Fees Due by Lawyer report does not reconcile to the Lawyer WIP, Billing, & Collection Summary for 
billed fees, write-offs, or receipts, for the Fees Due by Lawyer report may not include invoices that do not 
have an outstanding receivables balance.

The Fees Due by Lawyer report does not reconcile to the Write Up/Down Journal for total write-offs for fee 
credit lawyer for the Fees Due by Lawyer report may not include invoices where there is no outstanding 
receivables balance.

The Fees Due by Lawyer report does not reconcile to the Payment Allocation Listing or Fees Collected 
Summary for receipts, for the Fees Due by Lawyer report may not include invoices where there is no 
outstanding receivables balance and the latter two reports do not group payments by invoice number.
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Firm Cash & Fee Summary
The Firm Cash & Fee Summary provides hours and fees docketed, fees billed, payments allocated to fees, and 
adjustments made to fees after billing for each fee credit lawyer. The values are displayed for the selected 
calendar month, as well as year to date, where the start of the year is determined when creating the report. 
Matter and invoice detail is not provided.

What Entries Appear on the Report
Fee values are included on the Firm Cash & Fee Summary through one of the following features:

Fee adjustments, time added at the time of billing, and write ups/downs of billed time are included on the 
report as part of the fee value.

Fees Billed values are included on the Firm Cash & Fee Summary through one of the following features:

Fees Collected totals are included on the Firm Cash & Fee Summary through one of the following features:

A write-off value appears on the Firm Cash & Fee Summary through the Change/Write off Bill feature. For the 
Accrual accounting method, provisional write-offs are not included in the Write-offs section.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-59.  The Common tab of the Firm Cash & Fee Summary 

Fee Credit Lawyer: To view fee information for a specific fee credit lawyer, type or select the lawyer. 

Start of Year: To set the start of the year to specific month, select the month.

Month: To set the current month to appear on the report, select the month.

The current month represents the last month information appears on the report. 
Transactions dated after the current month are not included on the report.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Create Bill/Quick Bill/Release Bill 
• Calendar/Appointment Sheet • Matter Opening Balances • Phone Call Manager
• Change/Write Off Bill • Matter Manager > Time/Ledger tabs.

• Create Bill/Release Bill • Quick Bill • Matter Opening Balances.

• Receive Payment • Trust-to-General Transfer (to existing A/R Balances)
• Register > General tab • Create Bill/Release Bill • Quick Bill.

Pull-down menu: Reports > Productivity > Firm Cash & Fee Summary > Common Tab
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The Report
The Firm Cash & Fee Summary provides an overview of fees billed, collected, and written off by fee credit 
lawyer.

Exhibit 6-60. An excerpt from the Firm Cash & Fee Summary 

Lawyer: Lists the nickname and name for each fee credit lawyer that has activity in the selected 
month or year. 

Hours: This section displays docketed hours for the current month and selected year.

Fee Value: This section displays time, fees, and adjustments recorded for both the current month 
and the selected year. The Fee Value includes time and fees entered prior to the time of 
billing, time and fee adjustments entered at the time of billing, and write-offs to fees 
after billing. The Fee value also includes non-billable tasks.

Fees Billed: This section displays fees billed during the current month and selected year. The Fees 
Billed value is determined by the A/R date of the invoice and not when the fees were 
originally posted.

Fees Collected: This section displays the value of payments applied to fees during the current month 
and selected year.

Fee Write-Offs: This section displays write-offs of fees for the current month and selected year.

The Firm Cash & Fee Summary does not contain any summary sections.

Drill Down
The Firm Cash & Fee Summary allows drill down in the following areas:

Exhibit 6-61. Table displaying fields where drill down is enabled and the reports or features that are opened 

Drill down on Opens the following window

Hours no drill down available

Fee Value Time Listing for working lawyer

Fees Billed Billing (Fees) Journal for fee credit lawyer

Fees Collected Payment Allocation Listing for allocated lawyer

Fee Write-Offs Write Up/Down Journal for assigned lawyer
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Reconciling the Firm Cash & Fee Summary
The chart below lists PCLaw reports that reconcile to the Firm Cash & Fee Summary. The reports must be run 
with identical dates and parameters.

Exhibit 6-62.  Table displaying the different reports and their sections that reconcile to the Allocation Listing 

Firm Cash Fee 
Summary

Reconciles to Additional comments

Hours Time Listing Summary by 
Working Lawyer > 
Hours

For lawyer and firm.

Time Summary Summary by 
Working Lawyer > 
Hours

For working lawyer and firm.

Time Utilization 
Analysis

Total Hours / Firm 
Total Hours

For working lawyer and firm. Include 
billable and non-billable tasks.

Comparative Time 
Analysis

Hours > Totals For working lawyer or firm. Include billable 
and non-billable tasks.

Fee Value Time Summary Summary by 
Working Lawyer > 
Value

For lawyer and firm.

Fees Billed Billing (Fees) 
Journal

Summary by Lawyer 
> Billed > Fees

For lawyer and firm. Run Billing (Fees) 
Journal for all dates. Select Include Paid 
Invoices. Deselect Include Write Ups and 
Write Downs.

Invoice Journal Summary by Fee 
Credit Lawyer > 
Fees

For lawyer and firm. 

Client WIP Billing & 
Collection 
Summary

Collections > Fees For firm only.

Lawyer WIP Billing 
& Collection 
Summary

Collections > Fees For fee credit lawyer and firm. Discount 
PWO on Lawyer WIP report.

Fees Collected Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer > 
Fees

For fee credit lawyer and firm.

Collection 
Summary

Payments Used > 
Fees

For fee credit lawyer or firm.

Fees Collected 
Summary

This Month/This 
YTD

For fee credit lawyer. Payment Allocation 
Listing must be run for calendar month or 
from start of fiscal year.

Client WIP Billing & 
Collection 
Summary

Collections > Fees For firm only.

Lawyer WIP Billing 
& Collection 
Summary

Collections > Fees For fee credit lawyer and firm. Payment 
Allocation Listing cannot be dated for 
partial months.

Fee Write-Offs Write Up/Down 
Journal

Task Code by Fee 
Credit Lawyer

For lawyer and firm. Select Exclude 
Provision for Write-offs.
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The Firm Cash & Fee Summary does not reconcile to the Time Listing, Comparative Time Analysis or 
Client Fees Listing for Fee Value as the latter three reports do not include fee adjustments after the time of 
billing. 

The Firm Cash & Fee Summary does not reconcile to the Client Fees Listing for Fees Billed for the Firm 
Cash & Fee Summary displays billed fees value by A/R date, whereas the Client Fees Listing displays billed 
fees value according to the date that the fee was posted.

The Firm Cash & Fee Summary does not reconcile to the Client Ledger or Client Summary for fee value, 
billed fees, write-offs, or receipts for the Firm Cash & Fee Summary is created by fee credit lawyer, 
whereas the client reports are created by responsible lawyer.

The Firm Cash & Fee Summary does not reconcile to the Collection Summary for billed fees, for the 
Collection Summary includes write-downs in the billed fees values.

The Firm Cash & Fee Summary does not reconcile to the Client WIP, Billing, & Collection Summary for 
lawyer totals for the Firm Cash & Fee Summary is created by fee credit lawyer whereas the Client WIP 
report is created by responsible lawyer.

The Firm Cash & Fee Summary does not reconcile to the Fee Allocation Summary for total write-offs under 
the fee credit lawyer for the Fees Due by Lawyer report may not include invoices where there is no 
outstanding receivables balance.

The Fees Due by Lawyer report does not reconcile to the Payment Allocation Listing or Fees Collected 
Summary for Fees Collected. Fees manually allocated at the time of billing take precedence on the Firm 
Cash & Fee Summary over allocation percentages under the Open Matter > Collections tab, and the 
Income Allocation Percentage under the Lawyers and Rates > Accounting Tab. For the Fee Allocation 
Summary, the allocation percentages override any manual allocation made under the Allocation button of 
the Billing Information window. Fees Collected are also sub-divided into lawyer categories on the Fee 
Allocation report.

The Firm Cash & Fee Summary does not reconcile to the Fees Due by Lawyer report for the latter report 
may not include invoices for where there is both no outstanding A/R balance and no activity in the current 
report period.
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Billable Time Summary by Working Lawyer
The Billable Time Summary by Working Lawyer shows a comparison of hours and amounts for the month and 
year by working lawyer, categorized by responsible lawyer. The start of year can be manually selected when 
creating the report. Although the report can be filtered to show time or fees only, and billed or unbilled time 
only, the report does not indicate what portion of time or fees have been billed.

What Entries Appear on the Report
Fee values appears on the Billable Time Summary by Working Lawyer through one of the following features:

Fee adjustments and time added at the time of billing are included on the report as part of the fee value. Write 
downs that occur after the time are billing are not included on the report.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-63. The Common tab of the Billable Time Summary by Working Lawyer 

Matter: To view billable time for a single matter, type or select the matter nickname.

Client: To view billable time for matters belonging to a specific client, type or select the client 
name.

Resp Lawyer: To view billable time for matters assigned to a specific responsible lawyer, type or select 
the lawyer.

Start of Year: To set the start of the year to specific month to use on the report, select the month.

Month: To set the current month to use on the report, select the month.

Totals Only: To view only the Summary by Responsible Lawyer and Summary by Working Lawyer 
sections, select this check box.

Time Sheet/Fee Sheet Quick Timer/PCLaw Timers Create Bill/Quick Bill/Release Bill 

Calendar/Appointment Sheet Matter Opening Balances Phone Call Manager

Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Billable Time Summary by Working Lawyer > Common Tab



Billable Time Summary by Working Lawyer

Page 221

Options: Select one of the following:

Time: To view billable time values from time entries only, select this 
option.

Fees: To view billable time values from fee entries only, select this option.

Both: To view billable time values from both time and fee entries, select 
this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used. 

Exhibit 6-64. The Other tab of the Billable Time Summary BY Working Lawyer report 

Include Entries: Select one or both of the following:

Billed: To include billed time and fee entries as part of the billable time 
value, select this check box.

Unbilled: To include unbilled time and fee entries as part of the billable time 
value, select this check box.

Working Lawyer: To show only billable time values for a specific working lawyer, type or select that 
lawyer.

All responsible lawyers for which the working lawyer has posted time for appears on 
the report. However, only the time posted by the working lawyer is displayed.

Task Code: To show only billable time values for a specific task code, type or select the task.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Billable Time Summary by Working Lawyer displays billable time values by working lawyer for each 
responsible lawyer.

Exhibit 6-65. An excerpt from the Billable Time Summary by Working Lawyer report 

Pull-down menu: Reports > Productivity > Billable Time Summary by Working Lawyer > Other Tab
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Each responsible lawyer is listed under its own heading.

Client/Matter: Displays the client last and first name or client firm name, and the matter nickname.

Description: Displays the matter description as it appears in Matter Manager.

Working Lawyer: Lists the working lawyer for each matter where they have posted time.

This Month: This section lists the hours and time value posted for the month selected.

Year To Date: This section lists the hours and time value posted from the start of the year as specified 
when the report was created. This year to date is entered manually and does not need to 
correspond to the calendar or fiscal year to date. 

Drill Down
The Billable Time Summary by Working Lawyer allows drill down in the following areas:

Exhibit 6-66. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Billable Time Summary by Working Lawyer Report
The chart below lists PCLaw reports that reconcile to the Billable Time Summary by Working Lawyer report, 
and the item on the report that can be reconciled. The reports must be run with identical dates and 
parameters.

Drill down on Opens the following window

Matter Information Open Matter

This Month Client Fees Listing for month for the matter

Year to Date Client Fees Listing for specified months for the matter
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Exhibit 6-67.  Table displaying the different reports and their sections that reconcile to the Allocation Listing

The Billable Time Summary by Working Lawyer does not reconcile to the Time Listing or Time Summary 
when fee entries are included in the billable time values as the latter reports include fee adjustments as 
part of fees.

The Billable Time Summary by Working Lawyer does not reconcile to the Comparative Time Summary, 
Client Fees Listing, or Firm Cash & Fee Summary for billable time values for the latter reports include write 
offs in their billable time values.

The Billable Time Summary by Working Lawyer does not reconcile to the Collection Summary for the 
Collection Summary is created by fee credit lawyer.

Billable Time 
Summary by 
Working Lawyer

Reconciles to Additional comments

Hours Time Listing Summary by 
Working Lawyer > 
Hours

For working lawyer and firm. 

Time Summary Summary by 
Working Lawyer > 
Hours

For working lawyer and firm.

Time Utilization 
Analysis

Month > Total 
Hours 

For working lawyer and firm for month. 
Deselect Include non-billable tasks.

Comparative Time 
Analysis

Hours > Totals For working lawyer or firm. Include billable 
and non-billable tasks.

Lawyer WIP, Billing, 
& Collection 
Summary

Billable Time 
Worked > Hours 

For working lawyer and firm.

Amount Time Listing Summary by 
Working Lawyer > 
Amount

For lawyer and firm. For Time Entries Only. 
Will not reconcile if Include Fees or Both is 
selected.

Time Summary Summary by 
Working Lawyer > 
Value

For lawyer and firm. Deselect Include Non-
billable work. For Time Entries Only. Will 
not reconcile if Include Fees or Both is 
selected. 

Lawyer WIP, Billing, 
& Collection 
Summary

Billable Time 
Worked > Fees

For working lawyer and firm.

Summary by 
Responsible Lawyer

Client WIP, Billing, 
& Collection 
Summary

Summary by 
Responsible Lawyer 
> Billings > Fees

For responsible lawyer and firm. Select 
Show Billings and Write-offs Separately.
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Comparative Time Analysis
The Comparative Time Analysis compares two periods of time as specified when the report is created. Hours 
and Amount values are compared, as are percentages by task code or type of law. The Amount value, 
compiled by working lawyer, is comprised of time and fee entries, adjustments to fees made at the time of 
billing, and write-downs to fees after billing. A differentiation is not made between unbilled and billed fees, 
or between time and fee entries.

What Entries Appear on the Report
Fee values are included on the Comparative Time Analysis report through one of the following features:

Time entries are included on the Comparative Time Analysis according to their posted date. Fee adjustments 
are included on the report according to the date of the invoice. Write-offs of fees are included on the report 
according to the date of the write-off.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-68. The Common tab of the Comparative Time Analysis report. 

Working Lawyer: To view fee values for a specific working lawyer, type or select the lawyer.

By Task Code: To categorize fee values by task code for each working lawyer, select this option.

By Type of Law: To categorize fee values by type of law for each working lawyer, select this option.

Current Period: Complete the following as required:

Start Date: To select the start of the first comparison period, select the date.

End Date: To select the end of the first comparison period, select the date.

Comparison Period: Complete the following as required:

Start Date: To select the start of the second comparison period, select the date.

End Date: To select the end of the second comparison period, select the date.

Totals Only: To view only the Firm Totals section of the report, select this check box.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Create Bill/Quick Bill/Release Bill 
• Calendar/Appointment Sheet • Matter Opening Balances • Phone Call Manager
• Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Comparative Time Analysis > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

 The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 6-69. The Other tab of the Comparative Time Analysis report 

Include Allocations: Select at least one item and one task:

Billed Items: To include time entries that are billed, select this check box.

Unbilled Items: To include time entries that are yet to be billed, select this check box.

Billable Tasks: To include time entries assigned a billable task code, select this 
check box.

Non-Billable Tasks: To include time entries assigned a non-billable task code, select 
this check box.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Comparative Time Analysis report compares time values by working lawyer for two selected periods.

Exhibit 6-70. An excerpt from the Comparative Time Analysis report 

Task Code: This column appears only when By Task Code is selected under the Common tab. All 
task codes used by each working lawyer is listed under that lawyer.

Type of Law: This column appears only when By Type of Law is selected under the Common tab. All 
task codes used by each working lawyer is listed under that lawyer.

Description: Displays the full description for the task code or type of law.

Pull-down menu: Reports > Productivity > Comparative Time Analysis > Other Tab
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Hours: Displays the hours posted during the selected period. A separate column is provided for 
both the Current and Comparison period.

 % Lwyr: This column, adjacent the Hours column, displays the hour value of each task code or type 
of law as a percentage, to the total hours for the working lawyer. The Firm Totals section 
the total hours for each working lawyer, as a percentage, of the total hours for the firm. 

Amount: Displays time and fee entries, fee adjustments, and write-downs to fees posted during the 
selected period. A separate column is provided for both the Current and Comparison 
period.

% Lwyr: This column, adjacent the Amount column, displays the fee value by task code or type of 
law as a percentage of the total value for the working lawyer. The Firm Totals section 
displays the total fee value by working lawyer as a percentage of the total fee value of the 
firm. 

Drill Down
The Comparative Time Analysis allows drill down on the following areas:

Exhibit 6-71. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Comparative Time Analysis Report
The chart below lists PCLaw reports that reconcile to the Comparative Time Analysis report, and the item on 
the report that can be reconciled. The reports must be run with identical dates and parameters.

Drill down on Opens the following window

Hours Time Listing

Amount Time Listing

Firm Totals Time Listing

Comparative Time 
Analysis

Reconciles to Additional comments

Hours Time Listing Summary by 
{section name} > 
Hours

For working lawyer, type of law, task code, 
and firm. Select Both in Options section.

Time Summary Summary by 
Working Lawyer > 
Hours

For working lawyer, type of law, task code, 
and firm. Select Both in Options section. 
Include Billed, Unbilled, Billable, and non-
billable tasks.

Time Utilization 
Analysis

Month > Total 
Hours > 

For working lawyer, task code, and firm. For 
calendar month only. Include Billed, 
Unbilled, Billable, and Non-billable tasks.

Amount Client Fees Listing (Fees > Unbilled) + 
(Fees > Billed)

Include Billed, Unbilled, Billable and Non-
billable tasks.
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The Comparative Time Analysis does not reconcile to the Client Ledger or Client Summary for the latter 
two reports provide totals by matter and not by working lawyer, task code or type of law.

The Comparative Time Analysis does not reconcile to the Time Listing or Time Summary for time values as 
the latter reports do not include write offs in as part of fees.

The Comparative Time Analysis does not reconcile to the Billable Time Summary by Working Lawyer for 
Hours or Amount for the Comparative Time Analysis report includes non-billable tasks and write-off in its 
hours and fee values.

The Comparative Time Analysis does not reconcile to the Collection Summary for the Collection Summary 
includes only billed hours and fee values.

The Comparative Time Analysis does not reconcile to the Client WIP, Billing,& Collection Summary for 
billed fees on the Client WIP report is presented by responsible lawyer.

The Comparative Time Analysis does not reconcile to the Lawyer WIP, Billing, & Collection Summary for 
the Lawyer WIP report is created by fee credit lawyer and does not include non-billable tasks that are 
unbilled.

The Comparative Time Analysis does not reconcile to the Firm Cash & Fee Summary for the Comparative 
Time Analysis report includes fee values according to the date the fee was posted, not when the fee is 
billed. This is inconsistent with the Fees Billed column on the Firm Cash & Fee Summary.
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Daily Time Summary
The Daily Time Summary displays billable, non-billable, and total hours for one full calendar month by the 
individual working lawyer. The Summary by Working Lawyer gives a total for billable and non-billable hours, 
the number of unique days that time is docketed and the average number of hours for each day.

What Entries Appear on the Report
Hours appearing on the Daily Time Summary are added from one of the following features:

Unbilled hours appearing on the Daily Time Summary can be modified from one of the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 6-72. The Common tab of the Daily Time Summary 

Working Lawyer: To view hours for a working lawyer, select the lawyer.

Task Code: To view hours for a specific task code, type or select the code.

Type of Law: To view hours for a specific type of law, select the law type. 

Date: Select the month to view.

Totals Only: To view category totals and the Summary by Working Lawyer section, select this check 
box.

Include: Select one of the following options:

Billable: To display only time entries with a billable task code, select this option.

Non-Billable: To display only time entries with a non-billable task code, select this 
option.

Both: To display all time entries, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet • Quick Timer/PCLaw Timers • Create Bill > Details Button
• Calendar/Appointment Sheet • Phone Call Manager.

• Register > Time/Ledger tabs • Global Change Time • Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Daily Time Summary > Common Tab
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The Report
The Daily Time Summary displays hours by working lawyer divided into billable, non-billable, and total 
categories. 

Exhibit 6-73. An excerpt from the Daily Time Summary 

Working Lawyer: Each working lawyer displays billable, non-billable, and hours categories. Each lawyer 
is represented in a double rowed column. There is a separate total for each day for each 
category.

The Daily Time Summary report includes the following summary section:

Exhibit 6-74. Table of the summary section provided by the Daily Time Summary and when it appears 

Drill Down
The Daily Time Summary allows drill down in the following areas:.

Exhibit 6-75. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Daily Time Summary
The chart below lists PCLaw reports that reconcile to the Daily Time Summary, and the item that can be 
reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-76. Table displaying the different reports and their sections that reconcile to the Daily TIme Summary 

Summary Title Appears when

Summary by Working Lawyer Always appears.

Drill down on Opens the following window

daily hour Detailed Time Listing

Daily Time 
Summary 

Reconciles to Additional comments

Total Hours > Total Time Listing Hours > Total Select Options > Time Entry. 

Time Summary Hours/Day 
Reported > Total

Select Options > Time Entry.

Summary by 
Working Lawyer > 
Total

Client Fees Listing Summary by 
Working Lawyer > 
Total

Daily or monthly totals.

Time Utilization 
Analysis

Monthly > Total For firm or working lawyer for month only.

Firm Cash & Fee 
Summary

Hours > This Month For firm or working lawyer for month only.
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Time Utilization Analysis
The Time Utilization Analysis displays hours in a monthly calendar format by each working lawyer. Totals are 
given per month for a 12 month period. Hours are divided into billable and non-billable categories for each 
lawyer, with sub-totals. 

What Entries Appear on the Report
Hours included on the Time Utilization Analysis are added from the following features:

Hours included on the Time Utilization Analysis can be modified from the following features:

The Common Tab

The Common tab contains the most frequently used options on any PCLaw report.

Exhibit 6-77. The Common tab of the Time Utilization Analysis 

Working Lawyer: To view hours for a working lawyer, select the lawyer.

Task Code: To view hours for a specific task code, type or select the code.

Date: Select the final month for the 12 month view.

Include: Select at least one item and one task:

Billed Items: To display only billed hours, select this check box.

Unbilled Items: To display only unbilled hours, select this check box.

Billable Tasks: To display only hours with a billable task code, select this check box.

Non-Billable Tasks: To display only hours with a non-billable task code, select this check 
box.

Totals Only: To view category totals and the Summary by Working Lawyer section, select this check 
box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• Time Sheet • Quick Timer/PCLaw Timers • Create Bill > Details Button
• Calendar/Appointment Sheet • Phone Call Manager.

• Global Change Time • Register > Time/Ledger tabs • Matter Manager > Time/Ledger tabs.

Pull-down menu: Reports > Productivity > Time Utilization Analysis > Common Tab
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The Report
The Time Utilization Analysis displays hours by working lawyer then by task code. 

Exhibit 6-78. An excerpt from the Time Utilization Analysis report 

Task Code: Each lawyer is listed separately. Task codes are sub-categorized under each lawyer as 
being billable or non-billable. Individual task codes are listed under these sub-
categories.

Hours for all task codes are displayed and totalled under the monthly headings. Billable and non-billable 
hours as a percent of total hours are also provided.

The Time Utilization Analysis report includes the following summary sections:

Exhibit 6-79. Table of the summary sections provided by the Time Utilization Analysis and when they appear 

Drill Down
The Time Utilization Analysis allows drill down on the follow area:

Exhibit 6-80. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Time Utilization Analysis
The chart below lists PCLaw reports that reconcile to the Time Utilization Analysis, and the item that can 
be reconciled. The reports must be run with identical dates and parameters.

Exhibit 6-81. Table displaying the different reports and their sections that reconcile to the Time Utilization Analysis 

Summary Title Appears when

Firm Summary Always appears.

Summary of Billable/Non-billable Hours by 
Working Lawyer

Always appears.

Drill down on Opens the following window

Monthly hours Detailed Time Listing

Time Utilization 
Analysis 

Reconciles to Additional comments

Total Hours > Total Time Listing Hours > Total Select Options > Time Entry. 
Time Summary Hours/Day 

Reported > Total
Select Options > Time Entry.

Monthly > Total Client Fees Listing Summary by 
Working Lawyer > 
Total

Run report for month.

Daily Time 
Summary

Summary by 
Working Lawyer > 
Total

For firm or working lawyer for month only.

Firm Cash & Fee 
Summary

Hours > This Month For firm or working lawyer for month only.
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Unbilled Time & A/R Summary by Working Lawyer
The Unbilled Time & A/R Summary by Working Lawyer displays unbilled time and fees, and time and fees 
that has been billed but not yet collected. Information is grouped by matter for each working lawyer. A 
summary sections are provided for working and responsible lawyers. Use this report to determine the billing 
status of time and the collection status of time and fees. 

The Unbilled Time & A/R Summary also displays unbilled fees.

What Entries Appear on the Summary
Unbilled time values appear on the Unbilled Time & A/R Summary by Working Lawyer through the following 
features:

Billed and Uncollected Fees values are modified on the Unbilled Time & AR Summary by Working Lawyer 
report through one of the following features:

Fee adjustments and fee write-downs after the time of billing are included on the report as part of the billed 
value. Receive Payments reduce the Billed but Uncollected Fee Total regardless of the report period. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step. 

Exhibit 6-82. The Common tab of the Unbilled Time & A/R Summary by Working Lawyer 

Matter: To view the unbilled time value for a single matter, type or select the matter nickname.

Client: To view the unbilled time value for matters belonging to a specific client, type or select the 
client name.

• Time Sheet • Quick Timer/PCLaw Timers
• Calendar/Appointment Sheet • Phone Call Manager.

• Receive Payment • Change/Write-off Bill • Create Bill/Quick Bill/Release Bill.

Pull-down menu: Reports > Productivity > Unbilled Time & A/R Summary by Working 
Lawyer > Common Tab
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Resp Lawyer: To view unbilled time values for matters assigned to a specific responsible lawyer, type 
or select the lawyer.

Start Date: To view unbilled time on or after a specific date, select the date.

End Date: To view unbilled time on or prior to a specific date, select the date.

Totals Only: To view only the Summary by Working Lawyer and the Summary by Responsible 
Lawyer sections, select this check box.

Working Lawyer: To view only unbilled time values for one working lawyer, type or select the lawyer.

Include if matter has: Select one or both of the following:

Unbilled Time: To view only time values for matters that have unbilled time, select 
this check box.

A/R: To view only time values for matters that have an A/R balance, select 
this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Unbilled Time & A/R Summary by Working Lawyer report displays unbilled time values and billed but 
not collected time and fees by matter for each working lawyer.

Exhibit 6-83. An excerpt from the Unbilled Time & AR Summary by Working Lawyer 

Information for each working lawyer is provided under its own heading.

Client Name: Displays the client last and first name or the client firm name.

Matter: Displays the matter nickname.

Description: Displays the matter description as it appears in Matter Manager. 

Res Lwyr: Lists the responsible lawyer for each matter.

Hours: Displays time in hours posted by the working lawyer during the period that the report 
was created.

Value: Displays time values posted by the working lawyer during the period that the report 
was created.

Matter Total: For Unbilled, displays the total value for time posted by all working lawyers for the 
period that the report was created.
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Wkg Lawyer: Displays the dollar value for time and fees posted by the working lawyer, fee adjustments 
at the time of billing and write-off of fees after the time of billing, that were allocated to the 
working lawyer.   The value is reduced by Receive Payments applied to the invoice, 
regardless of when the payment occurs.

Matter Total: For Billed and Uncollected, displays value for time and fees, fee adjustments at the time of 
billing, and write-off of fees after billing for all working lawyers. The value is reduced by 
Receive Payments applied to the invoice, regardless of when the payment occurs.

Billed fee values, fee adjustments, and write-downs are included on the report according 
to the A/R date of the invoice. 

The date of the write-down is not taken into consideration when including write-downs on 
the report. 

All payments applied to the outstanding A/R total are included in the balance, even if the 
payment is made after the report period end date.

Drill Down
The Unbilled Time & A/R Summary allows drill down for the following areas:

Exhibit 6-84. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Unbilled Time & A/R Summary by Working Lawyer Report
The chart below lists PCLaw reports that reconcile to the Unbilled Time & A/R Summary by Working Lawyer, 
and the item on the report that can be reconciled.

Exhibit 6-85. Table displaying the non-reconciling sections of the Unbilled Time & A/R Summary by Working Lawyer 

Drill down on Opens the following window

Matter information Matter Manager

Unbilled section Work-in-Progress report for the working lawyer

Wkg Lawyer Client Fees Listing for matter

Matter Total Billing (Fees) Journal for matter and responsible lawyer

Summary by Working Lawyer Unbilled Time & A/R Summary by Working Lawyer for the working 
lawyer

Summary by Responsible Lawyer Unbilled Time & A/R Summary by Working Lawyer for the 
responsible lawyer

Unbilled Time & A/R Summary by Working 
Lawyer

Reconciles to

Hours not a reconcilable amount

Value not a reconcilable amount

Wkg Lawyer not a reconcilable amount

Matter Total not a reconcilable amount
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The Unbilled Time & A/R Summary by Working Lawyer does not reconcile to the Time Listing, Lawyer 
WIP, Billing, & Collection Summary or Comparative Time Analysis for Hours or Value for the latter reports 
do not separate billed and unbilled time.

The Unbilled Time & A/R Summary by Working Lawyer does not reconcile to the Time Summary or Time 
Utilization Analysis for Hours or Value, for transactions that are billed after the end of the report period 
are still considered billed on the latter reports. 

The Unbilled Time & A/R Summary by Working Lawyer does not reconcile to the Client Fees Listing, 
Work-In-Progress or Client WIP, Billing, & Collection Summary for Unbilled Value, for the Unbilled Time 
& A/R Summary report includes only time entries.

The Unbilled Time & A/R Summary by Working Lawyer does not reconcile to the Billing (Fees) Journal, 
Receivables by Client, Collection Summary, Client WIP, Billing, & Collection Summary or Lawyer WIP, 
Billing, & Collection Summary for Billed and Uncollected Fees. Billable time values for these reports do 
not include payments made after the end date of the report period, whereas the Unbilled Time & A/R 
Summary does include post-dated payments.
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Matters Opened Summary
The Matters Opened Summary displays the number of matters opened by month for a 12 month period. 
Values are provided for each lawyer, as client introducing, responsible, and assigned lawyer.

What Entries Appear on the Report
Matter values are compiled on the Matters Opened Summary through the following features:

Split matters are assigned the same client introducing, responsible, and assigned lawyers as the main matter. 
Matter introducing lawyers are not assigned.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 6-86. The Common tab of the Matters Opened Summary 

Lawyer: To display matter counts for a single lawyer, type or select the lawyer.

Month: To set the end of the twelve month period, select the month and year.

Summarize By: If preferred, select one or more of the following:

Type of Law: To include a Summary by Type of Law section, select this check box.

Resp. Lawyer: To include a Summary by Responsible Lawyer section, select this check 
box.

Referral Type: To include a Summary by Referral Type section, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• New Matter • Matter Manager > Billing tab.

Pull-down menu: Reports > Productivity > Matters Opened Summary > Common Tab
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The Report
The Matters Opened Summary provides an overview of matters opened for a twelve month period.

Exhibit 6-87. An excerpt from the Matters Opened Summary 

A column for each month indicates the number of matters opened during that month. Values are given for 
each lawyer in their role of client introducing, responsible, and assigned lawyer.

Lawyer:  Displays lawyer nickname and name.

Total: Provides the number of unique matters that the lawyer has been assigned to a minimum 
of one of the three lawyer categories.

Firm Total: Provides the total number of matters opened in each month.

The Matters Opened Summary does not include any summary sections.

Drill Down
The Matters Opened Summary allows drill down in the following areas:

Exhibit 6-88. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Matters Opened Summary
The Matters Opened Summary does not display any accounting information thus cannot reconcile to 
other accounting reports. However, matters opened can be compared to other reports.

Drill down on Opens the following window

Matter value for client introducing lawyer List of Clients for the selected lawyer as client introducing lawyer

Matter value for responsible lawyer List of Clients for the selected lawyer as responsible lawyer

Matter value for assigned lawyer List of Clients for the selected lawyer as assigned lawyer

Matters Opened 
Summary 

Reconciles to Additional comments

Introducing Lawyer WIP, Billing, 
& Collection 
Summary

Matters > Introd For lawyer and firm. For calendar month 
only.

Responsible Lawyer WIP, Billing, 
& Collection 
Summary

Matters > Opened For lawyer and firm. For calendar month 
only.

Monthly > 
Responsible Lawyer

List of Clients Firm Summary > 
Total Matters

Run the List of Clients for an individual 
responsible lawyer for a single month, or 
for full calendar months and compile the 
monthly Firm Totals on the Matters Opened 
Summary

Monthly > Firm 
Total

List of Clients Firm Summary > 
Total Matters

Run the List of Clients for a single month, or 
for full calendar months and compile the 
monthly Firm Totals on the Matters Opened 
Summary.
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Lawyer Budgeting Report
Lawyer Budgeting report displays budget comparisons in the Lawyer Budgeting and Lawyers and Rates 
formats, showing actual work done, fees billed, and payments received.

What Entries Appear on the Report
Budget figures on the Lawyer Budgeting report are added from the following features:

Items included when Budget vs. Worked is selected are added from the following features:

Items included when Budget vs. Billed is selected are added from the following features:

Items included when Budget vs. Collected is selected are added from the following features:

Common Tab

The Common tab contains the most frequently used options on any PCLaw report.

Exhibit 6-89. The Common tab of the Lawyer Budgeting report 

Lawyers: To create the report for one or more lawyers, click this button or leave the field blank to 
run the report for all lawyers.

Start Month: To view budget figures starting in a given month, select the date.

End Month: To view budget figures up to a specific month, select the date.

Budget Only: To view budget figures only, select this option.

Budget vs. Worked: To compare budget figures to work completed, regardless of whether or not it has been 
billed, select this option. 

Budget vs. Billed: To compare budget figures to billed fees, select this option. 

Budget vs. Collected: To compare budget figures to payments received, select this option.

Options: If preferred, select one or more of the following:

Totals Only: To display lawyer totals only, select this check box.

Show Budget by Month: To view by Lawyer Budgeting format, select this check box.

When the options is not checked, the report appears in Lawyers and 
Rates format.

New Page for Each Lawyer: To print each lawyer on a separate page, select this check box.

• Lawyer Budgeting • Lawyers and Rates > Budget Figures.

• Time Sheet/Fee Sheet • Quick Timer/PCLaw Timers • Phone Call Manager
• Calendar/Appointment Sheet • Matter Opening Balances (for all comparisons).

• Create Bill/Release Bill • Quick Bill • Change/Write Off Bill.

• Receive Payment • General Retainer (once billed).

Pull-down menu: Reports > Productivity > Lawyer Budgeting Report > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Lawyer Budgeting report can be run in Budget Only, Budget vs. Worked, Budget vs. Billed, and 
Budget vs. Collected formats. Each format is described separately.

Budget Only
The Budget Only option displays only the hours and amounts entered through the Lawyer Budgeting and 
the Lawyers and Rates features. 

Exhibit 6-90. The Lawyer Budgeting report displaying budgeted hours and time value only 

Budget vs. Worked
The Budget vs. Worked option displays the hours and amounts entered through the Lawyer Budgeting and 
the Lawyers and Rates features and compares them to actual hours worked and the value of both time and 
fees worked. 

Variance: Displays differences between budget and fees posted. Positive values indicate the 
budget is exceeded. 

Var %: Displays the difference as a percentage.

Exhibit 6-91. The Lawyer Budgeting report comparing budgeted hours and time values to actual time worked 

Worked includes both unbilled and billed time and fees. Time can have a billable or non-billable task 
code. Fee adjustments and write-offs are not included as work. 

Budget vs. Billed
The Budget vs. Billed option displays the hours and amounts entered through the Lawyer Budgeting and 
the Lawyers and Rates features and compares them to actual hours billed and the net value of the billing 
for the month.

Variance: Displays differences between budget and fees billed. Positive values indicates the 
budget is exceeded. 

Var %: Displays the difference as a percentage.

Exhibit 6-92. The Lawyer Budgeting report comparing budgeted hours and time values to actual time billed 

The billed value includes fees on invoices with an A/R date for the month, any fee adjustments made 
during billing, and write-offs to invoices that were created during or prior to the month.
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Budget vs. Collected
The Budget vs. Collected option displays the hours and amounts entered through the Lawyer Budgeting and 
the Lawyers and Rates features and compares them to monies received during the month that were applied to 
billing. Hour budgeting is not comparable to payments and is therefore not included on the report.

Variance: Displays differences between budget and payments collected. Positive values indicate the 
budget is exceeded.

Var %: Displays the difference as a percentage. 

Exhibit 6-93. The Lawyer Budgeting report comparing budgeted hours and time values to payments collected 

Collected includes general retainers applied on invoices created for the selected month and payments 
received during the month on invoices created during or prior to the report period.

Drill Down
The Lawyer Budgeting report allows drill down in the following areas:

Exhibit 6-94. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Report
Lawyers or months with zero budgets are not included on the report.   Thereby worked, billed, and collected 
information for those lawyers or months are also excluded, making comparisons with other reports 
cognitional and difficult. 

Exhibit 6-95. Table displaying the different reports and their sections that reconcile to the Lawyer Budgeting report 

For Budget vs. Worked, worked hours cannot reconcile to the Lawyer WIP, Billing, & Collection Summary for 
non-billable hours are included on the Lawyer Budgeting report only. 

For Budget vs. Billed, it is not possible to reconcile to the Billing (Fees) Journal since the Lawyer Budgeting 
report includes write-offs to invoices that were billed prior to the report period. Those write-offs are not 
included on the Billing (Fees) Journal since the affected invoice does not fall into the report period.

Drill down on Opens the following window

Worked column Time Listing

Billed columns Billing (Fees) Journal

Collected column Payment Allocation Listing

Lawyer Budgeting Reconciles to Additional comments

Worked (hours and 
value)

Time Listing Summary by 
Working Lawyer

Run the Time Listing report for a single 
calendar month

Billed(value only) Lawyer WIP, Billing, 
& Collection 
Summary

Billings > Fees + 
Write-offs > Fees

Hours value is not available

Collected Payment Allocation 
Listing

Summary by Fee 
Credit Lawyer > Fee 
column

Payment Allocation Listing must be run for 
the same period.

Lawyer WIP, Billing 
& Collection 
Summary

Collection > Fees Gives values by monthly increments



    Page 241

Non-Accounting Reports

Non-Accounting Report Overview.......................................................242

Appointment Listing .............................................................................243

Appointment Schedule .........................................................................246

Contact Listing ......................................................................................248

User Security Listing ............................................................................251

File Conflict List ....................................................................................252

Research Listing ...................................................................................254

Document Listing..................................................................................256



PCLaw Reports

Page 242 

Non-Accounting Report Overview

Exhibit 7-1. Table listing non-accounting reports, their defining parameters, and what the report displays 

Report Run the Report 
By...

What it Does

U
se D

ocum
ent M

anager

A
dm

inistrator access required

PC
Law

, PC
Law

 Plus, PC
Law

Pro, and PC
Law

Pro Enterprise

Contact Listing matter/client
lawyer
firm name

Lists contacts and their addresses, phone numbers and e-mail 
addresses.

Appointment 
Listing

matter/client
lawyer
appointment code
location code

Lists activities from the calendar in a report format.

Appointment 
Schedule

matter/client
lawyer
appointment code
location code

Displays activities in a calendar format.

Document Listing matter/client
contact
user
document type

Provides a list of documents saved to PCLaw, with corresponding 
description, matter and contact information.

m
ust be enabled

Research Listing matter/client/
lawyer
contact
user
research type

Provides a list of research conducted in PCLaw, with corresponding 
description, matter and URL information.

File Conflict List client/vendor/
contact name
client last name
billing last name
matter description
memos

Provides a list of possible matches to names of new clients, 
contacts, or vendors.

User Security 
Listing

active user
inactive user
user name

Provides a list of users and assigned rights within PCLaw
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Appointment Listing
The Appointment Listing displays Calendar and Notes information in a report format. The report shows 
what is due for a specified reminder date or due date and can include one or more of appointments, to 
do’s, or notes. The user has a choice of viewing only uncompleted or completed events, or both.

What Entries Appear on the Listing
Events listed on the Appointment Listing are added or modified through the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 7-2. The Common tab of the Appointment Listing 

Matter: To display events associated with a single matter, type or select the matter nickname.

Client: To display events associated with matters belonging to a specific client, type or select 
the client number.

Lawyer: To display events associated with a specific lawyer, type or select the lawyer nickname.

Appt: To display events assigned a specific appointment code, select the code.

Location Code: To display events assigned a specific location code, select the code.

Start Date: To view events on or after a specific date, select the date.

End Date: To view events on or before a specific date, select the date.

• Calendar/Appointment Sheet • Notes • Matter Manager > Appointments tab
• New/Change Appointment • Register > Appointments tab • Phone Call Manager
• Phone Calls > Create To Do button. •

Pull-down menu: Reports > Appointment Listing > Common Tab
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Date Range: Select one of the following:

Due Date: To include all events with a due date falling within the specified date 
range, select this option.

Reminder Date: To include all events with a reminder date falling within the specified 
date range, select this option.

Both: To include all events with one or both of the due date or reminder date 
falling within the specified date range, select this option.

Sort By: Select one of the following:

Client and Name:  To list events in order by client number and matter nickname, select 
this option.

Lawyer: To list events in order by lawyer nickname, select this option.

Appt Code: To list events in order by appointment code, select this option.

Location Code: To list events in order by location code, select this option.

Due Date: To list events in order by due date, select this option.

Reminder Date: To list events in order by reminder date, select this option.

Include: Select one or more of the following:

Appointments: To include appointments on the report, select this check box.

To Do’s: To include to do’s on the report, select this check box.

Notes: To include notes on the report, select this check box.

Phone Calls/Messages: To include calls and messages from the Phone Call Manager on the 
report, select this check box.

Include Completed Activities: To display both uncompleted events, and events marked as completed, select 
this check box.

Show Only Completed Activities: To display only events marked as completed, select this check box.

Include Corrected Entries: To display original events and their modifications, select this check box.

Contact: To show events for a single contact, click this button. 
The Pop Up Help - Contacts window appears.

Clear: To clear the selected contact, click this button.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.



Appointment Listing

Page 245

The Report
The Appointment Listing provides a list of appointments, to do’s, and note, including recurring events. 
Associated clients and matters are displayed, including client name and matter description.

Exhibit 7-3. An excerpt from the Appointment Listing 

Lawyer: Displays the lawyer or lawyers to whom the event is assigned.

Due Date/Reminder Date: Displays due and reminder dates if applicable. Dates for events are not 
required.

Action/Description: Displays the contents of the Action box for appointments and to do’s, and the 
contents of the notes box for notes.

Start: Displays the contents of the Start Time box for appointments and contents of the Time 
box for notes. To do’s do not have start times.

Location: If the appointment or to do is assigned a location code, that code is displayed. Location 
codes are not mandatory. Notes cannot be assigned location codes.

Duration: Displays the duration of the appointment or to do. Notes do not have a duration option.   

Completed: Indicates whether the appointment or to do has been marked as completed. Notes do 
not have a completed option.

Client, Name: Displays the client nickname and client last and first name or client name.

Matter, Description:Displays the matter nickname and descripiton as it appears in Matter Manager

The Appointment Listing does not contain any summary sections.

Drill Down
The Appointment Listing allows drill down on the following areas:

Exhibit 7-4. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling with Other Reports
As a non-accounting report, the Appointment Listing does not reconcile with other PCLaw reports.

Appointments and to do’s listed on the Appointment Listing are also displayed on the Appointment 
Schedule. Both reports must be produced for the same parameters, including date, for the same events to 
appear on each report. The Appointment Schedule may exclude information due to limitations of space.

Notes and Phone Calls appearing on the Appointment Listing are not included on the Appointment 
Schedule.

Drill down on Opens the following window

Appointment Change Appointment

To Do Change To Do

Note Note

Phone Call Change Phone Call

Recurring Entries Change - Recurring Event

Linked Event Change - Link Dates Event
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Appointment Schedule
The Appointment Schedule displays appointment and to do information in a Calendar format. The schedule 
can be displayed in a daily, weekly, or monthly view beginning at the start date of the program. Events are 
displayed for a specified reminder date or due date.

What Entries Appear on the Schedule
Events listed on the Appointment Schedule are added or modified through one of the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 7-5. The Common tab of the Appointment Schedule

Matter: To display events associated with a specific matter, type or select the matter nickname.
Matter information appears in the summary section at the bottom of the window.

Client: To display events associated with matters belonging to a specific client, type or select the 
client number.

Lawyer: To display events associated with a specific lawyer, type or select the lawyer nickname.

Schedule For: Select one of the following:

Day of: To display events for a specific day, select this option.

Week beginning: To display events for a seven day period, select this option.

Month Beginning: To view events for a month long period, select this option.

On the adjacent calendar, select the day to be displayed for a daily view, or the start date 
for a weekly or monthly view.

Appointments: To include appointments on the report, select this check box.

To Do’s: To include to do’s on the report, select  this check box.

Load Last: To use the settings from the last time the report was created, click this button.

OK: To create the report, click this button.

• Calendar/Appointment Sheet • New/Change Appointment • Matter Manager > Appointments tab
• Register > Appointments tab • Phone Call Manager/Phone Calls > Create To Do button.

Pull-down menu: Reports > Appointment Schedule > Common Tab
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The Report
The Appointment Schedule displays appointments and to do’s in a calendar format.   

Exhibit 7-6. An excerpt from the Appointment Schedule 

For the daily view, the date is displayed at the top center of the schedule. For a weekly or monthly view, 
the start and end dates are displayed. 

The current month is displayed in the left header with the start date highlighted. The next calendar month 
is displayed in the right header.

The daily format is divided into half hour intervals. The weekly and monthly formats are divided into daily 
intervals.

The Appointment Schedule does not contain any summary sections.

Drill Down
The drill down feature is not available on the Appointment Schedule.
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Contact Listing
The Contact Listing displays information and all associated matters for a contact. Contact name, address, 
type, e-mail and phone numbers are included on the report. If the contact is associated with a matter, the 
matter name, description, lawyers, type of law, billing rate, and date opened is displayed below the contact.

What Entries Appear on the Listing
Contacts listed on the report are added or changed using one of the following features:

Contacts can be associated with matters, appointments, or time keepers.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report.

Exhibit 7-7. The Common tab of the Contact Listing 

Matter: To list contacts associated with a specific matter, type or select the matter nickname.

Client: To list contacts associated with matters belonging to a specific client, type or select the 
client number.

Lawyer: To list contacts associated with a specific lawyer, type or select the lawyer nickname .

Contact: To view a specific contact, click this button.
The Contact Selection window appears.

Select the contact.

Contact Type: To list all contacts for a specific category, type or select the contact type.

Include Contacts: To include contacts on the report, select this check box.

Include Clients: To include clients on the report, select this check box.

Include Vendors: To include Vendors on the report, select this check box.

Sort By: Select one of the following:

Name: To list contacts in order by last name, select this option.          

Last Contacted: To list contacts in order according to the date of the appointment or to-
do to which they were associated, select this option.

Contact Type: To list contacts in order by type, select this option.

Include Address Info: To include contact address information on the report, select this check box.

Include Matter Info: To include matters associated with each contact, select this check box.

• Contact Manager • Matter Manager > Contacts tab • New/Change Phone Call > Contact box

• New/Change Appointment • New/Change To Do > Contact(s) button.

Pull-down menu: Reports > Contact Listing > Common Tab
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Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that may not be as frequently used.

Exhibit 7-8. The Other tab of the Contact Listing 

Contact Date: Complete the following as required:

Begin: To list contacts added on or after a specific date, select the date.

End: To list contacts added on or before a specific date, select the date.

Date Last Contacted: Complete the following as required:

Begin: To list contacts associated with appointments or to-do’s that were 
scheduled on or after a specific date, select the date.

End: To list contacts associated with appointments or to-do’s that were 
scheduled on or prior to a specific date, select the date .

Firm Name: To list contacts matching a specific firm name, type the beginning characters of the 
name.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Contact Listing provides a list of contacts and any associated matters. Contacts include relevant 
information such as address, phone numbers, type and lawyer. Matters include matter description, 
assigned and responsible lawyers, billing rates and date opened. Both contact descriptions and matter 
information can be suppressed on the report.

Exhibit 7-9. Excerpt from the Contact Listing 

Pull-down menu: Reports > Contact Listing > Other Tab
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Name: Displays the contact last and first name or the contact firm name.

Address: Displays the contact address. This column is optional.

E-mail: Displays the contact’s business e-mail address.

Matter: Displays the nickname of all matters associated with the contact. This column is optional.

Description: DIsplays the associated matter description as it appears in Matter Manager. This column is 
optional.

Contact Type: Displays the contact type assigned to the contact.

Lawyer: Displays the lawyer associated with the contact.

Business/Fax/Home: Displays the business phone number, business fax number, and home phone number for 
the client.

Law Type: Displays the type of law assigned to the associated matter. This column is optional.

Rate: Displays the default billing rate for the associated matter. This column is optional.

Res: Displays the responsible lawyer for the associated matter. This column is optional.

Open Date: Dipslays the date the associated matter was opened. This column is optional.

The Contact Listing does not contain any summary sections.

Drill Down
The Contact Listing allows drill down on the following areas:

Exhibit 7-10.  Table displaying fields where drill down is enabled and the reports or features that are opened 

Drill down on Opens the following window

Contact information Open Contact > Contact Information

Matter information Open Matter > Main tab
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User Security Listing
The User Security Listing displays users, their groups, and what access they have to PCLaw menu items, 
matters, and bank accounts. A user requires rights to Security to create the report.

User Security Listing Window

Run the User Security Listing from the Security Setup window, by clicking the Reports button and clicking 
Yes to the succeeding PCLaw prompt.

Exhibit 7-11. The User Security Listing selections window

Select From: Select one of the following:

Active Users: To view only current users, select this option.

Inactive Users: To view only users that have been removed from the Security Setup 
window, select this option.

Both: To view both active and inactive users, select this option.

User Name: To view rights for one user only, type the name of the user.

Load Last: To use the settings from the last time the report was created, click this button.

OK: To create the report, click this button.

The Report 
The User Security Listing provides a list of users and assigned rights. Rights are indicated as having some 
or all.

Exhibit 7-12. An excerpt from the User Security Listing 

Groups Member Of: Lists all the groups to which the user is a member. 

Menu Items: Indicates if the user has access to all or some of the menu items.

Matters: Indicates whether the user has access to all matters or some due to restrictions under 
the Matter tab of Advanced Security Settings.

General Bank: Indicates if the user has access to all general bank accounts or some due to restrictions 
on the Bank Accounts tab of Advanced Security Settings.

Trust Bank: Indicates if the user has access to all trust bank accounts or some due to restrictions on 
the Bank Accounts tab of Advanced Security Settings.

Internet License: Indicates if the user is assigned a Web Timer license. 

Status: Indicates whether the user has an active or inactive status in the Web Timer Manager.

The User Security Listing do es not contain any summary sections.

Pull-down menu: Options > Administrator > Security > Report button
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File Conflict List
The File Conflict List provides a list of clients, matters, contacts, or vendors that match a given search name. 
Information is presented to determine if a possible conflict of interest exists between the search name and any 
of the created matches.

The File Conflict list is produced only when performing a Conflict Search. The Conflict Search window is 
located on the File > Client pull-down menu. 

Users can also click the Conflict button in the New Client and New Matter windows. 

What Entries Appear on the Report
Matches listed on the File Conflict list are pulled from the following locations, depending on the criteria 
selected when performing the search.
• New Client/Client Manager (client first name, client last name, firm name, memos, attention line)
• New Matter/Matter Manager (client first name, client last name, firm name, billing last name, second 

billing address last name, matter description, memos, attention line)
• New Vendor/Open Vendor (vendor last name, vendor firm name, attention line)
• New Contact/Contact Manager (contact last name, contact firm name, attention line)
• Memorized Transactions (payees).

Producing the File Conflict List Report

The File Conflict List is created though the Conflict Search window.

Exhibit 7-13. The Conflict Search window 

Name: Type the information for the requested search.

Show Full Re Line/Memo: To show more than the first 255 characters of the re line or memo, select this check 
box. 

The Report
The File Conflict List can only be produced from the Conflict Search window. The report does not appear 
elsewhere in PCLaw.

Exhibit 7-14. An excerpt from the File Conflict List 

Conflicts found on search for: {name}: Each search criteria is found under its own sub-heading. This is further 
divided into more detailed entities, such as Contacts, Accounting, Time Dockets, Calendar, 
Documents, and Notes.

Reference: Displays the nickname for matching contacts, clients, matters, or vendors or the entry 
number for data entry matches, document, or event matches.

Record Type: Indicates the entity from which the match occurs.

Pull-down menu: File > Client > Conflict Search
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Contacts: Lists all matches of persons, such as a contact, client, matter, or vendor.

Memo: Displays the first 75 characters of the memo as it appears on the 
Summary tab of Matter Manager. If Show Full Re Line/Memo is 
enabled, the entire memo text is displayed.

Field: Displays the area within the person that contains the match.

Context: Displays how the search item appears within the field.

Resp Lawyer: Displays the responsible lawyer for any matching matters.

Matter Num: Displays the matter nickname for any matching matters. If the match 
is a client, the field within the associated matter is listed.

Calendar: Lists all matches for appointments and to do’s.

Date: Displays the date of the event.

Explanation: Displays the explanation or action field for the event.

Field: Displays the area within the event that contains the match.

Context: Displays how the search item appears within the field.

Notes: Lists all matches for notes.

Date: Displays the date of the note.

Details: Displays the first 80 characters of the Note text field. If Show Full Re 
Line/Memo is enabled, the entire note is displayed.

Field: Displays the area within the note that contains the match.

Context: Displays how the search item appears within the field. If the search 
item is within the note text, only the 80 characters surrounding the 
search item is displayed.

Time Docket: Lists all matches for time and fee entries.

Date: Displays the date of the transaction.

Lwyr: Displays the working lawyer credited with the time entry.

Task: Displays the assigned task code for the time entry.

Explanation: Displays the first 80 characters of the Explanation text field. If Show 
Full Re Line/Memo is enabled, the entire explanation is displayed.

Field: Displays the area within the time entry that contains the match.

Context: Displays how the search item appears within the field. If the search 
item is within the explanation, only the 80 characters surrounding 
the search item is displayed.

Accounting: Lists all matches for financial entries, including general/ trust bank, billing, or a/p.

Field: Displays the area within the transaction that contains the match.

Context: Displays how the search item appears within the field. If the search 
item is within the explanation, only the 80 characters surrounding 
the search item is displayed. 

Documents: Lists all matches to documents added to PCLaw.

Matter Num: Displays the matter nickname to whom the document is assigned.

Description: Displays the first 80 characters of the description that appears in the 
PCLaw document window. If Show Full Re Line/Memo is enabled, 
the entire description is displayed.

Drill Down
The File Conflict List does not provide the drill down option.
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Research Listing
The Research Listing displays research items performed and saved in PCLaw. The report can be created by 
matter, client, lawyer, user, or research type. Text contained in the general description cab also be referenced. 
Items can be sorted by matter, research date, or entry order.

How Items are Included on the Listing
Items displayed on the Research Listing are added through one of the following features:

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 7-15. Research Listing selection window displaying the Common tab 

Matter: To list items assigned to a single matter, select the matter nickname.

Client: To list items assigned to matters of a specific client, select the client number.

Lawyer: To list items associated with a specific lawyer, type or select the lawyer nickname.

Sort By: Select one of the following:

Entry: To list items in order that they were added in PCLaw, select this option.

Date: To list items in order by the date, select this option.

Matter: To list items in order by matter nickname, select this option.

User: To list items researched by a specific user, type or select the user.

Search Type: To list items displayed belonging to a specific category of search, select one of Research, 
Case, Statute, or Sheppards.

To not restrict research by category, select All.

Search Description and Categories Fields: To list only items containing specific text in the Description or 
Memo boxes, type the text.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

• LexisNexis Research • Matter Manager > Research tab • Document Manager > Research tab

Pull-down menu: Reports > Research Listing > Common Tab
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The Report
The Research Listing provides a list of items in PCLaw, associated matters, URL addresses and other 
research properties. The appearance of the report does not change no matter how the report is sorted.

Exhibit 7-16. The Document Listing report 

Matter: Displays the Matter nickname assigned on the Lexis Research window.

URL: Displays the web page address where the resource item was sourced.

Date: Displays the date selected on the Lexis Research window.

User: Displays the staff member who conducted the research.

Type: Displays the research category selected.

Description: Displays the comments typed in the Memo box on the Lexis Research window.

Memos: Displays information typed in the Description box on the Lexis Research window.

The Research Listing does not contain any summary sections.

Drill Down
Drilling down on the first line of any research item on the Research Listing opens the Lexis Research 
window.
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Document Listing
The Document Listing displays documents, e-mails, and precedents in PCLaw. Documents can be sorted by 
name, type, matter and other criteria. The report format can be selected to list just the matter, name, 
description and comment, or all document property information. The report can be further refined to show 
only one or a combination of documents, e-mails, and precedents. Searches can be performed to find 
documents containing a certain word or phrase within the document name, description, or body.

How Documents are Included on the Listing
Documents on the Document Listing are added or modified through the following features:

Documents must be associated with matters. Associating documents with contacts is optional, however, even 
if there is a contact association, a matter association is still required.

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 7-17. Document Listing selection window displaying the Common tab 

Matter: To list documents associated with a specific matter, type or select the matter nickname.

Client: To list documents associated with matters assigned to a specific client, type or select the 
client number.

Contact: To view documents associated to one or more contacts, click this button.
The Contact Selection widnow appears.

Sort By: Select one of the following:

Doc Name: To list documents in order by document name, select this option.

Author: To list documents in order by the user who added the document to 
PCLaw, select this option.

Doc Type: To list documents in order by document type, select this option.

• Document Manager • Matter Manager > Docs tab • Contact Manager > Documents tab
• New Document • Microsoft Word • Windows Explorer
• Microsoft Outlook.

Pull-down menu: Reports > Document Listing > Common Tab
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Matter: To list documents in order by matter nickname, select this option.

Creation Date: To list documents in order by the date they were added in PCLaw, 
select this option.

Last Modified Date: To list documents in order by the last date the document was 
modified, select this option.

Author: To list documents created by a specific user, type or select the user.

Document Type: To list a specific document type, type or select the nickname.

Although document property values such as author and creation date are assigned by 
default when the document is added to PCLaw, these values can be modified at any 
time.

Simple Format: To display only the matter nickname, document name, document description, and 
comments on the report, select this check box.

Include Contact Info: To display the name of any contacts associated with the document, select this 
option.

Options: Select one or more of the following:

Include Documents: To include documents on the report, select this option.

Include E-mail: To include e-mails on the report, select  this option.

Include Precedents:To include precedents on the report, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Other Tab

The Other tab displays report options that are not be as frequently used as those under the Common tab.

Exhibit 7-18. Document Listing sections window, Other Tab displayed 

Document Creation Date: Complete the following as required:

Begin: To list documents associated with a matter on or after a specific 
date,type or select the date.

End: To list documents associated with a matter on or prior to a specific 
date, type or select the date.

Pull-down menu: Reports > Document Listing > Other Tab
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Date Last Documented: Complete the following as required.

Search Description and Comments Fields For: To list only documents containing word or 
string in the Description or Comments boxes, type the text.

Document Contains: To list only documents containing a word or string in the document 
body, type the text.

Document Name:  To list only documents containing a word or string in the name or 
document, type the text.

Document ID: To list documents matching a specific ID number, type the number.

The document ID box searches only for exact matches, and not for a 
string of characters that might exist within a document ID.   For 
example, when searching for 12, a document with ID 123 will not be 
included on the report.

OK: To create the report, click this button.

The Report
The Document Listing provides a list of documents in PCLaw, associated matters, and other document 
properties according to how the report is created.

Exhibit 7-19. Excerpt from the Document Listing 

Matter: The matter nickname nickname always appear on the report regardless of the format 
selected. If Simple Format is selected, it is one of only four items included on the report. 

Document Name: The document name always appear on the report regardless of the format selected. If 
Simple Format is selected, it is one of only four items included on the report. 

Description: Displays the document description as it appears in Document Properties.  The Description 
always appear on the report regardless of the format selected. If Simple Format is selected, 
it is one of only four items included on the report.  

Comments; Displays the comment as it appears in Document Properties. Comments always appear on 
the report regardless of the format selected. If Simple Format is selected, it is one of only 
four items included on the report. 

If Simple Format is not selected. the following information is included on the report:

Doc Type: Displays the document type nickname.

Author: Displays the user who added the document to the matter.

Law Type: Displays the type of law of the matter.

Creation Date: Displays the date the document was associated to the matter.

Last Modified: Displays the date the document was last changed.

If Include Contact Info is selected, the following information is included on the report:

Associated Contacts: Displays the name of contacts associated with the document. The first and last name of 
the contact appears, providing Display As Person is selected for the contact. The firm name 
appears if Display As Corporation is selected for the contact. 

Drill Down
Drilling down on any information on the Document Listing with the exception of Contact Name will open 
the Change Document Properties window.   Drill down is not available for the contact name.
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Month End Report Overview

Exhibit 8-1. Table listing month end reports, their defining parameters, and what the report displays 

not available for M
obile M

odules

Report Run the Report 
By...

What it Does

A
ll C

ountries

A
ll PC

Law
 versions

G/L Reconciliation 
report

report month Compares journal balances to their associated control accounts at 
month end.

Cash Flow Planner report month Provides a list of cash on hand, aged A/P, A/R, and Work-in-
Progress, bills sent, and cash received for one month.

Bank 
Reconciliation 
report

bank 
reconciliation 
period

Lists statements of reconciliation to the bank statement, bank 
journal, and optionally provides an outstanding items list.
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G/L Reconciliation Report
The G/L Reconciliation report compares PCLaw journals with both client ledger balances, and the 
journals’ g/l control accounts. If there is a discrepancy between the journal and either the ledger or the 
control account, the amount is displayed on the report. The report is created for a specific point in time, 
and is detailed to the accounting method utilized for the set of books.

What Entries Appear on the Report
Trust bank values are calculated from the following features:

General bank values are calculated from the following features:

Accounts receivable values are calculated from the following features:

Only Accrual systems reconciles the journal and ledger balances to the general ledger. Modified Cash and 
Cash systems do not use the general ledger to track receivables.

Values for Client Disb Recov (1210), for Accrual systems, and Client Disb Expense (5010) for Modified 
Cash systems are calculated from the following features:

Client Disbursement Expense (5010) is not a reconcilable account for Cash systems.
For Accrual systems only: Accounts payable values are calculated from the following features:

For firms using GST : GST values are calculated from the following features:

General ledger values on the G/L Reconciliation report are modified with their corresponding journals 
through any of the above listed features, and through the following features:

Transactions created through the Request Check or Request Bill features do not affect the G/L 
Reconciliation report until the check or bill is released. 

The Report Selection Window

The report selection window appears when selecting the report from a menu or Quick Step.

Exhibit 8-2. The G/L Reconciliation Report selection window 

• Data Entry > Trust Bank (all features) • Billing > Trust-to-General Transfer.

• Data Entry > General Bank > {all features) • New Payable > Pay Now
• Process Payable.

• Create Bill/Release Bill • Quick Bill • Receive Payment
• Change/Write Off Bill.

• General Bank > Check • Expense Recovery • General Retainer
• New Payable • Create Bill/Quick Bill/Release Bill (for Accrual systems only)
• Change/Write off Bill (for Modified Cash systems only)
• Receive Payment (for Modified Cash systems only).

• New/Open Payable • General Bank > Check • Process Payable.

• General Bank > Check • Change/Write Off Bill • Create Bill/Quick Bill/Release Bill.

• G/L Adjustment • Correct G/L Adjustment • G/L Opening Balances.

Pull-down menu: Reports > G/L Reconciliation Report
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As Is: To view journal, client ledger, and G/L balances at a specific point in time, type or select 
the date.

Reread G/L Information: To have PCLaw reread the general ledger for transactions entered since the last time 
a statement was created, select this check box.

It is recommended that this box be always checked.

Load Last: To use the settings from the last time the report was created, click this button.

OK: To create the report, click this button.

The Report
The G/L Reconciliation report provides a comparison of journal, client ledger, and general ledger balances 
for a particular point in time.

Exhibit 2: G/L Reconciliation report - Accrual Accounting method shown.

Trust Bank
This section displays the balances of individual trust bank accounts up to and including the date displayed in 
the heading of the report. A separate balance is provided for each account. 

Client: Provides the balance of each trust account as they appear on the Client Trust Listing. 

Trust Funds Owed Provides the sum of all trust accounts on the G/L Reconciliation report as they appear on 
the Client Trust Listing.

Journal: Provides the balance of each trust account as they appear on the Trust Bank Journal.

Trust Funds Owed: Provides the sum of all trust accounts on the G/L Reconciliation report, as they appear on 
the Trust Bank Journal.

G/L: Provides the end balance of all trust G/L accounts on the General Ledger.

Trust Funds Owed: Displays the end balance of Trust Funds Owed (2200), and is not the sum of the G/L 
balances as they appear on the G/L Reconciliation report.

Client/Journal: Compares the Client Trust Listing and the Trust Bank Journal.

Journal/G/L: Compares the Trust Bank Journal to the end balance of the respective trust bank control 
accounts on the General Ledger and also compares the sum of all bank balances to the 
end balance of Trust Funds Owed (2200).
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General Bank
This section displays the balances for all general bank accounts up to and including the date displayed in 
the heading of the report. A separate balance is provided for each account. A total for each bank count is 
not provided. There is no corresponding client ledger comparison for the general bank.

Journal: Provides the balance of individual general bank account as they appear on the General 
Bank Journal.

G/L: Provides the end balance of each general bank control account on the General Ledger.

Journal/G/L: Compares the General Bank Journal to the end balance of the respective general bank 
control accounts on the General Ledger. 

Accounts Receivable
(1200) Account Receivable: Provides the balance of the Client Ledger and the Billing (Fees) Journal up to 

the end date of the report. Payments received after the end date are not included on the 
report. Modified Cash and Cash accounting systems do not use the general ledger to 
track receivables.

Client: Provides the A/R Balance that appears in the Firm Totals section of the Client Ledger 
when produced for all matters.

Journal: Provides the Outstanding balance that appears in the Firm Totals section of the Billing 
Fees Journal when produced for all matters.

G/L: Provides the end balance of Accounts Receivable (1200).

Client/Journal: Compares the Firm Totals of the Client Ledger’s A/R Balance to the Billing Fee Journal’s 
Outstanding balance.

Journal/G/L: For Accrual systems only: Compares the Firm Totals > Outstanding balance on the 
Billing Fees Journal to the end balance of Accounts Receivable (1200).

Client Disb Recov: For Accrual systems only: Provides the balance of the Client Ledger up to the end date 
of the report. Items that are billed after the end date of the report are still included as an 
unbilled cost.

Client: Provides the sum of CHE and RECOV balances that appear in the 
Firm Totals section of the Client Ledger.

G/L: Provides the end balance of Client Disb Recov (1210).

Client/Journal: Compares sum of the Firm Totals > CHE and RECOV balances of the 
Client Ledger to the end balance of Client Disb Recov (1210). 

Client Disb Recov: For Modified Cash systems only: Provides the balance of unbilled disbursements plus 
disbursements billed but not yet payed, less unallocated general retainers and 
compares this balance to the general ledger. Payments received or retainers applied 
after the end date of the report are not included in the calculation of the balance.

Client: Provides the CHE and RECOV balances that appear in the Firm 
Totals section of the Client Ledger. It adds the Disb balance from the 
Total column in the Billing Fees Journal’s Firm Summary section. 
Finally it deducts the balance of general retainers that have not yet 
been applied, as displayed under the Firm Totals of the Client Ledger.

G/L: Provides the end balance of Client Disb Recov (1210).

Client/Journal: Compares the disbursement calculation described in Client to the 
end balance of Client Disb Recov (1210).

For Cash systems only: Client Disb Expense (5010) is not a reconcilable balance since as an expense 
account, its balance is allocated to net income at the close of each year. Therefore Client Disb Expense 
(5010) does not appear on the G/L Reconciliation report.
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Accounts Payable
For Accrual systems only: This section compares the Payable Listing report to General Liabilities (2000). 
Payables processed after the end date of the report do not affect the end balance of the report.

Journal: Displays the total of payables outstanding as it appears on the Firm Totals line of the 
Payable Listing.

G/L: Displays the end balance of General Liabilities (2000).

Journal/G/L: Compares the Firm Totals line of the Payable Listing to the end balance of General 
Liabilities (2000).

For Modified Cash and Cash systems: Outstanding payables are not tracked in the general ledger. Therefore 
this section is not included on the G/L Reconciliation report for either accounting method.

GST
For firms collecting GST only: This section compares the General Reconciliation balance on the GST journal 
to the end balance of GST Payable (2400).

Journal: Displays the General Reconciliation balance of the GST Journal.

G/L: Displays the end balance of GST Payable (2400).

Journal/G/L: Compares the General Reconciliation balance of the GST Journal to the end balance of 
GST Payable (2400). 

 Reconciling the G/L Reconciliation Report
The chart below lists the core journals, client ledgers, and general ledger accounts that reconcile to the G/L 
Reconciliation report, and the item on the report that can be reconciled.

G/L Reconciliation Reconciles to Additional comments

Trust Bank > Client
(individual bank 
accounts)

Client Trust Listing Firm Totals by 
Accounts > 
Account Balance 
(for individual 
accounts)

Run Trust Listing from 1/1/82 to the end 
date of the G/L Reconciliation. report 
should be for all matters and can be for 
Firm Totals only.

Trust Bank > Client
(trust funds owed 
line) 

Client Trust Listing Firm Totals by 
Accounts > 
Account Balance > 
Firm totals.

Run Trust Listing from 1/1/82 to the end 
date of the G/L Reconciliation. report 
should be for all matters and can be for 
Firm Totals only.

Trust Bank > Journal
(individual bank 
accounts)

Trust Bank Journal Bank Account 
Summary > Balance 
(for individual 
accounts)

Run journal for the end date of the G/L 
Reconciliation report.

Trust Bank > Journal
(trust funds owed 
line)

Trust Bank Journal Bank Account 
Summary > Balance 
> Total

Run journal for the end date of the G/L 
Reconciliation report. Report should be for 
all bank accounts.

Trust Bank > G/L
(individual bank 
accounts)

General Ledger Closing Balance - 
Trust Bank Acct #

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

Trust Bank > G/L 
(trust funds owed 
line)

General Ledger Closing Balance - 
Trust Funds Owed

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

General Bank> 
Journal (individual 
bank accounts)

General Bank 
Journal

Bank Account 
Summary > Balance 
(for individual 
accounts)

Run journal for the end date of the G/L 
Reconciliation report.
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Exhibit 8-3. Table displaying the different reports that reconcile to the G/L Reconciliation report 

G/L Reconciliation Reconciles to Additional comments

General Bank > G/L 
(individual bank 
accounts)

General Ledger Closing Balance - 
General Bank Acct 
#

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

Accounts 
Receivable > Client 
(all accounting 
methods)

Client Ledger Balances > A/R Run ledger from 1/1/82 to end date of the 
G/L Reconciliation report. Report can be 
run for Firm Totals only. Refer to End Date 
line.

Accounts 
Receivable > 
Journal 
(all accounting 
methods)

Billing (Fees) 
Journal

Firm Summary > 
Total > Total

Run journal from 1/1/82 to end date of the 
G/L Reconciliation report. Report can be 
run for Firm Totals only. Refer to Firm 
Summary.

Accounts 
Receivable > G/L 
(for accrual 
accounting)

General Ledger Closing Balance - 
Accounts 
Receivable

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

Client Disb Recov > 
Client 
(for accrual 
accounting)

Client Ledger Unbilled > Che + 
Unbilled > Recov

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

Client Disb Recov > 
Client 
(for modified cash 
accounting)

Client Ledger +
Billing (Fees) 
Journal

(from client ledger) 
Unbilled > Che + 
Unbilled > Recov - 
General Retainers + 
(from billing fees 
journal) Firm 
Summary > Total 
Disb

Run ledger from 1/1/82 to end date of the 
G/L Reconciliation report. Report can be 
run for Firm Totals only. Refer to End Date 
line.
Run journal from 1/1/82 to end date of the 
G/L Reconciliation report. Report can be 
run for Firm Totals only. Refer to Firm 
Summary.

Client Disb Recov > 
G/L 
(for accrual & 
modified cash 
accounting)

General Ledger Closing Balance - 
Client Disb Recov

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

Accounts Payable > 
Client 
(for accrual 
accounting)

Payable Listing Outstanding > Firm 
Totals

Run listing from 1/1/82 to end date of the 
G/L Reconciliation report. Report can be 
run for Firm Totals only. Refer to End Date 
line. Run for Unpaid or Both.

Accounts Payable > 
G/L 
(for accrual 
accounting)

General Ledger Closing Balance - 
General Liabilities

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.

GST > Journal (for 
firms using GST)

GST Journal General 
Reconciliation 
Balance

Run journal for the end date of the    G/L 
Reconciliation report.

GST > G/L (for firms 
using GST)

General Ledger Closing Balance - 
GST Payable

Run ledger for the month that includes the 
end date of the G/L Reconciliation report, 
up to the end date only.
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Cash Flow Planner
The Cash Flow Planner offers a quick analysis of the short term cash flow of the firm. The report provides an 
inventory of cash on hand and cash received by the firm for a selected month. A summary of payables and 
receivables due is given, as well as current work-in-progress and invoices created during the month.

What Entries Appear on the Report
Cash on Hand values on the Cash Flow Planner are modified through the following features:

A/P values on the Cash Flow Planner are modified through the following features:

A/R values on the Cash Flow Planner are modified through the following features:

Work-in-progress values on the Cash Flow Planner are modified through the following features:

Bills Sent Month To Date values on Cash Flow Planner are modified through the following features:

Cash In Month To Date values on the Cash Flow Planner are modified through one of the following features:

Transactions created through the Request Check or Request Bill features do not affect the Cash Flow Planner 
until the check or bill is released.

The Selection Window

The report selection window appears when selecting a report from the pull-down menu or Quick Step.

Exhibit 8-4. The report selection window for the Cash Flow Planner 

Report Month: To view cash flow for a specific month, type or select the date.

Load Last: To use the settings from the last time the report was created, click this button.

OK: To create the report, click this button.

• General Check • General Release Check • General Bank-to-Bank Transfer
• Receive Payment • General Retainer • Firm Receipt
• New Payable > Pay Now • Process Payable.

• New/Open Payable • Process Payables • General Check.

• Receive Payment • Change/Write Off Bill • Create Bill/Quick Bill/Release Bill.

• Time Sheet/Fee Sheet • PCLaw Timers • Calendar
• Phone Call Manager • General Check • Expense Recovery.

• Create Bill • Quick Bill • Release Bill

• Trust-to-General Transfer • Create Bill/Release Bill • Quick Bill
• Receive Payment. • General Retainer • Firm Receipt

Pull-down menu: Reports > Cash Flow Planner
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The Report
The Cash Flow Planner reports on the short term cash position of the firm.

Exhibit 8-5. An excerpt from the Cash Flow Planner 

Cash on Hand: Displays the balances for all general bank accounts up to and including the date 
displayed in the heading of the report. Each bank account, including its account 
number, account name, and balance is included on the report. Post-dated checks and 
receipts are not included in the balance, even if the date falls within the report month.

Cash on Hand does not include balances for trust accounts, for trust funds are 
simultaneously a firm asset and liability and do not add to the short term equity of the 
firm. Only when trust funds are transferred into a general bank account, are the funds 
then included in the Cash on Hand balance. 

Accounts Payable: Displays the balance for all outstanding payables, if the invoice date of the payable falls 
on or before the date displayed in the heading of the report. Payables and payments 
dated after the heading date are not included on the report, even if that date falls within 
the report month. Payable information is divided into periods, based on the heading 
date of the report minus the interval of days specified. 

Accounts Receivable: Displays the balance for all outstanding receivables where the A/R date of the 
invoice falls on or before the date displayed in the heading of the report.   Invoices and 
payments dated after the heading date do not affect the balance displayed on the 
report, even if they are dated within the report month. Receivable information is 
divided into periods, based on the heading date of the report minus the interval of days 
specified.

All write downs affect the Accounts Receivable value regardless whether the write 
down is dated prior to, during, or after the report month. Provisional write-offs do not 
affect the Accounts Receivable balance.

 Work in Progress > Current: Balance includes total unbilled fees, disbursements and general retainers 
from 30 days prior to the date displayed in the report heading forward, including post 
dated items. Aged Work in Progress information is divided into periods based on the 
heading date of the report minus the interval of days specified. 

If work in progress is billed, the invoice date is used to determine if the WIP is included 
in the displayed balance. If the invoice date is after the heading date, then the items are 
still considered unbilled and are included in the work in progress balance.
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Bills sent month to date: Balance includes the dollar amount of fees, disbursements, and taxes included on 
invoices where the invoice A/R date is within the report month. The date that is displayed 
in the report heading has no bearing on the values displayed in this section.

Only write-offs dated within the report month on invoices with an A/R date within the 
report month affect the Bills sent month to date balance.   Provisional write-offs do not 
affect the balance. The report heading date does not filter write-offs.

Cash in month to date: Balance includes receive payments, general retainers, and firm receipts received 
during the current month. Receive payment amounts are displayed according to how they 
are allocated to fees, disbursements and taxes. If a general retainer received during the 
report month is applied to a billing, the retainer amount is reduced and the appropriate 
fees, disbs, or taxes values are increased. The date that is displayed in the report heading 
do not filter the balances displayed in this section.

Recurring Entries due this month: Provides all recurring entries that contain a due date that falls within the 
report month.

The Cash Flow Planner does not have contain any summary sections.

Drill Down
The Cash Flow Planner does not support drill down on sections or balances that appear on the report.

 Reconciling the Cash Flow Planner
The chart below lists PCLaw reports that reconcile to the Cash Flow Planner, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 8-6. Table displaying the different reports and their sections that reconcile to the Cash Flow Planner 

Cash Flow Planner Reconciles to Additional comments

Cash on Hand
(individual bank 
accounts)

General Bank 
Journal > Bank 
Account Summary

Account Balance Run for all bank accounts with a start date 
of 1/1/82 and an end date as displayed in 
Header of Cash Flow Planner.

Bank Balances Balance Select As of Today

Accounts Payable Payable Listing Firm Totals > Aging 
Categories

Run for all Vendors. Change Aging 
Categories to 1 = 1, 2 = 8, 3 = 30. For 
Include Invoices; select Unpaid. For Age 
By; select Until Due. For Payments Up To 
date, select date displayed in Header of 
Cash Flow Planner.

Bills sent month to 
date (Fees/Disbs/
Taxes)

Billing (Fees) 
Journal

Firm Totals >(Fees/
Disb/Tax) 

Run report for all matters, dated from the 
first day to the last day of the month. 
Include Write-offs

Cash in month to 
date (Fees/Disbs/
Taxes)

Payment Allocation 
Listing

Total Payments/
Adjustments > (Fee 
Total/Disb/Tax)

Run report for all matters, dated from the 
first day to the last day of the month. 
Reports will only reconcile if there are no 
payment adjustments due to write-offs
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The Cash Flow Planner does not reconcile to the Receivables by Client report for Accounts Receivables for 
the Cash Flow Planner includes write-offs entered after the date of the report.

The Cash Flow Planner does not reconcile to the Lawyer WIP, Billing, & Collection Summary for Accounts 
Receivables for the Cash Flow Planner includes write-offs that are entered after the date of the report.

The Cash Flow Planner does not reconcile to the Client Summary for Work in Progress or Accounts 
Receivable as the Client Summary cannot be created for a single month. 

The Cash Flow Planner does not reconcile to the Work-in-Progress report for Work in Progress, for the 
Cash Flow Planner still includes WIP that has been billed, providing the invoice date is after the heading 
date of the report. The Work-in-Progress report does not include WIP that has been billed at a future date.

The Cash Flow Planner does not reconcile to the Invoice Journal for Bills sent month to date, for the Cash 
Flow Planner may include write-offs in its values.

The Cash Flow Planner does not reconcile to the Client Ledger for Bills sent month to date as the Client 
Ledger would not include individual charges entered prior to the report month.

The Cash Flow Planner does not reconcile to the Collection Summary for Retainers as displayed the Cash 
in Month to Date section as the Cash Flow Planner reduces the retainer amount when a retainer is applied 
during the billing process. The Collection Summary does not adjust the retainer amounts.

There is not an equivalent report for reconciliation of Firm in the Cash in Month to Date section, as no 
other reports isolate that value.
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Bank Reconciliation Report
The Bank Reconciliation report is produced from within the Bank Reconciliation module. The report displays 
cleared and outstanding checks and receipts, and possible differences between the actual and calculated 
bank statement and bank journal balances.

Producing Bank Reconciliation Reports

Print the Bank Reconciliation report prior to saving the bank reconciliation and proceeding to the next 
period. It is not possible to reprint the Bank Reconciliation report for the reconciled period, after moving 
forward to the next period, unless you reopen the bank reconciliation.

The Bank Reconciliation report can only be created from within the Bank Reconciliation module, and only 
for the active session of the reconciled account.

PCLaw prompts you, when saving a reconciled account, to print the report for the current period. Ensure you 
have the most up to date report before proceeding.

Sort By: Select one of the following:

Date: To sort by item date, select this option.

Check Number: To sort by check or receipt number, select this option.

Paid To/Receive From: To sort by paid to or received from information, select this option.

Amount: To sort by item amount, select this option.

Print Separate Outstanding Items List: To print a list of outstanding items, select this check box.

Totals Only: To create a report without item details, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Bank reconciliation report is displayed in three sections:
• bank statement reconciliation
• bank journal reconciliation
• outstanding items (if the report option is selected).

The Bank Statement Reconciliation Section
The statement reconciliation section compares the sum of marked items against the bank statement balance. 
The bank statement values are entered in the Select Account window or carried over from the previous bank 
reconciliation.

Bank Reconciliation: Report button
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The Bank Statement Reconciliation section displays all marked checks, marked receipts, and New Errors 
entered for the period.

Exhibit 8-7. The Bank Reconciliation report displaying the Bank Statement Reconciliation section 

Calculated Statement Balance: Provides the sum of the bank statement opening balance as shown in the 
Select Account window, marked receipts, and New Errors, less marked checks. 

Bank Statement: Displays the closing balance entered in the Select Account window.

Difference: Compares the difference between the calculated Marked Items balance and the actual 
balance of the bank statement. A difference of zero indicates the bank is reconciled to 
the statement. A positive or negative difference indicates an imbalance with the 
reconciliation that has occurred in the current period.

If there is a non-zero difference, confirm all checks and receipts are correctly marked or 
unmarked. All bank debit and credit memos are properly accounted for in PCLaw. All 
errors on the current bank statement are properly recorded.

Bank Journal Reconciliation Section
The Bank Journal Reconciliation section calculates a balance for the bank journal from information on the 
reconciliation and compares that to the actual bank journal balance. The bank journal values are pulled 
from the bank journal for the end date of the reconciliation as entered in the Select Account window.

Exhibit 8-8. The Bank Reconciliation report displaying the Bank Journal Reconciliation section 

The Bank Journal Reconciliation displays all outstanding checks and receipts as of the end date of the 
reconciliation period, as well as outstanding bank errors. New errors entered in the current period are 
displayed the opposite of how they appear in the bank statement.

Calculated Bank Journal Balance: Displays the sum of the bank statement closing balance as entered or 
displayed in the Select Account window plus outstanding receipts and bank errors and 
less outstanding checks.

Actual Bank Journal Balance: Displays the closing balance on the bank journal for the end date of the 
reconciliation period as entered in the Select Account window.
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Difference: Compares the difference between the calculated and actual balance of the bank journal. A 
difference of zero indicates the bank is reconciled to the journal. A positive or negative 
difference indicates an imbalance with prior items listed or not listed in the current period.

If there is a non-zero difference, confirm there are no entries dated prior to the current 
period, that did not appear as outstanding on the previous reconciliation. Run a bank 
journal for the prior reconciliation period and compare the closing balance of the journal 
to the Actual Bank Journal Balance on the previous period’s Bank Reconciliation report. If 
the two balances are not the same, then one or more back-dated entries may have 
occurred or the bank journal balance needs to be verified.

If a check or receipt has been outstanding for two years, that entry may have been summarized during the last 
month end. Call LexisNexis PCLaw Technical Support at 1-800-387-9785 for assistance with this issue.

For first time reconciliations, confirm the bank journal opening balance is correct and all prior checks and 
receipts have been included on the Prior Items window.

Outstanding Items List
The Outstanding Items section displays a list of all outstanding checks, receipts, and errors. The list provides a 
sub-total for each category, as well as a Total Outstanding Items balance for all outstanding items.

Exhibit 8-9. The Bank Reconciliation report displaying the Outstanding Items List 

The Outstanding Items List section is an optional section on the Bank Reconciliation report.
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Trust Administration Fee Detail 
The Trust Administration Fee (TAF) Detail lists TAF charges recorded in PCLaw within the date range of the 
report. The report provides a hard copy of TAF entries for a specific matter, lawyer, or period.

The TAF Detail report is available for British Columbia firms only. 

What Entries Appear on the TAF Detail Report
The TAF Detail report displays charges added through the TAF Entry window. Changes to TAF charges that 
appear on the TAF Detail report can be performed through the Register, Matter Manager, or Correct TAF 
features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-1. The Common tab of the TAF Detail report for British Columbia 

Matter: To view the TAF for a specific matter, type or select the matter nickname.

Lawyer: To view charges for a specific lawyer, type or select the lawyer nickname.

Start Date: To view charges on or after a specific date, select the date.   

End Date: To view charges on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The TAF Detail report lists trust administration fees for the criteria specified when creating the report.

Exhibit 9-2. An excerpt from the TAF Detail report 

Matter: Displays the matter nickname.

Lawyer: Displays the responsible lawyer for the matter.

Entry Date: Displays the date of the TAF entry, not the date of the first eligible trust receipt.

Pull-down menu: Reports > Trust Administration Fee > TAF Detail Report > Common tab
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Fee: Lists the trust administration fee amount.

GST: Lists the applicable GST charge on the fee.

Total: Lists the transaction total.

The TAF Detail report does not contain any summary sections.

Drill Down
The TAF Detail report allows drill down in the following area:

Exhibit 9-3. Table displaying fields where drill down is enabled and the reports or features that are opened

Reconciling the TAF Detail report
The chart below lists PCLaw reports that reconcile to the TAF Detail report, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-4.  Table displaying the different reports and their sections that reconcile to the TAF Detail report 

Drill down on Opens the following window
anywhere on the TAF transaction line Correct TAF Entry

TAF Detail report Reconciles to Additional comments

Fee > Total TAF Summary Sub-Total For reporting period.

GST > Total TAF Summary (Sub-Total x 0.07) 
GST

For reporting period.

Total > Total TAF Summary Total Payable For reporting period.
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Trust Administration Fee - Eligibility Report 
The Trust Administration Fee (TAF) - Eligibility report is the report submitted with your TAF remittances. The 
report calculates the TAF remittance including GST for a specific period.

The TAF - Eligibility report is available for British Columbia firms only.

What Entries Appear on the TAF - Eligibility Report
TAF values appear on the TAF - Eligibility report through the Data Entry > Trust Receipt window where a TAF 
Eligible explanation code is used. TAF Entered dates appear through the TAF Entry window on the Data Entry 
pull-down menu, and in the Trust Receipt window, when a TAF eligible receipt is entered.

Changes to TAF values on the TAF - Eligibility report can be performed through the Register, Matter Manager, 
or Correct TAF features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-5. The Common tab of the TAF - Eligibility report for British Columbia 

Start Date: To include eligible trust receipts on or after a specific date, select the date.   

End Date: To include eligible trust receipts on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The TAF - Eligibility report provides all trust receipts where a TAF eligible explanation code is used, even if 
this is not the first trust receipt for the matter to use such a code. If the matter has already been charged TAF, 
that date also appears on the report.

Exhibit 9-6. Excerpt from the TAF - Eligibility report for British Columbia 

Matter: Displays the matter nickname.

Client: Displays the client nickname.

Matter Description: Displays the matter description as it appears in Matter Manager.

Pull-down menu: Reports > Trust Administration Fee > TAF Eligibility Report > Common tab
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Trust Balance: Provides the total of trust funds for the matter. This value appears only if a TAF eligible 
trust receipt is entered within the date range of the report. The value of the trust balance 
includes entries outside the date range of the report, including post-dated entries. The 
value of the specific entry is not displayed. 

TAF Entered: If a TAF was charged to the matter, the date of the charge is listed. This date can be 
outside the date range of the report. 

Number of Trust Administration Fees Entered: Provides the count of matters listed on the report that 
possess a TAF Entered date.

Number of Trust Administration Fees Not Entered: Provides a count of matters listed on the report that do 
not possess a TAF Entered date.

The TAF - Eligibility report does not contain any summary sections.

Drill Down
The TAF - Eligibility report allows drill down in the following area:

Exhibit 9-7. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the TAF - Eligibility Report
The TAF Eligibility report not a reconcilable report.

Drill down on Opens the following window

anywhere on the matter/trust balance line Matter Manager
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Trust Administration Fee Summary 
The Trust Administration Fee (TAF) Summary is the report submitted with your TAF remittances. The report 
calculates the TAF remittance including GST for a specific period.

The TAF Summary is available for British Columbia firms only.

What Entries Appear on the TAF Summary
TAF values appear on the TAF Summary through the Data Entry > TAF Entry window, and in the TAF Entry 
window that is displayed in the Trust Receipt window, when a TAF eligible receipt is entered.

Changes to TAF values on the TAF Summary report can be performed through the Register, Matter Manager, 
or Correct TAF features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-8. The Common tab of the TAF Summary for British Columbia 

Start Date: To include charges on or after a specific date, select the date.   

End Date: To include charges on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The TAF Summary provides the total number and dollar amount of charges in the report period grouped by 
the TAF entry date.

Exhibit 9-9. Excerpt from the Transaction Levy Summary for Newfoundland and Labrador 

Pull-down menu: Reports > Trust Administration Fee > TAF Summary > Common tab
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Firm Filing ID: (not shown) Displays the ID number entered on the Provincial tab of System Settings.

Month: Displays the separate calendar months in the reporting period. 

# of Client Matters: Lists the number of matters where a TAF was charged by month. 

Total: Provides the dollar value of all TAF entries for each month, the GST charged for all 
entries, and the total remittance amount.

The Transaction Levy Summary does not contain any summary sections.

Drill Down
The TAF > Summary does not provide the option to drill down on entries.

Reconciling the TAF Summary
The chart below lists PCLaw reports that reconcile to the TAF Summary, and the item on the report that 
can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-10.  Table displaying the different reports and their sections that reconcile to the TAF Summary 

TAF Summary Reconciles to Additional comments

Subtotal TAF Detail Fee > Total For reporting period.

(Sub-Total x 0.07) 
GST

TAF Detail GST > Total For reporting period.

Total Payable TAF Detail Total > Total For reporting period.



PCLaw Reports

Page 280 

Transaction Levy Detail (Newfoundland)
The Transaction Levy Detail report lists transaction levies recorded in PCLaw for real estate, civil litigation, 
and personal property categories. The report provides a hard copy of transaction levies entered for a specific 
matter, lawyer, or period.

The report is available for Newfoundland and Labrador firms only. 

What Entries Appear on the Transaction Levy Detail report
The Transaction Levy Detail report displays charges added through the Transaction Levy Entry window.

Changes to transaction levies that appear on the Transaction Levy Detail report can be performed through the 
Register, Matter Manager, or Correct Transaction Levy features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-11. The Common tab of the Transaction Levy Detail report for Newfoundland and Labrador 

Matter: To view levies for a particular matter, type or select the matter nickname.

Client: To view levies for matters belonging to a particular client, type or select the client 
nickname.

Start Date: To view levies filed on or after a specific date, select the date.   

End Date: To view levies filed on or before a specific date, select the date.

Real Estate: To view levies recorded for Real Estate, select this check box.   

Civil Litigation: To view levies recorded for Civil Litigation, select this check box.

Personal Property:To view levies recorded for Personal Property, select this check box.

Load Last: To use the settings from the last time the report was created, click this button.

OK: To create the report, click this button.

The Report
The Transaction Levy Detail report lists transaction levies for the criteria specified when creating the report.

Exhibit 9-12. An excerpt from the Transaction Levy Detail report 

Matter: Displays the matter nickname.

Lawyer: Displays the responsible lawyer for the matter.

Entry Date: Displays the date of the levy entry, not the date of the first eligible trust receipt.

Pull-down menu: Reports > Transaction Levy > Transaction Levy Detail Report > Common tab
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Type: Indicates whether the levy for civil litigation, real estate, or private property.

Category: Lists the sub-type for the respective type. For example, Statement of Claim for Civil 
Litigation or Transferor for Deed/Transfer. 

Fee: Lists the transaction levy charge.

HST: Lists the applicable HST charge on the levy.

Total: Lists the transaction total.

The Transaction Levy Detail report does not contain any summary sections.

Drill Down
The Transaction Levy Detail report allows drill down on the following features:

Exhibit 9-13. Table displaying fields where drill down is enabled and the reports or features that are opened 

Reconciling the Transaction Levy Detail report
The chart below lists PCLaw reports that reconcile to the Transaction Levy Detail report, and the item on 
the report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-14.  Table displaying the different reports that reconcile to the Nfld Transaction Levy Detail report 

Drill down on Opens the following window

anywhere on the transaction levy line Correct Nfld Transaction Levy

Transaction Levy 
Detail report

Reconciles to Additional comments

Total > Total Transaction Levy 
Summary for Nfld

Total Transactions For reporting period.
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Transaction Levy Summary (Newfoundland)
The Transaction Levy Summary is the report submitted with your transaction levy remittances. The report 
calculates the transaction levy remittance for a specific period for real estate, civil litigation, and personal 
property categories.

The report is available for Newfoundland and Labrador firms only. 

What Entries Appear on the Summary
Values appear on the Transaction Levy Summary through the Transaction Levy Entry window.

Changes to transaction levy values on the Transaction Levy Summary can be performed through the Register, 
Matter Manager, or Correct Transaction Levy features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-15. The Common tab of the Transaction Levy Summary for Newfoundland and Labrador 

Real Estate: To include levies filed for Real Estate, select this check box.   

Civil Litigation: To include levies filed for Civil Litigation, select this check box.

Personal Property:To include levies filed for Personal Property, select this check box.

Start Date: To include levies on or after a specific date, select the date.   

End Date: To include levies on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Transaction Levy > Transaction Levy Summary > Common tab
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The Report
The Transaction Levy Summary provides the total number and dollar amount of transaction levies for the 
report period grouped by the Matter Open Date.

Exhibit 9-16. Excerpt from the Transaction Levy Summary for Newfoundland and Labrador 

1. General Information: Displays the name of the law firm, its managing partner or sole practitioner, 
address, phone number, and e-mail. 

2. Transactions:  Provides a break down between the three transaction levy types, and the total levy 
value to remit, including detail on HST. 

3. Declaration: Provides an area to sign and date the remittance, and the address for the Law Society of 
Newfoundland and Labrador. 

The Transaction Levy Summary does not contain any summary sections.

Drill Down
The Transaction Levy Summary does not provide the option to drill down on entries.

Reconciling the Transaction Levy Summary
The chart below lists PCLaw reports that reconcile to the Transaction Levy Summary, and the item on the 
report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-17.  Table displaying the different reports and their sections that reconcile to the Nfld Transaction Levy Summary 

Transaction Levy 
Summary

Reconciles to Additional comments

Total Transactions Transaction Levy 
Detail for Nfld

Total > Total For reporting period.
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Transaction Levy Detail (Ontario)
The Transaction Levy Detail report lists transaction levies recorded in PCLaw for both real estate and civil 
litigation categories. The report provides a hard copy of transaction levies entered for a specific matter, 
lawyer, or period.

This report is available for Ontario firms only.

What Entries Appear on the Transaction Levy Detail report
The Transaction Levy Detail report displays charges added through the Transaction Levy Entry window.

Changes to transaction levies that appear on the Transaction Levy Detail report can be performed through the 
Register, Matter Manager, or Correct Transaction Levy features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-18. The Common tab of the Transaction Levy Detail report for Ontario 

Matter: To view the transaction levy for a single matter, type or select the matter nickname.

Lawyer: To view levies for a specific lawyer, type or select the lawyer nickname.

Start Date: To view levies filed on or after a specific date, select the date.   

End Date: To view levies filed on or before a specific date, select the date.

Real Estate: To view levies recorded for Real Estate, select this option.   

Civil Litigation: To view levies recorded for Civil Litigation, select this option.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Transaction Levy Detail report lists transaction levies for the criteria specified when creating the report.

Exhibit 9-19. An excerpt from the Transaction Levy Detail report 

Matter: Displays the matter nickname.

Lawyer: Displays the responsible lawyer for the matter.

Entry Date: Displays the date of the levy entry, not the date of the first eligible trust receipt.

Real Estate Type:  For Real Estate: Lists the Document Registered category.

Pull-down menu: Reports > Transaction Levy > Transaction Levy Detail Report > Common tab
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Transaction Category: For Real Estate: Lists the Acting For category.

Claim Category: For Civil Litigation: Lists the Document Filed category.

Fee: Lists the amount of the transaction levy charge.

GST: Lists the applicable GST charge on the charge.

Total: Lists the transaction total.

The Transaction Levy Detail report does not contain any summary sections.

Drill Down
The Transaction Levy Detail report does not provide the option to drill down on entries.

Reconciling the Transaction Levy Detail report
The chart below lists PCLaw reports that reconcile to the Transaction Levy Detail report, and the item on 
the report that can be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-20.  Table displaying the different reports and their sections that reconcile to the Ontario Transaction Levy Detail report 

Transaction Levy 
Detail report

Reconciles to Additional comments

Total > Total Transaction Levy 
Summary

Total Transaction 
Levies Due

For reporting period.
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Transaction Levy Summary (Ontario)
The Transaction Levy Summary is the report submitted with your transaction levy remittances. The report 
calculates the transaction levy remittance for a specific period both real estate and civil litigation categories.

This report is available for Ontario firms only.

What Entries Appear on the Summary
Values appear on the Transaction Levy Summary through the Transaction Levy Entry window.

Changes to transaction levy values on the Transaction Levy Summary can be performed through the Register, 
Matter Manager, or Correct Transaction Levy features. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw report. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-21. The Common tab of the Transaction Levy Summary 

Real Estate: To include levies filed for Real Estate, select this option.   

Civil Litigation: To include levies filed for Civil Litigation, select this option.

Start Date: To include levies filed on or after a specific date, select the date.   

End Date: To include levies filed on or before a specific date, select the date.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

Pull-down menu: Reports > Transaction Levy > Transaction Levy Summary > Common tab
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The Report
The Transaction Levy Summary provides the total number and dollar amount of transaction levies for the 
report period grouped by the Matter Open Date.

Exhibit 9-22. Excerpt from the Transaction Levy Summary 

The transaction levy category is displayed as a title on the top of the report.   The name, managing partner, 
address, and phone number of the law firm are also provided. 

Transaction levies are grouped into the below categories based on the opening date of the matter to which 
they are applied. A total of transaction levies is provided, along with the portion of the total allocated to 
GST. GST allocations are applicable to levies charged to matters opened in 1998 and before.
• Prior to 1996
• Between 1996 and 1998
• After 1999.

The lower portion of the Transaction Levy Summary lists the law society members of the firm, provides a 
statement, and a place for the signature of the managing partner. 

The Transaction Levy Summary does not contain any summary sections.

Drill Down
The Transaction Levy Summary does not provide the option to drill down on entries.

Reconciling the Transaction Levy Summary
The chart below lists PCLaw reports that reconcile to the Transaction Levy Summary, and the item that can 
be reconciled. The reports must be run with identical dates and parameters.

Exhibit 9-23.  Table displaying the different reports that reconcile to the Ontario Transaction Levy Summary 

Transaction 
Summary

Reconciles to Additional comments

Total Transaction 
Levies Due

Transaction Levy 
Detail report

Total > Total For reporting period.
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Volume Surcharge Summary
The Volume Surcharge Summary calculates the volume surcharge remittance in order to send a summary of 
civil litigation and real estate activity to the Law Society of Upper Canada. Run this report twice to submit as 
a hard copy with your remittance, once for civil litigation, and once for real estate. 

This report is available for Ontario firms only.

What Entries Appear on the Volume Surcharge Summary
All items displayed on the Volume Surcharge Summary is calculated when creating the report. 

The Common Tab

The Common tab contains the most widely used options on any PCLaw Summary. It is the first tab to appear 
when selecting a report from the pull-down menu or Quick Step.

Exhibit 9-24. The Common tab of the Volume Surcharge Summary 

Gross Billing: Type the amount of the firm’s gross billing. 

To find the gross billing amount, create a Billing (Fees) Journal for the calendar year, 
deselecting Include Write-Ups and Write-Downs. Refer to Total Fees Billed. Create a Write 
Up/Down Journal for the same period. Use Total Fees Billed less Fees Written-off. 

Average Number of Lawyers: Type the average number of lawyers for the reporting period.

 To determine the average number of lawyers, add up the fewest number of lawyers in the 
firm for each fiscal quarter being reported. Divide the number by four. Round up to the 
nearest integer. Only include timekeepers who are members of the Law Society of Upper 
Canada. Omit timekeepers such as paralegals and administrative staff.

Fiscal Year End: Type or select the date of the end of the fiscal year.

Load Last: To use the settings from the last time the report was created, click this button.

Other tabs: To access additional settings, click the tab.

OK: To create the report, click this button.

The Report
The Volume Surcharge Summary calculates the average gross billing by dividing the gross billing amount by 
the average number of timekeepers for the law firm.

The name, managing partner, address, and phone number of the law firm are provided at the top of the 
report.

Four calculation lines are displayed, for gross billing for the firm, average number of lawyers, average billing 
for the firm, and volume surcharge payable.

Pull-down menu: Reports > Transaction Levy > Volume Surcharge Summary > Common tab
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The lower portion of the Volume Surcharge Summary lists the law society members of the firm, provides a 
statement, and a place for the signature of the managing partner.

Exhibit 9-25. An excerpt from the Volume Surcharge Summary 

The Volume Surcharge Summary does not contain any summary sections.

Drill Down
The Volume Surcharge Summary does not provide the option to drill down on entries.

Reconciling the Volume Surcharge Summary
The Volume Surcharge Summary is not a reconcilable report.
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Where Canadian Reports are Available
Transaction Levy and Trust Administration Fee reports are available for Canadian firms, providing the 
following province is selected on the Provincial tab of Options > System Settings.

Some reports are not available for earlier versions of PCLaw.

Exhibit 9-26. Table listing Canadian reports, and for what province they are available 

Report Name Included in 

Province

Transaction Levy Detail Ontario

Transaction Levy Summary Ontario

Transaction Levy Detail Newfoundland and Labrador

Transaction Levy Summary Newfoundland and Labrador

Trust Admin Fee Detail British Columbia

Trust Admin Fee Eligibility British Columbia

Trust Admin Fee Summary British Columbia

Volume Surcharge Summary Ontario
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Matter Tab
The Matter tab is found on all matter based reports in PCLaw. This tab allows you to define the report by any 
combination of selected matters, clients, lawyers, types of law, or matter status. You can also sort by type of 
lawyer.

Exhibit 10-1. The typical format of a Matter tab found on many PCLaw reports. Depending on the report, the matter tab may not contain 
all the options as shown above

All: To run the report for all matters, select this option.

Selected Matters: To create the report for specific matters, select this option.
The adjacent Select button becomes available.

Click the Select button.
A Select Matters window appears.

Selected Clients: To create the report for specific clients, select this option.
The adjacent Select button becomes available.

Click the Select button.
A Select Clients window appears.

Range of Clients - By Client Nickname: To create the report for a sequential range of clients by client 
nickname, select this option. 
The adjacent From and To boxes become available.

From: Type or select the first client nickname, alphanumericly, for the range of 
clients.

To: Type or select the last client nickname, alphanumerically, for the range 
of clients.

Range of Clients - By Client Name: To create the report for a sequential range of clients by client name, 
click this option. 
The adjacent From and To boxes become available.

From: Type or select the first name, alphabetically, for the range of clients.

To: Type or select the last name, alphabetically, for the range of clients.

Major Clients: For PCLawPro and PCLawPro Enterprise only: To create the report for specific major 
clients, check this option.
The adjacent Select button becomes available.

Click the Select button.
A Select Major Clients window appears.
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Sort By: Select one of the following: (some options are not available for some reports).

Default: To sort by its default settings (by date or entry order, depending on 
the report), click this option. 

Responsible Lawyer: To sort by the matter’s responsible lawyer, select this option.
The New Page for Each Lawyer option becomes available.

To display information for each responsible lawyer on a separate 
page when printing the report, check New Page for Each Lawyer.

Assigned Lawyer: To sort by the matter’s assigned lawyer, select this option.

Client Intro Lawyer: To sort by the matter’s client introducing lawyer, select this option.

Type of Law: To sort by the matter’s assigned type of law, select this option.

New Page for Each Matter: When printing the report, to create a separate page for each matter, select this 
check box.

Client Intro Lawyers: To specify one or more client introducing lawyers, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Select Client Introducing Lawyer window appears.

Matter Intro Lawyers: For PCLawPro and PCLawPro Enterprise: To specify one or more matter introducing 
lawyers, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Select Matter Introducing Lawyer window appears.

Responsible Lawyers: To specify one or more responsible lawyers, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Select Responsible Lawyer window appears.

Assigned Lawyers: To specify one or more assigned lawyers, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Select Assigned Lawyer window appears.

Task Codes: To specify one or more task codes, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Task Code window appears.

Type of Law: To specify one or more types of law, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Type of Law window appears.

Department: To specify one or more departments, select this option. 
The adjacent Select button becomes available.

Click the Select button.   
The Department window appears.

Select From: Select one or more of the following: 

Active Matters: To include active matters on the report, select this check box.

Inactive Matters: To include inactive matters on the report, select this check box.

Archived Matters: To include archived matters on the report, select this check box.

Some information for archived matters may be not be available.
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Layout Tab
The Layout tab allows you to adjust the physical appearance of the report without affecting how information 
is extracted from the database. What information gets displayed on the report is determined by the options 
selected under the Layout tab. A check box exists for all columns on the report, and all items that appear in 
the summary and total sections.

Exhibit 10-2. The typical format of a Layout tab found on many PCLaw reports. The selections for each report differ 

The Layout tab does not have settings to hide some options that appear on certain reports, for example, Show 
User Name or Daily totals. For these options not to appear on the report, deselect the options under their 
appropriate tabs.

The Layout tab is not included with those reports that provide the Customizable report option.

Template: To use a previously saved layout, select from the drop down list.

Check boxes: To have an item not appear on a report, deselect the check box adjacent the item.

For items not currently displayed on a report, select the check box adjacent the item.

OK: To apply your selections, click this button.
The Report Layout prompt appears:

To modify the current template:

Click Save the Changes to the current template.

Click OK.
A PCLaw prompt appears:

Click Yes.
The report is created.
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To create a new template:

Click Create a new template. 

Assign a name to the new template in the adjacent box.

Click OK.
A PCLaw prompt appears:

Click Yes.
The report is created.

Not all users may have access to the layout tab. Rights to the tab can be restricted in Groups tab in 
Security. The user may be granted rights to:
• default only
• allow change
• allow change and save.

To open security, select Administrator > Security on the Options pull-down menu. 
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Customizing PCLaw Reports

About Customizable Reports
Selected reports in PCLaw can be customized to meet the needs of your firm. The Customizable report 
feature, on the Common tab of the report selection window lets you choose the columns that appear on the 
report and the order that they appear. Columns can be individualized in terms of width, font type and size, 
alignment, color and width. The layout can be saved under a unique name, allowing multiple layouts to be 
used for any report. 

Because of each report’s unique data fields, layouts are specific to the report where they have been added 
and cannot be transferred to other customizable reports.

Once completed, you can choose to make the layout your default layout to be used when producing the 
report. If you do not assign your layout as the default for the report, you can still select it at any time when 
producing the report. Customizable layouts can be changed at any time, or removed when they are no longer 
required.

Customizable Reports are currently available for the following reports:

Customizing Reports
The Layout area displays on the Common tab of any customizable report. Use this option to select a layout 
when producing the report. New layouts can also be created. Existing layouts can be modified or removed.

Exhibit 10-3. The Layout area on the Common Tab of all customizable reports.

Layout: To select a layout, from the drop down list, highlight the layout you wish to use.

Add: To create a new layout for this report, click this button. 
The Custom Report Layout window appears. 

Change: To change an existing layout, from the drop down list, highlight the layout.

Click the Change button.
The Custom Report Layout window appears.

Remove: To remove an existing layout, from the drop down list, highlight the layout.

Click the Remove button.
A PCLaw prompt appears.

Click Yes.
The layout is removed from the report.

• General Bank Journal • Trust Bank Journal • Trust Bank Matter-to-Matter 
Journal

• Billing (Fees) Journal • Invoice Journal • Write Up/Down Journal
• Client Ledger • Client Summary • Client Fee Listing
• Client Trust Listing • Client Trust Ledger • List of Clients
• Receivables by Client • Payment Allocation Listing • Time Listing
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Custom Report Layout Window
Use this window to create or change a customizable report layout.

Exhibit 10-4. The Custom Report Layout window for customizing reports

Layout Name: This area contains the basic details for the layout, including the layout name, default 
font, and source report.

Layout View: This area provides a actual view of how the final report will appear.

Available/Selected: Use these boxes to decide what fields you want on the report and in what order.

Select Field Properties: This area provides you with the tools to customize each individual column.

Layout Name
Prior to creating a layout, the layout name is required. Each layout must have a unique name.

Name: Type the name for the layout.

Report Font: Select the default font to use on the report.

In the adjacent box, select the font size.

The font size directly affects the amount of information the report can contain.

Layout View
Each field moved to the Selected box appears in the layout view. Columns appear in descending order as 
they are listed in the Selected box. If more columns are selected than there is horizontal width on the 
report, PCLaw automatically creates a second row of information below the first.

Lines appear in the format that they are used on the report. For example, a date field displays an eight digit 
date. Explanation fields display text1, text 2, text 3. Numeric fields displays numbers.

For fields that contain multiple rows of information, all secondary lines contain the word Repeat to 
indicate it is a continuation of the primary line. Each new row of primary information is alternatively 
shaded.
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Available and Selected
All available fields specific to the current customizable report are listed in the Available box. Formulas and 
customizable fields cannot be added to a customizable report. Use the Add and Remove arrows to add fields 
to the reports. Columns appear on the final report in the order that they are added to the Selected box.

Available: To add a field to a customizable report, highlight the field.

Click ADD >>
The field is moved to the Selected box and appears on the layout view.

Selected: To remove a field from a customizable report, highlight the field.

Click << Remove.
The field is moved to the Available box and no longer appears on the layout view.

To remove all fields from a customizable report, click << ALL.
All fields are moved to the Available box and the layout view is cleared.

Selected Field Properties
The appearance of each column can be customized to best meet the needs of the report.

Heading: Selections in this area change how the column heading appears:

Title: To change the name of the column, type the new name.

Size: To change the size of the column title fonts, select the size ratio in 
relation to the layout’s default font.

Bold: To bold the column title, select this check box.

Italic: To italicize the column title, select this check box.

Row (line): To set where the field appears in relation to the primary row, select the number.

1 signifies the field appears on the primary row, space allowing. 2 indicates the field 
appears one row below the primary row. 3 indicates the field appears 2 rows below.

Alignment: To align the contents in the field, select one of Left, Center, or Right.

Location: To set the location of the column on the report:

Start: Type the distance, in inches, the column is placed from the left margin. 

If this is not the first column on the report, PCLaw defaults to the end of 
the previous column. You cannot place a column overtop another 
column.

Len.: To fix the length of the column, type the width in inches.

End: To fix the end of the column, type the distance in inches from the left 
margin.

Color: To change the font color of the column text, select the color.

Bold: To bold the contents of the row, select this check box.

Italic: To italicize the contents of the row, select this check box.

Over Line: To place a line above the contents of the row, select this check box.

Under Lined: To place a line below the contents of the row, select this check box.

Strikethrough: To place a line through the contents of the row, select this check box.

Wrap: To word wrap a line, select this check box.

OK: To save your selections, click this button.
You are returned to the Common tab.
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Index

Symbols
# of Client Matters column 279
% Change column 201
% Column 84
% Firm column 126
% Lwyr 226
% Realized column 191
%(Hrs) column 182
%(Value) column 182

Numerics
1. General Information section 283
1099 Forms 136, 162
1099 Listing 4, 6, 136, 146, 156, 160–

162
1099 Type 160
121 Days column 84
2. Transactions section 283
3. Declaration section 283
31-60 Days column 84
61-90 Days column 84
91-120 Days column 84

A
A/P Allocations Summary 138, 142
A/P Pending column 96
A/R Alert check box 99
A/R Balance column 63, 169
A/R Balance total 38, 55, 59, 65, 101, 

109, 123, 134, 171, 188, 265
A/R column 58
A/R Date column 122
A/R total 38, 59, 109, 123, 188
Account # column 58
Account Balance column 72, 76
Account Balance total 77
Account box 145
Account column 53, 145
Accounting

Context column 253
Field column 253

Accounts Payable
New Payable 11, 14, 49, 56, 60, 78, 

82, 86, 90, 94, 137, 140, 144, 
148, 152, 154, 160, 184, 194, 
261, 266

New Vendor 152, 158, 160, 252
NewPayable 30
Open Payable 11, 30, 49, 56, 60, 78, 

82, 86, 90, 94, 137, 140, 144, 
148, 154, 160, 184, 194, 261

Open Vendor 152, 158, 160, 252
Pay Now option 261, 266
Process Payable 14, 30, 140, 144, 148, 

154, 160, 261, 266
Accounts Payable section 264, 267
Accounts Payable total 268
Accounts Receivable account (1200) 38, 

55, 59, 65, 123, 263
Accounts Receivable column 100
Accounts Receivable section 263, 267
Accounts Receivable total 101
Accrual accounting 31, 45, 121, 125, 

145, 168, 172, 216, 261, 263–
265

Acct box 14, 18, 22, 71, 74
Acct# column 16, 20, 23

Acting For category 285
Action/Description column 111, 245
Active Matters check box 293
Active Users option 251
Activity column 133
Actual Bank Journal Balance 17, 21, 271
Actual billed fees 164
Add button 296
Add PCLaw Document window 106
Address column 104, 250
Adjustment Sales Tax column 31
Adjustments column 191
Adjustments total 192
Advanced Column 96
Age By options 141
Age From box 36, 79, 83, 120
Aging Categories boxes 120, 141
Aging Categories total 143
Alignment box 298
All option 292
Allocated Amount column 23
Allocated column 150
Allocation button 204
Allocation column 130
Allocation Listing 4, 6, 136, 139, 142, 

147, 148–151, 157
Amount (-Disc) column 146
Amount (-Disc) total 146, 156
Amount box 32
Amount column 13, 68, 88, 92, 142, 

150, 153, 226
Amount total 69, 142, 223, 226
Appointment code 242
Appointment Listing 4, 6, 242, 243–245
Appointment Schedule 4, 6, 242, 245, 

246–247
Appointment Sheet

See Calendar
Appointments

See Calendar
Appt box 243
Archived Matters check box 112, 293
As Is box 262
Assigned Lawyer

See Lawyers
Assigned Lawyer column 62, 104
Assigned Lawyers option 293
Associated Contacts column 258
Audit Trail 8
Australia 4, 5, 48
Author box 257
Author column 258
Auto Allocate Payments to G/L Accounts 

128
Available box 298
Available/Selected area 297
Average gross billing 288
Average Number of Lawyers box 288

B
Balance column 53, 146, 150
Balance Owing column 133
Bank account 10
Bank Account Summary 17, 21, 23
Bank Acct# column 72, 76
Bank Check check box 16, 20
Bank Journal Reconciliation section 270, 

271
Bank Reconciliation 270
Bank Reconciliation report 4, 6, 17, 21, 

260, 270–272

Bank statement balance 270
Bank Statement column 271
Bank Statement Reconciliation section 

270
Batch column 16, 20
Billable Hours total 174
Billable Hours Worked total 183
Billable time 164
Billable Time Summary by Working Law-

yer 4, 6, 164, 220–223, 227
Billable Time Worked column 173
Billable Time Worked total 174, 183
Billed column 88, 92, 96, 122, 125, 166, 

191
Billed disbursements 101, 164
Billed Disbursements + Tax total 198
Billed Disbursements column 63, 186
Billed Disbursements total 13, 38, 43, 

54, 64, 89, 93, 126, 187
Billed fees 164
Billed Fees column 63, 185
Billed Fees total 38, 43, 54, 59, 64, 126, 

167, 187, 192, 198, 210, 214, 
218

Billed hours 164, 165
Billed Hours column 62
Billed Hours total 38, 64, 167, 192
Billed Invoice# column 52
Billed Out option 26
Billed Receipts total 54
Billed Tax total 38, 43, 54
Billed time 165
Billed total 126, 139, 142, 151, 167
Billed Up To box 86, 90, 94
BIlling

Recreate Bill 34
Billing 230

Create Bill 3, 11, 18, 30, 34, 40, 49, 
56, 60, 66, 86, 90, 94, 98, 106, 
119, 124, 128, 132, 165, 168, 
172, 176, 180, 184, 190, 194, 
200, 208, 212, 216, 220, 224, 
228, 230, 232, 238, 261, 266

Pre-Bill 34
Quick Bill 11, 14, 30, 34, 40, 49, 56, 

60, 66, 86, 90, 94, 98, 106, 119, 
124, 128, 132, 165, 168, 172, 
176, 180, 184, 190, 194, 200, 
204, 208, 212, 216, 220, 224, 
232, 238, 261, 266

Release Bill 11, 14, 18, 30, 34, 40, 49, 
56, 60, 66, 86, 90, 98, 106, 119, 
124, 128, 132, 165, 168, 172, 
176, 180, 184, 190, 194, 200, 
208, 212, 216, 220, 224, 228, 
230, 232, 238, 261, 266

Split Billing 130
Undo Bill 34, 40, 56, 119, 124, 132

Billing (Fees) Journal 4, 6, 8, 10, 34–39, 
43, 54, 55, 59, 64, 65, 69, 101, 
109, 123, 126, 134, 167, 170, 
171, 174, 175, 187, 189, 192, 
198, 203, 207, 210, 211, 214, 
218, 235, 240, 263, 265, 268, 
288, 296

Billing by Lawyer report 4, 6, 39, 123, 
127, 134, 164, 165–167, 183

Billing Information window 37, 204
Billing On Invoice 57
Billing Realization report 4, 6, 38, 69, 

164, 190–193, 207
Billing Status column 68
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Billings column 173, 196
Bills Sent Month to Date section 268
Bills Sent Month to Date total 268
Bold area 298
Bold check box 298
Box 7 total 162
British Columbia 20, 274, 276, 278, 290
Budget Figures 238
Budget Only option 238
Budget vs. Billed option 238
Budget vs. Collected option 238
Budget vs. Worked option 238
Business column 104
Business Phone # column 122
Business/Fax/Home column 250
By Task Code option 224
By Type of Law option 224

C
Calculate Interest check box 86
Calculated Bank Journal Balance 271
Calculated Statement Balance column 

271
Calculator button 204
Calendar 49, 60, 66, 78, 82, 98, 172, 

176, 180, 184, 190, 194, 216, 
220, 224, 228, 230, 232, 238, 
243, 246, 266

Appointment Sheet 49, 60, 66, 78, 82, 
98, 172, 176, 180, 184, 190, 194, 
216, 220, 224, 228, 230, 232, 
238, 243, 246

Appointments 243, 245, 246
Change Appointment 106, 243, 246, 

248
Change To Do 106
Context column 253
Date column 253
Explanation column 253
Field column 253
New Appointment 106, 243, 246, 248
New To Do 106
To do’s 243, 245, 246

Canada 4, 5, 274–290
Cash accounting 30, 145, 261, 263, 264
Cash basis 10
Cash check box 16, 20
Cash Flow Planner 4, 6, 39, 143, 260, 

266–269
Cash In

Receipts total 198
Retainers total 198

Cash In column 169
Cash in Month to Date section 268
Cash in Month to Date total 268
Cash on Hand section 267
Cash on Hand total 268
Categories column 166, 182, 281
Category column

see Categories column
Certified Check check box 16, 20
Change Appointment

See Calendar
Change button 296
Change column 45
Change Notes 106
Change Phone Call 248
Change To Do 106

See Calendar
Change total 43

Change/Write Off Bill 11, 30, 34, 37, 40, 
44, 49, 56, 60, 66, 94, 98, 119, 
124, 132, 165, 168, 204, 212, 
216, 232, 238, 261, 266

Che#/Rec# column 16, 20, 52, 76
Che/Inv column 80
Che/Rec# box 14, 18
Check

See General Bank or Trust Bank
Check # column 31
Check box 145
Check check box 16, 20
Check column 16, 20, 145
Check number 10
Check Number column 156
Cheque

See Check
Civil litigation 280, 282, 284, 285, 286, 

288
Civil Litigation check box 280, 282
Civil Litigation option 284, 286
CL Intro column 42
Claim Category column 285
Clear button 244
Client 10, 48, 118, 164, 242
Client # column 130
Client Accounting Ledger 4, 6, 48, 54, 

55, 56–59, 64, 65, 73, 77, 101, 
109, 123, 134

Client Balances Only check box 61, 66, 
78, 83

Client box 34, 40, 44, 50, 57, 61, 66, 70, 
74, 78, 82, 86, 90, 94, 102, 
106, 110, 112, 114, 119, 128, 
132, 180, 190, 194, 208, 220, 
232, 243, 246, 248, 254, 256, 
280

Client column 13, 16, 20, 23, 37, 42, 62, 
72, 76, 104, 107, 111, 113, 
115, 178, 191, 206, 213, 245, 
262, 263, 276

Client Costs Journal 4, 6, 10, 11–13, 81, 
85, 89, 93, 97, 101, 189, 199

Client Disb Clearing account (5210) 13
Client Disb Expense account (5010) 263
Client Disb Recov account (1210) 263
Client Expense Recovery

See Expense Recovery
Client Fees Listing 4, 6, 8, 39, 48, 54, 64, 

65, 66–69, 81, 85, 101, 108, 
179, 183, 187, 192, 197, 207, 
211, 219, 223, 226, 229, 231, 
235

Client Information column 133
Client Intro Lawyers button 99
Client Introducing lawyer

See Lawyers
Client Introducing Lawyer column 130, 

133, 196
Client Introducing Lawyers option 293
Client Ledger 4, 6, 8, 13, 38, 43, 48, 49–

55, 59, 64, 65, 69, 73, 77, 81, 
85, 88, 89, 92, 93, 96, 97, 101, 
108, 109, 123, 134, 167, 171, 
179, 183, 187, 188, 192, 197, 
207, 219, 227, 263, 265, 269, 
296

Client Manager 252
Client Name column 37, 42, 84, 87, 92, 

95, 104, 107, 111, 113, 115, 
196, 233

Client No. & Name column 122

Client Summary 4, 6, 8, 13, 38, 43, 48, 
54, 55, 59, 60–65, 69, 77, 81, 
85, 89, 93, 101, 106, 108, 109, 
123, 134, 167, 171, 179, 183, 
187, 188, 192, 197, 219, 227, 
269, 296

Client Totals Only check box 120, 190, 
195

Client Trust Ledger 4, 6, 8, 21, 48, 55, 
59, 65, 74–77, 109, 296

Client Trust Listing 4, 6, 8, 21, 48, 55, 59, 
65, 70–73, 77, 101, 109, 123, 
188, 262, 264, 296

Client WIP, Billing, & Collection Sum-
mary 4, 6, 46, 54, 64, 69, 81, 
85, 108, 164, 170, 171, 175, 
187, 189, 193, 194–199, 202, 
210, 211, 215, 218, 223, 227, 
235

Client/Journal column 262, 263
Client/Matter column 222
Clients 252
Close Date column 113, 115
Close Matter 102, 110, 112, 114
Close Number column 113
Closed Files report 4, 6, 48, 112–113
Closed Matter Register 102, 110, 112, 

114
Closing Balance 17, 21, 38, 55, 59, 65, 

73, 77, 123, 264
Clr box 16
Clr column 20
Cntngncy button 204
Collecting Lawyer

See Lawyers
Collecting Lawyer box 36, 42, 120
Collecting Lawyer column 122, 125
Collection Summary 4, 6, 164, 168–171, 

175, 198, 201, 203, 211, 218, 
223, 235, 269

Collections
Disbursements + Tax total 198
Fees total 198, 201, 202, 218

Collections column 173, 196
Color area 298
Comments column 258
Common tab

See Tabs
Comparative Time Analysis 4, 6, 65, 69, 

109, 164, 179, 183, 193, 218, 
219, 223, 224–227, 235

Comparison Period box 224
Completed column 245
Conflict Search 105
Conflicts Found on Search for column 

252
Consolidate Payments check box 51
Contact 242
Contact box 248
Contact button 244, 256
Contact Date box 249
Contact Listing 4, 6, 242, 248–250
Contact Manager 102, 248, 252

Documents tab 256
Contact Type box 248
Contact Type column 250
Contacts 248, 249, 252, 256

Context column 253
Field column 253
Matter Number column 253
Memo column 253
Responsible Lawyer column 253
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Contingency fee 204
Control accounts 263
Correct G/L Adjustment 24, 261
Correct TAF 274, 276, 278
Correct Transaction Levy 280, 282, 284, 

286
Create Bill

See Billing
Creation Date column 258
Credit check box 16, 20
Cross Reference column 115
Current A/R Balance column 80
Current A/R column 85
Current column 84
Current Period box 224
Current Trust Balance column 80
Current Trust column 85
Custom Report Layout window 297
Custom Reports 8
Customizable Reports 296–298

see Reports Customizable
Customizing reports

see Customizable Reports

D
Daily Time Summary 4, 6, 65, 109, 164, 

183, 193, 228–229, 231
Daily Totals by Lawyer Summary 179, 

206
Daily Totals check box 12, 206
Daily Totals column 21
Data After Change column 111
Data Before Changes column 111
Date 10
Date box 32, 228, 230
Date column 12, 16, 20, 23, 31, 37, 42, 

45, 52, 57, 68, 76, 80, 87, 92, 
95, 111, 130, 133, 153, 155, 
178, 206, 255

Date Last Contacted box 249
Date Last Documented box 258
Debit column 89, 93, 97
Debit total 139, 142
Department option 293
Description column 72, 76, 87, 92, 104, 

107, 113, 115, 130, 133, 178, 
191, 196, 206, 222, 225, 233, 
250, 255, 258

Destroy Date column 113
Detailed Report check box 137, 141, 

158
Details button 204
Details for Checks 75
Details for Receipts 75
Difference column 271
Direct Deposit check box 16, 20
Disb column

See Disbursement column
Disbs column 76

See Disbursement column
Disbsursements total 43
Disbursement + Tax column 173
Disbursement Alert check box 99
Disbursement Analysis & Interest report 

4, 6, 48, 86–89
Disbursement Analysis and Interest 

option 86
Disbursement column 31, 37, 42, 58, 

80, 130, 196
Disbursement History option 90

Disbursement History report 13, 81, 85, 
90–93, 97

Disbursements 37, 51, 56, 59, 101
Disbursements + Tax Collected total 175
Disbursements + Tax total 170
Disbursements + Tax Write-offs total 175
Disbursements column 85
Disbursements total 38, 54, 59, 64, 81, 

85, 101, 109, 126, 187, 265
Disc column 150
Discount Listing 4, 6, 136, 139, 143, 

147, 151, 152–153, 157
Discount percentage 159
Display in Order Entered check box 12, 

36
Document Contains box 258
Document Creation Date box 257
Document Filed category 285
Document ID box 258
Document Listing 4, 6, 242, 256–258
Document Manager 106, 256

Research tab 254
Document Name box 258
Document Name column 258
Document Registered category 284
Document type 242
Document Type box 257
Document Type column 258
Documents 256

Description column 253
Matter Number column 253

Drill down 8, 13, 17, 21, 23, 25, 38, 43, 
46, 53, 58, 63, 68, 72, 76, 81, 
85, 88, 92, 100, 105, 108, 116, 
123, 126, 131, 134, 139, 142, 
146, 150, 153, 156, 159, 166, 
174, 179, 182, 187, 192, 197, 
201, 209, 214, 217, 222, 226, 
229, 231, 234, 237, 240, 245, 
250, 255, 258, 275, 277, 281

Due column 138, 141, 145, 150, 153, 
155

Due date 136
Due Date box 137, 140, 152
Due Date option 244
Due Date/Reminder Date column 245
Duration column 245

E
Editor 8
Effective Rate/Hr column 191
e-mail 8, 256
E-mail column 250
End box 298
End Date box 11, 14, 18, 22, 24, 26, 30, 

35, 40, 44, 50, 57, 61, 66, 70, 
74, 75, 78, 82, 86, 90, 94, 106, 
110, 119, 128, 132, 160, 165, 
176, 180, 184, 190, 195, 205, 
208, 212, 233, 243, 274, 276, 
278, 280, 282, 284, 286

End Month box 168, 172, 238
End of Year 24
Entered column 138, 141, 145, 150, 153
Entries Older Than ## Days box 79, 83
Entry # column 16, 20, 23, 37, 42, 52, 

68, 76, 80, 130, 133, 138, 141, 
178, 206

Entry Date column 274, 280, 284
Entry Total column 17, 20
ePCLaw 4, 5, 118

Excel97 format 8
Exclude

Details for Clients with Totals less than 
check box 75

General Retainers check box 130
Matters with Zero Time 191
Provision for Write-offs option 45, 

121, 125
Expense Recovery 11, 49, 56, 60, 78, 82, 

86, 90, 94, 98, 184, 194, 261, 
266

Expense Recovery total 13
Explanation 10
Explanation box 32
Explanation column 12, 16, 20, 23, 31, 

45, 52, 57, 68, 76, 80, 88, 92, 
96, 138, 141, 145, 150, 153, 
156, 178

Explanation For Fee Adjustment window 
204

F
Fax column 104
Fee Adjustment column 206
Fee adjustments 204, 216, 220, 224, 232
Fee Adjustments report 4, 6, 164, 192, 

204–207
Fee Allocation Summary 4, 6, 164, 203, 

207, 208, 211, 219
Fee column 275, 281, 285
Fee Credit Lawyer

See Lawyers
Fee Credit Lawyer box 36, 42, 130, 165, 

168, 212, 216
Fee Credit Lawyer column 125, 130, 

166, 182, 209
Fee Entry option 176, 180
Fee Sheet 49, 60, 66, 78, 82, 98, 106, 

172, 176, 180, 184, 190, 194, 
216, 220, 224, 228, 230, 238, 
266

Fee total 218
Fee Total column 130
Fee Value column 217
Fee Write-Offs column 209, 217
Fee Write-Offs total 211, 218
Fee/Time column 68, 80
Fees 3, 37, 56
Fees Billed column 209, 213, 217
Fees Billed total 174, 210
Fees collected 164
Fees Collected As Fee Collecting Lawyer 

total 175
Fees Collected column 209, 217
Fees Collected Summary 4, 6, 164, 171, 

175, 198, 200–203, 215, 218
Fees Collected total 175, 210, 211, 218
Fees column 37, 42, 52, 58, 173
Fees Due by Lawyer report 4, 6, 164, 

201, 203, 212–215, 219
Fees option 221
Fees Received column 213
Fees Received total 201
Fees total 38, 43, 59, 64, 69, 81, 85, 108, 

126, 167, 187, 197, 214, 218, 
223, 275, 279

Fees Write-Offs total 175
Fees written-off 164
File Close Date area 112
File Conflict List 4, 6, 105, 242, 252–253
File Destroy Date area 112



Page 298

File location 48
File Location area 113, 115
File Location column 113, 116
File Location report 4, 6, 48, 114–??
File Number column 116
File Open Date area 112
Firm Cash & Fee Summary 4, 6, 164, 

179, 216–219, 223, 227, 229, 
231

Firm Filing ID 279
Firm Name box 249
Firm Summary 37, 80, 104, 166, 169, 

231
Firm Total column 237
Firm Totals 13, 46, 53, 58, 63, 182, 213
Firm Totals by Account 21, 72, 76
Firm Totals Only check box 35, 50, 57, 

71, 74, 78, 91, 95, 120, 168, 
172, 190, 195

Fiscal Year End box 288

G
G/L account 10, 136
G/L Account box 11, 14, 24, 137, 144
G/L Account column 13, 16, 33, 45, 

138, 145
G/L Account Summary 13, 17, 25, 46, 

146
G/L Adjustment 24, 261
G/L column 262, 263, 264
G/L Opening Balances 24, 261
G/L Reconciliation report 4, 6, 260, 

261–265
General Bank

Bank-to-Bank Transfer 266
Check 11, 14, 30, 49, 56, 60, 78, 82, 

86, 90, 94, 98, 140, 144, 148, 
154, 160, 184, 194, 261, 266

Correct Check 3
Firm Receipt 14, 266
General-to-General Transfer 14
Receive Payment 14, 37, 49, 56, 60, 

106, 119, 124, 128, 132, 168, 
172, 184, 194, 200, 208, 212, 
216, 232, 238, 261, 266

Release Check 3, 11, 14, 30, 49, 60, 
78, 82, 86, 90, 94, 194, 266

Remittance check 28, 32
Retainer 14, 18, 37, 49, 53, 56, 60, 62, 

78, 106, 128, 184, 238, 261, 266
General Bank account 17
General Bank column 251
General Bank Journal 4, 7, 8, 10, 14–17, 

55, 162, 263, 264, 268, 296
General Bank Opening Balances 14
General Bank section 263
General Disbursements column 52
General Journal 4, 7, 8, 10, 24–25
General Ledger 109, 171, 203, 263, 264
General Liabilities account (2000) 145, 

264
General Receipts column 52
General Reconciliation Balance 28, 265
General Retainer total 55, 59, 65, 109
Global Change Time 49, 60, 66, 78, 82, 

172, 176, 180, 184, 194, 228, 
230

Gross Billing box 288
Groups Member Of column 251
GST 37, 58
GST column 42, 138, 150, 275, 285

GST Journal 4, 7, 10, 26–29, 264, 265
GST on disbursements 45
GST on fees 45
GST Payable account (2400) 28, 264
GST refund 29
GST section 264
GST total 38, 43, 275, 279

H
Hard & Soft Cost Analysis 13, 55, 81, 85, 

89, 93, 94–97, 197
Hard and Soft Cost Analysis option 94
Hard Cost section 96
Hard Costs total 13, 89, 93, 97, 197
Heading area 298
Home column 104
Home Phone # column 122
Hourly rate 164
Hours column 37, 68, 84, 166, 173, 

178, 182, 191, 217, 226, 233
Hours total 38, 64, 69, 81, 85, 167, 179, 

183, 192, 218, 223, 226, 229, 
231

Hours/Day Reported total 183
HST 283
HST column 281

I
Ignore Matter If

A/R Balance Less Than box 121
Charges Less Than box 80, 84
Disbursements Less Than box 80, 84
Fees Less Than box 79, 84
Outstanding Days Less Than box 121

Inactive Matters check box 112, 293
Inactive Users option 251
Include

Accounts Payable Entries check box 
12

Address Info check box 248
Allocations check box 149
Appointments check box 244
Billable option 228
Billable Tasks check box 67, 181, 225, 

230
Billed Entries check box 221
Billed Items check box 67, 181, 225, 

230
Billed Only check box 51
Billed option 87, 91, 95
Both option 15, 19
Clients check box 248
Completed Activities check box 244
Contact Info check box 257
Contacts check box 248
Contingency Matters check box 80, 84
Disbursements check box 51, 79, 83
Disbursements option 15, 19
Documents option 257
E-mail option 257
Expense Recovery Entries check box 

12
General Check Allocations check box 

12
General Checks check box 161
If Matter has A/R check box 233
If Matter has Unbilled Time check box 

233
Invoices option 141
Matter Balances check box 107
Matter Info check box 248

Matters with Non-zero Balances 
check box 61

Matters with Zero Balances check box 
61

Negative Unbilled Disb Balance 
check box 51

Non-Billable option 228
Non-Billable Tasks check box 67, 225, 

230
Non-billable Tasks check box 181
Notes check box 244
Only Held Items check box 177
Only Matters with Negative Unbilled 

Disbursement Balances check 
box 62, 79, 83

Only Matters with No Activity After 
check box 106

Only Matters with Retainer Balances 
check box 51, 62

Only Matters with Unbilled Disburse-
ments Over box 62

Paid by Client option 87, 91, 95
Paid Invoices check box 35
Phone Calls/Messages check box 244
Precedents option 257
Provision for Write-offs option 45, 

121, 125
Receipts check box 51
Receipts option 15, 19
Retainers check box 79
Time/Fees 83
Time/Fees check box 51, 79
To Do’s check box 244
Totals for all Matters check box 75
Trust check box 51
Trust Checks check box 161
Unbilled Entries check box 221
Unbilled Items check box 67, 181, 

225, 230
Unbilled option 87, 91, 95
Unpaid by Client option 87, 91, 95
Unpaid Invoices check box 145
Vendors 158, 161
Vendors box 144
Vendors check box 248
Vendors option 137, 141, 149, 152
W/O’s in Billings option 195
Write-Offs Only check box 42
Write-Ups and Write-Downs check 

box 36
Include Corrected Entries check box 12, 

15, 19, 36, 41, 45, 51, 177, 
244

Input Tax Credit 32
Interest

Due 53, 63
Paid 53, 63
Show Interest check box 51

Interest Calculation report 5, 7, 55, 65, 
118, 132–134

Interest column 88, 92, 133
Interest Due total 55, 65
Interest Paid total 55, 65
Interest Rate box 86
Interest Rate column 133
Interest to box 86
Interest Up To box 51, 132
Internet License column 251
Introducing and Responsible column 

209
Introducing Lawyer column 104, 122
Introducing Only column 209
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Introducing total 237
Invoice # column 31, 68, 122, 130, 133, 

213
Invoice box 35, 44, 132, 140
Invoice column 37, 42, 45, 156, 206
Invoice date 136
Invoice Date box 137, 140, 145, 148, 

152
Invoice Date column 45
Invoice Journal 5, 7, 8, 10, 38, 40–43, 

46, 54, 55, 64, 65, 101, 109, 
126, 167, 171, 174, 175, 193, 
198, 203, 207, 210, 215, 218, 
269, 296

Invoice Number column 155
Invoice total 156
Invoice Total column 138
Italic area 298
Italic check box 298
ITC Adjustments 32
Item column 45

J
Journal column 262, 263, 264
Journal/G/L column 262, 263, 264

L
Last Activity column 100
Last Appointment column 107
Last Billed column 63
Last Billing column 106, 107
Last Document column 106, 107
Last Entry column 62, 72
Last Modified column 258
Last Note column 106, 107
Last Payment column 106, 108, 213
Last Receipt column 122
Last Time Entry column 84, 106, 107
Last To Do column 107
Last YTD column 201
Last YTD total 202
Last/Next Appointment Entry column 

106, 107
Last/Next column 107
Last/Next To Do Entry column 106, 107
Law Society of Newfoundland and 

Labrador 283
Law Society of Upper Canada 288
Law Type column 42

See Type of Law column
Lawyer

Collecting 6, 7
Fee Credit 6, 7
Responsible 6, 7

Lawyer box 172, 184, 200, 236, 243, 
246, 248, 254, 274, 284

Lawyer Budgeting 238, 239
Lawyer Budgeting report 5, 7, 164, 238–

240
Lawyer column 37, 173, 178, 206, 217, 

237, 245, 250, 274, 280, 284
Lawyer Summary 166
Lawyer WIP, Billing, & Collection Sum-

mary 5, 7, 38, 46, 164, 170, 
172–175, 183, 193, 198, 201, 
203, 211, 215, 218, 223, 227, 
235, 237, 240, 269

Lawyers
Assigned 3, 6, 7, 46, 164
Client Introducing 3, 6, 7
Collecting 3, 10, 118, 164

Fee Credit 3, 10, 35, 40, 46, 118, 164, 
165, 168, 175, 201, 205

Introducing 164
Matter Introducing 3, 6, 7
Responsible 3, 10, 35, 46, 48, 118, 

164, 175, 201, 202, 205
Working 3, 6, 7, 48, 164, 176, 183

Lawyers and Rates 238, 239
Lawyers box 238
Layout area 15, 19, 22, 35, 41, 45, 50, 

61, 67, 71, 74, 102, 120, 129, 
177, 296

Layout Name area 297
Layout tab

See Tabs
Layout View area 297
Length box 298
LexisNexis Research 254
List of Clients report 5, 7, 8, 48, 102–

105, 237, 296
Location area 298
Location code 242
Location Code box 243
Location column 245

M
Major Client column 104
Major Clients option 292
Marked items 270
Marked Items balance 271
Matter 10, 48, 118, 136, 164, 242
Matter # column 87, 92, 130, 138
Matter and Expl. Code Totals Only check 

box 91, 95
Matter Balances Only check box 66, 78, 

83
Matter box 11, 34, 40, 44, 50, 57, 61, 

66, 70, 74, 78, 82, 86, 90, 94, 
102, 106, 110, 112, 114, 119, 
128, 132, 148, 180, 190, 194, 
208, 220, 232, 243, 246, 248, 
254, 256, 274, 280, 284

Matter Change Log 5, 7, 48, 110–111
Matter Close Date area 103, 115
Matter column 13, 16, 20, 23, 31, 37, 

42, 62, 72, 76, 84, 95, 104, 
107, 111, 113, 115, 122, 133, 
150, 178, 191, 196, 206, 213, 
233, 245, 250, 251, 255, 258, 
274, 276, 280, 284

Matter Description column 37, 42, 111, 
276

Matter Introducing Lawyer 196
See Lawyers

Matter Introducing Lawyer column 130
Matter Introducing Lawyers option 293
Matter Manager 3, 42, 60, 274, 276, 

277, 278, 280, 282, 284, 286
Appointments tab 243, 246
Billing tab 102, 114, 236
Contacts tab 102, 248
Docs tab 256
Ledger tab 22, 34, 40, 44, 56, 66, 70, 

74, 78, 82, 98, 119, 124, 132, 
165, 172, 176, 180, 184, 190, 
194, 216, 220, 224, 228, 230

Main tab 102, 103, 110, 252
Research tab 254
Settings tab 102
Summary tab 102, 106

Time tab 66, 78, 82, 172, 176, 180, 
184, 190, 194, 216, 220, 224, 
228, 230

Trust tab 18
Matter Name column 138
Matter Open Date 283, 287
Matter Open Date area 103, 115
Matter Opening Balances 11, 18, 34, 40, 

49, 56, 66, 70, 74, 78, 82, 86, 
90, 94, 98, 119, 124, 128, 132, 
165, 168, 172, 176, 180, 184, 
190, 194, 208, 212, 216, 220, 
224, 238

Matter Status report 5, 7, 38, 48, 54, 55, 
59, 64, 65, 69, 73, 77, 81, 
106–109, 123, 197

Matter tab
See Tabs

Matter Total column 76, 133, 233, 234
Matter Totals Only check box 91, 95, 

120, 190, 195
Matter Totals Summary 53
Matters 249, 252

Purged 39
Matters Fee Value column 173
Matters Introducing column 173
Matters Opened column 173
Matters Opened Summary 5, 7, 164, 

174, 236–237
Matters Opened total 174
Memo column 106, 108
Memorized Transactions 252
Memos column 255
Menu Items column 251
Microsoft Outlook 256
Microsoft Word 256
Mobile Modules 260
Modified Cash accounting 30, 145, 261, 

263–265
Money Order check box 16, 20
Month box 200, 216, 220, 236
Month column 169, 279
Monthly comparison 164
Monthly total 231

N
Name box 252, 297
Name column 130, 191, 245, 250
Negative Balances Only check box 71, 

74
Net Billed column 169
Net Fees Billed total 170
Net Total column 206
New Appointment

See Calendar
New Client 252
New column 45
New Contact 252
New Document 256
New Matter 3, 102, 236, 252
New Notes 106
New Page for Each Lawyer check box 

125, 238, 293
New Page for Each Matter check box 293
New Payable

See Accounts Payable
New Phone Call 248
New To Do 106
Newfoundland and Labrador 280, 282, 

290
Next Appointment column 107
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Next To Do column 107
No Activity After box 51
No Time Entries for check box 99
Non-employee Compensation column 

161
Non-Employee Compensation total 162
Notes 243, 245

Context column 253
Date column 253
Details column 253
Field column 253

Number of Clients box 184
Number of Trust Administration Fees 

Entered column 277
Number of Trust Administration Fees Not 

Entered column 277

O
Ontario 284, 286, 288, 290
Open Date column 62, 104, 113, 115, 

250
Open Payable

See Accounts Payable
Opening Balance column 161
Original column 45, 213
Original total 214
Other staff 48
Other Staff box 103
Other Staff column 104
Other tab

See Tabs
Output 8
Outstanding column 122, 126, 142, 213
Outstanding Items 270
Outstanding Items List section 272
Outstanding total 38, 55, 59, 65, 101, 

109, 146, 188, 214, 265
Over Line check box 298
Overdue Recurring Transactions 140, 

144, 148

P
Paid > Tax total 126
Paid by Check # notation 58
Paid By Client column 96
Paid by installments 28
Paid column 126, 150
Paid Disbursements total 126
Paid Fees column 185
Paid Fees total 126, 187
Paid Out option 26
Paid to 10
Paid To column 12, 31
Paid To/Fee/Time column 80
Paid total 38, 54, 126, 167
Paid+Disc column 142
Partner Alert 98–101
Partner Alert Criteria tab

See Tabs 98
Partner Alert report 5, 7, 48
Past Due Notices 34
Pay GST box 32
Payable column 153
Payable Listing 5, 7, 136, 139, 140–143, 

146, 151, 157, 264, 268
Payment # column 130
Payment Allocation Listing 5, 7, 8, 38, 

54, 118, 126, 128–131, 167, 
169, 171, 175, 187, 188, 198, 
201, 202, 210, 211, 215, 218, 
240, 268, 296

Payment column 146
Payment date 136
Payment Date box 145
Payment Date column 145
Payment Listing 5, 7, 136, 139, 142, 

144–147, 151, 156, 162
Payment Method 20

 16
Payment total 146, 156, 162
Payment Used column 169
Payment Used total 171, 175
Payments and Adjustments total 187, 

188
Payments column 156
Payments Up To box 141
Payments Used Fees total 202
Payroll 24
PCLaw Plus 4, 5, 10, 48, 128, 136, 164, 

242
PCLaw Timers 49, 60, 66, 78, 82, 98, 

172, 176, 180, 184, 190, 194, 
216, 220, 224, 228, 230, 232, 
238, 266

PCLawPro 3–5, 10, 41, 43, 48, 79, 121, 
128, 136, 164, 168, 242, 292, 
293

PCLawPro Enterprise 3–5, 10, 41, 43, 48, 
79, 121, 128–131, 136, 164, 
168, 242, 292, 293

PDF 8
Percent column 153
Period Totals 28
Personal property 280, 282
Personal Property check box 280, 282
Phone Call Manager 66, 78, 82, 98, 172, 

176, 180, 184, 190, 194, 216, 
220, 224, 228, 230, 232, 238, 
243, 246, 266

Phone Calls 49, 60, 243, 245, 246
Phone Numbers column 159
Portable document format 8
Principal column 133
Principal total 134
Printer 8
Process Payable

See Accounts Payable
Productivity by Client report 5, 7, 164, 

184–189
Provision for Write-offs Only option 45, 

121, 125
Provisional Write Off Bill 30, 44
PST Adjustments 32
PST Collectable 32
Purchases Journal 5, 7, 137–139, 142, 

147, 151, 157
Purged matters 39

Q
Quick Bill

See Billing
Quick Timer 49, 60, 66, 78, 82, 98, 172, 

176, 180, 184, 190, 194, 216, 
220, 224, 228, 230, 232, 238

R
Range of Clients

By Client Name option 292
By Client Nickname option 292

Rate column 104, 250
Rate/Hr column 166, 182
Rates column 178

Real estate 280, 282, 284, 285, 286, 288
Real Estate check box 280, 282
Real Estate option 284, 286
Real Estate Type column 284
Receipt column

See Receipts column
Receipts column 16, 20, 37, 76, 169
Receipts Up To box 35, 86, 90, 94, 120
Receivables by Client report 5, 7, 8, 38, 

55, 59, 65, 101, 109, 119–123, 
126, 134, 188, 235, 269, 296

Receivables by Lawyer report 5, 7, 8, 38, 
55, 59, 65, 109, 118, 123, 
124–127, 296

Received (%) column 166
Received column 166
Received from 10
Received From/Paid To box 16, 20
Received From/Paid To column 16, 20, 

23, 52, 57, 76
Recipient’s ID column 161
Recipient’s Name and Address column 

161
Record Type column 252
Recovery total 64, 89, 93
Recreate Bill

See Billing
Recurring Entries due this month section 

268
Ref# box 11, 22
Ref# column 13, 23, 57, 88, 92, 96
Reference box 24
Reference column 138, 142, 145, 150, 

153, 252
Reference number 10
Referral type 48
Referral Type box 103
Referred By column 104
Register

A/P tab 11, 30, 78, 82, 86, 90, 94, 
137, 148, 154, 194

Appointments tab 243, 246
Expense tab 11, 78, 82, 86, 90, 94, 

194
General tab 11, 14, 30, 78, 82, 86, 90, 

94, 144, 148, 154, 160, 172, 184, 
194, 216

Invoice tab 34, 40, 44, 56, 66, 98, 
119, 124, 132, 165

Ledger tab 11, 30, 34, 40, 44, 56, 66, 
70, 74, 78, 82, 90, 94, 98, 119, 
124, 132, 165, 172, 176, 180, 
184, 194, 228, 230

Matter tab 18, 22
Time tab 66, 78, 82, 172, 176, 180, 

184, 194, 228, 230
Trust tab 18, 22, 70, 74, 160

Release Bill
See Billing

Reminder Date option 244
Remittance check

See General Bank
Remittance payments 28
Remittance period 28
Remove button 296
Report Detail

Daily Totals check box 19
Totals Only check box 19

Report Details
Daily Totals check box 15
Totals Only check box 15

Report Font box 297



Page 301

Report Month box 266
Reports

Customizable 8
Request Bill

See Release Bill
Request Check

See Release Check
Reread G/L Information check box 262
Research Listing 5, 7, 242, 254–255
Research type 242
Resp Lawyer box 35, 40, 44, 50, 57, 61, 

66, 70, 74, 78, 82, 86, 90, 94, 
102, 106, 112, 114, 119, 128, 
132, 190, 195, 208, 220, 233

Responsible Lawyer
See Lawyers

Responsible Lawyer column 62, 72, 76, 
88, 92, 104, 113, 116, 130, 
191, 196, 206, 233, 250

Responsible Lawyers button 99
Responsible Lawyers option 293
Responsible Only column 209
Responsible total 237
Retainer column 37, 58, 63, 169
Retainer total 59, 65, 109
Retainers column 80
Reverse Provision For Write Off 30, 44
Rich text format 8
Row (line) box 298
Run Report on a Cash Basis check box 

26
Running Balance 28
Running Balance column 17, 21, 33

S
Sales column 31
Sales tax 37, 58
Sales Tax column 42
Sales Tax Journal 5, 7, 10, 30–33
Sales tax on disbursements 45
Sales tax on fees 45
Sales Tax Payable account (2450) 32, 33
Sales tax total 38, 43
Saving column 153
Schedule for

Day of option 246
Screen 8
Search Description and Categories Fields 

box 254
Search Description and Comments 

Fields For box 258
Search Type box 254
Security 251, 295
Select button 292, 293
Select Field Properties area 297
Selected box 298
Selected Clients option 292
Selected Matters option 292
Settlement Statement 34
Show Balances As of End Date check 

box 35, 120, 125
Show Billings and Write-offs Separately 

option 195
Show Budget by Month check box 238
Show by

Matter Introducing Lawyer check box 
195

Task Code option 181, 205
Type of Law option 181, 205

Show Client Address and Matter 
Description check box 71

Show Client Address check box 51
Show Entries which result in a negative 

trust balance 75
Show Full Re Line/Memo check box 252
Show Interest check box 51
Show Invoices that Payments were 

Applied To check box 51
Show Matters with No Activity After box 

62, 71, 75
Show Only Completed Activities check 

box 244
Show Only TAF Eligible Entries check 

box 20
Show Paid By Check # on Paid Payables 

check box 51, 57
Show payments to original Payable G/L 

Accounts check box 145
Show Summary Only check box 103
Show User Name check box 12, 138, 

206
Simple Format check box 257
Size area 298
Soft Cost column 96
Soft Costs total 13, 89, 93, 97, 197
Sort by

Amount option 270
Appointment Code option 244
Assigned Lawyer option 293
Author option 256
Billed Disbs option 185
Billed Fees option 185
Check Number option 15, 18, 270
Client and Name option 244
Client Introducing Lawyer option 293
Client Name option 35, 41
Client/Matter option 110
Closed Number option 113
Contact Type option 248
Creation Date option 257
Date option 15, 18, 35, 41, 110, 177, 

205, 254, 270
Default option 293
Deposit Slip option 15, 18
Doc Name option 256
Doc Type option 256
Due Date option 244
Entry Number option 15, 18
Entry option 254
Fee Credit Lawyer option 165, 205
File Location option 113, 115
Invoice option 35, 41, 148
Last Contacted option 248
Last Modified Date option 257
Lawyer option 244
Location Code option 244
Matter box 257
Matter option 35, 102, 148, 254
Name option 102, 248
Order Entered option 177, 205
Paid Fees option 185
Paid To/Receive From option 270
Print Separate Outstanding Items List 

check box 270
Reference Number check box 24
Reminder Date option 244
Responsible Lawyer option 293
Task Code option 177, 205
Total A/R option 185
Total Disbs option 185
Total Fees option 185
Total Paid option 185
Total Trust option 185

Type of Change option 110
Type of Law option 165, 177, 205, 

293
Unbilled Disbs option 185
Unpaid Fees option 185
User option 110
Working Lawyer check box 181
Working Lawyer option 177

Source column 13, 156
Source of Change column 111
Split Bill Fee Transfer 183
Src column 96
Start box 298
Start column 245
Start Date box 11, 14, 18, 22, 24, 26, 30, 

35, 40, 44, 50, 57, 66, 75, 78, 
82, 86, 90, 94, 106, 110, 128, 
132, 160, 165, 176, 180, 184, 
190, 195, 205, 208, 212, 233, 
243, 274, 276, 278, 280, 282, 
284, 286

Start Month box 168, 172, 238
Start of Year box 200, 216, 220
Status column 251
Strikethrough check box 298
Sub-totals by Working Lawyer 84
Summary

Client Introducing Lawyer check box 
36, 41, 79, 121, 129, 168, 195

Collecting Lawyer check box 121
Daily Totals check box 177
Department by Lawyer check box 41, 

121, 177
Department check box 36, 41, 62, 79, 

121, 129, 177
Explanation Code check box 12, 87, 

91, 95
Fee Credit Lawyer check box 36, 41, 

129, 168
G/L Summary Only check box 12
Lawyer by Department check box 36, 

129
Matter Introducing Lawyer check box 

41, 79, 121, 129, 168, 195
Referral Source check box 36
Referral Type check box 41, 103, 129, 

236
Responsible Lawyer check box 12, 15, 

36, 41, 79, 83, 87, 91, 95, 103, 
121, 129, 137, 141, 168, 195, 
236

Responsible Lawyer within Type of 
Law check box 41, 129

Show Trust Summary by Account 
check box 51, 57

Type of Law check box 41, 87, 91, 95, 
103, 129, 195, 236

Working Lawyer check box 79, 83
Summary by Client Introducing Lawyer 

37, 43, 80, 122, 131, 169, 196
Summary by Collecting Lawyer 122
Summary by Department 37, 43, 63, 80, 

122, 131, 179
Summary by Department by Lawyer 179
Summary by Explanation Code 13, 88, 

92, 96
Summary by Fee Credit Lawyer 37, 43, 

131, 169
Summary by Fee Credit Lawyer by Task 

Code 46
Summary by Lawyer 37
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Summary by Lawyer by Department 37, 
43, 122, 131

Summary by Matter Introducing Lawyer 
43, 80, 122, 131, 169, 196

Summary by Referral Source 37, 131
Summary by Referral Type 43, 104
Summary by Responsible Lawyer 13, 17, 

37, 43, 63, 68, 72, 80, 88, 92, 
96, 104, 122, 131, 138, 142, 
150, 169, 192, 196, 206, 223

Summary by Responsible Lawyer by 
Type of Law 43, 131

Summary by Task Code 179, 182, 206
Summary by Task Code by Fee Credit 

Lawyer 46
Summary by Type of Law 43, 88, 92, 96, 

104, 131, 179, 182, 192, 196, 
206

Summary by Working Lawyer 68, 80, 
179, 182, 192, 206, 229

Summary of Billable/Non-billable Hours 
by Working Lawyer 231

Summary Only check box 26, 30
Suspense account (9999) 13
System Settings

Data Entry tab 128
Other tab 8
Provincial tab 290

T
Tabs

Common 2, 11, 14, 18, 22, 24, 26, 34, 
40, 44, 50, 56, 60, 66, 70, 74, 78, 
82, 86, 90, 94, 102, 106, 110, 
112, 114, 119, 124, 128, 132, 
137, 140, 144, 148, 152, 154, 
158, 160, 165, 168, 172, 176, 
180, 184, 190, 194, 200, 205, 
208, 212, 216, 220, 224, 228, 
230, 232, 236, 238, 243, 246, 
248, 254, 256, 274, 276, 278, 
280, 282, 284, 286, 288

Displaying 8
Layout 2, 294–295
Matter 2, 6, 292–293
Other 2, 6, 12, 15, 19, 35, 41, 50, 61, 

67, 71, 75, 79, 103, 113, 114, 
120, 129, 149, 177, 181, 195, 
221, 225, 249, 257

Partner Alert Criteria 98
TAF 274–279, 290
TAF Detail report 5, 274–275, 279, 290
TAF Eligibility report 5, 276–277, 290
TAF Eligible Explanation codes 276
TAF Entered column 277
TAF Summary 5, 275, 278–279, 290
Task Code box 176, 221, 228, 230
Task Code column 45, 225
Task Code option 178, 293
Task codes 46, 231
Task column 178, 206
Tax 59, 164
Tax column 31, 37, 63, 130
Tax total 38, 43, 46, 54, 65, 126
Template box 294
Text 8
This Month column 201, 222
This Month total 201, 202
This YTD column 201
This YTD total 202
Threshold amount 136

Threshold Amount box 160
Time 3, 56, 101, 224
Time Alert check box 99
Time column 196
Time Docket

Context column 253
Date column 253
Explanation column 253
Field column 253
Lawyer column 253
Task column 253

Time Entry option 176, 180
Time Listing 5, 7, 65, 69, 81, 85, 101, 

109, 164, 175, 176–179, 183, 
193, 218, 219, 223, 226, 229, 
231, 235, 240

Time option 221
Time Sheet 49, 60, 66, 78, 82, 98, 106, 

172, 176, 180, 184, 190, 194, 
216, 220, 224, 228, 230, 232, 
238, 266

Time Summary 5, 7, 8, 65, 69, 81, 85, 
101, 109, 164, 167, 174, 175, 
179, 180–183, 192, 218, 223, 
226, 229, 231, 235

Time Utilization Analysis 5, 7, 164, 174, 
179, 183, 192, 218, 223, 226, 
229, 230–231, 235

Timekeeper 3
Title area 298
To box 32
To do’s

See Calendar
Total 43
Total A/R column 186
Total Billed 32
Total column 42, 84, 122, 126, 130, 

133, 178, 237, 275, 279, 281, 
285

Total Disbursements column 186
Total Fees column 186
Total Outstanding Items balance 272
Total Paid column 186
Total Purchases 32
Total Transaction Levies Due 285, 287
Total Trust column 186
Totals Only check box 35, 41, 45, 50, 

57, 61, 66, 71, 74, 78, 82, 129, 
177, 180, 206, 208, 212, 220, 
224, 228, 230, 233, 238, 270

Transaction Amount column 161
Transaction Amount total 146, 156, 162
Transaction Category column 285
Transaction Levy 49, 280–290
Transaction Levy Detail report 5, 280–

281, 283, 284–285, 290
Transaction Levy Summary 5, 281, 282–

283, 285, 286–287, 290
Transactions total 281, 283
Trust Administration Fee

See TAF
Trust Alert check box 99
Trust Balance column 63, 100, 122, 277
Trust Balance total 55, 65, 77, 101, 109, 

188
Trust Bank

Bank-to-Bank Transfer 18, 49, 56, 60, 
184

Check 18, 49, 56, 60, 70, 74, 98, 160, 
184

Correct Check 3

Matter-to-Matter Transfer 18, 22, 49, 
56, 60, 70, 74, 98, 184

Receipt 18, 49, 56, 60, 70, 74, 98, 
184, 276, 278

Release Check 3, 18, 49, 56, 60, 70, 
74, 98, 184

Trust-to-General Transfer 14, 18, 30, 
37, 49, 56, 60, 70, 74, 98, 106, 
119, 124, 128, 132, 168, 172, 
184, 194, 200, 208, 212, 216, 
261, 266

Trust Bank account 21, 73, 77
Trust Bank column 251
Trust Bank Journal 5, 7, 10, 18–21, 59, 

73, 77, 101, 162, 264
Trust Bank Matter-to-Matter Transfer 

Journal 5, 7, 8, 10, 22–23, 296
Trust Bank section 262
Trust column 58
Trust Disbursements column 53
Trust Funds Owed account (2200) 77
Trust Funds Owed balance 264
Trust Funds Owed total 262
Trust Only check box 57
Trust Receipts column 53
Trust Summary by Account 53, 58
Trust total 59, 65, 73, 77, 123, 188
Type column 57, 133, 255, 281
Type of law 46, 164, 165
Type of Law box 165, 176, 228
Type of Law column 88, 92, 96, 104, 

130, 178, 191, 196, 206, 225, 
250, 258

Type of Law option 293

U
Unbilled Amount total 197
Unbilled Check total 13, 54, 59, 64, 81, 

85, 89, 93, 97, 101, 109, 188, 
197, 265

Unbilled disbursements 101
Unbilled Disbursements column 63, 

100, 186
Unbilled Disbursements total 13, 54, 59, 

64, 81, 85, 89, 93, 101, 109, 
188, 197

Unbilled Fees column 62, 185
Unbilled Fees total 54, 64, 69, 81, 85, 

101, 108, 187, 197
Unbilled Hours column 62
Unbilled Hours total 64, 69, 81, 85
Unbilled Recovery total 54, 59, 81, 85, 

97, 101, 109, 188, 197, 265
Unbilled Retainer total 81
Unbilled time 101
Unbilled Time & A/R Summary by Work-

ing Lawyer 65, 109, 164, 232–
235

Unbilled Time column 100
Unbilled Time Summary by Working 

Lawyer 5, 7
Unbilled Time total 101
Unbilled total 54, 139, 151
Under Lined check box 298
Undo Bill

See Billing
United Kingdom 4
United States 4, 136
URL column 255
Use Advanced Report Selections 8
Use Document Manager 242
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User 242
User box 254
User column 255
User Name column 111
User Security Listing 5, 7, 242, 251

V
Value column 173, 182, 191, 233
Var % column 239, 240
Variance column 239, 240
Vendor 136, 152, 242
Vendor # column 159
Vendor box 137, 140, 144, 148, 152, 

160
Vendor column 138, 141, 145, 150, 153
Vendor discounts 152
Vendor Ledger 5, 7, 136, 143, 146, 154–

157, 162
Vendor Listing 5, 7, 139, 158–159
Vendor Name & Address column 159
Vendor total 139, 142
Vendor Total column 138
Vendors 252
Volume Surcharge Summary 5, 7, 288–

290

W
Windows Explorer 256
WIP column 196
WIP Disbursements total 188, 197
WIP Summary by Responsible Lawyer 5, 

7, 48, 69, 81, 82–85, 97, 179, 
183, 197, 199

WIP Time total 54, 64, 69, 81, 108, 187, 
197

Wire check box 16, 20
Working Lawyer

See Lawyers
Working Lawyer box 51, 62, 67, 79, 83, 

176, 180, 205, 221, 224, 228, 
230, 233

Working Lawyer column 68, 84, 191, 
222, 229, 234

Working Lawyers option 178
Work-in-Progress report 5, 7, 48, 54, 59, 

64, 69, 78–81, 85, 97, 101, 
108, 109, 164, 179, 183, 187, 
189, 197, 199, 235, 269

Work-in-Progress section 267
Workstation Settings

Other tab 8
Wrap check box 298
Write Up/Down Journal 5, 7, 8, 10, 43, 

44–46, 170, 175, 199, 207, 
211, 214, 215, 218, 288, 296

Write-Offs column 42, 173, 196, 213
Write-Offs Disbursement total 46
Write-Offs Fees total 46
Write-Offs total 43, 46, 214

Y
Year To Date column 222


